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Chapter 1: Reference     

Chapter 1: Reference 
Harmony has several commands, dialog boxes, and buttons. The Reference section lists all of them along with 
the matching definition. To understand how to use these functions in a production context, read the User guide. 

In the Reference guide, you will learn about the various parameters available in dialog boxes, menus, nodes, 
toolbars, views, and windows. 

The Preferences guide provides additional details about each individual preference. 
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Chapter 2: Dialog Boxes
Dialog boxes contain controls such as options and lists through which you can carry out a particular command or 
task. For example, in the Scene Settings dialog box, you must indicate the resolution and alignment. A typical dialog 
box looks as follows:

Add Column Dialog Box 18

Add Drawing Layer Dialog Box 20

Add Frames Dialog Box 22

Add Prefix or Suffix Dialog Box 23

Add Synced Drawing Layer Dialog Box 24

Advanced Save Dialog Box 25

File Tab 26

Drawings (Harmony Server only) 26

Palettes Tab 27

Palette Lists Tab 28

Auto-Matte Dialog Box 29

Close Gaps Dialog Box 30

Column Properties Dialog Box 31

Column Types Dialog Box 32

Configure Line Art to Colour Art Dialog Box 33

Convert to Synced Drawing Layer Dialog Box 34

Create Cycle Dialog Box 35
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Render Write Nodes Dialog Box 98
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Add Column Dialog Box
The Add Column dialog box lets you add a column in the Xsheet view.

By default, when you create a new scene, there is one drawing column in the Xsheet view and one corresponding 
drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the Timeline 
view, and a node in the Node view.

How to access the Add Column dialog box

 1. Do one of the following:

 l In the Xsheet menu, select Columns > Add Columns. 

 l Click the Add Columns  button. 

 l Press Shift + C.

NOTE: The Add Column dialog box contains additional parameters for working with elements which will only 
display if you set advanced preferences. To do this, press Ctrl + U (Windows/Linux) or ⌘  + U (Mac OS X) to 
open the Preferences dialog box. Select the Advanced tab, then select the Advanced Element Mode 
option and click OK.

Parameter Description

Name Lets you give the new column a meaningful name.

Type
Lets you select a type of column to create. Choices include: Drawing, Timing, 
Sound, 3D Path, 3D Rotation, Bezier Curve, Ease Curve, Expression and 
Annotation. 
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Drawing Layer Options

Line Art Creates a vector or bitmap drawing column in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing column in the Colour Art layer. 

Element

Create New Element Creates an independent column with its own drawing folder.

Vector
Select this option if you want the layer to contain vector drawings. 
Deselect this  option if you want the layer to contain bitmap images. 
Most of the time, the Vector option will be enabled.

Bitmap Format
Lets you select the type of bitmap image to insert in the column. Select SCAN 
from the list if you are planning to scan drawings using the Toon Boom 
Harmony Scan module.

Scan Type
If you chose SCAN from the Bitmap Format list, select the kind of scanning 
you want to achieve.

Field Chart
When importing traditional animation, lets you indicate the size of paper on 
which the animation or background was drawn. If you are not using perforated 
animation paper, leave the 12 field default value as is.

Reuse Existing 
Element

Links your column to an existing folder within the Element folder of your scene.

Folder Lets you select the folder to which you want to link your new column.

Use Existing Element

Uses drawings from an existing column in the new column. Both columns will 
be attached to the same set of drawings, but their timing will remain  
independent  from one another. If you modify one of the drawings, it will be 
modified in both columns. This is the same principle as the Clone column.

Name Lets you select the column to which you want to link your new column.

Add and Close
Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view and closes the dialog box. The names of the 
layers/columns are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view. The dialog box remains open for you to add as 
many layers/columns as needed. The names of the layers/columns are 
automatically numbered incrementally.

Close Closes the dialog box.
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Add Drawing Layer Dialog Box
The Add Drawing Layer dialog box lets you add a drawing layer  to your project. 

By default, when you create a new scene, there is one drawing column in the Xsheet view and one corresponding 
drawing layer in the Timeline view.

You can add an element for each drawing and it will appear as a column in the Xsheet view,  a layer in the Timeline 
view, and a node in the Node view.

How to access the Add Drawing Layer dialog box

 1. Do one of the following: 

 l In the Timeline view, click the Add Drawing Layer  button.

 l From the top menu, select Insert > Drawing.

 l Press Ctrl + R (Windows/Linux) or ⌘  + R (Mac OS X).

Parameter Description

Name Lets you give the new layer a meaningful name.

Overlay Art Creates a vector or bitmap drawing layer in the Overlay Art layer. 

Line Art Creates a vector or bitmap drawing layer in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing layer in the Colour Art layer. 

Underlay Art Creates a vector or bitmap drawing layer in the Underlay Art layer. 

Add and Close
Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view and closes the dialog box. The names of the lay-
ers/columns are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view. The dialog box remains open for you to add as 
many layers/columns as needed. The names of the layers/columns are 
automatically numbered incrementally.
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Close Closes the dialog box.
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Add Frames Dialog Box
The Add Frames dialog box lets you add frames anywhere in the middle of the scene—before or after a selection. 
If you select a frame row in the Xsheet view, Harmony will add the new frames before or after the selection, 
depending on your choice.

How to access the Add Frames dialog box

 1. Do one of the following: 

 l In the Timeline view, select the frame to which you want to add frames before or after.

 l In the Xsheet view, select a frame row. 

 l In the Timeline view, select the frame to which you want to add frames before or after.

 2. Do one of the following:

 l From the top menu, select Scene > Frame > Add Frames Before Selection or Add 
Frames After Selection. 

 l In the Xsheet view, right-click and select Frames > Add Frames Before Selection or Add 
Frames After Selection.

 l In the Xsheet toolbar, click the Add Frames  button to add frame after your selection.

 l Press Ctrl + G and Ctrl + H (Windows/Linux) or ⌘  + G and  Ctrl + H (Mac OS X).

The Add Frames dialog box opens.

Parameter Description

Number of frames to add Lets you enter the number of frames needed in the scene.
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Add Prefix or Suffix Dialog Box
The Add Prefix or Suffix dialog box lets you add or remove a prefix or suffix for a multi-layer or multi-node selection.

How to access the Add Prefix or Suffix dialog box

 1. In the Network or Timeline view, select all the nodes or layers to rename or press Ctrl + A (Windows/Linux) or 
⌘  + A (Mac OS X).

 2. In the Scripting toolbar, click the Add Prefix or Suffix Script  button. If the Scripting toolbar is not visible, 
you can display it by selecting Windows > Toolbars > Scripting from the top menu. If the Add Prefix or 
Suffix Script  button is not visible in the Scripting toolbar.

The Add Prefix or Suffix dialog box opens.

 

Parameter Description

Suffix
Allows you put a defined set of characters (letters, numbers, symbols) after the 
pre-existing layer or node name.

Prefix
Allows you put a defined set of characters (letters, numbers, symbols) before the 
pre-existing layer or node name.

Insert Text Enter a set of characters to be added to the selected layers or nodes.

Remove Text Enter a set of characters to be removed from the selected layers or nodes.
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Add Synced Drawing Layer Dialog Box
The Add Synced Drawing Layer dialog box lets you add a drawing layer  to your project that will automatically be 
synced with the currently selected layer.

Depending on whether the Support Overlay and Underlay Arts option was selected in the Advanced tab of the 
Preferences panel, the Add Synced Drawing Layer dialog box may look one of two ways.

How to access the Add Synced Drawing Layer dialog box

 1. In the Timeline view, right-click on the drawing layer you would like to sync with another layer.

 2. From the right-click menu, select Add Synced Drawing Layer.

Parameter Description

Name Lets you give the new layer a meaningful name.

Overlay Art Creates a vector or bitmap drawing layer in the Overlay Art layer. 

Line Art Creates a vector or bitmap drawing layer in the Line Art layer. 

Colour Art Creates a vector or bitmap drawing layer in the Colour Art layer. 

Underlay Art Creates a vector or bitmap drawing layer in the Underlay Art layer. 

Add and Close
Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view and closes the dialog box. The names of the lay-
ers/columns are automatically numbered incrementally.

Add

Adds the selected type of layers to the Timeline view and corresponding 
column in the Xsheet view. The dialog box remains open for you to add as 
many layers/columns as needed. The names of the layers/columns are 
automatically numbered incrementally.

Close Closes the dialog box.
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Advanced Save Dialog Box
In Harmony Server, the Advanced Save dialog box lets you save the scene as a new version, overwrite an existing 
version, set a new current version, display a list of modified drawings, colour palettes, and modified colour palette 
lists. 

How to access the Advanced Save dialog Box

 1. Make sure that you have the necessary rights to save the current scene version. If you do not, you can 
acquire the rights by selecting File > Rights to Modify Scene Version or Rights to Modify Scene. 

 2. From the top menu, select File > Advanced Save. 
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File Tab

Parameter Description

Save

‣ Enable this option if you want to save the modifications made to the 
current scene. 

‣ Deselect the Save option if you only want to save specific components 
of your scene listed in the Drawings, Palettes or Palette Lists tabs. This 
will disable all option in the File tab. 

This Version (number)
Saves the current version of the scene. You can rename the current version by 
typing a new name into the field. 

New Version (number)
Saves the current scene as a new version. You can name this new version by 
typing a name into the field. 

Overwrite Existing Version Lets you select an existing version of your scene from the list to overwrite it.

Description
Use this field to add or edit an existing description for the scene version you 
want to save. 

Mark as Current
Lets you set this scene version as the current one. This version will be auto-
matically selected as the default current version when the scene is selected in 
the Database Selector dialog box

Drawings (Harmony Server only) 
The Drawings tab lists the modified drawings.
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Parameter Description

Drawing list
Lets you select the modified drawings to save, and deselect the ones you do not 
want to save.

Select All Selects all modified drawings in list.

Deselect All Deselects all modified drawings in the list.

Palettes Tab
The Palette tab lists the modified colour palettes.

 

Parameter Description
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Colour Palette list
Lets you select the colour palette to save, and deselect the ones you do not want 
to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified colour palettes in the palette list.

Deselect All Deselects all modified colour palettes in the palette list.

Palette Lists Tab
The Palette Lists tab lists all the modified colour palette lists.

 

Parameter Description

Palette Lists
Lets you select the modified palette list to save, and deselect the ones you do 
not want to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified palette lists in the list.

Deselect All Deselects all modified palette lists in the list.
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Auto-Matte Dialog Box
The Auto-Matte dialog box lets you generate a matte for a drawing. 

How to access the Auto Matte dialog box

 1. In the Camera or Drawing view, select the drawing you want to create a matte for.

 2. Do one of the following: 

 l From the top menu, select Drawing > Generate Auto-Matte. 

 l In the Camera or Drawing menu, select Drawing > Generate Auto-Matte.

Parameter Description

Settings

Apply to all Drawings Creates a matte for all the drawings included in layer.

Radius
Lets you increase or decrease the radius value depending on the precision or 
roughness of your line. Use a lower value, the closer to your lines’ contours the 
matte will be shaped. The higher the value, the looser the matte will be shaped.

Source Art
Lets you select the layer from which you want the matte created: Line Art,Colour 
Art, Underlay or Overlay.

Destination Art
Lets you select the layer on which you want the matte to be created: Line 
Art,Colour Art, Underlay or Overlay.

Clear Destination Art First Deletes existing artwork on the destination layer before adding a matte to it.

Copy Strokes in Destination
Copies the contour of your lines as invisible lines in the matte drawing. This is 
useful if you need to reuse the lines later.
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Close Gaps Dialog Box
The Close Gaps dialog box lets you close up drawing areas that not are closed. This may sometimes happen 
when painting. You can close small gaps in a drawing by creating small, invisible strokes between the two 
closest points to close the colour zone. You do not need to trace directly over the gap. You can draw it a few 
millimeters away. The two closest points automatically close the gap.

How to access the Close Gaps dialog box

 1. Select View > Show > Show Strokes or press K to see a preview of the result.

 2. To flatten the strokes you draw, click the Auto-Flatten  button in the Tool Properties view.

 3. Select Drawing > Clean Up > Close Gaps or press Shift + F10 (Windows/Linux only).

The Close Gaps dialog box opens.

Parameter Description

Size Lets you set the size of the gap you want to be closed.

Apply to all drawings Closes all gaps in the drawing of the selected layer.
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Column Properties Dialog Box
The Column Properties dialog box lets you add, delete or modify elements (drawing folders) in your scene.

How to access the Drawing dialog box

 1. In the Xsheet view, double-click on a column name. Do not click on the drawing folder name that the column 
is linked to (this also appears in the column header just below the column name).

Parameter Description

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Element

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Vector
Select this option if the new element is a vector drawing or if you want to enable 
the parameters on the selected element in the Elements list.

Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Scan module, 
select the scan type from the list.

Field Chart
If you're importing traditional animation, select the size of the paper on which the 
animation was drawn.
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Column Types Dialog Box
The Columns Types dialog box lets you show or hide columns in the exposure sheet. 

How to access the Columns Types dialog box

 1. In the Xsheet view, select View > Column Types Manager.

The Column Types dialog box opens.

Parameter Description

Column Types Lets you select the types of columns to display in the Xsheet view.

Save as Default Makes these new settings the default ones used each time you start Harmony.

Restore Default Returns the settings to their defaults.
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Configure Line Art to Colour Art Dialog Box
The Configure Line Art to Colour Art dialog box lets you modify settings for the Line Art and Colour Art layers.

How to access the Configure Line Art to Colour Art dialog box

 1. In the Tools toolbar, select the Select tool. 

 2. In the Tool Properties view, hold down the Shift key and click on the Creatre Colour Art from Line Art button.

Parameter Description

Use rendered version of the 
drawing

Renders the drawing and vectorize it to calculate the position of the centreline 
that will produce the colour art stroke.

Maximum Resolution for 
rendered image

The size of the rendered image.

Threshold for rendered image The value of grey processed to create the rendered vectorized arts.

Fitting error for rendered Bez-
iers

This value represents how precise the fitting of the colour art zone in relation to 
the line art will be.

Source layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 
colour art to be created from.

Destination layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 
colour art to be created on.

Clear Destination Art Layer 
First

Deletes the content before the colour art is added. This is useful when you 
already have artwork on the destination layer.

Perform Line Art to Colour Art 
Operation Immediately

Performs the Create Colour Art from Line Art command when you click OK.
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Convert to Synced Drawing Layer Dialog Box
The Sync Layer feature allows for drawings to be separated on different layers, but to have the same timing.

How to access the Convert to Synced Drawing Layer dialog box

 1. Right-click on a drawing layer you would like to sync with another layer. 

 2. From the right-click menu, select Sync Layers With.

In the Choose the Parent Drawing Layer drop-down list, with the exception of the selected layer, every 
layer in your scene is listed.

 3. To sync a layer with your currently selected layer, from the drop-down list, select a parent drawing layer 
and click OK. The child layer immediately updates to the parent layer's timing.
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Create Cycle Dialog Box
The Create Cycle dialog box lets you create cycles from a series of drawings and exposures. 

When you create a drawing cycle, all the repeated drawings are linked to the same original files. When modify, 
repaint, or correct a drawing named “1” for example, all drawings named “1” are updated simultaneously. In order to 
modify a drawing independently from its other exposures, you must duplicate the drawing.

How to access the Create Cycle dialog box

 1. In the Timeline or Xsheet view, select the cell range to loop.

 2. In the Timeline toolbar, click the Create Cycle  button (you may have to customize the toolbar to display 
it).

The Create Cycle dialog box opens.

Parameter Description

Number of Cycles Lets you specify the number of cycles, including the current selection.
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Create Drawing from Drawing Selection Dialog Box
The Create Drawing from Drawing Selection dialog box lets you cut a part of a drawing and send it to a new or 
existing layer.  

How to access the Create Drawing from Drawing Selection dialog box

 1. From the top menu, select Edit > Create Drawing From Drawing Selection or press F9 (Win-
dows/Linux) or ⌘  + F9 (Mac OS X).

The Create Drawing From Drawing Selection dialog box opens.

Parameter Description

Layer Name
Lets you enter a name for the layer using the naming convention you 
established.

Cut Artwork From Source Lets you cut the selected artwork from the model.
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Create Function Step On Dialog Box
The Create Function Step On dialog box lets you  hold the same value over a selected number of frames for multiple 
parameters (pos x, scale y, etc.). This works well when you are animating drawings on 2s or 3s, for example, and 
you want to hold the same value for a function over those two or three frames.

How to access the Create Function Step On dialog box

 1. Add the Scripting toolbar to your interface:

 l Go to the top menu and select Windows > Toolbars > Scripting.

 l Right-click on the empty space near the top of the interface  and from the quick-access menu selecting 
Scripting.

 l Right-click on the empty space near the top of a view and from the quick-access menu selecting 
Scripting.

 2. In the Scripting toolbar, click on the Manage Scripts  button to open the Scripts Manager window.

 3. In the Scripts Manager, in the Files section, select the file TB_CreateStepsOn.js.

The functions associated with that file appear in the Functions section.

 4. In the Functions section, select TB_CreateStepsOn.

The Add script to toolbar button becomes active.
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 5. Click on the Add script to toolbar button.

The TB_CreateStepsOn script  button is added to the Scripting toolbar.

 6. Click Apply.

 7. Click OK.

 8. In the Timeline view, select the layer whose parameter values you would like to hold. 

 9. In the Scripting toolbar, click on the TB_CreateStepsOn script  button.

The Create Function Step On dialog box appears.

Parameter Description

Settings

Every Number of Frames Enter in the number of frames you would like to hold your functions.

Selection

First Frame

Enter in the frame number of where you would like the stepped holds to 
start.  The playhead location determines the lowest value you can enter 
for the first frame. You need to move the playhead to frame one if you 
would like to set frame one as the lowest possible starting value. 
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Last Frame
Enter in the frame number of where you would like the stepped holds to 
stop.
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Create Palette Dialog Box
The Create Palette dialog box lets you create a palette in Basic mode. For simple productions, it is recommended 
to use the Basic mode.  This setting stores the palettes automatically for you and saves them at the Scene level. 
When you use the Advanced Palette Lists mode, you can decide at which level you want to store your palettes: 
Environment, Job, Scene, or Element. 

How to access the Create Palette dialog box

 1. From the Colour view menu, select Palettes > New or click the New Palette button.

 l Make sure you have the rights to modify the palette list. If not, select  Edit > Edit Palette 
List Mode.

Parameter Description

New Palette Name Lets you enter a name for the new palette.
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Database Selector Dialog Box
The Database Selector dialog box lets you connect to your studio's central database when working on Harmony 
Server.

When you connect to the database, you cannot create new scenes directly from Harmony Premium. The available 
scenes will be the ones that were previously created using the Control Center module. 

How to access the Database Selector dialog box

 1. Start  Harmony Server.

The Database Selector dialog box opens.

Parameter Description

Environments Lets you select the scene's environment (project, movie).

Jobs Lets you select the scene's job (episode, sequence). 

Scenes Lets you select the scene.

Get rights to modify the scene
Allows you to modify the selected version of the scene and access the version 
manager during the opened session

Get rights to modify the scene 
version

Allows you to modify the currently selected scene version, but locks access to 
the version manager during the opened session.

Get rights to modify all scene 
assets

Automatically gets the rights to modify the scene and its assets. The user locking 
the scene using this option is the only one that can edit and save the scene 
version, all the drawings in that scene, all the palettes in the palette-list, both 
palette-lists, but not the library folders.

Version If you saved different versions of a scene, this lets you select one to open.
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Edit Default Paste Preset Dialog Box
The Edit Default Paste Preset dialog box lets you modify settings for the keyframe and exposure paste presets, 
as well as setting the defaults.

How to access the Edit Default Paste Preset dialog box

 1. From the Timeline menu, select Edit > Modify Paste Presets > All or Key Frame or Exposure.

Parameter Description

Drawings

Add/Remove Exposure

 

Never create drawing files: When adding exposures to a drawing layer, 
drawing files will not be created.

Only create drawing files when they do not exist: When adding exposures 
to a drawing layer, new drawings will be created only when drawings with the 
same name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure
If there are key exposures that exist on copied drawings, they are preserved 
when pasting. No key exposures are added. This is the default behavior when 
pasting.

Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key 
Exposure

Fills selected area till the next key exposure.

Keyframes

Add/Remove 
Keyframes

Motion: Copies the properties of the selected motion keyframe to the new 
frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.
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Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End: Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.
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Edit Exposure Paste Preset Dialog Box
The Edit Exposure Paste Preset dialog box lets you reuse key exposures as you animate.  

How to access the Edit Exposure Paste Preset dialog box

 1. From the Timeline view menu, select Edit > Modify Paste Presets > Exposure.

The Edit Exposure Paste Preset dialog box opens.

Parameter Description

Drawings

Add/Remove Exposure

 

Never create drawing files: When adding exposures to a drawing layer, 
drawing files will not be created.

Only create drawing files when do they do not exist: When adding 
exposures to a drawing layer, new drawings will be created only when 
drawings with the same name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure Creates a key exposure on the same drawing.

Fill Gap with Previous Drawing Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key Exposure Fills selected area till the next key exposure.

Keyframes

Add/Remove Keyframes

Motion: Copies the properties of the selected motion keyframe to the new 
frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.
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Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End:  Adds a keyframe to the 
beginning and end of the pasted function, reproducing the source function.

Reset to Default Return all values to their defaults.
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Element Manager Dialog Box
The Element Manager window lets you Opens the Element Manager window where you can add, delete or modify 
elements (drawing folders) in your scene. If you have drawing folders that are not linked to a column in your 
scene, use the Element Manager to delete them if needed. See xref Reference > Windows > Element Manager.

How to access the Element Manager window

 1. From the top menu, select Scene > Element Manager.

Parameter Description

Elements

Delete Elements Deletes the selected elements.

Delete Elements and 
Directories

Deletes  the selected layer and its directories (drawing folder).

Add/Modify Element

Name
Type in a new name in this field to create an element or to rename the selected 
element.

Vector
Select this option if the new element is a vector drawing or if you want to 
enable the parameters on the selected element in the Elements list.

Bitmap Format Lets you select the file format of the bitmap layer.

Scan Type
If you're planning to scan elements with the Toon Boom Harmony Scan 
module, select the scan type from the list.

Field Chart
If you're importing traditional animation, select the size of the paper on which 
the animation was drawn.

Add
Creates a new element with the current parameters entered in the Add/Modify 
Element section.

Modify Applies the parameter changes made to the selected element.
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Export Layout Image Dialog Box 
The Export Layout Image dialog box allows you to export your drawings as bitmap images matching the scene 
resolution size, taking camera motions into account, to paint them in an external bitmap editing software.

Access Method

 1. From the top menu, select one of the following:

 l File > Export > Layout Image to export all the elements in your scene to the layout .psd file.

 l File > Export > Layout Image from Selection to export only the selected elements. 

The Export Layout Image dialog box opens.

Parameter Description

Destination Path
Use the Browse button to select a location to save your layout and name the res-
ulting .psd file.

File Pattern
Automatically puts the name of the scene and/or the frame number in the name of 
the file you create.

Image Size

The size of the .psd image file that will be exported. The resulting image will be 72 
dpi as the standard television resolution and its size in pixel will fit your scene res-
olution settings. i.e HDTV, NTSC, PAL, etc. Note that if you have a camera 
movement going over the normal camera frame limit, for example a pan, the 
image will be bigger.

Options File Format: Lets you select the format to export your layout.
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Export Camera Frame: Prints the first and last camera frame of each scene into 
the exported layout images. If exporting in .psd format, the camera frames will be 
printed on a separate layer. 

Add a Camera Frame for Each Keyframe: If a scene contains complex camera 
movements, this prints each camera keyframe into the layout.

Label Camera Frame: Adds the camera position label in the top-left corner of 
each camera frame. Camera frames are labeled with a letter of the alphabet 
indicating their respective order.

 

Expand Render Area: Expands the area to render into the layouts. By default, 
only the area of the scene that is covered by the camera is rendered, and exported 
layout images are cropped at the edges of the camera frames. If enabled, this 
option adds space around the render area and captures extra details outside the 
camera frames. By default, the render area is expanded by 10%. You can use the 
input field to the right of the option to change this ratio.

Scale Image: Ensures that when a camera close-up is included in a scene, the 
exported image is larger so that the closest camera frame is at least the size of 
the chosen image size. This way, the layout does not appear pixelated when 
zooming in on the closest camera frame. If disabled, the size of the exported 
images will be based off the chosen Base Image Size and Expand Render Area 
options.

Maximum Size: If the Scale Image Up to Smallest Camera Frame option is 
enabled, this ensures images do not get scaled up too much. If enabled, images 
will be limited to 4096 pixels in width and height by default.

 

Vector Options 

If you export one or more vector-based drawing layers in your layout image, you 
have the option to export only the drawing layers you want. Enable or disable the 
following options to export or prevent the export of the corresponding art layers.  
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Overlay: Exports the art in the Overlay layer of the drawings to be exported to the 
layout image.  

Line Art: Exports the art in the Line layer of the drawings to be exported to the 
layout image.  

Colour Art: Exports the art in the Colour layer of the drawings to be exported to 
the layout image.  

Underlay: Exports the art in the Underlay layer of the drawings to be exported to 
the layout image.
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Export Soundtracks Dialog Box
The Export Soundtracks dialog box lets you export a sound file to use it in another application, such as an editing 
software. Harmony allows you to export sound files as a merged soundtrack or as a series of individual files. The 
exported soundtracks are generated as *.wav files.

How to access the Export Soundtracks dialog box

 1. From the top menu, select File > Export > Soundtrack.

The Export Soundtracks dialog box opens.

Parameter Description

Output Lets you specify the location in which the file will be exported.

Export Range

All Exports the sound over all the frames of your scene.

Frames Sets the start and end frames in the corresponding fields on the right.

Options

Process Soundtracks 
Individually

Each soundtrack from all layers is exported as individual files.

Merge All Soundtracks

One single file is created, combining all the sound files you imported in your 
scene. Note that it will only use the sound files in the selected frame range set 
in the Export Range section. If you selected to export all the frames, all the 
sound files will be processed.

Sound Settings

Rate Lets you set the rate of the soundtrack.

Size Lets you export the soundtrack at 8 or 16 bits.

Use Lets you export the soundtrack as mono or stereo.
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Export to Easel JS Dialog Box
The Export to Easel JS window lets you flatten an image sequence of your animation. Even if you have a fully rigged 
puppet or a single drawing layer with your animation sequence, the outcome will still be a flattened output of each 
frame, grouped together in your sprite sheet. This allows for more flexibility and freedom of work as you have access 
to any tools or effect modules you want to use. However, this can result in heavier files depending on the length, 
complexity and export size of your animation.

How to access the Export to Easel JS window

 1. Select Windows > Toolbars > Game.

 2. Click the Export to Easel JS  button.

Parameter Description

Select Directory

Save Path The folder path where you want to save your export.

Save Name
The folder name in which you will save your export. This will also be the name of 
your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder Displays the clips in the folder.
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Scene Options

Display

Here, you must select the Display of your character. This is the one that will be 
used to render out all of the information attached to that Display node. If the 
Unconnected_Display option is selected, all of the visual information in your 
scene will be rendered out.

Sprite Sheet Preferences

Max Width This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.Max Height

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it does 
not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 1024 
x 1024.  This is optimized for many graphics cards, but consumes more memory.

NPOT: Some game engines are optimized specifically to render to non powers of 
two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames

This option works in tandem with the Threshold option. The export will compare 
the drawings in your project to reuse a maximum of similar drawings and reduce 
the amount of information found in the sprite sheet, making it lighter. The export 
will omit the creation of new drawings if the difference is less than the threshold 
percentage.

Threshold

Calculates the differences between multiple drawings. A 2% threshold will 
prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, only 
2 of those pixels need to be different from my other drawing in order to create a 
new one. The higher the threshold, the fewer similar drawings you will have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.
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Export to Flash Movie Dialog Box
The Export to Flash Movie dialog box lets you export your animation as a Flash (.swf) movie.  

How to access the Export to Flash Movie dialog box

 1. From the top menu, select File > Export > SWF.

The Export to Flash Movie (.swf) dialog box opens.

Parameter Description

Output Lets you specify the location in which the file will be exported.

Display Source
Lets you select a Display node to read from in the Export From Display Node 
menu.

Export Range

All Exports all the frames of your movie.

Frames Export a frame range which you specify

Options

Frame Rate
Lets you enter a Frame rate (fps). By default, it will be set to match the fps of your 
Harmony project. If you choose a lower frame rate, your export playback will be 
faster than your actual project. The reverse is also true for a higher frame rate. 

Jpeg Quality

Lets you select a JPEG quality:

‣ 100 = Full quality

‣ 50 = Average quality at about 1/5th of the size.

‣ 25 = Medium quality where loss of high image resolution starts to 
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occur.

‣ 10 = Low quality where “macro-blocking” or large pixelation become 
obvious.

‣ 1 = Lowest quality where there is extreme loss of colour and detail and 
the image becomes nearly unrecognizable. 

Protect from Import Prevents the movie from being imported into another application.

Convert Pencil Lines to 
Brush Lines

Retains the thickness of pencil lines.

Compress Movie
Compresses the movie for a lighter format. The movie may lose some quality, but 
the file will be lighter.

Do Not Export

Lets you select the effects you do NOT want to be rendered in the SWF movie.

NOTE: Certain Harmony effects are not listed in this section as they are not 
compatible and therefore not available for SWF export. These effects will not 
appear in the SWF render. 
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Export to QuickTime Movie Dialog Box
The Export to QuickTime Movie dialog box lets you export your animation as a QuickTime movie. If you want to 
render a QuickTime movie with lossless compression and transparency, you can use the Animation video codec 
with the colour depth set to Millions of Colours +. 

If you added burn-in information to your scene, it will be included in your exported file—see Burn-In Node on page 
407.

How to access the Export to QuickTime Movie dialog box

 1. From the top menu, select File > Export > Movie.

Parameter Description

Output

Browse
Lets you select a folder in which to save your movie and give it a file name for the 
export.

Display Source

Export from Display Node

If there is no Display node in your scene, the only available option will be Display 
All. This renders nodes in your scene, including ones that are not connected to 
anything, in the order in which they're listed in the Timeline view. Hence, it is 
always recommended to have a Display node connected to your scene's main 
composite, and to render from that Display node, so as to have control over what 
is rendered.

Export Range

All Exports the entire frame range.

Frames Lets you enter the frame range to export.

Resolution

Resolution list
Lets you select a resolution ratio. If you select Custom, you can enter the width 
and height.
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Width and Height Lets you specify the width and height of the resolution.

Options

Movie Options
Opens the Movie Settings dialog box in which you can set the the compression 
settings for the movie you will export—see Movie Settings Dialog Box.
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Export to Sprite Sheet Dialog Box
The Export to Sprite Sheets window export to multiple resolutions, generating multiple .xml files and one or multiple 
sprites sheets depending how many sprite resolutions you defined.

This saves different animations of the same character into the same name. For example, if there's an idle, run, and 
jump animation, these should all share the same Save Name. You can think of it as the overall collection of 
animations. Inside are the different saved scene versions whose drawings you can reuse for all the animations in 
that character set. Each scene version will be displayed as an item in the list.

When you export an animation, only the drawings used in that scene are exported. All the drawings are exported 
individually first and then atlased together into a sprite sheet.

If you saved multiple animations to the same Save Name (i.e. SpaceDuck: run, idle), then it will reatlas the sprite 
sheet to include all the drawings from all the animations in that folder, creating a new animation file, but reusing the 
same skeleton.

How to access the Export to Sprite Sheets window

 1. Select Windows > Toolbars > Game.
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 2. Click the Export to Sprite Sheets  button.

Parameter Description

Select Directory

Asset Path The folder path where you want to save your export.

Asset Name
The folder name in which you will save your export. This will also be the name 
of your asset in Unity. Your scene file name will be used as the clip name.

Existing Clips in Folder

Preview Window
Displays a list of pre-existing clips in the same export folder location, most  
likely exported there from a previous time.

Use Scene Markers to 
Export Clips

Uses scene markers to define the export range, instead of exporting the entire 
scene.

Project Settings

Unit Scale

Lets you change the scale when exporting to Unity to accommodate the size of 
the export without it affecting the Harmony scene. This helps you resize 
assets properly for Unity without having to resize them in Harmony. The basic 
scale is one Animation Field for one Unity unit.

Preset
Lets you select the unit conversion from Harmony to Unity, by selecting one of 
4 presets. Note: a field is a unit of measure in traditional animation grid.

Sprite Sheet Preferences

Max Width
This is a value, in pixels, for the maximum width and height the exported sprite 
sheet should be. By default, both values are set to 2048 pixels.

Max Height
Makes linear values for interpolation. This increases the amount of memory 
used but frees up the calculation so it is not done on the fly.

Expand Sprite Sheet Uses the minimum size necessary up until it reaches the maximum resolution.

Fixed Sprite Sheet
Creates a texture of the specified size (Max Width and Max Height) even if it 
does not fill it up completely by all the drawings in your scene.

Resolution Type

POT: Exports to sprite sheets with sizes that are a power of 2. For example: 
1024 x 1024.  This is optimized for many graphics cards, but consumes more 
memory.

NPOT: Some game engines are optimized specifically to render to non powers 
of two, so that it will avoid those numbers.  Example: 1000 x 1000.

Reuse Frames

This option works in tandem with the Threshold option. The export will 
compare the drawings in your project to reuse a maximum of similar drawings 
and reduce the amount of information found in the sprite sheet, making it 
lighter. The export will omit the creation of new drawings if the difference is 
less than the threshold percentage.

Threshold Calculates the differences between multiple drawings. A 2% threshold will 
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prevent the creation of a new drawing if the drawing is too similar to an existing 
drawing. For instance, with a 2% threshold, and my drawing is 100 pixels big, 
only 2 of those pixels need to be different from my other drawing in order to 
create a new one. The higher the threshold, the fewer similar drawings you will 
have.

Sprite Resolutions Size of the render of the individual sprite, when it exports each drawing out.

Delete Existing Clips Select this option to delete any pre-existing clips in the export location.

Bake Animation Curves
Makes linear values for interpolation. This increases the amount of memory 
used but frees up the calculation so it is not done on the fly.

Clear Texture Folder
Removes any information from the texture folder within the Harmony file. This 
has no incidence towards the Unity export but contributes to a lighter Harmony 
file.
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Expression Dialog Box
In Harmony, you can use expressions to automate the calculation of effect values based on the values in another 
function. An expression is a mathematical formula that allows you to manipulate the value in the source function 
to create new values for the destination effect.

The Expression dialog box is where you write expressions. It's a simple text editor that can handle incomplete or 
invalid JS programs although they will not be evaluated. Harmony can save and load invalid JS programs.

The Expression editor evaluates the current script at the current global frame and reports any errors or returns the 
numerical result of the program.

How to access the Expression dialog box

 1. In the Xsheet view menu, select Columns > Add Columns or press Shift + C.

The Add Column dialog box opens.

 2. In the Name field, type a name for the column.

 3. From the Type menu, select Expression and click OK.

 4. Double-click on the column's header to open the Expression dialog box.
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The Expression dialog box opens.

Parameter Description

Name
Indicates the name of the expression column in the Xsheet. You can edit this 
name.

Description field Area in which you can type in expressions.
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Extend Exposure Dialog Box
The Extend Exposure dialog box lets you extend the exposure of a selected cell in the Timeline or Xsheet. 

How to access the Extend Exposure dialog box

 1. Select a cell and do one of the following:
 l From the top menu, select Animation > Cell > Extend Exposure.

 l Press F5.

The Extend Exposure dialog box opens.

Parameter Description

Extend to Frame
Lets you enter the frame up to which you want to extend the exposure. You can 
expose the drawing in the frames and replace the drawings that were originally 
there or move the subsequent frames forward in time.

Overwrite
Lets you expose the drawing in the frames and replace the drawings that were 
orginally there.

Insert
Lets you expose the drawing in the frames and move the subsequent frames 
forward in the Timeline view.
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Fill Cells Randomly Dialog Box
The Fill Cells Randomly dialog box lets you Lets you fill in random values over a selection. You can give a maximum 
and a minimum value and create a range for Harmony to choose the random values from. The selection can be over 
one cell or a cell range in one column or more or an entire column or many entire columns.

How to access the Fill Cells Randomly dialog box

 1. Do one of the following:

 l Select Animation > Cell > Fill Cells Randomly.

 l In the Xsheet view, click the Fill Cells Randomly  button  (you may have to customize the 
toolbar to display it).

The Fill Cells Randomly dialog box opens.

Parameter Description

Minimum Value The lowest value to be used in the randomized exposure or keyframe value.

Maximum Value The highest value to be used in the randomized exposure or keyframe value.

Hold The exposure holding value.

Whole Numbers
If you are applying this to a drawing column, this option lets you avoid having 
decimal points.

Add Key Exposure After Inserts a key exposure on the frame following the last cell of the selection.
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Fill Exposure Using Render Changes Dialog Box
The Fill Exposure Using Render Changes dialog box lets you detect if a threshold of changes has occurred 
between two consecutive images and then expose the affected textures for further processing. It can be used for 
example to change the texture on a characters shirt only when the shape of the shirt is changed significantly from 
the previous frame.  This avoids unnecessary repetitive texture changes on every frame.

How to access the Fill Exposure Using Render Changes dialog box

 1. In the Timeline view, select the textures or live-action sequence.

 2. From the top menu, select Scene > Default Display > desired Display node.

 3. From the top menu, select Animation > Exposure Fill > Using Render Change.

Wait while Harmony creates a low resolution render of the images to preview.
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 4. In the Fill Exposure Using Render Changes window, use the Frame slider to view the motion change 
analysis.

 5. Based on your style preference, adjust the parameters to assign when the texture exposure changes will 
occur. You can adjust the type of filter to use for the motion detection, as well as threshold values to indicate 
what will be considered a big enough motion variation for an exposure change. 

Parameter Description

Changes Detection Settings

Frame: Use the slider to see when a change is necessary. A red edge indicates 
there is a large enough motion for the texture to change.

Use: Lets you use either the Red, Green, Blue, or Alpha channel, or Luminance 
difference between frames to analyze the motion changes. The Alpha channel is 
selected by default as it is the most commonly used parameter.

Pixel Value Change Threshold: The percentage of change in a pixel to be con-
sidered different from one frame to another. The higher the value, the more 
change is required when comparing two images in order for a new texture to be 
used.

Area Change Threshold: The percentage of non-empty pixels that must change 
from one frame to another to be considered different.

Fill Settings

These settings let you change the exposure. You can also decide on how many 
images you want to cycle. 

First/Last Frame: Lets you set the first and last frame for the exposure change. 
You can set this for the entire scene or for part of the scene (frames 20 to 32 for 
example).

 Number of Drawings in Cycle: Lets you set of the number of drawings to 
include in the cycle.

 First Drawing Used in Cycle: Lets you set the first drawing used in the cycle. 
Your drawings must be named using numeric values only, or number values with 
a prefix or suffix. It cannot only be letters.

 Drawing Name Prefix: Adds a prefix before the number. For example, texture_
01, texture_02 and so on.

 Drawing Name Suffix: Adds a suffix after the number. For example, 01_texture, 
02_texture and so on.
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Fill Selection Dialog Box
The Fill Selection dialog box lets you Lets you fill the same value over an entire selection. The selection can be 
over one cell, a cell range in one column, a cell range over many columns, an entire column, or many columns. 
You can use numbers, words, letters, or any alphanumeric value.

How to access the Fill Selection dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 1. Do one of the following: 

‣ From the top menu, select Animation > Cell > Fill Selection. 

‣ In the Xsheet toolbar, click the Fill Selection  button (you may have to customize the toolbar to 
display it).

‣ Press Ctrl + T (Windows/Linux) or ⌘  + T (Mac OS X)).

The Fill Selection dialog box opens.

Parameter Description

Value This is the value to be used in the filled selection.

Add Key Exposure After Inserts a key exposure on the frame following the last cell of the selection. 
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Import 3D Models Dialog Box
Use the Import 3D Models dialog box to import 3D models into Harmony.

How to open the Import 3D Models dialog box

 1. From the top menu, select File > Import > 3D Models.

The Import 3D Models dialog box opens.

Parameter Description

Files

Browse
Lets you locate and select 3D model file formats from a location on your computer 
or a location accessible from your computer (network, server, etc.).

Layer

Create Layers(s)
This option is selected by default. A new layer will be created for the selected 3D 
model files for the import. You have two choices:

Create Single Layer 
Named

Creates a new layer for your 3D model that you can name. Name the new layer 
immediately by entering a name into the provided field.

Create Layer(s) Based 
on Filenames

Creates a layer based on each unique filename prefix. For example, the filenames 
a-1.obj, a-2.obj and b-1.obj will create layers named "a" and "b", where "a" has 
two 3D models and "b" has one. When creating a single layer from these three 
filenames, all three models will be imported to the new layer.

Add to Existing Layer

Imports the selected files to an existing layer in the scene. Once this option is 
selected the adjacent drop-down list becomes active. Select an existing layer 
name from the drop-down list. Note that if you select a vector layer, it will 
encapsulate the 3D model inside a symbol.

Conversion

Convert to FBX format  Select this option if your file isn't already a *.fbx file and you would like it to be.  
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This format incorporates all associated files, such as the texture files.
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Import Images Dialog Box
T-HFND-007-011

The Import Images dialog box lets you  import bitmap images and vectorize them, making the images editable. Then 
you can use a variety of drawing tools to edit the image. Or you can always keep the original bitmap image as is.

Also, you can choose to import bitmap images on bitmap or vector layers depending on your project..

How to open the Import Images dialog box

 1. Do one of the following:

 l From the top menu, select File > Import > Images. 

 l In the File toolbar, click the Import Images  button.

 l In the Xsheet view, right-click anywhere in the frame area and select Import > Images.

The Import Images dialog box opens.

Parameter Description

Files

Browse Lets you find and select images on your computer.

Layer

Create Layers(s) Create layers for imported images.

Create Single Layer 
Named

Creates a new layer with the specified name and imports the images into it.

Create Layer(s) Based 
on Filenames

Creates a layer based on each unique filename prefix. For example, if you import 
three files named a-1.tga, a-2.tga and b-1.tga, this will create two layers, one 
named "a" and one named "b". Layer "a" will contain the two first images and "b" 
will contain the third one.
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Add to Existing Layer

Imports the images into the specified layer. Note that you can only import into 
layers that are compatible with your import options. For example, if you're 
importing images as vector drawings, you can only import them into vector 
drawing layers. 

Import Options
Depending on how you choose to import images, the Alignment section offers 
different options.

Keep as Original 
Bitmap

Retains an imported image as a bitmap. In the Alignment section, decide on the 
size and placement of your image within the camera frame. Depending on the 
Scene Settings (the height and width in pixels that you chose for your project), an 
image that you import may get scaled to the point where all its individual pixels 
become visible.

Import as Toon Boom 
Bitmap Drawing

Imports a drawing into a vector layer where you can edit the image using the 
drawing tools.

Convert to Toon Boom 
Vector Drawing

Imports a drawing and converts it to a Toon Boom vector drawing.

Alignment (Keep As Original Bitmap)

Rules

Fit:

Adjusts the image's size to fit completely within the scene's field, both vertically 
and horizontally, making sure the entire image is visible. 

If the image's orientation is portrait, then it will adjust the image's height to fit the 
field's height, without affecting the image's aspect ratio:

If the image orientation is landscape, then it will adjust the image's width to fit the 
field's width, without affecting the image's aspect ratio:
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Pan: 

This has the opposite effect to the fit parameter. The image's smallest dimension 
will be made to fit the scene frame's matching dimension, and the image's largest 
dimension will be adjusted proportionally, making the image fill the entire scene 
field, and bleed past its boundaries it if its aspect ratio does not match the field's 
aspect ratio. This option can be used to import a panning background image, also 
referred to as a pan.

If the image's orientation is portrait, it will adjust the image's width to fit the field's 
width, without affecting its aspect ratio:

If the image's orientation is landscape, it will adjust the image's height to fit the 
field's height, without affecting its aspect ratio:

This has the opposite effect to the fit parameter. The image's smallest dimension 
will be made to fit the scene frame's matching dimension, and the image's largest 
dimension will be adjusted proportionally, making the image fill the entire scene 
field, and bleed past its boundaries it if its aspect ratio does not match the field's 
aspect ratio. This option can be used to import a panning background image, also 
referred to as a pan.

If the image's orientation is portrait, it will adjust the image's width to fit the field's 
width, without affecting its aspect ratio:
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This has the opposite effect to 
the fit parameter. The image's 
smallest dimension will be 
made to fit the scene frame's 
matching dimension, and the 
image's largest dimension will 
be adjusted proportionally, 
making the image fill the entire 
scene field, and bleed past its 
boundaries it if its aspect ratio 
does not match the field's 
aspect ratio. This option can 
be used to import a panning 
background image, also 
referred to as a pan.

If the image's orientation is 
portrait, it will adjust the 
image's width to fit the field's 
width, without affecting its 
aspect ratio:

If the image's orientation is 
landscape, it will adjust the 
image's height to fit the field's 
height, without affecting its 
aspect ratio:

This has the opposite effect to 
the fit parameter. The image's 
smallest dimension will be 
made to fit the scene frame's 
matching dimension, and the 
image's largest dimension will 
be adjusted proportionally, 
making the image fill the entire 
scene field, and bleed past its 
boundaries it if its aspect ratio 
does not match the field's 
aspect ratio. This option can 
be used to import a panning 
background image, also 
referred to as a pan.

If the image's orientation is 
portrait, it will adjust the 
image's width to fit the field's 
width, without affecting its 
aspect ratio:

If the image's orientation is 
landscape, it will adjust the 
image's height to fit the field's 
height, without affecting its 
aspect ratio:

Project Resolution: Scales 
the image to fit the scene's 
resolution, making each pixel 
in the image take one pixel in 
the scene's field. For example, 
if the image's dimensions in 
pixels are half of the scene's 
resolution in pixels, then the 
image's dimensions will 
appear to be half of the scene 
field's dimensions. 

Alignment (Import as Toon Boom Bitmap Drawing)

Rules

Horizontal Fit: 

Adjusts the image's size so that its width matches the scene's width, without 
affecting its aspect ratio.

Vertical Fit: 

Adjusts the image's size so that its height matches the scene's height, without 
affecting its aspect ratio.

Actual Size: Imports the image in its actual size, without adjusting its size 
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relative to the scene's resolution. For example, if the image's dimensions in pixels 
are half of the scene's resolution in pixels, then the image's dimensions will 
appear to be half of the scene field's dimensions. 

Transparency

Alpha

Premultiplied with White: Individual pixels at the edge of an image are blended 
with white.

Premultiplied with Black:Pixels at the edge of an image are blended with black.

Straight: Pixels at the edge of an image are blended with black, white and greys.

Clamp Colour to Alpha:Premultiplies the colour value with the alpha value. 
When the colour is clamped to the alpha, the colour value cannot be higher than 
the alpha value. It calculates the real colour value faster. When the RGB values 
are multiplied with the alpha value, that is to say, if you have a pixel of value 
R=247, G=188, B=29 and the alpha is 50% or the image has a 50% transparency, 
then the actual RGB values that are output would be half of the amounts listed 
above. 

Vectorization

Black and White
Vectorizes drawings with a solid black line. This creates a 100% vector-based 
drawing and paints it with the Vectorized Line colour swatch from your scene's 
palette.

Grey
Vectorizes the image as a mix of vector contour and greyscale bitmap filling. 
Lines keep the texture from the scan, and the white of the paper becomes 
transparent.

New Preset Lets you create a new preset.

Delete Preset Lets you delete any preset in the list.

Edit Preset Lets you edit the vectorization parameters for the selected preset.
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Manage Tool Presets Dialog Box
The Tool Presets window lets you create new tool presets and manage them. 

How to access the Manage Tool Presets window

 1. Do one of the following:

 l From the top menu, select Windows > Toolbars > Tool Presets.

 l Right-click an empty area below the top menu and select Tool Presets.

 2. In the Tool Presets toolbar, click the Manage Presets  button.

Parameter Description

Icon Lets you select a preset to manage.

Import Lets you import an existing preset.

Export Lets you export a preset for use in other projects.

Delete Removes the preset from the list of tool presets.

Name Lets you change the name of the preset.

Icon list Lets you select an icon for the preset.

Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the new preset.
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Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any tool. 
The colour preset would then work on any selected tool. Selecting the brush tool 
was only a vehicle to get into the New Tool Preset dialog box. 

Update
After adjusting the settings for a preset, the current properties are applied to the 
presets, as well as any other changes you made in the Manage Tool Presets 
window.
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Marker Colour Dialog Box
The Marker Colour dialog box lets you set the colour of scene markers that are displayed at the top of the Timeline 
view (in the frame counter area). Using colours for scene markers helps to differentiate them visually, making them 
easy to identify in the Timeline view.

You can select a colour by choosing from a basic set of colours, using the colour wheel or by specifying the HSV or 
RGB values. Once you have selected a colour, you can adjust its intensity and save it as a custom colour that you 
can reuse.

How to access the Marker Colour dialog box

 1. In the frame counter area of the Timeline view, select a frame range to mark.

 2. Right-click and select Create Scene Marker.

The Timeline Scene Marker dialog box opens. The Colour box displays a black colour swatch, or the colour of 
the last scene marker you created.

 3. Click the colour swatch.

The Marker Colour dialog box opens.

 

Parameter Description

Basic colours A basic set of colours to choose from.

Custom colours Displays the custom colours you previously stored using the Add to Custom 
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Colours button.

Add to custom colours Lets you add the selected colour to the Custom colours list above.

Colour wheel Lets you select a colour by dragging the T-shaped pointer.

Value slider
Once you select a colour, you can drag the slider to change the intensity and see 
it previewed in the Colour Preview window below.. 

Colour Preview Displays the colour you are currently selecting. To apply the colour, click OK.

Hue, Saturation, Value
Lets you set the hue (colour), saturation (amount of colour) and brightness (value) 
of the colour.

Red, Green, Blue Lets you set the red, green and blue values.
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Movie Settings Dialog Box
The Movie Settings dialog box lets you set the compression settings for the movie you will export.

How to access the Movie Settings dialog box

 1. From the top menu, select File > Export > Movie.

 2. In the Export to QuickTime Movie dialog box that opens, click Movie Options.

Parameter Description

Video

Settings
Opens the Standard Video Compression Settings dialog box. This is where you 
can set the video compression settings for the movie you will export—see 
Standard Video Compression Settings Dialog Box on page 120.

Filter
Opens the Choose Video Filter dialog box, where you can select from a range of 
filters to apply to your video export.

Size
Opens the Export Size Settings dialog box. The size settings are overridden by 
the Harmony's scene settings.

Sound  

Settings
Opens the Standard Video Compression Settings dialog box. This is where you 
can you set the sound compression settings for the movie you will export—see 
Sound Settings Dialog Box on page 119.
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New Scene Dialog Box
The New Scene window lets you create a new scene.

How to access the New Scene window

 1. Do one of the following:

 l From the top menu, select File > New. 

 l In the File toolbar, click the New  button. 

 l Press Ctrl + N (Windows/Linux) or ⌘  + N (Mac OS X).

The New Scene dialog box opens.

Parameter Description

Name Lets you type in a name for the new scene.

Location Lists the locations you used most frequently for storing scenes.

Browse
Opens a browser in which you can specify a location for the new scene that is 
not listed in the Location list.

Camera Size Opens a list of resolutions.

+ (Create Custom Resolution)
Opens the New Resolution window in which you can create a custom 
resolution that is added to the Camera Size list.

- (Delete Custom Resolution) Lets you remove a custom resolution from the Camera Size list.

Width Indicates the width of the resolution you chose from the Camera Size list.
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Frame Rate Indicates the frame rate of the resolution you chose from the Camera Size list.
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New Tool Preset Dialog Box
The New Tool Preset dialog box lets you create new tool presets and manage them. 

Tool presets let you save a variety of settings and are very efficient for accessing the tools you use most often. 
That way, the tool is already set with the desired properties, such as colour, line thickness, whether to enable 
Draw Behind or Auto Flatten mode, and so on. You can create presets for these tools and many more: Brush, 
Pencil, Eraser, Rectangle, Ellipse, and Line. 

The difference between a tool preset and a brush preset is that when you save a tool preset, you have the option 
of saving the colour and assigning a shortcut, which you cannot do with brush presets.

How to access the New Tool Preset dialog box

 1. Do one of the following:

 l From the top menu, select Windows > Toolbars > Tool Presets.

 l Right-click an empty area below the top menu and select Tool Presets.

 2. In the Tool Presets toolbar, click the New Tool Preset   button.

Parameter Description

Name Lets you give the preset a meaningful name.

Icon list Lets you select an icon for the preset.

Folder icon Lets you select an image for the preset.

Shortcut Lets you assign a keyboard shortcut to the preset.

Colour Saves the current colour into the tool preset.

Tool

If you disable this option, only the colour will be associated. You could, for 
example, set three different colours with shortcuts not associated with any 
tool. The colour preset would then work on any selected tool. Selecting the 
brush tool was only a vehicle to get into the New Tool Preset dialog box. 
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Onion Skin and Light Table Transparency Dialog Box 
This dialog box lets you adjust the Onion Skin and Light table transparency parameters.

How to access the Onion Skin and Light Table Transparency dialog box 

 l In the Drawing view toolbar, click on the Top Light button to open the Onion Skin and Light Table Trans-
parency dialog box.

Command Description

Onion Skin Opacity
Sets the maximum opacity value for the onion skin opacity display.  Moving the 
slider all the way to the left = 0% opacity. Moving the slider all the way to the 
right = 100% opacity.

Lighttable Opacity
Sets the maximum opacity value for the light table display. Moving the slider all 
the way to the left = 0% opacity. Moving the slider all the way to the right = 
100% opacity.

LightTable Wash
Sets the washed-out value for the light table display.  Moving the slider all the 
way to the left = 0% opacity. Moving the slider all the way to the right = 100% 
opacity.

Bitmap Background 
Wash

Sets the maximum opacity value for the background wash.   Moving the slider all 
the way to the left = 0% opacity. Moving the slider all the way to the right = 
100% opacity. Only works for bitmap layers.

Pencil Lines Opacity
Sets the maximum opacity value for central vector lines (lines made by the 
Pencil or Shape tools). Moving the slider all the way to the left = 0% opacity. 
Moving the slider all the way to the right = 100% opacity.
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Palette Browser Dialog Box
When you start Toon Boom Harmony connected to the database, you can access the Palette Browser dialog box 
from the Palette Operations dialog box when you want to clone palettes. 

In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. When a palette is 
created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene 
directory in a palette-library folder unless you specify a different location.

How to access the Palette Browser dialog box

 1. Start Harmony and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

 1. In the Palette Operations dialog box that opens, select the palette you want to clone at the location and 
level in which it was stored. 

 2. Click Clone.

Parameter Description

Palette Location

Environment The production, project, feature film or series.

Job The episode and sequence from each environment.

Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

New Palette Name
Lets you enter a name for the new palette. There is no need to add the suffix 
"palette"  to the name as it is always recognized as a palette file.
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Palette List

Scene Palette List

The Scene Palette List is mainly used with cut-out animation. A cut-out 
character will often be divided in twenty to thirty different drawing elements 
that use the character's master palette. 

The palette list is stored at the scene level instead of the Element directory. 
This way, all palettes linked to this list will appear in every drawing element 
created in the scene. There is no need to manually load the palette in each 
element. 

Element Palette List

The Element Palette List is mainly used with traditional and paperless 
animation. Unlike cut-out animation, all columns (drawing elements) contain 
different characters, props, backgrounds and effects. The Element Palette List 
is used because you do not necessarily want all of the palettes for all of your 
elements linked in every column. 

The palette list is stored in the drawing element's directory instead of directly in 
the Scene level. This ensures that the links to the palettes appear only in the 
appropriate element. If you prefer to access a global palette list, link your 
palettes to the Scene Palette List.
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Palette Operations Dialog Box
When you start Toon Boom Harmony connected to the database, you can access the Palette Operations dialog 
box which lets you clone, rename, or delete palettes. 

In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. When a palette is 
created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene 
directory in a palette-library folder unless you specify a different location.

There are four locations where you can find palette-library folders: Element, Scene, Job and Environment.

How to access the Palette Operations dialog box

 1. Start Harmony and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

Parameter Description

Environment The production, project, feature film or series.

Job The episode and sequence from each environment.

Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

Description Notes, if any, of the project.

Clone
Opens the Palette Browser dialog box from which you can select the level in 
which to store the palette file.

Rename Lets you rename a palette.

Delete

Lets you delete a palette.

NOTE: It is not recommended to disable the warning message that 
appears when you are attempting to delete a palette as this operation can-
not be undone.

Close Closes the Palette Operations dialog box.
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Paste Preset Dialog Box
When pasting key frames and exposures, you can modify the existing presets to your liking. There are three presets 
you can modify: the default presets for both key frames and exposures, key frames only and exposures only.

Parameter Description

Drawings

Add/Remove Exposure

 

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure
If there are key exposures that exist on copied drawings, they are preserved when 
pasting. No key exposures are added. This is the default behavior when pasting.

Fill Gap with Previous 
Drawing

Fills selected area in the Xsheet or Timeline view with the previous drawing.

Fill to Next Key 
Exposure

Fills selected area till the next key exposure.

Keyframes

Add/Remove 
Keyframes

Motion: Copies the properties of the selected motion keyframe to the new frame.

Velocity: Copies the properties of the selected velocity keyframe to the new 
frame.

Rotation: Copies the properties of the selected rotation keyframe to the new 
frame.

Scale: Copies the properties of the selected scale keyframe to the new frame.

Skew: Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at Function's Beginning and End: Adds a keyframe to the 
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beginning and end of the pasted function, reproducing the source function.
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Paste Special Dialog Box
The Paste Special dialog box lets you determine how templates and symbols are imported in the Timeline view. 

When you import a template in the Timeline view, all layers are created as well as drawings and keyframes. You can 
choose to import only the keyframes without the drawings or import only the drawings that are not already in your 
layers. You can adjust the behaviour using the Paste Special dialog box.When you import a symbol in your scene, 
its full length is exposed by default. If you import a symbol in the Timeline view’s left side, all the frames will be 
exposed. However, if you import it into an existing layer, you can use the Paste Special dialog box to adjust the 
import behaviour to fit your requirements.Once you set the parameters, Harmony will reuse them each time you 
import a symbol in the Timeline view’s right side until you set new parameters.

How to access the Paste Special dialog box

 1. In the Library view, select the symbol or template to import.

 2. Press Ctrl + B (Windows/Linux) or ⌘  + B (Mac OS X) and drag the selection to the Timeline view.

NOTE: Drop the selection in the Timeline view before releasing the keyboard shortcut key.

The Paste Special dialog box opens.

Parameter Description

Drawings

Do Nothing Does not create or overwrite drawings.

Update Drawing Pivot
Revises the drawing pivot in the destination to use the same drawing pivot as the 
first drawing in the template. If you have a range of drawings selected in the 
destination, the pivot points of all selected drawings will be updated.

89



Chapter 2: Dialog Boxes     Paste Special Dialog Box

Add/Remove Exposure

Never create drawing files: When adding exposures to a drawing layer, drawing 
files will not be created.

Only create drawing files when they do not exist: When adding exposures to a 
drawing layer, new drawings will be created only when drawings with the same 
name do not already exist in the destination.

Replace existing drawings. Create drawing files when they do not exist: 
Replace drawings with the same names to update a scene with new modified 
drawings and preserve the animation.

Tip: If you don't want to lose the existing animation when pasting a 
template,  such as when placing new drawings after the animation, 
then delete the template's animation.  It will still have updated the 
drawings but not override the existing animation.

Always create drawing files: When adding exposures to a drawing layer, new 
drawings will always be created. If drawing files with the same name already 
exist, Harmony will create a new name for the drawing.

Enforce Key Exposure: If there are key exposures that exist on copied draw-
ings, they are preserved when pasting. No key exposures are added. This is the 
default behavior when pasting.

Fill Gap with Previous Drawing: Fills selected area in the Xsheet or Timeline 
view with the previous drawing.

Fill to Next Key Exposure: Fills selected area till the next key exposure.

Paste all frames of the symbol (full movie): When enabled, the Paste Special 
command exposes all the symbol's frames instead of only the first one.

Symbols

Copy symbols if they 
do not exist

This is the default setting for this operation and will prevent Symbols in an Action 
template from being copied.

Duplicate symbols
Creates a duplicate of the symbol instead of linking the Symbol instance to the ori-
ginal one. The new Symbol is created in the Library.

Paste all Frames of the 
symbol (full movie)

When enabled, the Paste Special command exposes all the symbol's frames 
instead of only the first one.

Add Remove/Keyframes

Motion Copies the properties of the selected motion keyframe to the new frame.

Velocity Copies the properties of the selected velocity keyframe to the new frame.

Rotation Copies the properties of the selected rotation keyframe to the new frame.

Scale Copies the properties of the selected scale keyframe to the new frame.

Skew Copies the properties of the selected skew keyframe to the new frame.

Force Keyframes at 
Function's Beginning 
and End

 Adds a keyframe to the beginning and end of the pasted function, reproducing the 
source function.

Offset Keyframes
When pasting functions, offsets keyframes from the function's last frame value 
by the values in the pasted function. This will continue the progression of a func-
tion instead of repeating the values.
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Options

Palettes

Do nothing: Does not create, overwrite, merge or link palettes.

Reuse palettes. Copy palettes if they do not exist: Palettes in the destination 
drawings are left as they are.

Copy and overwrite existing palettes: Overwrites destination palettes with the 
palettes from the source drawings.

Copy and create new palette files: Creates new palette files, placing them at 
the same relative environment and scene level as the source. If the palettes in the 
templates were stored at the environment level of the source scene, the paste 
operation will place the palettes in the environment level of the destination scene.

Copy and create new palette files in element folder: Creates new palette files 
in the element folders of the destination scene, rather than in the same relative job 
or environment.

Copy palette and merge colours. Add new colours only: Adds new colours to 
the destination palettes and ignores colours that are the same in the two palettes.

Copy palettes and update existing colours: Adds new colours to the 
destination palette and updates duplicate colours in the destination with colour 
values from the source.

Link to original palettes (colour model): Links the colour palettes in the 
destination scene to the palettes in the source. Use this to link drawings to the 
palettes in a colour model.

Copy scene palettes and merge colours. Add new colours only: Adds new 
colours to the destination scene palettes and ignores colours that are the same in 
the two palettes.

Copy scene palettes and update existing colours: Adds new colours to the 
destination scene palette and updates duplicate colours in the destination with the 
colour values from the source.

Cycles

Normal (forward):Pastes your selection as is, starting with the first cell and end-
ing with the last.

Reverse: Pastes your selection in reverse, starting with the last cell and ending 
with the first.

Forward > Reverse:Pastes your selection as a yo-yo, starting with the first cell, 
going to the last one and ending with the first cell.

Reverse > Forward: Pastes your selection as a reverse yo-yo, starting with the 
last cell, going to the first one and ending with the last cell.

Nodes
Create New Columns: A new column is created when you copy and paste 
nodes from the Node view or layer in the Timeline view. If the layers are linked to 
function curves, the function curves, drawings and timing will be duplicated.

Elements
Reuse existing elements: Lets you paste existing elements without creating 
new ones. This should be used only when pasting within versions of the same 
scene.

Validation Match by Node/Layer Name: When pasting a template with a hierarchy onto 
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another hierarchy, this option looks to match the pasting elements with the same 
layer or node name, rather than the same hierarchical structure. This means that 
even if the two hierarchies are different, a new pose of a character's body part will 
still be pasted on the correct body part layer, as long as both layers are named the 
same.
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Pose Copier Dialog Box
The pose copier contains many buttons and other information to facilitate the insertion of poses in the animation.

Parameter Description

Preview Window Based on master template's generated thumbnails, previews currently selected 
frames.

UPD Updates the template with the newly selected template.

RST Reset the template's cache, getting rid of default destination information and 
excluded modules.

Template Name Name of the currently selected template.

Vertical Slider (SLV) Linked to the slv- node of the node system.

Horizontal Slider 1 (SLH) Linked to the slh- node of the node system. Default slider for the pose copier if 
no guide layers are created.

Horizontal Slider 2 (SLX) Linked to the slx- node of the node system.

Fill to Next Key Exposure Having this option checked will automatically extend the exposure of the 
pasted frame up to the next key.

Use Default Destination Module When enabled, the pasted keys will automatically refer to the destination 
defined in the option Set Default Destination Module.

Paste by Layer Name When this option is checked the pasted layers will look for the individual layer 
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name instead of matching the hierarchy of the template. 

Set Default Destination Module Instead of selecting the destination every time, the layer set as default des-
tination will automatically paste the keys onto those layers.

Find This will center on the default destination in the timeline.

Paste Paste the current position of the pose copier onto the destination.

Vertical Currently selected frame on the vertical slider. (based on frame name in slv-
node)

Horizontal 1 Currently selected frame on the horizontal slider 1. (based on frame name in 
slh-node)

Horizontal 2 Currently selected frame on the horizontal slider 2. (based on frame name in 
slx-node)

Frame Frame number of the selected frame within the master template.
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Preferences Dialog Box
The Preferences dialog box lets you adjust preferences to suit your work style, allowing you to work more efficiently.

NOTE: To learn more about the individual preferences, refer to the Preferences guide.

NOTE: Some preferences require you to exit and restart the application, or close a view and reopen it.

How to access the Preferences dialog box

Do one of the following:

 l Select Edit > Preferences (Windows/Linux) or Harmony Premium > Preferences (Mac OS X). 

 l Press Ctrl + U (Windows/Linux) or ⌘  + U (Mac OS X).
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Remove Dirt Dialog Box
The Remove Dirt dialog box lets you select small dots and hairs on a drawing for removal.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. 
These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Dirt dialog box

 1. Do one of the following:

 l From the top menu, select Drawing > Clean Up > Remove Dirt.

 l From the Camera or Drawing View  menu, select Drawing > Clean Up > Remove Dirt.

 l Press Shift + D.

Parameter Description

Slider

Lets you adjust the amount of detail removed from the layer. 

Raising the Remove Dirt level will select bigger dots. When selecting larger 
dots, be careful not to lose small details like pupils and nostrils. Once you have 
chosen the level, you can apply it to the current drawing or the entire animation 
sequence. This is a quick way to get rid of most dirt and dust.

During this process, the dirt that will be removed is highlighted in red.

Apply to all drawings Applies the operation to all drawings in the layer.
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Remove Hair Dialog Box
The Remove Hair dialog box lets you remove any small strokes created in the Colour Art layer from very thick lines 
or filled zones. Increasing the Remove Hair level value will select larger strokes for removal from the drawing.

When paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. These 
lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Hair dialog box

 1. In the Timeline or Xsheet view, select the drawing containing the drawing to clean.

 2. From the top menu, select View > Show > Show Strokes to display the invisible lines or press K.

 3. In the top menu, select Drawing > Clean Up > Remove Hair.

Parameter Description

Slider Lets you adjust the number of length of hairs selected. 

Apply to all drawings Applies the operation to all drawings in the layer.
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Render Write Nodes Dialog Box
The Render Write Nodes dialog box lets you configure your scene to render locally or sent it to a render farm so 
other computers can render your scenes while you continue working on your station. 

In Harmony Stand Alone, the Render Write Nodes dialog box will look as follows:

In Harmony Server, the Render Write Nodes dialog box will have an additional section, Batch Composite 
Options, which allows to set parameters for the server's batch rendering service:

There are two approaches to rendering a scene in Harmony Server:

 l Local Rendering is done directly by your machine in your Harmony session. Hence, it uses your 
machine's resources and will prevent you from working on the scene until the render is done. You will see 
the render progress in real time and will be able to preview the results right after it's finished. 

 l Batch Rendering is done by sending a scene to the server's render queue so it can be processed by the 
render farm. This allows you to keep working on your scene while the render is being done. The rendering 
progress can be monitored in Control Center and, when finished, the results can be previewed in  Play. 

In either case, the render will be output in the same folder and in the same file formats, as those are determined by 
the scene's Write nodes. However, batch rendering supports additional options, such as rendering in chunks, or 
in different resolutions than the scene's resolution. 
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How to access the Render Write Nodes dialog box

 1. Do one of the following:

 l From the top menu, select File > Export > Render Write Nodes.

 l Press Ctrl + Shift + Y (Windows/Linux) or ⌘  + Shift + Y (Mac OS X).

The Render Write Nodes dialog box opens.

 

Parameter Description

Range

All Frames Sends all the frames in the scene to be rendered.

Selected Frames Sends the specified range of frames to be rendered. 

Batch Composite Options
Check this to send the scene to batch rendering and unlock batch rendering 
options. Otherwise, the scene will be rendered locally. 

Debug
Instructs the batch rendering service to log debug information. When this is 
checked, the machine that processes the render will have more information about 
the compositing process in its batch rendering service's log. 

Chunk

When checked, this splits the render job sent to the server's render queue into 
several smaller render jobs, allowing it to be processed by several machines in 
the render farm. Note that this only affects Frame renders. If the render includes a 
movie file, the movie will still be exported as a single file once all the frames have 
been rendered.

Size (Frames)
Specifies the amount of frames each chunk will include. For example, when 
rendering a 50 frames scene by chunks of 30, this will make the first render job 
render frames 1 to 30, and the second render job render frames 31 to 50.

Camera
If you created a scene with several Camera nodes, this allows you to specify 
which one to use for the render.

Resolution

This allows you to set the width and height of the rendered images or movie, 
either:

By Name: Allows you to select between Default or one of the available resolution 
presets. If Default is selected, the scene will be rendered in its own resolution. 

By Value: Allows you to set the width and height of the rendered images in pixels. 

Field Composite Options

Add Pulldown

Renders using the 3:2 pull-down approach. Every odd-numbered frame will be 
rendered on 3 images, and every even-numbered frame will be rendered on 2 
images. 

Images will be named in pairs to indicate that they are to be combined together. 
Therefore, the output will look like this:

Exported Image File Rendered Frame
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final-0001-f1.tga Frame 1 of the scene

final-0001-f2.tga Frame 1 of the scene

final-0002-f1.tga Frame 1 of the scene

final-0002-f2.tga Frame 2 of the scene

final-0003-f1.tga Frame 2 of the scene

final-0003-f2.tga Frame 3 of the scene

final-0004-f1.tga Frame 3 of the scene

final-0004-f2.tga Frame 3 of the scene

This makes a scene animated in 24 frames per second output in 60 images per 
second. Hence, once the paired images are combined, this will make a 30 frames 
per second render.

Automatic Combine
Combines each pair of images rendered with Pulldown by interlacing them 
together.

Second Field First

By default, when images rendered with Pulldown are combined, the first image in 
a pair is rendered on odd lines (referred to as the first field), and the second is 
rendered on even lines (referred to as the second field). This does the 
opposite: The second image in a pair is rendered on odd lines and the first one is 
rendered on even lines.

Preview
When rendering locally, this opens the rendered image sequence in Play 
immediately after the render is done. 
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Save Dialog Box
The Save dialog box lets you save a scene for the first time in Harmony Server.

How to access the Save dialog Box

 1. Make sure you have the necessary rights to save the current scene version. If you do not, you can acquire 
the rights by selecting File > Rights to Modify Scene Version or Rights to Modify Scene. 

 2. From the top menu, select File > Save or press Ctrl + S (Windows/Linux) or ⌘  + S (Mac OS X). 

When saving the scene for the first time, the Save dialog box opens, prompting you to name the version.

 

Parameter Description

This Version Lets you enter a relevant name for the current version.

New Version
Lets you enter a relevant name to save your scene as a new version. Note that 
the drawing files are shared between versions. Only a new version of the timing, 
Xsheet, and Node view are saved (information contained in the xstage file).

Overwrite Existing Version Allows you to save the current state of your scene over an existing scene version.

Description Enter a short description of the current version.

Mark as Current
After selecting an existing version of your scene, you can make that version the 
current one that will open by default.
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Scene Settings Dialog Box
The Scene Settings dialog box lets you parameters for your scene. 

When you created your new scene, you set up the resolution and the alignment. However, if you want to change 
these initial settings later, you can do it using the Scene Settings dialog box. The different Scene Settings options 
are separated into four tabs.

How to access the Scene Settings dialog box

 1. Select Scene > Scene Settings.

The Scene Settings dialog box opens.

 

Resolution Tab
 

Parameter Description

Resolution Presets

You can select your project’s resolution (camera frame size) from this preset list.

‣ HDTV: High definition television delivers a higher quality image than 
standard television (4:3) does, because it has a greater number of lines of 
resolution. To take advantage of the superior quality your output device 
must be compatible with HDTV technology to make this resolution setting 
useful.

‣ HDTV_Vertical: The "vertical resolution" of HDTV_Vertical refers to how 
the images will be aligned in relation to the actual scene frame (default 4:3 
grid). Note that the camera resolution and the scene frame are not the 
same. When working with 12 or 16 field drawing grids, the grid is a different 
aspect ratio from the camera frame. When you fit vertically, you fit the 
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images with the top and bottom of the scene grid.

‣ film-1.33: Use this resolution setting for the academy film format that 
conforms to the standard 4:3 aspect ratio.

‣ film-1.66:  Use this resolution setting for the widescreen film format that 
conforms to the 16:9 aspect ratio.

‣ film-1.66_Vertical: This is essentially the same as film-1.66. Refers to 
how the drawing is fit into the scene frame. When working with 12 or 16 
field drawing grids, the grid is a different aspect ratio from the camera 
frame. When you fit vertically, you fit the images with the top and bottom of 
the scene frame.

‣ NTSC: This is the standard analogue television broadcasting system used 
in North America and conforms to the North American standards on how 
rectangular pixels are displayed for computer and television screens.

‣ PAL: This resolution works best with the European format for television 
and computer screens, as the rectangular pixels are displayed at a 
different orientation.

‣ Low: This format is ideal for videos destined for the web, where size and 
fast download of a video file might take precedence over quality.

‣ Cloud Preview: This is the resolution used by Web Control Center to 
create its preview.

Selected Resolution Preset Displays the selected resolution preset.

Save Resolution Setting

Click the Save Resolution button after you define your new resolution to save it as 
a preset.

If you are working in Harmony Server, you will be prompter a dialog box asking 
you to name the new resolution as well as the level at which you want to save the 
resolution,conf file.

Pixel Dimensions

Displays the pixel dimensions for your project resolution.

If you decide to type in the pixel dimensions, or use the up and down arrows to 
change the pixel increments, you will have to save your custom selection in order 
to save it as a new preset. It will then appear in the resolution selection list. It 
doesn't modify the current resolution preset.

Aspect Ratio
Displays the ratio between the horizontal and vertical dimensions of the camera 
framing. Each resolution setting has a preset aspect ratio that cannot be changed.

Frame per second

Sets the frame rate for your project. The higher the frame rate, for example 30 fps, 
the faster the animation will play. The lower the frame rate, for example 12 fps, the 
slower your animation will play. Avoid going under 12 frames per second as your 
animation will have a choppy playback. The human eye requires a minimum of 12 
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frames per second to perceive a fluid animation.

Field of View

Use these options to define the FOV (field of view) of the camera (angle of the 
camera cone) and how the drawing elements (and drawing grid) align to the scene 
grid. The drawing grid is always scaled proportionally to a 4:3 ratio (unless you 
change the scene alignment), therefore changing the Field of View setting may 
not show a visible difference if your project resolution is also 4:3, such as NTSC.

 l Horizontal Fit: The camera resolution is set to fit the left and right edges of 
the scene grid.

 l Vertical Fit: The camera resolution is set to fit the top and bottom edges of 
the scene grid. 

 l Custom Fov: After selecting this option, enter a value, in degrees, of the 
angle that you want the camera cone to be. Increasing this value  will make 
the camera cone wider (the angle is more obtuse). Widening the FOV will 
make the grid and all elements appear farther away. Decreasing the default 
value  will create the opposite effect.

Projection

The Projection settings allows you to modify the type of camera your scene is 
using. You can either use a perspective camera (regular camera) or orthographic 
camera (no perspective).

 l Perspective: The Perspective option is the default and most common 
option. Objects placed closer to the camera will be displayed bigger and 
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objects placed further away will be displayed smaller.

 l Orthographic: The Orthographic option is specific to the gaming pipeline. 
It changes the camera from Perspective to Orthographic, meaning that 
there is no more perspective in the Camera view. Objects, when moved in 
depth will not change size. There is more information available about this 
option in the Gaming user guide. In order  to create scenes with the Ortho-
graphic camera by default, you need to create a new custom scene res-
olution.

 

Alignment Tab
 

Parameter Description

Alignment

The Alignment presets give you two preset options:

‣ 4:3 12 Fields: Defines the units of your project to have a 4:3 ratio and sets 
up 12 of these units to run both vertically and horizontally in four cardinal 
quarters (NW, NE, SW, SE). This Alignment preset is visible in the FOV 
and drawing grids.

‣ Square 12 Fields: Defines the units of your project to have a 1:1 or 
square ratio and sets up 12 units to run both vertically and horizontally in 
four cardinal quarters (NW, NE, SW, SE). This Alignment preset is NOT 
visible in the FOV and drawing grids.

Units Aspect Ratio In the Units Aspect Ratio fields, enter the aspect ratio of the grid you will use. The 
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aspect ratio describes the shape of the grid unit. A square grid unit would have the 
ratio 1:1, whereas a grid unit of aspect ratio 4:3 is a unit with one side 1.33 times 
as big as the other side.

If the aspect ratio you want to use is 1:1, enter 1 in the Left/Right field (X-axis) 
and 1 in the Up/Down field (Y-axis). The default Aspect Ratio is set to 4:3 as it is 
the one used by traditional animators, who are accustomed to working with the 
grid system described above. 

Number of Units

In the Number of Units fields, enter the number of horizontal, vertical and depth 
units for your scene’s grid.

Animators who prefer to work traditionally will understand the default setting of 24 
units horizontal by 24 units vertical as it, once again, corresponds to the grid 
above. Twelve is a common setting for the field depth.

Those who prefer to work in pixels should enter the pixel dimensions (3) of their 
project. This way if you want to move something over 600 pixels you just need to 
type in 600 units.

Coordinates at Centre

In the Coordinates at Centre, you can enter a new coordinate for the centre of 
your scene.

By default, the (0,0) centre is set in the middle of the grid as shown in the grid 
above. If you want to change the centre of your grid, for example to the upper left 
corner, you would enter (-12, 12), -12 units across and 12 units up. That is of 
course unless you changed the number of units to match the pixel dimensions of 
your scene. Then you would enter negative half the width and positive half the 
height.

Save
Saves your current Alignment settings and be able to select them later from the 
list.
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NOTE: If you change your scene‘s alignment from 4:3 12 Fields to Square 12 Fields part way though your pro-
ject, you may find that the animation grid becomes offset. To correct this, choose the following setting from the 
Layer Properties panel‘s Advanced tab: Alignment > Alignment Rule > Centre First Page.

 

Bitmap Resolution Tab
 

Parameter Description

Scene Resolution This is the scene resolution preset name and size in pixels.

Width

This is the width of the resolution for the bitmap that will be created. This is not 
the actual size of the bitmap. TVG drawings (Toon Boom drawing native format) 
have an infinite size. Bitmap TVGs are composed of small tiles. Therefore it does 
not mean that because you have artwork at the four corners of your camera frame 
or even quite far outside of your drawing that your bitmap image will be very large 
and heavy. By default, it is set to the same width as the scene resolution.

Height
This is the height of the resolution for the bitmap that will be created. By default, it 
is set to the same height as the scene resolution.

Resolution Factor

This is the size of the bitmap resolution in relation to the scene resolution. If you 
increase the percentage, the width and height fields will increase accordingly. If 
you plan to animate the camera and zoom into your background, you will need to 
set a higher resolution so that the smaller area in which you will zoom will be 
100% of the scene resolution.

 

Advanced Tab
The Advanced tab contains an option for Toon Boom Digital Pro release 7.3 and Harmony release 7.3. 

Since version 7.8, the method in which Z-Ordering is calculated has been optimized. Enable this option if you want 
to use the version 7.3 system.

Toon Boom Digital Pro and Toon Boom Harmony 7.3 allowed smaller values on the Z-axis such as 0.0001. Since  
version 7.8, the Z-ordering calculation is now optimized and allows only larger values such as 0.001.
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Scripts Manager Dialog Box
The Scripts Manager dialog box lets you link a script to a toolbar button for quick and easy access. Once you 
select a script, you can add it to the toolbar, load a custom icon and add a tooltip.

How to access the Scripts Manager Dialog Box

 1. In the Scripting toolbar, click the Manage Scripts  button.

The Scripts Manager dialog box opens.

 

Parameter Description

Files A list of the available JavaScript files.

Functions A list of the available functions for the selected script.

In Toolbar Adds the selected script to the toolbar.

Execute Runs the script you selected. Press Esc to interrupt the execution of the script.

Customize Icon Lets you load a custom icon for the function. You can browse for a *.png, 
*.jpg or *.xpm file.

Customize Tooltip Lets you type in a tooltip for the function. When you hover over the button in the 
toolbar, your tooltip will appear.
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Select Colour Dialog Box
The Select Colour dialog box lets you set the colour of layers and columns.  Using colours for layers and columns 
helps to differentiate them visually, making them easy to identify. The colours you choose will be reflected in the 
Node view.

You can select a colour by choosing from a basic set of colours, using the colour wheel or by specifying the HSV or 
RGB values. Once you have selected a colour, you can adjust its intensity and save it as a custom colour that you 
can reuse.

How to access the Select Colour dialog box in the Timeline view

 1. In the Timeline view, click the Change Track Colour  button of the layer you want to modify. 

The Select Colour dialog box opens.

How to access the Select Colour dialog box in the Xsheet view

 1. In the Xsheet view, select one or more columns to modify.

 2. Right-click on the column’s header and select Colour > Change Columns Colour.

The Select Colour dialog box opens.

 

Parameter Description

Basic colours A basic set of colours to choose from.

Custom colours
Displays the custom colours you previously stored using the Add to Custom 
Colours button.

Add to custom colours Lets you add the selected colour to the Custom colours list above.

Colour wheel Lets you select a colour by dragging the T-shaped pointer.
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Value slider
Once you select a colour, you can drag the slider to change the intensity and see 
it previewed in the Colour Preview window below.. 

Colour Preview Displays the colour you are currently selecting. To apply the colour, click OK.

Hue, Saturation, Value
Lets you set the hue (colour), saturation (amount of colour) and brightness (value) 
of the colour.

Red, Green, Blue Lets you set the red, green and blue values.
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Selection Presets Dialog Box
As you're animating, you might find that you are constantly selecting the same pegs, drawing layers, bezier points 
on a deformation envelope, part of a character rig, etc. You can create a preset that automatically selects any 
defined element or group of elements.

How to access the Selection Presets dialog box

 1. Add the Scripting toolbar to your interface:

 l Go to the top menu and select Windows > Toolbars > Scripting.

 l Right-click on the empty space near the top of the interface  and from the quick-access menu selecting 
Scripting.

 l Right-click on the empty space near the top of a view and from the quick-access menu selecting 
Scripting.

 2. In the Scripting toolbar, click on the Manage Scripts  button to open the Scripts Manager window.

 3. In the Scripts Manager, in the Files section, select the file TB_SelectionPreset.js.

The functions associated with that file appear in the Functions section.

 4. In the Functions section, select TB_SelectionPreset.

The Add script to toolbar button becomes active.
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 5. Click on the Add script to toolbar button.

The TB_SelectionPreset script  button is added to the Scripting toolbar.

 6. Click Apply.

 7. Click OK.

 8. In the Scripting toolbar, click on the TB_SelectionPreset  button.

The Selection Presets window opens.

Parameter Description

Refresh Removes any highlighted zones from the Group column.

Add Selection Preset 

Opens the Save Selection As Preset dialog box. After entering a name for the 
new preset and clicking OK, a new Selection Preset is added to the Selection 
Presets list. Note: before clicking on the Add button, make a selection in your 
scene of the elements for which you wish to create a Selection Preset.

Delete Selection Preset Deletes the selected Selection Preset from the list.

Group
Double-click in this area, next to the  Selection Preset you wish to use, to 
select the elements defined by the preset.

Name Displays the name of the preset.

Apply to Selection Selects the elements defined by the selected preset from the Name list.

Close Closes the Selection Presets window.
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Sequence Fill Dialog Box
The Sequence Fill dialog box lets you Lets you create a numbered sequence over a selection. The sequence can be 
forward, backward, single, double or higher increment, as a cycle, and so on. The selection can be over one cell or a 
cell range in one column or more or an entire column or many entire columns.

How to access the Sequence Fill dialog box

 1. In the Timeline or Xsheet view, select a cell range.

 2. Do one of the following:

 l From the top menu, select Animation > Cell > Sequence Fill. 

 l In the Timeline view, right-click and select Exposure > Sequence Fill.

 l In the Xsheet toolbar, click the Sequence Fill  button (you may have to customize the toolbar 
to display it).

 l Press Ctrl + M (Windows/Linux) or ⌘  + M (Mac OS X)).

The Sequence Fill dialog box opens.
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Parameter Description

Starting Value The first number in the sequence.

Increment
Lets you type the number by which the drawing number will increase from 
frame to frame. For example, an increment of 1 gives you: 1-2-3-4; an 
increment of 2 gives you: 1-3-5-7; and -2 gives you this: 8-6-4-2.

Hold The exposure holding value.

Cycle
Enable this option to cycle the values and enter the number of cycles in the 
Cycle field.

End Frame
Enable this option to stop the fill at a specific frame within the selection. 
Indicate the frame number in the End Frame field.

Padding
Enable this option to add a 0 padding before the drawing name. In the Padding 
field, enter as many hash symbols (#) as digit you want in your drawing name, 
including the value itself.

Add Key Exposure After
Inserts a key exposure on the frame following the last cell of the new fill 
selection. 
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Set Ease for Multiple Parameters Dialog Box
The Edit Set Ease for Multiple Parameters dialog box lets you apply ease to multiple functions and keyframes. You 
can display the function curve and modify the Bezier or Ease curve.

How to access the Set Ease for Multiple Parameters dialog box

 1. In the Timeline view, select a keyframe on one or more layers.

 2. Do one of the following:

 l In the Timeline view, right-click and select Set Ease For Multiple Parameters. 

 l In the Timeline toolbar, click the Set Ease For Multiple Parameters  button.

The Set Ease For Multiple Parameters dialog box opens.

 

Parameter Description

Filters

Motion

 

Motion: Applies the easing parameters to the selected Position X, Position Y, 
Position Z and 3D Path functions.

Rotation: Applies the easing parameters to the selected Angle functions.

Scale: Applies the easing parameters to the selected Scale functions.

Skew: Applies the easing parameters to the selected Skew functions.

Morphing: Applies the easing parameters to the selected Morphing Velocity 
functions. Note that it applies to the Morphing velocity function found in the Layer 
Properties window, not the basic morphing ease in the Tool Properties view.
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Other: Applies the easing parameters to all the other the selected functions, such 
as all functions created to animate effect parameters.

Left and Right Time Ratio
Lets you type the percentage value corresponding to the length of time you want 
the easing to last. Stay between 0% and 100%. If you go beyond 100%, your 
motion will overshoot. 

Left and Right Value Ratio
Lets you type the percentage value of how strong you want the easing out to be. 
Stay between 0% and 100%. If you go beyond 100%, your motion will overshoot. 

Apply/Previous
Applies the easing parameters to the selected keyframes and then selects the 
previous keyframe in the timeline.

Apply Applies the easing parameters to the selected keyframes.

Apply/Next
Applies the easing parameters to the selected keyframes and then selects the 
next keyframe in the timeline.

Close Close the dialog box. If you did not apply the modifications, they will be cancelled.
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Show Hidden Columns Dialog Box
The Show Hidden Columns dialog box lets you display all the columns contained in the exposure sheet. It can be 
used to hide individual columns.

How to access the Show Hidden Columns dialog box

 1. In the Xsheet view, do one of the following:

 l Click the thick grey line that represents a hidden column. 

 l Right-click on the column header and select Show Hidden Columns.

 l Press Alt + Shift + H.

The Show Hidden Columns dialog box opens.

 

Parameter Description

Show Lets you select the hiddens columns to display in the Xsheet view.

Name Name of the drawing.
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Type Indicates the column type such as column, timing, and expression.

Check Selects all columns.

Uncheck Deselects all selected columns.
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Sound Settings Dialog Box
The Sound Settings dialog box lets you set the compression settings for the movie you will export.

How to access the Sound Settings Dialog Box

 1. From the top menu, select File > Export > Movie.

 2. In the Export to QuickTime Movie dialog box that opens, click Movie Options.

 3. In the Movie Setting dialog box that opens, click Settings in the Sound section.

 

Parameter Description

Compressor

Lets you select a compression type. The default setting is None. This exports 
your audio as is without performing any lossy compression or conversion, 
preserving its fidelity. Other compressors can be used if you need your movie's 
audio track to be exported in a specific format, or if disk space or download speed 
is critical, but they may impact the quality of your movie's soundtrack negatively. 

Rate

Lets you select the audio rate at which to export.                          It is best to export your audio at 
a rate that matches the rate of your original sound files. For example, if your file 
has an audio sample rate of 48 kHz and you choose a conversion rate of 22.05 
kHz, the sound will play at the same speed, but higher frequencies will be 
missing, making it sound muffled. For reference, the standard sound quality is 
44.1 kHz for films, and 48 kHz for DVD. Lower rates are liable to impact the 
quality of your movie's soundtrack negatively, but they can be useful if disk space 
or download speed is critical.

Size

Lets you select the encoding size. Also known as Bit Depth, this determines the 
amount of precision used to record each wavelength in the soundtrack. The 
standard size is 16-bit. If you choose 8-bit, the amount of disk space your sound 
track requires is halved, but the audio will sound muffled.

Use

Lets you decide whether to use the Mono or Stereo channel mode.  Stereo sound 
has a separate sound track for the left and the right speakers, allowing to make 
the origin of each sound realistically match the origin of their corresponding 
action. If you choose Mono, your sound track may use less disk space, but both 
the left and right channels will be merged into a single track. 
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Standard Video Compression Settings Dialog Box
The Standard Video Compression Settings dialog box lets you set the compression settings for the movie you will 
export.

How to access the Standard Video Compression Settings Dialog Box

 1. From the top menu, select File > Export > Movie.

 2. In the Export to QuickTime Movie dialog box that opens, click Movie Options.

 3. In the Movie Setting dialog box that opens, click Settings in the Video section.

 

Parameter Description

Compression Type
Lets you select a codec. The availability of certain compression settings 
depends on the Compression Type selected. For example, Animation is the 
default compression type and as a result the Data Rate option is greyed out. 

Motion

Frame Rate

Lets you select a frame rate. By default, it is set to match the frames-per-
second (fps) of your Harmony project. If you choose a lower frame rate, your 
export playback will be faster than your actual project. The reverse is also true 
for a higher frame rate. 

Key Frames

Automatic: 

Every: Inserts keyframes. This is the option is recommended by QuickTime. 
For further details, refer to the QuickTime documentation.

All: 

Frame Rendering: 

Frames: Lets you set the number of keyframes to insert.
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Compressor

Depth
Lets you select a depth based on your movie’s needs. For example, Millions of 
Colours+ houses an alpha channel.

Quality
Lets you choose a quality setting. The higher the quality of the export, the 
larger the resulting file.

Data Rate

Date Rate

Automatic: Lets the system automatically select the most optimal bit rate.

Restrict To: Lets you enter a rate to save space and allow for faster 
downloading at a cost to the quality of the export. 

Optimized For: Lets you select the intended viewing method.

Preview Displays a preview of the movie to be exported.
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Timeline Scene Marker Dialog Box
The Timeline Scene Marker dialog box lets you create and manage scene markers in the Timeline view. Scene 
markers are visual indicators displayed at the top of the Timeline view in the frame counter area. You can use it to 
denote anything relevant to your work. You can indicate the frames you want to clean up, a change in action, an 
impact, or where you intend to apply an effect. You can also add a note to a scene marker, which is displayed 
when you hover over the scene marker.

How to access the Timeline Scene Marker dialog box

 1. In the frame counter area of the Timeline view, do one of the following:

‣ Drag to select the frame range to mark.

‣ Right-click and select Scene Markers > Mark Current Frame.

Parameter Description

Colour swatch
Opens the Mark Colour dialog box where you can select a colour for the scene 
marker.

Note (Tooltip)
Lets you type in a name for your scene marker. Making the name meaningful 
will help you to quickly identify scene markers especially when there are many 
of them in the frame counter area of the Timeline view.
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Tint Offset/Blend  Dialog Box 
You can offset, blend, or mix the colours in a colour palette using the sliders and increasing the Amount value.

How to access the Tint Offset/Blend dialog box

 1. From the Colour View  menu, select Palettes > Tint Panel or right-click and select Tint Panel.

The Blend/Offset Tint panel opens.

 

Parameter Description

Offset
Offsets the selected colours by the adjustments made using the HSB and RGB 
sliders. Use the Amount slider to adjust the degree of offset. Use the Alpha slider 
to adjust the opacity of the selected colour. 

Blend

Blends the selected colours with the colour swatch in the top-right corner. Use the 
Amount slider to adjust the degree of blend. A blend of 100% turns the selected 
colours into the same colour as the swatch. Adjusting the HSB and RGB sliders 
affect the swatch colour, which in turn affects the selected colours on the left. 
Use the Alpha slider to adjust the opacity of the swatch.

Mixer

Select a Base and Tint colour to form a third colour swatch. Use the slider just 
beneath to mix the Base and Tint colours by different amounts. This will affect the 
mixed swatch whether it is selected or not. Select either the Tint or Base swatch 
and use the HSB and RGB sliders to adjust its colour. This will affect the mixed 
swatch colour, which in turn affects the selected colours on the left.
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Toolbar Manager Dialog Box
The Toolbar Manager dialog box lets you customize the toolbar in any of the views. You can add your favourite 
tools to a toolbar for an efficient workflow.

How to access the Toolbar Manager dialog box

 1. Right-click on a toolbar in any view and select Customize. Note that the menu will not appear if you right-
click on a disabled icon.

 

Parameter Description

Available Tools Displays the complete list of tools available for customizing a toolbar.

Toolbar Displays a list of the tools currently available on the toolbar.

Default Restores the toolbar with its default items.
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Vectorization Parameters Dialog Box
The Vectorization Parameters dialog box lets you vectorize pencil drawings, along with any red, blue or green pencil 
marks you may have used to indicate highlights and shadows. The drawing will be vectorized into pure red, blue, 
green and black (RGB values), while creating colour art zones wherever lines connect. After painting in your tones 
and highlights, change your pure RGB colours to transparent (0 Alpha) in the Colour Picker window and watch the 
indicator colour zone lines disappear.

How to open the Vectorization Parameters dialog box

 1. From the top menu, select File > Import > From Scanner.
You can also open it from any other import option that allows you to customize the vectorization parameters 
(i.e. from the scanner).

 2. In the Scan Drawings window, do the following:

 l In the Layer section, decide on the layer options.

 l In the Import Options section, select the Convert to Toon Boom Vector Drawing option

 l Click Preview.

 3. In the Vectorization section, click the Vectorization Parameters button.

 

Options Tab
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The Options tab contains the main vectorization settings. More settings are available in the Help tab.

Parameter Description

Input The input filters are applied to the bitmap image before it is vectorized.

One Pass
One threshold value is applied to both the Line and Colour Art. For drawings 
with distinct vector-style lines of mattes, you only need one pass.

Two Passes
Applies a different threshold value to each layer. For greyscale drawings, you 
may want to perform the vectorization process twice to apply different 
threshold values to the Line and Colour Art layers.

Threshold
Determines which values in the scanned image are considered part of the Line 
and Colour Art layer and what will be eliminated from the vectorized drawing; 
0% is white and 100% is black. The threshold is between these two values.

Expand Bitmap
Lets you enter a value to scale the bitmap to detect small variations in the line. 
Use this option if you scanned a greyscale image and want to preserve small 
variations in the texture to apply to the line art.

Jag Filter
Lets you enter a value to scale back the bitmap to remove some of the line’s 
roughness. This is useless when you have a drawing that appears quite rough; 
the Jag filter will eliminate excess strokes in the final drawing.

Line Art Threshold (%)
Determines which values in the scanned image are considered part of the Line 
Art layer and what will be eliminated from the vectorized drawing; 0% is white 
and 100% is black. The threshold is between these two values.

Colour Art Threshold 
(%)

Determines which values in the scanned image are considered part of the 
Colour Art layer and what will be eliminated from the vectorized drawing; 0% is 
white and 100% is black. The threshold is between these two values.

Output The output filters are applied during the vectorization process.

No Colour Art Does not generate filling zones in the Colour Art layer.

No Texture
Does not generate texture in the Line Art layer in the final images. Select this 
option to create solid lines in the final line art.

Generate Matte in 
Underlay Layer

Creates an opaque zone behind your drawing’s lines to avoid seeing through 
the layers.

Colour as Texture Converts colour values into a texture layer.

Optical Registration The optical registration options are used to automatically align drawings based 
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on the position of the peg holes on the animation paper. The peg holes must 
appear in the scanned drawings for the optical registration to work.

DPI
Lets you enter the dots-per-inch value of your image. You must enter the same 
value as the DPI used to scan the image.

Peg Side
Lets you select the position of the peg holes on your drawings. Identify whether 
they are on the top, bottom, left or right.

Strictness

Determines how exact the location of the peg holes must be for the software to 
recognize them. There are two values to choose from:

Strict: The peg holes must be in a tightly defined area to be recognized.

Loose: The peg holes can be recognized somewhere in a larger area. This is 
the recommended setting.

Field Chart Lets you indicate the size of the animation paper, 12 or 16.

Post Processing The Post Processing filters are applied to the final vector images.

Remove Holes Removes holes of a specified value that might make painting difficult.

Remove Dirt Removes stray marks and dirt of a specified value. Try a value around 500.

Remove Hair Size Removes small strokes that have no line art.

Remove Hair: Number 
of Passes

The number of times the drawing will be analyzed to identify hair marks.

Miscellaneous

Close Gaps Closes gaps in the Colour Art so you can paint it.

Smooth Passes for Line 
Art Before Breaking 
Triangles

The number of times the smoothing operation runs before creating the triangles 
that break lines in the drawing. If unnecessary triangles are appearing in the 
drawing, increase this value.

Smooth Passes for Line 
Art

The number of times the smoothing operation is performed after the triangles 
have been created. This further smooths the line art.

Preview

Show Strokes Shows the strokes in the Vectorized Image panel.

Stroke Thickness Shows the size of the strokes.

 

Help Tab
The Help tab contains the most advanced vectorization settings which you type in the Advanced Option fields at the 
bottom of the Vectorization Parameters dialog box.
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File IO Options

-file <filename (including extension)> [ options ]

-infile <filename (including extension)>; same as -file

-outfile <filename>; alternate output file

-informat <format>; the input format. Used if reading from stdin

-debug; turn on debug mode

-noforce; don't force output if image is inconsistent

-version; print version information and quit

-output_version <version>; output files of this version. Valid versions can be: 0 or 604

-force_unamed_palette_for_texture; will generate a texture in TVG's internal palette

Registration Options 

-register <dpi side strictness>; perform optical registration.

• Side can be one of left, right, top, bottom or l, r, t, b.

• Strictness can be either loose, strict or l, s.

-register_center_peg_holes; will use only round holes in 16 fields page

-rcph; short form of register_center_peg_holes

-registration_looseness_factor <factor>; registration looseness factor (default 2.000000)

-rlf; short form of registration_looseness_factor

-rdebug; output registration debug messages

-pegpitch <inch (default 8.000000)>; distance between peg bars

-threshr < (default 0.500000)>; threshold for optical registration; range 0.0 to 1.0

-rmargin <inch (default 1)>; region size where to look for peg bars 

-peg_distance_from_center <inch (default 5.25)>; peg distance from centre of the image 
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-pdfc; short form of -peg_distance_from_center 

-out_peg_position <side (default same)>; wanted position of the peg on the drawing.

• Can be one of right, left, top, bottom (or r, l, t, b) or same.

• A rotation will be performed if it is different from the side passed to -register.

-output_peg_matrix; output the peg transformation matrix on standard output.

-scanner_calibrate; < (default 1.0000 1.0000) > x and y scale factors to be applied to scanner image.

Filtering Options 

-pixel <pixel_shape (default '4x3')>; Valid values: 4x3

-gap <worldUnits (default 10)>; close gaps up to this big

-pencil; generate line art only

-keep_dirt; don't filter out dirt

-thresh <threshold (default 0.2)>; range 0.0 to 1.0

-rmv_hairs <worldUnits (default 1)> <passes (default 1)> 

• remove hairs of size smaller than "size" in "passes" passes 

-rmv_holes <area (default 7)>; remove holes smaller than "area" 

-rmv_dirt <area (default 1)>; remove dirt smaller than "area" 

• try values between 100 and 500 for rmv_holes and rmv_dirt. The area is in world units squared

-rmv_triangles <worldUnits (default 30.000000)>; remove triangles at "pixels" 

• distance from each other. Use -no_break to remove all triangles

-no_texture; don't generate textured strokes

-color_as_texture; will vectorize the alpha channel and put the RGB colour in a textured colour

-noclosegap; disable all gap closing algorithms

-no_break; disable the breaking of line art

-jag_filter <pixels (default 0>; expand the pixels in the vectorization bitmap

-expand_bitmap <pixels (default 0>; expand the pixels in the vectorization bitmap

-fit_errorc <error (default 1.000000>; fitting error for the colour art

-fit_errorl <error (default 1.000000>; fitting error for the line art

-smoothl <passes (default 1>; number of smooth passes for line art

-smoothc <passes (default 1>; number of smooth passes for colour art

-first_smooth <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothl <passes (default 0>; number of smooth passes for line art before breaking triangles

-first_smoothc <passes (default 0>; number of smooth passes for line art in colour art pass (needs -2pass)

-2pass; specify two sets of parameters; one for line art "l", one for colour art "c"
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(-thresh, -rmv_holes and -rmv_dirt will be overridden by -threshl, threshc, -rmv_holesl,

-rmv_holesc, -rmv_dirtl and -rmv_dirtc)

-threshl <threshold for line art (default 0.5)>; range 0.0 to 1.0

-threshc <threshold for color art (default 0.5)>; range 0.0 to 1.0

-jag_filterl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art

-jag_filterc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-expand_bitmapl <pixels (default 0>; expand the pixels in the vectorization bitmap for line art

-expand_bitmapc <pixels (default 0>; expand the pixels in the vectorization bitmap for colour art

-rmv_holesl <area (default 7)>; remove line art holes smaller than "area" 

-rmv_holesc <area (default 7)>; remove colour art holes smaller than "area" 

-rmv_dirtl <area (default 1)>; remove line art dirt smaller than "area" 

-rmv_dirtc <area (default 1)>; remove colour art dirt smaller than "area" 

try values between 100 and 500 for rmv_holesl, rmv_holesc, rmv_dirtl and rmv_dirtc. The values are in 
world units squared 

-margins <inch (default 0.25)>; remove margin around bitmap 

-top_margin <inch (default 0.25)>; remove margin at top of bitmap 

-bottom_margin <inch (default 0.25)>; remove margin at bottom of bitmap 

-left_margin <inch (default 0.25)>; remove margin at left of bitmap 

-right_margin <inch (default 0.25)>; remove margin at right of bitmap 

-remove_peg_bars; remove the peg bar holes

-field_size <fields (default 12 or use value in scan file)>; set the drawing to this field size

-fs; short hand for -field_size

-peg_bar_size <inch (default 1)>; the size of the peg bar region

-noframe; do not put a frame around the colour art

-frame_fields <default -1.000000>; put a frame of the specified dimension around the colour art

-downscale_input <default 1>; downscale the raw input by this integer factor

-downscale_texture <default 1>; downscale the output texture by this integer factor

-buildmatte; generate a matte on underlay for line test

-buildmatte_colourart; generate a matte on colour art for line test

NOTE: -buildmatte and -buildmatte_colourart are mutually exclusive

-copystrokes; copy original strokes when building matte.
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Options for bitmap that has no registration information 

-pixel_margins <inch (default 0)>; remove margin around bitmap 

-top_pixel_margin <inch (default 0)>; remove margin at top of bitmap 

-bottom_pixel_margin <inch (default 0)>; remove margin at bottom of bitmap 

-left_pixel_margin <inch (default 0)>; remove margin at left of bitmap 

-right_pixel_margin <inch (default 0)>; remove margin at right of bitmap 

-dpi <(default -1)>; dpi information of input bitmap 

RGB Keying Options 

-rgb; generate separate zones for red, green and blue lines

-rgb_alpha <value (default 255)>; generate red, green and blue colour with alpha of this value

-no_red; ignore red colour in vectorization

-no_green; ignore green colour in vectorization

-no_blue; ignore blue colour in vectorization

-flatten; flatten the drawing after generating colours

-rmv_rgb_dirt <threshold area default 0.0>; remove red, green and blue regions smaller than area

-expand_bitmap_rgb <pixels (default 0>; expand the pixels in the vectorization bitmap for rgb

-threshrgb <value> <threshold for rgb vectorization default 0.200000>;

-threshsv <saturation threshold default 0.500000> <value threshold default 0.500000>; thresholds on saturation and 
value to consider a pixel to be grey

Colour Vectorization Options 

-color_vectorize; perform a colour vectorization

-file2 <colour art filename>; specify the colour art bitmap

-penstyle <center alpha (0.0-20.0)> <edge alpha (0.0-20.0)> <gamma (0-10)><centre pressure effect (0.0-1.0)> 
<edge pressure effect (0.0-1.0)><texture bitmap downscaling (0.2-20)> <texture bitmap file (valid filename or "" if no 
file)>; generate brush texture for the line art

-pressure_variation <strategy (0, 1 or 2)> <min pressure (0.0-1.0)> <max pressure (0.0-1.0)> <max variation (0.0-
1.0)>; specify a pressure strategy for the centre line. 

-blur_radius <pixels (default 0)>; blur the penstyle texture generated

-color_contour_smooth_passes <times (default 3)>; perform number of smooth passes on contour before 
computing texture

-ccsp <times (default 3)>; short for -color_contour_smooth_passes

-color_rmv_holesl <world units (default 0.000000)>; remove holes of this size when computing texture

-color_fill_holesl <world units (default 0.000000)>; fill holes of this size for colour line art
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Bubble Usage (implemented only for colour vectorization's line art)

-create_bubbles; add bubbles into the LineArt. Implemented for colour vectorization only 

-bubble_gap <value (default 3)>; max number of colour art points between 2 bubbles

-bubble_length <value (default 10)>; max number of circles in a bubble

-min_radius <value (default 1.5000)>; min radius of a circle in a bubble relative to the line thickness (must be >= 
1.0)

-max_radius <value (default 3.5000)>; max radius of a circle in a bubble relative to the line thickness (must be 
>= 1.0)

-uniform_gap; the space between bubbles is constant 

4 Colour Vectorization

-4colours [key:value] ... [key:value] ; The key value list can be empty. The list of keys is:

rgbdiff:value ; between [0.0-1.0] or [0-255]

dark:value    ; between [0.0-1.0] or [0-255]

grey:value    ; between [0.0-1.0] or [0-255]

white:value   ; between [0.0-1.0] or [0-255]

dirt:value    ; dirt area. 200 is a good value

rt:value      ; between [0.0-1.0] or [0-255]

gt:value      ; between [0.0-1.0] or [0-255]

bt:value      ; between [0.0-1.0] or [0-255]

NOTE: There must be no space between the colon and the key/value. For example: -4colours rgbdiff:20 
dark:20 grey:120 white:250 dirt:200 rt:240 gt:240 bt:240

132



Harmony 14 Premium - Reference Guide

Versions Dialog Box
The Versions window lets you delete any unnecessary versions of scenes when working with Harmony Server. 
When working with multiple versions of a scene, you may to clean up the database by deleting the ones you no 
longer need.

How to access the Versions window

 1. Make sure you have the necessary rights. If you do not, select File > Rights to Modify Scene. 

 2. Select File > Manage Versions. 

Parameter Description

Existing Versions Displays the different versions of a scene that you can delete.

Description Displays information about the selected version.

Delete

Removes the selected version of a scene. 

IMPORTANT: This operation cannot be undone.
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Xsheet Column Width Dialog Box
The Xsheet Column Width dialog box lets modify the width of a column in the Xsheet view and use it as the 
default column width.

How to access the Xsheet Column Width Dialog Box

 1. In the Xsheet view, select a column.

 2. From the Xsheet menu, select View > Set Columns Width.

The Xsheet Column Width dialog box opens.

 

Parameter Description

Columns Width (pixels) Lets you set the width of the selected columns (in pixels).

Apply
Applies the value you entered to the selected column without closing the dialog 
box.

Set As Default Uses the value you entered as the default for all columns in the Xsheet.
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Chapter 3: Menus
The Menus section covers all the menu entries available in Harmony. There are several types of menus in Harmony: 
main menus, quick-access menus and view menus. Menus contains most of the functions available. They may also 
have a toolbar button or keyboard shortcut equivalent.

Main Menus 136

Animation Menu 137

Drawing Menu 143

Edit Menu 148

File Menu 151

Help Menu 154

Insert Menu 155

Play Menu 156

Scene Menu 157

View Menu 159

Windows Menu 162

Quick-access Menus 164

View Menus 165

3D Graph View Menu 166

Camera View Menu 168

Colour View Menu 179

Drawing View Menu 181

Function View Menu 189

Library View Menu 191

Model View Menu 193

Node View Menu 194

Node Library View Menu 198

Perspective View Menu 199

Side View Menu 203

Timeline View Menu 206

Top View Menu 209

Xsheet View Menu 212
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Main Menus
The main menu contain most of the commands. Depending on the view you're working in and the element, some 
commands are available and others not. The main menu is always located at the very top of the interface.

On Mac OS X, there is also a Harmony Premium category that contains the following commands: Preferences, 
About, and Quit.

Animation Menu 137

Drawing Menu 143

Edit Menu 148

File Menu 151

Help Menu 154

Insert Menu 155

Play Menu 156

Scene Menu 157

View Menu 159

Windows Menu 162
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Animation Menu
The Animation menu lets you access tools, adjust animation timing, set deformation, morphing and IK parameters, 
lock or unlock layers, and select elements in the Xsheet and Timeline views.

How to access the Animation menu

 l At the top of the interface, select Animation.

Command Description

Animate

Enables the Animate mode which records the position, rotation, scale, 
skew, etc. of objects as keyframes in the Timeline view. Turn off the 
Animate mode to reposition objects for the entire scene. When the 
Animate mode is disabled, keyframes are not created when an object's 
parameters change.

Stop-Motion Keyframe

Sets a stop-motion keyframe which there is no computer-generated 
motion between two keyframes. The segment is constant or flat. The 
drawing remains still until the playback reaches the next keyframe, 
then the drawing pops to its new location.

Delete Keyframe Deletes the selected keyframes.

Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate 
and skew as one unit, which is useful for cut-out characters.

Inverse Kinematics
Lets you pull on a character's extremities, such as the hands and feet, 
and have the rest of the body follow. Can be used on any piece con-
nected in a hierarchy. 

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale 
an object up to make it larger or down to make it smaller. Press Shift to 
scale the element while maintaining its proportions.

Skew Slants the selected element.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you 
move them towards or away from the camera.

Spline Offset

Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If 
your elements were drawn in a different location than the centre of the 
drawing area, it will look like the trajectory is not aligned with your 
drawing. Also, if you have several elements attached to one trajectory, 
you might want your trajectory to be at a different location to represent 
the group's motion better.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every 
drawing included in a layer. 

Cell
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Increase Exposure

Adds one more exposure to a selected cell; repeating this action adds 
an extra cell each time. This is an efficient way to extend a drawing's 
exposure and is always set in Insert mode. Increasing an exposure 
pushes the existing exposure forward.

Decrease Exposure

Decreases exposure of a selected cell by one; repeating this action 
decreases one exposure adds an extra cell each time. This is an 
efficient way to shorten a drawing's exposure. Decreasing an exposure 
pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure

Lets you enter the frame up to which you want to extend the exposure. 
You can expose the drawing in the frames and replace the drawings 
that were originally there or move the subsequent frames forward in 
time. 

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key Exposure
Removes only the key exposure (key frames) not all the exposures. 
The existing key exposure is replaced by the preceding exposure.

Remove Duplicate Key Exposure

When working with drawings to adjust the timing of a mouth in a 
lipsync, for example, and forcing the use of specific key exposures, 
unnecessary key exposures will be created. You can delete these 
duplicates without affecting the rest of the drawing. The first drawing of 
the selection will be used for the range.

NOTE: Duplicate key exposures may occur when pasting with the 
Enforce Key Exposure option selected.

Fill Empty Cells

Lets you fill empty cells to extend the exposure of single frame 
drawings to fill the range of empty cells after each one.When creating 
drawings on  cells that are not side-by-side, the exposure of the first 
drawing no longer fills automatically. You must select the frame range 
where you want your drawings to hold their exposure up to the next 
drawing and use the Fill Empty Cells command.

Insert Blank Cell Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and Pull
Replaces the exposure from the selected cell with exposures that 
follow it.

Fill Selection

Lets you fill the same value over an entire selection. The selection can 
be over one cell, a cell range in one column, a cell range over many 
columns, an entire column, or many columns. You can use numbers, 
words, letters, or any alphanumeric value.

Sequence Fill

Lets you create a numbered sequence over a selection. The sequence 
can be forward, backward, single, double or higher increment, as a 
cycle, and so on. The selection can be over one cell or a cell range in 
one column or more or an entire column or many entire columns.

Fill Cells Randomly
Lets you fill in random values over a selection. You can give a 
maximum and a minimum value and create a range for Harmony to 
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choose the random values from. The selection can be over one cell or a 
cell range in one column or more or an entire column or many entire 
columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Deformation

Set Curves and Offsets 
Independent from Parent

When you transfer a curve's position to its parent offset, first you must 
to set curves and offsets independent from parent.

Transfer Curve Values to Offset

Lets you transfer all of the information from first curve deformer to its 
parent Offset node. This is useful for a legacy scene created using 
Curve deformations where the Offset's position has been placed far 
away from the drawing to make sure it doesn't affect  the drawing's 
deformation. You can bring back the offset and give it the first curve's 
position. The Envelope deformation lets you animate the offset of each 
curve separately. The offset no longer needs to be placed far away.

Convert Elliptic Deformation ROI 
to Shape

After you have created a deformation chain using Elliptic as the Zone of 
Influence type, you can select your deformer and click on this button to 
convert it to a Shaped type. Control points will appear around the shape 
making it easy to customize.You can also convert the Elliptic zone of 
influence to a shape. Select Animation > Deformation > Convert 
Elliptic Deformation ROI to Shape. This will create a much smaller  
initial zone of influence than if you were to convert it directly to a shape.

Convert Deformed Drawing to 
Drawings

Convert deformation animations to drawing sequences, so you can 
adjust the drawings using the drawing tools. You may also want to 
change the timing and set it on double frames instead of single frame.

Convert to New Drawing and Add 
Deformation Chain

Takes the pose/drawing and the deformer of the selected frame and 
converts it to a new pose/drawing with the corresponding deformer. 

Exposure Fill

Using Render Change

Modifies the timing (exposure) of the selected layer, lets you adjust the 
parameters to assign when the texture exposure changes will occur. 
You can adjust the type of filter to use for the motion detection, as well 
as threshold values to indicate what will be considered a big enough 
motion variation for an exposure change.

Morphing

Create Morphing
Lets you control a morphing sequence by placing different types of 
hints to help Harmony morph the animation the way you want it.

Insert Morphing Key Drawing Creates a morphing keyframe from a selected morphing frame.

Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire 
sequence between the two keyframes.

Convert Morphing to Drawing

Lets you convert your morphing inbetweens to real drawings you can 
edit. This is useful when manually editing a morphing sequence or if 
you prefer to have animation timing in double frame (on twos) instead of 
single frame (on ones). 

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in 
other words, on Contour vectors. It allows you to control the line 
thickness and contour position. Also, if a contour is not animated 
correctly, you can use hints to correct the animation. For example, if a 
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flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough 
away from the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity 
rule. The Zone Hint is placed in the centre of the colour zone. 
Sometimes a colour zone is not associated with the corresponding one 
by default. For example, in a splash animation there are many water 
droplets that are the same colour. Harmony automatically morphs the 
droplet to the nearest one. This is not always the one you may have 
predicted. A Zone Hint will force a colour zone to morph with another 
one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as 
central vector. It can be used on drawings that were done using the 
Pencil, Polyline, Ellipse, Line and Rectangle tools. Like the Contour 
Hint, the Pencil Hint snaps to the central vector. Make sure to place it 
far enough away from the line so you will see it snap when you move it.

Pencil Hint points are magenta in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing 
shape. A shape will appear in the destination drawing when there is no 
corresponding shape in the source drawing. If you do not place an 
Appearing Point Hint to control the point of appearance, the shape will 
appear from its centre and expand outwards.

Appearing Point Hint points are violet in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing 
shape. A shape will vanish from the source drawing when there is no 
corresponding shape in the destination drawing. If you do not place a 
Vanishing Point Hint to control the point of disappearance, the shape 
will vanish into its centre.

Vanishing Point Hint points are green in colour.

Switch Between Morphing Key 
Drawings

Toggles between the two key drawings in your morphing sequence. 
This option is useful while setting hints. You can use the default 
keyboard shortcut F4 to toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous Frame
Goes to the previous frame of the selected frame in the morphing 
sequence.

Go to Next Frame
Goes to the next frame of the selected frame in the morphing 
sequence.

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest Hints
Automatically sets hint points on key drawings as a help tool. If you're 
not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.

Hide Hints Temporarily hides the hint points from the key drawings. Use this 
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option when you have a series of hint points hiding some lines you 
would like to see.

IK Constraints

Set IK Nail Blocks the X, Y and Z positions.

Set IK Hold Orientation Blocks the angle.

Set IK Hold X Blocks only the X position.

Set IK Hold Y Blocks only the Y position.

Remove All Constraints Removes all nails except the minimum and maximum angles.

Lip-Sync

Change Mouth Shape to
Lets you change the mouth shape to one of the following: A, B, C, D, E, 
F, G, X.

Auto Lip-Sync Detection Generates a sound detection for lip-sync.

Map Lip-Sync
Automatically maps drawings in an element to the mouth chart you 
have generated for a sound. This can save time when you are lip-
synching a voice track.

Flip

Flip Horizontal Flips the selection horizontally.

Flip Vertical Flips the selection vertically.

Flip Scale X

Once your drawing layer is rotated, the original horizontal and vertical 
axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-
axis of the layer and flips the element following it.

Flip Scale Y
Remembers the original Y-axis of the layer and flips the element fol-
lowing it.

Linear Motion Switches between a linear and curved corner.

Lock in Time

Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it 
freely as other points are being added, moved, or adjusted (control 
point).

No Z Dragging
Keeps the Z value constant when you drag a character using the 
Transform or Translate tool.

Substitute Drawing Previous
Replaces the drawing or cell's symbol on the current frame by the 
previous drawing.

Substitute Drawing Next
Replaces the drawing or cell's symbol on the current frame by the next 
drawing.

Go to Previous Keyframe Goes to the previous keyframe.

Go to Next Keyframe Goes to the next keyframe.

Select Previous Keyframe /Point Select the previous keyframe/point.

Select Next Keyframe /Point Select the next keyframe/point.

Select Child Skipping Effects
Lets you select the first element parented to the selected peg element 
in the Timeline view skipping effects in the hierarchy.
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Select Child
Lets you select the first element parented to the selected peg element 
in the Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in 
the Timeline view.

Select Group Content Selects all of the contents of the group.

Select Parent Skipping Effects
Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the 
Timeline view.

Select Next Sibling
Lets you select the next element (below current element) in the 
Timeline view.

Lock

Lock Locks one or a multiple selection of layers. 

Unlock Unlocks one or a multiple selection of locked layers.

Lock All Locks all the layers in the Timeline view. 

Unlock All Unlocks all the layers in the Timeline view. 

Lock All Others Locks every layer except the selected ones.

Reset

Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation 
angle will be reset to 0 and if the Transform  tool is active, all the 
transformation values will be reset.

Reset All
Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting 
value. All transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often 
have a particular Z ordering for the different views of a character. You 
might want to reset the transformation, but not necessarily the Z 
position. 
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Drawing Menu
The Drawing menu lets you access many tools related to drawing, painting, dirt removal, optimizing strokes, and 
more.

How to access the Drawing menu

 l At the top of the interface, select Drawing.

Command Description

Drawing Tools

Activates a drawing tool including: 

Select, Contour Editor, Pencil Editor, Cutter, Smooth Editor, 
Perspective, Envelope, Reposition All Drawings, Drawing Pivot, 
Brush, Pencil, Text, Eraser, Dropper, Morphing, Line, Rectangle, 
Ellipse, Polyline, Paint, Ink, Repaint Brush, Close Gap, Stroke, Edit 
Gradient/Texture, Hand, Zoom and Rotate View.

These drawing tools are available on the Tools toolbar.

Clean Up

Remove Dirt
Opens the Remove Dirt dialog box where you can specify the number 
and size of dots removal from a selected drawing.

Remove Hair

Opens the Remove Hair dialog box where you can specify the number 
and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or 
filled zones. Increase the value to select larger strokes for removal 
from the drawing. 

Close Gaps

Closes small gaps in a drawing by creating small, invisible strokes 
between the two closest points to close the colour zone. You do not 
need to trace directly over the gap. You can draw it a few millimeters 
away. The two closest points automatically close the gap.

Remove Art Inside Selection

Removes any art inside a selection. It is recommended that you clean 
your Colour Art level as well. If you have a stroke accumulation in the 
Colour Art, it can result in large output files, especially if you work in 
high definition resolutions. 

Remove Art Inside Selection on 
All Drawings

Removes any art inside all drawings selected with the Permanent 
Selection  option in the Select tool.

Remove Art Outside Selection

Removes any art existing outside a selection. It is recommended that 
you clean the Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, 
especially if you work in high-definition resolutions.

Remove Art Outside Selection on 
All Drawings

Removes any art outside all drawings selected with the Permanent 
Selection  option in the Select tool.

Paint
NOTE: The Paint commands require you to use the Permanent 
Selection option in the Select tool so you can maintain a selection 
over multiple drawings.
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Unpaint Selection Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings
Unpaints all art contained inside a selection on all the drawings within 
the same layer.

Unpaint Outside Selection
Unpaints any art existing outside a selection. If no selection have been 
drawn using the Select tool, the entire drawing will be unpainted.

Unpaint Outside Selection on All 
Drawings

Unpaints all art outside a selection on all the drawings within the same 
layer. 

Repaint Selection Repaints any art inside a selection.

Repaint Selection on All Drawings
Repaints any art inside a selection on all the drawings contained within 
the same layer. 

Repaint Outside Selection
Repaints any art outside a selection. If no selection has been drawn 
using the Select tool, the entire drawing will be repainted.

Repaint Outside Selection on All 
Drawings

Repaints any art outside a selection on all the drawings contained 
within the same layer. 

Convert

Pencil Lines to Brush Strokes
Converts the selected centreline pencil strokes into contour strokes 
brush lines.

Brush Strokes to Pencil Lines
Converts selected contour strokes into centreline pencil strokes. The 
brush stroke thickness will be lost.

Strokes to Pencil Lines Converts the selected invisible line to a pencil line.

Break Apart Text Layers
Text is treated as a single drawing object. This separates the text so 
each character becomes an individual drawing object you can select 
and modify independently.

Optimize

Flatten

Merges drawing objects and brush strokes into a single layer. If you 
draw new lines to fix a drawing or line with many brush strokes, it can 
be useful to flatten them all into a single shape. By default, lines are 
drawn one on top of each other. If you intend to repaint the lines or 
modify their shape, it will be easier if they are flattened. 

Smooth Smooths selected drawing strokes and removes extra points.

Create Contour Strokes
Adds a permanent invisible line around a shape that was drawn directly 
in Harmony. This allows you to unpaint lines with the Paint  tool but 
maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes

Remove any permanently invisible lines that were created while 
scanning and vectorizing drawings or manually adding contour strokes. 
This is useful for removing the intersection triangles created during 
vectorization.

Remove Extra Strokes
Removes strokes inside painted area. This option only works after the 
painted drawing is flattened.

Optimize

Reduces the number of layers, such as overlapping brush strokes, in 
the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of 
the final image when they are merged. 
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Crop Brush Textures

Crops an unnecessarily large texture bitmap that lies unseen beneath 
the vector contour of a textured line. This often occurs when you cut 
and paste textured lines from one drawing into another. If you cut a por-
tion from a textured line and paste it into a different drawing, Harmony 
pastes the entire unseen texture bitmap from the source drawing into 
the new one, even if you only took a small portion of the source draw-
ing. Using the Crop Brush Texture command will crop away extraneous 
texture that does not touch the vector area. If there are many textured 
lines in your scene, this will greatly reduce the file size.

Reduce Drawing Texture 
Resolution

When you import and vectorize as texture (colour) a high resolution 
image, the size of your drawing can be heavy. You can reduce the size 
and resolution of the textures in a drawing. 

Transform

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 CW Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW Rotates the current selection 90 degrees counter-clockwise.

Rotate 180 Rotates the current selection 180 degrees.

Arrange

Bring to Front Moves the selected art to the front (on top).

Bring Forward Moves the selected art one level forward (closer to the front).

Send Backward Moves the selected art one level lower (behind).

Send to Back Moves the selected art behind everything (bottom / back).

Create Empty Drawing
Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets 
another drawing, key exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you 
modify an existing drawing but retain the original. When duplicating a 
drawing, the selected cell is replaced with the new drawing. The 
exposure of the original drawing that was on the current cell is 
removed. The original drawing is not deleted from the project folder or 
other cells in which it is exposed. 

Delete Selected Drawings
Permanently removes selected drawings. Once you save your project, 
these drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Rename Drawing with Prefix
Lets you rename a drawing sequence with a prefix, which can be quite 
useful for cut-out puppet breakdown and deformation animation. This 
applies to any deformation work done in pre-Harmony 12 versions.

Rename by Frame
Lets you rename a series of drawings relative to their frame position. 
This is useful in hand-drawn animation.

Select Strokes with Current Colour
Lets you select drawing elements and painted areas with the same 
colour as the currently selected colour in your colour palette.

Distribute to Layers Every selected stroke in the Camera view is placed on separate layers; 
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one layer per stroke. If artwork is composed of several strokes, you 
must group them to put them on the same layer. 

This operation cannot be done in the Drawing view.

Create Colour Art from Line Art

Lets you use the outline you traced on one of the four embedded layers 
(line art, colour art, overlay, underlay) and create invisible strokes to 
paint your drawings on separate layers. This provides more inking and 
painting flexibility. 

You can also configure this option to create the invisible strokes on any 
of the four embedded layers.

Create Breaking Triangles

Useful for brush strokes, creates triangular breaks at natural line 
intersections. These intersections are the probable locations where 
colour line breaks may occur, such as where a sleeve meets a hand. 

This makes it easier to soft trace lines in different colours when there 
are flattened or unflattened clean brush strokes.

Generate Auto-Matte
Fills colour based on currently selected colour swatch on different 
drawing layers (overlay, underlay) so overlapping lines are more visible 
during a line test.

Adjust Line Texture Opacity

 
Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap Drawing Resolution

This feature is very useful when you need to have a full resolution of a 
bitmap image (such as imported bitmaps as .psd or .tga for the 
background) for tracing to create a matte directly in Harmony.

By default, Harmony creates small thumbnail images when imported 
as bitmap in order to increase performance by using a small thumbnail 
image instead of using the original large size bitmap for animation work 
in Harmony. This will make difficult to view details or trace due to the 
low resolution (blurry). This option temporary increases the resolution 
of bitmaps up to their original bitmap resolution to make tracing easier.

NOTE: Regardless of using small thumbnails in Harmony, the 
final render will use the real image resolution so there is no loss of 
quality in the final render.

NOTE: The small thumbnail size can be changed in Preferences 
(Camera tab).

Previous Drawing
When a cell is selected in the Timeline or Xsheet view, displays the 
previous drawing.

Next Drawing
When a cell is selected in the Timeline or Xsheet view, displays the 
next drawing.

Previous Layer
When a cell is selected in the Timeline or Xsheet view, displays the 
previous layer.
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Next Layer

Once a cell is selected in the Timeline or Xsheet view, you can 
navigate between the drawings, frames, and layers. Displays the 
previous drawing, next drawing, previous layer or next layer.

When a cell is selected in the Timeline or Xsheet view, displays the 
next layer.

Colour Protection

Toggle Current Colour Protection
Temporarily enables/disables the Colour Protection feature so you can 
quickly correct wrongly inked or painted areas under protected colour 
without readjusting the Current Colour Protection option.

Respect Colour Protection

In the Colour view, you can protect a colour swatch to avoid repainting 
or unpainting the zones linked to that swatch. If you using the Paint tool 
and this option is deselected, you will repaint or unpaint the protected 
colours on your drawings until you enable the option again.
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Edit Menu
The Edit menu lets you repeat and undo actions, cut/copy/paste selected objects, select and manipulate objects, 
work with symbols, and access the Preferences dialog box.

How to access the Edit menu

 l From the top menu, select Edit.

Command Description

Undo
Removes the last change made to your project. Harmony supports 
multiple undo, so you can undo changes you made in the order you 
made them.

Redo
Redoes an operation you have undone. This command is active only 
after you use the Undo command.

Cut
Removes selected objects. You can then paste the object or its prop-
erties to another object.

Copy Copies selected objects and properties.

Paste
Places an object you cut or copied into the location you select in a 
view.

Paste Special

Opens the Paste Special dialog box which lets you determine how 
templates and symbols are imported in the Timeline view. 

There are advanced paste options for drawings, timings, keyframes, 
layers, as well as palettes and symbols.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the 
number of cycles to paste and select a type of cycle: Normal, 
Reverse, Forward-Reverse and Reverse-Forward.

Paste Reverse
Reverses the timing of drawings or keyframes in range of selection 
after copying.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the 
Drawing, Timeline and Camera views. This helps you manage 
multiple objects as one when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items 
that were not selected. For example, if some lines are selected in a 
drawing, this command will deselect them and select any other lines 
in the drawing that were not selected.

Auto-Apply

Automatically applies changes you make to a property window or dia-
log box. Harmony applies the modification automatically and dis-
plays the result in the Camera view. When working on a heavy 
scene, it is useful to turn off this option.If you want to always work in 
Auto-Apply mode, you can deselect the Auto-Apply option in the 
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Preferences dialog box (General tab). Then, each time you start Har-
mony, the Auto-Apply  mode will be off. You must click the Apply but-
ton to see any modifications.

Create Symbol
Creates a symbol from selected drawing elements in the Drawing or 
Camera view, nodes in the Node view, or a layer or cells in the 
Timeline view.

Open Merge Editor
Lets you bring together (merge) the layer or drawings from different 
versions of the same scene.

Expand Symbol

Extracts a symbol's contents and places it on the root timeline. Its 
contents will be copied and inserted into the root timeline. The 
symbol will not be removed from the Timeline view once it is 
expanded. 

The symbol's layers will be parented to it in case you created 
motions and transformations on the drawing layer that contain the 
symbol. Breaking the hierarchy could result in the loss of any scaling 
and animation you may have created.

Expand Selected Symbol in Groups
Expands a symbol within a group to avoid crowding the timeline with 
a series of layers. When you expand the symbols, the layers will be 
contained in a group node that you can expand to see the content.

Duplicate Selected Symbol
Creates a duplicate of a selected symbol. If other symbols are nes-
ted inside the new symbol, they are not duplicated. If you modify 
them, the original and other instances will also be modified.

Create Drawing from Drawing Selection
Breaks a character into its main body parts. There is no need to cre-
ate any layers prior to this process. Make sure your model is well 
centered and sized in the Camera view.

Clone: Drawings Only
Creates a copy of the drawings in the selected layer in the Timeline 
view or column in the Xsheet view. The timing it not copied.

Clone: Drawings and Timing
Creates a copy of the drawings and their timings in the selected 
layer in the Timeline view or column in the Xsheet view.

Duplicate

Duplicates a layer to have a copy of the drawings that are inde-
pendent from the original ones, as well as an independent timing 
(exposure). When you need the drawings to be modified inde-
pendently, you will want to duplicate the layer instead of cloning it.

Merge

There are two methods of merging drawings. 

• You can merge selected drawings in adjacent elements. The 
columns and layers will be left intact, and each new merged 
drawing will reside in the frames of the left-most column or 
lower layer.

• You can merge elements. All drawings will be merged. 
Unused columns and layers will be deleted, but the original 
drawing files are still accessible.

Group

Group Groups selected drawing objects in the Camera or Drawing view.

Ungroup
Ungroups a selected group of drawing objects in the Camera or 
Drawing view.
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Group Selected Layers
Groups selected layers in the Timeline view or nodes selected in the 
Node view.

Ungroup Selected Layers Ungroups a selected group in the Timeline or Node views.

Move to Parent Group
Moves selected nodes in the Node view up to the parent group level, 
maintaining all connections.

Edit Drawing Mode

When the Auto-Get Rights to Modify Drawings option is selected in 
the Preferences dialog box (General tab), the system automatically 
gets the rights to modify drawings when you select a drawing. 
Otherwise, you must manually get the rights to modify drawings.

Edit Palette List Mode

When the Auto-Get Rights to Modify Palette option is selected in the 
Preferences dialog box (General tab), the system automatically gets 
the rights to modify palettes and palette lists when you select a 
colour from a palette. Otherwise, you must manually get the rights to 
modify a palette or palette list.

Get Rights to Modify Drawing Manually releases the rights to modify a selected drawing.

Release Rights to Modify Drawing Manually releases rights to modify a selected drawing.

Force Release Rights to Modify Drawing
This option is always available even if the Get Rights to Modify All 
Scene Assets option is not selected in the Database Selector dialog 
box.

Preferences
Opens the Preferences dialog box where you can set your 
preferences for Harmony.
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File Menu
The File menu lets you open, close, save, scan, print, and import and export files.

How to access the File menu

 l From the top menu, select File.

Command Description

New
Creates a new scene while closing any scene already open. The New 
Scene dialog box opens, asking for directory, name, and resolution 
information.

Open
Displays the Open Scene dialog box where you can browse for a scene 
file.  You can open a new scene from the current one and the previous 
scene will close.

Open Recent Displays a list of the most recently opened scenes.

Clear Clears the list of recently opened scenes.

Close
Closes the currently opened scene, but does not close the Harmony 
application.

Save
Saves all changes made to the opened scene, drawings, palettes, and 
palette lists.

Advanced Save

Lets you do the following:

 l Save the scene as the current version.

 l Save different versions representing different stages of the pro-
duction of your scene.

 l Save different versions representing different scene setups.

 l Choose specific assets that you want to save, such as draw-
ings or palettes. 

Rights to Modify Scene Version
Allows you to modify the selected version of the scene and access the 
version manager during the opened session

Rights to Modify Scene
Allows you to modify the currently selected scene version, but locks 
access to the version manager during the opened session.

Read Changed Drawings

Determines which drawing files have been modified on disk since you 
loaded them. All updated drawings will be reloaded. 

NOTE: Reloading a locked drawing will discard unsaved changes.

Manage Versions Allows you to manage all the versions of the current scene.

Save As

Saves the current file with a different name and at a different location.

Saves the current state of a scene as another scene. The Save As 
window prompts you for a new name and a different location for this 
scene before saving it. This will create a complete scene directory for 
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the new scene.

NOTE: The scene name cannot exceed 23 characters.

Save as New Version
Saves the current scene as another version. The Save Version dialog 
box prompts you to give a name for this new version. This will create a 
new .xstage file in your current project directory.

Back Up Scene Backs up the current scene to a location you choose.

Update Database Scene
Updates your database with only the changes you made to the scene. 
To do this, you must enter your host name and host port in the 
Preferences dialog box, General tab.

Download Database Changes
If any changes were made to the scene you downloaded, you can 
perform an update by downloading these changes, which will be 
integrated into your scene.

Remove Unused Files Removes the unused palettes from the scene list.

Import

From Scanner Imports drawings from a TWAIN scanner.

Images Imports bitmap images which you can choose to vectorize.

3D Models

Once you have exported a model using a 3D authoring software, you 
can import it and integrate it in your 2D animation scene.  You have the 
possibility to convert your 3D models to *.osb files upon import to 
Harmony and save them as such. This will allow Harmony to render 3D 
files with the associated textures without the need to copy them 
manually (as long as the auxiliary files are linked correctly and named 
appropriately on your disk).

Link to Images
Links to images stored on a centralizer server when working with 
Harmony Server.

Movie
Lets you convert a QuickTime movie to an image sequence and audio 
file.

Sound Lets you import sound files into your project.

Colour Model
Lets you import TVG drawing file into your project. Once imported, it is 
display in the Model view for use as a colour model which you can load 
into any Harmony scene.

SWF, Illustrator Files to Library Lets you import SWF files into your project.

Export

Movie Exports animation as a QuickTime movie.

Render Write Nodes

Renders all the Write nodes in a node structure. 

When working with Harmony Server, you can send your scene to batch 
processing and to a render farm.

Soundtrack
Exports a sound file as a merged soundtrack or series of individual 
files. The exported soundtracks are generated as *.wav files.

SWF Exports a Flash movie file. 
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The SWF export supports some bitmap effects (which can be 
previewed in Render View  mode) and SWF Blend Modes (vector 
effects which can be previewed in OpenGL View  mode).

OpenGL Frames

Exports OpenGL frames (fast display mode) for a quick screen renders 
of a scene that contain no transparency channel. Heavier scenes 
containing 3D, multiple effects and camera moves can be fairly long to 
export.

Layout Image Exports all the elements in your scene to a layout .psd file.

Layout Image from Selection Exports only the selected elements to a layout .psd file.

Print

Xsheet
Prints the exposure sheet so you can take it to your animation table,  
provide a copy to the animator, or create your Xsheet skeleton directly 
in Harmony.

Node View Prints the Node view for reference purposes.

Quit Closes the application.
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Help Menu
The Help menu lets you display the Harmony documentation, Welcome screen and end user license agreement, 
as well as access the Toon Boom website, and identify the product name and version number.

How to access the Help menu

 l At the top of the interface, select Help.

Command Description

Online Help
Opens the Harmony Help system, complete with instructions on 
how to use the system. This requires an internet connection.

Getting Started
Opens the Harmony Getting Started Guide (in PDF format) in a 
browser window. Requires Acrobat Reader.

Toon Boom on the Web
Opens the Toon Boom website, which features a Support and 
Community > Forum section.

Customer Experience Improvement 
Program

The Customer Experience Improvement Program allows Toon 
Boom to collect usage information. The data does not contain any 
personally identifiable information and cannot be used to identify 
you. The data will consist of a basic hardware description, a project 
summary and usage information. The information is used only for 
software improvement purposes, as well as for sharing with third 
parties for the same reason.

This program is enabled by default but is voluntary. If you prefer not 
to participate, you can opt out when you first launch the software, by 
using a global preference, or by a command line argument.

About Identifies the product name and version number. 

Show Welcome Screen Displays the Harmony Welcome screen.

Show End User License Agreement Displays the End User License Agreement.

Debug Mode

Enables the Debug mode for gathering and displaying precise 
information about each rendering frame, such as the nodes 
encountered and action taken. You can view this information in the 
Message Log view.

Shortcuts Displays the complete list of keyboard shortcuts for Harmony.

154



Harmony 14 Premium - Reference Guide

Insert Menu
The Insert menu lets you create empty symbols in the Library view, different types of layers in the Timeline view, 
keyframes and control points.

How to access the Insert menu

 l At the top of the interface, select Insert.

Command Description

Create Empty Symbol in Library
Creates an empty symbol in the Library view to which you can edit (add 
content).

Bone Adds a new Bone layer to the Timeline view.

Camera Adds a new Camera layer to the Timeline view.

Colour-Card Adds a new Colour-Card layer to the Timeline view.

Drawing
Adds a new Drawing layer to the Timeline view and a column in the 
Xsheet view.

Game Bone Adds a new Game Bone layer to the Timeline and Node views.

Group Adds a new Group layer to the Timeline and Node views.

Kinematic Output Adds dd a new Kinematic Output layer to the Timeline and Node views.

Peg Adds a new Peg layer to the Timeline and Node views.

Quadmap Adds a new Quadmap layer to the Timeline and Node views.

Particle

Basic Particle System
Adds a new layer with a basic particle system in the Timeline and Node 
views. 

Basic Gravity-based System
Adds a new layer with a basic gravity-based particle system in the 
Timeline view. 

Keyframe Adds a keyframe to the selected cell in the Timeline view.

Keyframe and Duplicate Drawing
Adds a keyframe to the selected drawing layer cell in the Timeline view 
and creates a duplicate of the drawing, which sits on top of the original 
drawing.

Position Keyframe
Adds a position keyframe whereby keyframes will only be added on the 
X, Y and Z parameters of the selected layer. Keyframes are not added 
on the Angle, Scale and Skew parameters.

Control Point

Adds a control point to the trajectory of the selected element or peg in 
the Camera view when the element or peg is in a 3D path. Note that 
you must have a 3D path in the peg portion in order to add a control 
point.
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Play Menu
The Play menu lets you play back animation and sound. Use it to scrub the sound to create your lip-sync, loop the 
playback, navigate through frames, and change the playback range and speed.

How to access the Play menu

 l At the top of the interface, select Play.

Command Description

Play Plays and stops the animation.

Render and Play
Creates a render of your scene to play back the final result including 
the effects.

Test SWF Movie
Creates a SWF format movie and a report to test your result before 
proceeding to the final movie.

Stop Stops playback.

Playback Speed
Opens the Set New Frame Rate dialog box where you can set the 
frame rate at which the playback plays.

Loop Repeatedly plays back your animation indefinitely.

Enable Sound Turns on sound during playback.

Enable Sound Scrubbing Turns on sound scrubbing during playback.

Start Frame
Opens the Set Playback Start Frame dialog box where you can set 
the frame number on which to start playback.

Stop Frame
Opens the Set Playback Stop Frame dialog box where you can set 
the frame number on which to stop playback.

First Frame Moves the red playhead to the first frame.

Previous Frame Moves the red playhead to the previous frame.

Next Frame Moves the red playhead to the next frame.

Last Frame Moves the red playhead to the last frame.

Go to Frame
Opens the Go to Frame dialog box where you can enter the frame 
number on which the red playhead to be positioned in the Timeline 
view.

Enable Playback

Top View Plays back your animation in the Top view.

Side View Plays back your animation in the Side view.

Perspective View Plays back your animation in the Perspective view.
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Scene Menu
The Scene menu lets you set the scene length, add frames to the scene, view different displays of the scene, set 
render options, access the Scene Settings dialog box and Elements Manager window, and verify the drawing and 
palette files in your project.

How to access the Scene menu

 l At the top of the interface, select Scene.

Command Description

Scene Length Lets you set the length of the scene in frames.

Frame

Add Frames at Start Adds the number of frames you specify to the beginning of the scene.

Add Frames at End Adds the number of frames you specify to the end of the scene.

Add Frames Before Selection
Adds the number of frames you specify before or after your selection.

Add Frames After Selection

Remove Selected Frames Deletes the selected frames from your scene.

Camera

Default Camera
Lets you select a camera. If you only add one camera to your scene, 
you will only see Default Camera in your list.

Default Display

Display All Shows the contents of a specific Display node, updating the contents 
of the Camera, Top, Side, Perspective, and Timeline views.Display

Scene Settings
Opens the Scene Settings dialog box where you can set the resolution, 
alignment, bitmap resolution and many other parameters.

Render

Auto Render

Automatically recalculates the preview image whenever you modify a 
parameter. If your scene is heavy and you do not want the preview 
rendered automatically, deselect the Auto-Render option and do the pre-
view update manually.Note that this will slow down Harmony as it 
takes resources to update every frame.

Auto Render Write

Renders a frame each time the current frame is changed. 

You must have a Write node in your node structure to use this 
command.

Recalculate All
Refreshes the node structure and rerenders the display when the Cam-
era view is in render mode.

Recalculate Selected
Refreshes the node structure and rerenders the display of selected ele-
ments when the Camera View is in render mode.

Cancel Preview Render Cancels a render that was started.

Element Manager
Opens the Element Manager window where you can add, delete or 
modify elements (drawing folders) in your scene. If you have drawing 
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folders that are not linked to a column in your scene, use the Element 
Manager to delete them if needed. See xref Reference > Windows > 
Element Manager. 

Check Files Verifies the integrity of the drawing and palette files in your project. 
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View Menu
The View menu lets you manipulate the view by zooming, panning, or rotating. You can also display the grid and 
change its size, use the onion skin feature to help with drawing, and set the preview resolution. 

How to access the View menu

 l At the top of the interface, select View.

Command Description

Toggle Full Screen

Cycles through the following display modes:

 l Normal Full-Screen: The main application window becomes 
full screen.

 l View Full-Screen: The selected view becomes full screen and 
all other views are collapsed.

 l Normal: The main application window is restored to its original 
size and collapsed views are expanded.

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Rotate View CW
Rotates the Camera view 30 degrees clockwise, like an animation 
table.

Rotate View CCW
Rotates the Camera view 30 degrees counter-clockwise, like an anim-
ation table.

Reset Zoom Resets the view’s zoom to its default position.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Next Colour Goes to the next colour in the Colour view.

Previous Colour Goes to the previous colour in the Colour view.

Grid

Show Grid Displays the grid.

Grid Outline Only Displays the outline of the grid only.

Underlay Displays the grid under the drawing elements.

Overlay Displays the grid over the drawing elements.

Square Grid Displays a standard square grid.

12 Field Grid Displays a 12-field size grid.

16 Field Grid Displays a 16-field size grid.

Onion Skin

Show Onion Skin
Lets you preview the previous and next drawings. By default, the pre-
vious drawings appear in a shade of red and the next drawings are dis-
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played with a shade of green. You can change these colours in the 
Preferences dialog box. 

Add to Onion Skin Adds a series of selected elements to the onion skin preview.

Remove from Onion Skin Removes a series of selected elements from the onion skin preview.

Remove Unselected from Onion 
Skin

Removes all elements except the ones selected from the onion skin 
preview.

Add All to Onion Skin Adds all of the scene's elements to the onion skin preview.

Remove All from Onion Skin Removes all of the scene's elements from the onion skin preview. 

Onion Skinning by Drawing
In Camera view, the onion skin by default is per frame, this option lets 
you set it by drawing so you don't see any exposure's onion skin from 
the same drawing.

No Previous Drawing
Removes the previous drawing's onion skin and displays only the next 
drawing.

Previous Drawing Displays the previous drawing.

Previous Two Drawings Displays the previous two drawings.

Previous Three Drawings Displays the previous three drawings.

No Next Drawing Do not show the onion skin for all of the next drawings.

Next Drawing Show the onion skin for the next drawing.

Next Two Drawings Show the onion skin for the next two drawings.

Next Three Drawings Show the onion skin for the next three drawings.

Reduce One Previous Drawing Reduces the number of previous visible drawings by one.

Add One Previous Drawing Adds one drawing to the number of previous visible drawings.

Reduce One Next Drawing Reduces the number of next visible drawings by one.

Add One Next Drawing Adds one drawing to the number of next visible drawings.

Light Table
Turns on the light table so you can see the previous and subsequent 
active layers in washed-out colours. It is useful for seeing the other lay-
ers when designing, animating or cleaning up your animation. 

Backlight

Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of 
the ink and paint process. Any unpainted zones can be seen as the 
light shows through the unpainted areas of the silhouetted drawing.

Show

Symbol Pivot

Displays a symbol's pivot. The Symbol pivot is similar to the Drawing 
pivot. Each symbol cell can have its own pivot and act the same as the 
Drawing pivot. The Symbol pivot can also be referred to as embedded 
pivot. Inside a symbol, each drawing can have its own pivot. 

Safe Area
Displays the TV safety zone and the centre of the camera frame. The 
safe area adapts to the scene resolution, as well as the safety zone 
and frame’s centre.

Camera Mask
Displays a black mask around the scene’s frame to avoid seeing the 
unnecessary artwork. This option is handy when you're animating and 
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setting up the scene. It allows you to see your scene’s composition bet-
ter.

Control Displays the controls of the selected element.

Current Drawing on Top

Displays the selected drawing on top of everything while you draw. By 
enabling this option, each time you select a drawing tool, the selected 
drawing is displayed in front of everything in the Camera view. The 
Timeline and Node view ordering remain unchanged.You only need to 
enable this option once, it is not necessary to do it each time you select 
a drawing tool. 

Outline Locked Drawings
Displays drawing that are locked in the Timeline view (cannot be 
selected in the Camera view) as wireframes.

Show Strokes
Displays the strokes in your drawings so that the invisible lines stand 
out.

Show Strokes with Colour Wash Displays strokes with washed-out colours.

Hide All Controls Hides the controls of the selected element.

Deformation

Show Current Deformers and 
Hide All Others

Shows all current deformers and hides all other manipulators displayed 
in the Camera view.

Particle

Show Particles as Dots in 
OpenGL

Displays the particles as dots in the OpenGL preview mode. This 
makes the playback speed faster for a heavy scene.

Preview Manager
Opens the Preview Manager where you can set options for the quality 
of previews, and clearing and updating the cache.

Preview Resolution

Same as Scene Resolution

Lets you choose a resolution for previewing a scene.

3/4 of Scene Resolution

1/2 of Scene Resolution

1/3 of Scene Resolution

1/4 of Scene Resolution

Custom
Lets you select a resolution from a list of presets or enter X and Y 
values for a  custom preview resolution.

Bitmap File Quality
Lets you change the quality of the preview of the bitmap file in the 
Camera view. It will not affect the final render.
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Windows Menu
The Windows menu lets you customize your workspace to suit your working style, save it as a new workspace, 
and load it from the Workspace toolbar. You can also show or hide the different toolbars and views in Harmony.

How to access the Windows menu

 l From the top menu, select Windows.

Command Description

Restore Default Workspace
Returns modified workspaces to their original default layout if you do 
not like the current modifications or inadvertently closed some 
windows.

Workspace

Workspace Manager
Opens the Workspace Manager where you can modify, create, 
delete, rename and reorder your workspaces.

Save Workspace
Saves the current workspace along with any modifications you 
made.

Save Workspace As...
Saves the workspace as a new version to avoid overwriting the 
current one.

Workspace
Lets you open workspaces designed specifically for animating, 
compositing, hand drawing, scripting and the default workspace.

Toolbars

Lets you show or hide these toolbars: Tool Presets, Art Layer, 
Playback, File, Edit, Advanced Animation, Scripting, Coordinate, 
Control Point, Display, Tools, Flip, Onion Skin, Mark Drawing, Easy 
Flipping, Workspace, Deformation, Drawing View, Camera View, 
Xsheet View and Timeline View.

Camera Shows or hides the Camera view.

Colour Shows or hides the Colour view.

Coord. and Control Points Shows or hides the Coordinates and Control Points view.

Drawing Shows or hides the  Drawing view.

Function Shows or hides the Function view.

Layer Properties Shows or hides the Layer Properties view.

Library Shows or hides the Library view.

Message Log Shows or hides the Message Log view.

Model Shows or hides the Model view.

Node Library Shows or hides the Library view.

Node View Shows or hides the Node view.

Perspective Shows or hides the Perspective view.

Side Shows or hides the Side view.

Timeline Shows or hides the Timeline view.
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Tool Properties Shows or hides the Tool Properties view.

Top Shows or hides the  Top view.

Xsheet Shows or hides the Xsheet view.

3D Graph Shows or hides the 3D Graph view.

Integrated Help Shows or hides the Integrated Help view.

Metadata Editor Shows or Hides the Metadata Editor view.

Script Editor Shows or hides the Script Editor view.
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Quick-access Menus
A quick-access menu lets you open a list of the commands you will use most often.

 How to access a quick-access menu

 1. Right-click anywhere in a view.

164



Harmony 14 Premium - Reference Guide

View Menus
A view menu contains commands specifically related to that view.

How to access a  view menu 

 1. In the top-left corner of a view, click the Menu  button.

3D Graph View Menu 166

Camera View Menu 168

Colour View Menu 179

Drawing View Menu 181

Function View Menu 189

Library View Menu 191

Model View Menu 193

Node View Menu 194

Node Library View Menu 198

Perspective View Menu 199

Side View Menu 203

Timeline View Menu 206

Top View Menu 209

Xsheet View Menu 212
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3D Graph View Menu
The 3D Graph View menu lets you access commands related to the 3D Graph view, such as selecting different 
subnodes, disabling and enabling subnodes and inserting the 3D Kinematic Output node.

How to access the 3D Graph menu

 l In the upper-left corner of the 3D Graph view, click the menu button.

Command Description

Edit

Copy Subnode Name

Copies the name of the selected subnode for pasting in the Subnode Name 
field in the Layer Properties of the 3D Kinematic Output node. You need to 
enter the name of the subnode into the 3D Kinematic Output node if you add 
it to the Node view from the Node Library. If you use the Add 3D Kinematic 
Output button or menu command, the 3D Kinematic Output node will 
automatically be added and connected in the Node view, with the selected 
subnode name in the Subnode Name field.

Select All Selects all the items in the 3D graph (all the parts of the 3D model).

Deselect All Deselects all the items in the 3D graph (all the parts of the 3D model).

Select Parent Subnode Jumps to the parent subnode of a selected child subnode.

Select Child Subnodes
Jumps to the first child subnode of a selected parent subnode. Use the 
Select Next Sibling Subnode menu option to continue down the list of 
children.

Select Next Sibling 
Subnode

Selects the next child subnode, after the selected child subnode in the list.

Select Previous Sibling 
Subnode

Selects the child subnode previous to the selected child subnode in the list.

Subnodes

Enable

Enables the selected subnode in the 3D graph list. Enabling the subnode 
displays the corresponding part of the 3D model in the Camera and 
Perspective views. You can make a multi-selection with this command. You 
can also use the Enable Subnode button in the 3D Graph view toolbar to 
preform the same function.

Disable

Disables the selected subnode in the 3D graph list. Disabling the subnode 
hides the corresponding part of the 3D model in the Camera and Perspective 
views. You can make a multi-selection with this command. You can also use 
the Disable Subnode button in the 3D Graph view toolbar to preform the 
same function.

Insert

Make Properties 
Available

Adds the subnode to list of activated subnodes in the Layer Properties of the 
Subnode-Animation node, in the Node and Timeline views. This means that 
function columns (position x, y, z, velocity, scale, etc.) have been created 
for the subnode and that it is now animatable. You can also use the Make 
Properties Available button in the 3D Graph view toolbar to preform the same 
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function.

3D Kinematic Output

Adds a 3D Kinematic Output node under the selected node and sets it to use 
the selected subnode's transformation values. You can use the 3D 
Kinematic Output node to move another layer in sync with the moves done 
on the 3D subnode. An asterisk appears beside the subnode name in the 3D 
graph list to indicate the connection of the 3D Kinematic Output node. You 
can also use the Add 3D Kinematic Output node button in the 3D Graph view 
toolbar to preform the same function.
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Camera View Menu
The Camera View menu lets you do many things in the Camera view, including selecting and editing objects in 
different views, changing the display, setting morphing parameters, accessing tools and many more.

How to access the Camera menu

 l In the upper-left corner of the Camera view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Stroke With 
Current Colour

Select the strokes that contain the currently selected colour.

Invert Selection

Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command 
will deselect them and select any other lines in the drawing that were not 
selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child 
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Group
Group: Groups selected drawing objects in the Camera or Drawing view.

Ungroup: Ungroups a selected group of drawing objects in the Camera or 
Drawing view.

View
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Navigation

Zoom In: Zooms in the view.

Zoom Out: Zooms out the view.

Reset Zoom: Resets the view’s zoom to its default position.

Rotate View CW: Rotates the Camera view 30 degrees clockwise, like an 
animation table.

Rotate View CCW: Rotates the Camera view 30 degrees counter-clockwise, 
like an animation table.

Reset Rotation: Resets the view’s rotation to its default position.

Reset Pan: Resets the view’s pan to its default position.

Reset View:  Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line Art 
and Colour Art

Displays all Art layers.

Open GL View

Switches the Camera view to fast display, letting you see your animation play 
in real time. The OpenGL display requires less memory. The final look of your 
effects is not shown in the OpenGL View Mode. You must switch to the Render 
View Mode to see your effects.

Render View

Switches the Camera view to a fully rendered display showing the final image 
of the current frame. If a modification is done to your current frame or if you 
move to a different frame, click the Update Preview button to update the 
display if your preview does not update automatically.The Render View Mode 
display lets you see the final look of your frames including effects and 
antialiasing. You cannot play back your scene in Render View Mode. To see 
your scene fully rendered and to play it back, you must press the Render and 
Play  button in the Playback toolbar.

Matte View

Switches the Camera view to a matte display showing the alpha channel of the 
elements in your scene. The transparency level ranges from 0 to 100 percent. 
Zero percent is completely transparent and represented by black and 100 per-
cent is completely opaque and represented by white. Everything in between 
these extremes has a transparency level somewhere between 1 and 99 percent 
and is represented in various shades of grey. 

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.

Overlay: Displays the grid over the drawing elements.

Square Grid: Displays a standard square grid.

12 Field Grid: Displays a 12-field size grid.

16 Field Grid: Displays a 16-field size grid.

Onion Skin

Show Onion Skin: Lets Lets you preview the previous and next drawings. By 
default, the previous drawings appear in a shade of red and the next drawings 
are displayed with a shade of green. You can change these colours in the 
Preferences dialog box. 
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Add to Onion Skin: Adds Adds a series of selected elements to the onion skin 
preview.

Remove from Onion Skin: Removes Removes a series of selected elements 
from the onion skin preview.

Remove Unselected from Onion Skin: Removes Removes all elements 
except the ones selected from the onion skin preview.

Add All to Onion Skin: Adds Adds all of the scene's elements to the onion skin 
preview.

Remove All from Onion Skin: Removes Removes all of the scene's elements 
from the onion skin preview. 

Onion Skinning by Drawing: 

No Previous Drawing: 

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.

Next Two Drawings: Displays the next two drawings.

Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous 
visible drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by 
one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table

Turns on the light table so you can see Turns on the light table so you can see 
the previous and subsequent active layers in washed-out colours. It is useful 
for seeing the other layers when designing, animating or cleaning up your 
animation. 

Backlight

Produces Produces a silhouette effect by changing the drawing’s coloured 
areas into a single dark, solid colour. Use this to verify the completeness of the 
ink and paint process. Any unpainted zones can be seen as the light shows 
through the unpainted areas of the silhouetted drawing.

Show

Symbol Pivot: Displays a symbol's pivot. The Symbol pivot is similar to the 
Drawing pivot. Each symbol cell can have its own pivot and act the same as 
the Drawing pivot. The Symbol pivot can also be referred to as embedded pivot. 
Inside a symbol, each drawing can have its own pivot. 

Safe Area: Displays Displays the TV safety zone and the centre of the camera 
frame. The safe area adapts to the scene resolution, as well as the safety zone 
and frame’s centre.

170



Harmony 14 Premium - Reference Guide

Camera Mask: Displays Displays a black mask around the scene’s frame to 
avoid seeing the unnecessary artwork. This option is handy when you're anim-
ating and setting up the scene. It allows you to see your scene’s composition 
better.

Control: Displays the controls of the selected element.

BBox Selection Style: Lets you change the display style of selected elements 
to a bounding box style. This removes the default overlay highlight and leaves 
only the bounding box around the selected element.

Outline Locked Drawings: Drawings that are locked in the Timeline view 
(cannot be selected in the Camera view) are displayed as wireframes.

Show Current Drawing on Top: Displays Displays the selected drawing on 
top of everything while you draw. By enabling this option, each time you select 
a drawing tool, the selected drawing is displayed in front of everything in the 
Camera view. The Timeline and Node view ordering remain unchanged.You 
only need to enable this option once, it is not necessary to do it each time you 
select a drawing tool.

Show Strokes: Displays the strokes in your drawings so that the invisible lines 
stand out.

Show Strokes with Colour Wash: Displays strokes with washed-out colours.

Highlight Selected Colour: 

Show Scan Information: Displays a status bar showing the scanning inform-
ation at the bottom of the Drawing and Camera view.

Hide All Controls Hides the controls of the selected element.

Render Current Frame Renders only the current frame.

Auto Render

Automatically recalculates the preview image whenever you modify a para-
meter. If your scene is heavy and you do not want the preview rendered auto-
matically, deselect the Auto-Render option and do the preview update 
manually.Note that this will slow down Harmony as it takes resources to 
update every frame.

Layer Properties
Displays the Layer Properties window of the selected layer in the Timeline 
view.

Preview Manager
Opens the Preview Manager where you can set options for the quality of pre-
views, and clearing and updating the cache.

Bitmap File Quality
Lets you change the quality of the preview of the bitmap file in the Camera 
view. It will not affect the final render.

Drawing

Clean Up

Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
number and size of dots removal from a selected drawing.

Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes 
any small strokes created in the Colour Art layer from very thick lines or filled 
zones. Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible 
strokes between the two closest points to close the colour zone. You do not 
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need to trace directly over the gap. You can draw it a few millimeters away. The 
two closest points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if 
you work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a 
selection. It is recommended that you clean the Colour Art level as well. If you 
have a stroke accumulation in the Colour Art, it can result in large output files, 
especially if you work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside 
all drawings selected with the Permanent Selection  option in the Select tool.

Paint

Unpaint Selection: Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings: Unpaints all art contained inside a 
selection on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If 
no selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a 
selection on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.

Repaint Selection on All Drawings: Repaints any art inside a selection on all 
the drawings contained within the same layer. 

Repaint Outside Selection: Repaints any art outside a selection. If no 
selection has been drawn using the Select tool, the entire drawing will be 
repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a 
selection on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil 
strokes into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into 
centreline pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges Merges drawing objects and brush strokes into a single layer. 
If you draw new lines to fix a drawing or line with many brush strokes, it can be 
useful to flatten them all into a single shape. By default, lines are drawn one on 
top of each other. If you intend to repaint the lines or modify their shape, it will 
be easier if they are flattened. 

Smooth: Smooths selected drawing strokes and removes extra points.

172



Harmony 14 Premium - Reference Guide

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  
tool but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during vec-
torization.

Remove Extra Strokes: Removes strokes inside painted area. This option 
only works after the painted drawing is flattened.

Optimize: Reduces Reduces the number of layers, such as overlapping brush 
strokes, in the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of the final 
image when they are merged. 

Crop Brush Textures: Crops Crops an unnecessarily large texture bitmap that 
lies unseen beneath the vector contour of a textured line. This often occurs 
when you cut and paste textured lines from one drawing into another. If you cut 
a portion from a textured line and paste it into a different drawing, Harmony 
pastes the entire unseen texture bitmap from the source drawing into the new 
one, even if you only took a small portion of the source drawing. Using the Crop 
Brush Texture command will crop away extraneous texture that does not touch 
the vector area. If there are many textured lines in your scene, this will greatly 
reduce the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of 
the textures in a drawing. 

Arrange

Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).

Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).

Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty Drawing
Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you modify an 
existing drawing but retain the original. When duplicating a drawing, the selec-
ted cell is replaced with the new drawing. The exposure of the original drawing 
that was on the current cell is removed. The original drawing is not deleted from 
the project folder or other cells in which it is exposed.

When duplicating a drawing, the selected cell is replaced with the new drawing. 
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The exposure of the original drawing that was on the current cell is removed. 
The original drawing is not deleted from the project folder or other cells in which 
it is exposed.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art From 
Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings 
on separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the 
four embedded layers.

Generate Auto-Matte

Automatically creates a matte from a selected drawing or all drawings on a 
layer. 

Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will 
be created.

Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you Lets you change the resolution of bitmap art for individual drawings. 
You can reduce the resolution of your bitmap file as well as increase it. Be 
careful because enlarging the bitmap resolution on an existing drawing will 
result in a loss of quality.Harmony will perform a pixel smoothing pass 
(resampling) and create additional pixels to avoid losing too much quality, but 
only to a certain extent. This feature is very useful when you need to have a full 
resolution of a bitmap image (such as imported bitmaps as .psd or .tga for the 
background) for tracing to create a matte directly in Harmony.By default, 
Harmony creates small thumbnail images when imported as bitmap in order to 
increase performance by using a small thumbnail image instead of using the 
original large size bitmap for animation work in Harmony. This will make 
difficult to view details or trace due to the low resolution (blurry). This option 
temporary increases the resolution of bitmaps up to their original bitmap 
resolution to make tracing easier. 

Previous Drawing Once a cell is selected in the Timeline or Xsheet view, you can navigate 
between the drawings, frames, and layers. Displays the previous drawing, next 
drawing, previous layer or next layer.

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour 
Protection feature so you can quickly correct wrongly inked or painted areas 
under protected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour 
swatch to avoid repainting or unpainting the zones linked to that swatch. If you 
using the Paint tool and this option is deselected, you will repaint or unpaint the 
protected colours on your drawings until you enable the option again.
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Drawing Tools

Select Lets you select elements from the Camera and Drawing views.

Contour Editor Lets you add, remove or modify points on a vector line and control them.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust 
the stroke curve and position. 

Cutter Lets you cut a drawing area to move, copy, cut or delete it.

Smooth Editor Lets you optimize contours and reduce the number of points on a line.

Perspective Lets you deform a drawing selection and alter its perspective.

Envelope
Lets you deform and warp part of a drawing using a grid envelope and Bezier 
handles.

Reposition All 
Drawings

Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer.

Drawing Pivot Lets you set pivots on a characters, drawings and symbols.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing the final images, such as character 
nodes, cut-out puppet and clean animation. Creates a central vector shape.

Text Lets you type text in your project using various fonts and text attributes.

Eraser A pressure-sensitive tool for precisely erasing parts of a drawing.

Dropper Lets you pick a colour directly from a drawing.

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Line

Lets you draw straight lines which you can then edit.
Rectangle

Ellipse

Polyline

Paint Lets you paint both empty and filled zones.

Ink
Lets you paint only the segment you clicked on between two intersections to be 
painted.

Repaint Brush  

Close Gap
Lets you close small gaps in a drawing by creating small, invisible strokes 
between the two closest points.

Stroke Lets you draw stokes, connect line ends and flatten lines.

Edit Gradient/Texture
Lets you modify the position of a gradient or texture colour within a specific 
zone.

Hand Lets you pan the Drawing or Camera view.

Zoom Lets you zoom in and out of the Drawing or Camera view.

Rotate View Lets you rotate the Drawing or Camera view just like with a real animation disc. 
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Can also be used in Perspective view.

Animation

Insert Keyframe
Adds a keyframe on the selected cell in the Timeline view. If the Animate mode 
is enabled in the Camera view, a keyframe is automatically created on the 
current frame.

Insert Control Point Adds a control point to a 3D path function.

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic 
interpolation created between the selected point and the next one. The layer will 
maintain its position until the animation reaches the frame of the next point and 
will then jump to the new position. Deselect this option to generate interpolation 
and get the layer to progressively move to the next position.

Flip Flips the position of an element on its axis.

Set Ease for Multiple 
Parameters

Lets you set the ease in and ease out on multiple functions and keyframes. 
This opens the Set Ease For Multiple Parameters where you can modify the 
Bezier or Ease curve. You can apply easing parameters to a certain type of 
function only, such as rotation or scale.

Linear Motion
Transforms a curved path to a linear path removing tension, bias, and 
continuity.

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it freely as 
other points are being added, moved, or adjusted (control point).

No Z Dragging
Keeps the Z value constant when you drag a character using the Transform or 
Translate tool.

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.
Substitute Drawing 
Next

Select Previous 
Keyframe/Point

Select the previous keyframe/point.
Select Next 
Keyframe/Point

Lock Locks a layer so it cannot be selected in the Camera view.

Reset

Returns Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation angle 
will be reset to 0 and if the Transform  tool is active, all the transformation 
values will be reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z Resets Resets all transformations on the current frame except the Z position. 
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This is useful when doing cut-out animation. Cut-out puppets often have a 
particular Z ordering for the different views of a character. You might want to 
reset the transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and skew 
as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Skew Slants the selected element.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If your 
elements were drawn in a different location than the centre of the drawing area, 
it will look like the trajectory is not aligned with your drawing. Also, if you have 
several elements attached to one trajectory, you might want your trajectory to 
be at a different location to represent the group's motion better.

Inverse Kinematic Tool
Lets you pull on a character's extremities, such as the hands and feet, and 
have the rest of the body follow. Can be used on any piece connected in a 
hierarchy. 

IK Constraints

Set IK Nail Blocks the X, Y and Z positions.

Set IK Hold Orientation Blocks the angle.

Set IK Hold X Blocks only the X position.

Set IK Hold Y Blocks only the Y position.

Set IK Min Angle Sets limitations on the angle parameter to prevent the puppet from bending too 
far.Set IK Max Angle

Remove All 
Constraints

Removes all nails except the minimum and maximum angles.

Morphing

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in other 
words, on Contour vectors. It allows you to control the line thickness and 
contour position. Also, if a contour is not animated correctly, you can use hints 
to correct the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from 
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the contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity rule. The 
Zone Hint is placed in the centre of the colour zone. Sometimes a colour zone 
is not associated with the corresponding one by default. For example, in a 
splash animation there are many water droplets that are the same colour. 
Harmony automatically morphs the droplet to the nearest one. This is not 
always the one you may have predicted. A Zone Hint will force a colour zone to 
morph with another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as central vector. 
It can be used on drawings that were done using the Pencil, Polyline, Ellipse, 
Line and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps to the 
central vector. Make sure to place it far enough away from the line so you will 
see it snap when you move it.

Pencil Hint points are magenta in colour.

Vanishing Point Hint

A Vanishing Point Hint  is used to control the trajectory of a vanishing shape. A 
shape will vanish from the source drawing when there is no corresponding 
shape in the destination drawing. If you do not place a Vanishing Point Hint to 
control the point of disappearance, the shape will vanish into its centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing shape. 
A shape will appear in the destination drawing when there is no corresponding 
shape in the source drawing. If you do not place an Appearing Point Hint to 
control the point of appearance, the shape will appear from its centre and 
expand outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles Toggles between the two key drawings in your morphing sequence. 
This option is useful while setting hints. You can use the default keyboard 
shortcut F4 to toggle between your drawings.

Suggest HInts
Automatically sets Automatically sets hint points on key drawings as a help 
tool. If you're not sure where to set hints, you can use this option. It will set the 
main hints which you can then fine tune.

Hide Hints
Temporarily Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you would like to 
see.
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Colour View Menu
The Colour View menu lets you access commands related to the Colour view such as creating new palettes, adding 
new colour swatches, and displaying the Tint panel.

How to access the Colour menu

 l In the upper-left corner of the Colour view, click the menu button.

Command Description

Palettes

New

Creates a new colour palette.

By default, Toon Boom Harmony is set to the Basic mode. For simple 
productions, it is recommended to use the Basic mode.  This setting stores the 
palettes automatically for you and saves them at the Scene level. When you use 
the Advanced Palette Lists mode, you can decide at which level you want to store 
your palettes: Environment, Job, Scene, or Element.

Link Lets you access other palettes created in the project and link them to your scene.

Link to External
Lets you you link an external palette to your scene without copying it in your 
project.

Import Imports a colour palette located on your hard drive.

Remove Deletes the selected colour palette.

Rename Lets you five the selected colour palette a new name.

Duplicate
Creates a copy of the original palette, using the same names and colour values, 
but has a different ID and is independent from the original palette. This ensures 
that both the duplicate and original palettes are completely independent.

Clone
Creates a copy of the master palette. The colours in each palette have the same 
properties. The colours have the same identification number pointing to the same 
colour zones, but they can have different names and RGBA values.

Pencil Texture Palette Displays the colour palette containing the pencil line textures.

Move Up Moves the selected colour palette up one level.

Move Down Moves the selected colour palette down one level.

Colour Editor Opens the Colour Editor where you can pick and edit colour swatches.

Tint Panel
Opens the Tint panel where you can modify a series of colours to blend a tint in 
them or offset their RGBA values. 

Display Colour Values Display the colour values beside their colour swatches in the palette list.

Colours

Cut Cuts the selected colour swatch from the palette.

Copy Copies the selected colour swatch which you can paste in a different palette.

Copy Colour ID
Copies a colour swatch's colour ID so you can keep a reference file of colour IDs 
or use them with custom plug-ins. Example of a colour ID: 075cf5b552401130.
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Paste Colour Values Pastes the colour value of the copied swatch over an existing colour swatch.

Paste As New Colours Creates a new colour swatch from the colour value of the copied swatch.

Paste As Clones
Pastes a copied colour to a new palette as a clone of the original one. Both colour 
use the same colour ID. They have to be in different palettes.

New Creates a new colour swatch from the colour swatch that was last selected.

Edit
Opens the Colour Picker window in which you can edit the selected colour 
swatch.

Delete Deletes the selected colour swatch from the palette.

New Texture
Lets you add a bitmap colour swatch to your palette. You can load photos and 
textures and paint your drawings with it. The bitmap image must be a .tga or .psd 
file format.

Edit Texture
Opens the browser to replace the texture used in a textured colour swatch. All 
zones using the swatch will be updated with the new texture.

Scale Down Texture Lets you set a new maximum texture size or scaling factor.

New Default Colour Creates a new colour using the default colour set in the preferences.

Protect Colour
Locks a selected colour, so if you ever paint over it accidentally, the work already 
done will not be affected. You can also block the filling colours if you painted all of 
the animation in Line Art and plan to repaint the lines.

Swatch Mode
Displays the colour swatches with its corresponding name inside the swatch. 
When this option is not selected, the names of the colour swatches are displayed 
beside the swatch.

Independent Bitmap 
Colour

Bitmap colour selection is independent from the vector colour selection.

Bitmap Colour Sliders

RGB Displays the colour picking sliders as RGB (red, green, blue).

HSV Displays the colour picking sliders as HSV (hue, saturation, value).
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Drawing View Menu
The Drawing View menu lets you access tools, set morphing  parameters, lock or unlock layers, and select elements 
in the Drawing view.

How to access the Drawing menu

 l In the upper-left corner of the Drawing view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, Timeline 
and Camera views. This helps you manage multiple objects as one when moving 
them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Select Stroke With 
Current Colour

Select the strokes that contain the currently selected colour.

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation table.

Rotate View CCW Rotates the Camera view 30 degrees counter-clockwise, like an animation table.

Reset Rotation Resets the view’s rotation to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Switch to Colour Art
Displays the Colour Art layer. When switching art layers, you can edit the 
selected layer without affecting the other one.

Preview Line Art 
and Colour Art

Displays all Art layers.

Grid

Show Grid: Displays the grid.

Grid Outline Only: Displays the outline of the grid only.

Underlay: Displays the grid under the drawing elements.
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Overlay: Displays the grid over the drawing elements.

Square Grid: Displays a standard square grid.

12 Field Grid: Displays a 12-field size grid.

16 Field Grid: Displays a 16-field size grid.

Onion Skin

Show Onion Skin: Lets Lets you preview the previous and next drawings. By 
default, the previous drawings appear in a shade of red and the next drawings are 
displayed with a shade of green. You can change these colours in the Preferences 
dialog box. 

Show Centre Line: 

No Previous Drawing: Displays no previous drawing.

Previous Drawing: Displays the previous drawing.

Previous Two Drawings: Displays the previous two drawings.

Previous Three Drawings: Displays the previous three drawings.

No Next Drawing: Displays no next drawing.

Next Drawing: Displays the next drawing.

Next Two Drawings: Displays the next two drawings.

Next Three Drawings: Displays the next three drawings.

Reduce One Previous Drawing: Reduces the number of previous visible 
drawings by one.

Add One Previous Drawing: Adds one drawing to the number of previous visible 
drawings.

Reduce One Next Drawing: Reduces the number of next visible drawings by 
one.

Add One Next Drawing: Adds one drawing to the number of next visible 
drawings.

Light Table
Turns on the light table so you can see Turns on the light table so you can see the 
previous and subsequent active layers in washed-out colours. It is useful for 
seeing the other layers when designing, animating or cleaning up your animation. 

Backlight

Produces Produces a silhouette effect by changing the drawing’s coloured areas 
into a single dark, solid colour. Use this to verify the completeness of the ink and 
paint process. Any unpainted zones can be seen as the light shows through the 
unpainted areas of the silhouetted drawing.

Show

Show Strokes Displays the strokes in your drawings so that the invisible lines stand out.

Show Strokes with 
Colour Wash

Displays strokes with washed-out colours.

Highlight Selected 
Colour

Identify a selected colour swatch used in a drawing.

Show Morphing Key 
Drawing Thumbnail

When using the Morphing tools, this displays the source or destination drawing as 
a reference in the bottom corner of the Drawing view.

Show Scan Information Displays a status bar showing the scanning information at the bottom of the Draw-
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ing and Camera view.

Desk

No Thumbnail

Changes the size of the drawing desk thumbnails.
Small Thumbnail

Medium Thumbnail

Large Thumbnail

Remove Selected 
Drawing

Clears selected drawing from drawing desk.

Remove All Drawings Clears all drawing from drawing desk.

Drawing

Clean Up

Remove Dirt: Opens the Remove Dirt dialog box where you can specify the 
number and size of dots removal from a selected drawing.

Remove Hair: Opens the Remove Hair dialog box where you can specify the 
number and length of hairs for removal from a selected drawing. This removes any 
small strokes created in the Colour Art layer from very thick lines or filled zones. 
Increase the value to select larger strokes for removal from the drawing. 

Close Gaps: Closes small gaps in a drawing by creating small, invisible strokes 
between the two closest points to close the colour zone. You do not need to trace 
directly over the gap. You can draw it a few millimeters away. The two closest 
points automatically close the gap.

Remove Art Inside Selection: Removes any art inside a selection. It is 
recommended that you clean your Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high definition resolutions. 

Remove Art Inside Selection On All Drawings: Removes any art inside all 
drawings selected with the Permanent Selection  option in the Select tool.

Remove Art Outside Selection: Removes any art existing outside a selection. It 
is recommended that you clean the Colour Art level as well. If you have a stroke 
accumulation in the Colour Art, it can result in large output files, especially if you 
work in high-definition resolutions.

Remove Art Outside Selection On All Drawings: Removes any art outside all 
drawings selected with the Permanent Selection  option in the Select tool.

Paint

Unpaint Selection: Unpaints any art existing inside a selection. 

Unpaint Selection on All Drawings: Unpaints all art contained inside a selection 
on all the drawings within the same layer.

Unpaint Outside Selection: Unpaints any art existing outside a selection. If no 
selection have been drawn using the Select tool, the entire drawing will be 
unpainted.

Unpaint Outside Selection on All Drawings: Unpaints all art outside a selection 
on all the drawings within the same layer. 

Repaint Selection: Repaints any art inside a selection.

Repaint Selection on All Drawings: Repaints any art inside a selection on all the 
drawings contained within the same layer. 

183



Chapter 3: Menus     View Menus

Repaint Outside Selection: Repaints any art outside a selection. If no selection 
has been drawn using the Select tool, the entire drawing will be repainted.

Repaint Outside Selection on All Drawings: Repaints any art outside a 
selection on all the drawings contained within the same layer. 

Convert

Pencil Lines to Brush Strokes: Converts the selected centreline pencil strokes 
into contour strokes brush lines.

Brush Strokes to Pencil Lines: Converts selected contour strokes into 
centreline pencil strokes. The brush stroke thickness will be lost.

Strokes to Pencil Lines: Converts the selected invisible line to a pencil line.

Brush Apart Text Layers: Text is treated as a single drawing object. This 
separates the text so each character becomes an individual drawing object you 
can select and modify independently.

Optimize

Flatten: Merges Merges drawing objects and brush strokes into a single layer. If 
you draw new lines to fix a drawing or line with many brush strokes, it can be 
useful to flatten them all into a single shape. By default, lines are drawn one on top 
of each other. If you intend to repaint the lines or modify their shape, it will be 
easier if they are flattened. 

Smooth: Smooths selected drawing strokes and removes extra points.

Create Contour Strokes: Adds a permanent invisible line around a shape that 
was drawn directly in Harmony. This allows you to unpaint lines with the Paint  tool 
but maintain the shape of the lines, should you need to repaint later.

Remove Contour Strokes: Remove any permanently invisible lines that were 
created while scanning and vectorizing drawings or manually adding contour 
strokes. This is useful for removing the intersection triangles created during vec-
torization.

Remove Extra Strokes: Removes strokes inside painted area. This option only 
works after the painted drawing is flattened.

Optimize: Reduces Reduces the number of layers, such as overlapping brush 
strokes, in the selected drawing objects. Drawing objects will only be flattened 
and optimized if the selected objects do not change the appearance of the final 
image when they are merged. 

Crop Brush Textures: Crops Crops an unnecessarily large texture bitmap that 
lies unseen beneath the vector contour of a textured line. This often occurs when 
you cut and paste textured lines from one drawing into another. If you cut a portion 
from a textured line and paste it into a different drawing, Harmony pastes the 
entire unseen texture bitmap from the source drawing into the new one, even if you 
only took a small portion of the source drawing. Using the Crop Brush Texture 
command will crop away extraneous texture that does not touch the vector area. If 
there are many textured lines in your scene, this will greatly reduce the file size.

Reduce Drawing Texture Resolution: 

When you import and vectorize as texture (colour) a high resolution image, the 
size of your drawing can be heavy. You can reduce the size and resolution of the 
textures in a drawing. 

Arrange
Bring to Front: Moves the selected art to the front (on top).

Bring Forward: Moves the selected art one level forward (closer to the front).
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Send Backward: Moves the selected art one level lower (behind).

Send to Back: Moves the selected art behind everything (bottom / back).

Transform

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Rotate 90 CW: Rotates the current selection 90 degrees clockwise.

Rotate 90 CCW: Rotates the current selection 90 degrees counter-clockwise.

Rotate 180: Rotates the current selection 180 degrees.

Create Empty Drawing
Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another draw-
ing, key exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you modify an 
existing drawing but retain the original. When duplicating a drawing, the selected 
cell is replaced with the new drawing. The exposure of the original drawing that 
was on the current cell is removed. The original drawing is not deleted from the pro-
ject folder or other cells in which it is exposed.

When duplicating a drawing, the selected cell is replaced with the new drawing. 
The exposure of the original drawing that was on the current cell is removed. The 
original drawing is not deleted from the project folder or other cells in which it is 
exposed.

Delete Selected 
Drawings

Permanently removes selected drawings. Once you save your project, these 
drawings cannot be recovered.

Rename Drawing Lets you give a selected drawing a new name.

Create Colour Art From 
Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, 
colour art, overlay, underlay) and create invisible strokes to paint your drawings on 
separate layers. This provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the four 
embedded layers.

Generate Auto-Matte

Automatically creates a matte from a selected drawing or all drawings on a layer. 

Opens the auto-Matte dialog box where you can set the radius of the lines 
depending on how precise or rough your line is.

You can also select the source and destinatin layers from which the matte will be 
created.

Adjust Line Texture 
Opacity

Lets you adjust the contrast and opacity of textured lines in a drawing.

Change Bitmap 
Drawing Resolution

Lets you Lets you change the resolution of bitmap art for individual drawings. You 
can reduce the resolution of your bitmap file as well as increase it. Be careful 
because enlarging the bitmap resolution on an existing drawing will result in a loss 
of quality.Harmony will perform a pixel smoothing pass (resampling) and create 
additional pixels to avoid losing too much quality, but only to a certain extent. This 
feature is very useful when you need to have a full resolution of a bitmap image 
(such as imported bitmaps as .psd or .tga for the background) for tracing to create 
a matte directly in Harmony.By default, Harmony creates small thumbnail images 
when imported as bitmap in order to increase performance by using a small 
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thumbnail image instead of using the original large size bitmap for animation work 
in Harmony. This will make difficult to view details or trace due to the low 
resolution (blurry). This option temporary increases the resolution of bitmaps up to 
their original bitmap resolution to make tracing easier. 

Previous Drawing Once a cell is selected in the Timeline or Xsheet view, you can navigate between 
the drawings, frames, and layers. Displays the previous drawing, next drawing, 
previous layer or next layer.

Displays the previous drawing, next drawing, previous layer or next layer.

Next Drawing

Previous Layer

Next Layer

Colour Protection

Toggle Current Colour Protection: Temporarily enables/disables the Colour Pro-
tection feature so you can quickly correct wrongly inked or painted areas under pro-
tected colour without readjusting the Current Colour Protection option.

Respect Colour Protection: In the Colour view, you can protect a colour swatch 
to avoid repainting or unpainting the zones linked to that swatch. If you using the 
Paint tool and this option is deselected, you will repaint or unpaint the protected 
colours on your drawings until you enable the option again.

Drawing Tools

Select Lets you select elements from the Camera and Drawing views.

Contour Editor Lets you add, remove or modify points on a vector line and control them.

Pencil Editor
Lets you modify the thick and thin contour of a pencil line (basically a central 
vector shape). Shape control points along the central spine allow you to adjust the 
stroke curve and position. 

Cutter Lets you cut a drawing area to move, copy, cut or delete it.

Smooth Editor Lets you optimize contours and reduce the number of points on a line.

Perspective Lets you deform a drawing selection and alter its perspective.

Envelope
Lets you deform and warp part of a drawing using a grid envelope and Bezier 
handles.

Reposition All 
Drawings

Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer.

Drawing Pivot Lets you set pivots on a characters, drawings and symbols.

Brush
A pressure-sensitive tool for creating a contour shape with a thick and thin line 
effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing the final images, such as character nodes, 
cut-out puppet and clean animation. Creates a central vector shape.

Text Lets you type text in your project using various fonts and text attributes.

Eraser A pressure-sensitive tool for precisely erasing parts of a drawing.

Dropper Lets you pick a colour directly from a drawing.

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.
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Line

Lets you draw straight lines which you can then edit.
Rectangle

Ellipse

Polyline

Paint Lets you paint both empty and filled zones.

Ink
Lets you paint only the segment you clicked on between two intersections to be 
painted.

Repaint Brush

Close Gap
Lets you close small gaps in a drawing by creating small, invisible strokes 
between the two closest points.

Stroke Lets you draw stokes, connect line ends and flatten lines.

Edit Gradient/Texture Lets you modify the position of a gradient or texture colour within a specific zone.

Hand Lets you pan the Drawing or Camera view.

Zoom Lets you zoom in and out of the Drawing or Camera view.

Rotate View
Lets you rotate the Drawing or Camera view just like with a real animation disc. 
Can also be used in Perspective view.

Morphing

Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Contour Hint

The Contour Hint  point is used on the colour fill zone and brush lines; in other 
words, on Contour vectors. It allows you to control the line thickness and contour 
position. Also, if a contour is not animated correctly, you can use hints to correct 
the animation. For example, if a flag is not waving properly.

When adding a Contour Hint point, make sure to place it far enough away from the 
contour so you can see it snap to the contour. 

Contour Hint points are yellow.

Zone Hint

The Zone Hint  point is used on a colour zone to control the proximity rule. The 
Zone Hint is placed in the centre of the colour zone. Sometimes a colour zone is 
not associated with the corresponding one by default. For example, in a splash 
animation there are many water droplets that are the same colour. Harmony 
automatically morphs the droplet to the nearest one. This is not always the one 
you may have predicted. A Zone Hint will force a colour zone to morph with 
another one.

Zone Hint points are cyan in colour.

Pencil Hint

A Pencil Hint  point is used to control a pencil line, also known as central vector. It 
can be used on drawings that were done using the Pencil, Polyline, Ellipse, Line 
and Rectangle tools. Like the Contour Hint, the Pencil Hint snaps to the central 
vector. Make sure to place it far enough away from the line so you will see it snap 
when you move it.

Pencil Hint points are magenta in colour.

Vanishing Point Hint
A Vanishing Point Hint  is used to control the trajectory of a vanishing shape. A 
shape will vanish from the source drawing when there is no corresponding shape 
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in the destination drawing. If you do not place a Vanishing Point Hint to control the 
point of disappearance, the shape will vanish into its centre.

Vanishing Point Hint points are green in colour.

Appearing Point Hint

An Appearing Point Hint   is used to control the trajectory of an appearing shape. A 
shape will appear in the destination drawing when there is no corresponding shape 
in the source drawing. If you do not place an Appearing Point Hint to control the 
point of appearance, the shape will appear from its centre and expand outwards.

Appearing Point Hint points are violet in colour.

Switch Between 
Morphing Key 
Drawings

Toggles Toggles between the two key drawings in your morphing sequence. This 
option is useful while setting hints. You can use the default keyboard shortcut F4 
to toggle between your drawings.

Go to First Frame Goes to the first frame of your morphing sequence.

Go to Previous Frame Goes to the previous frame of the selected frame in the morphing sequence.

Go to Next Frame Goes to the next frame of the selected frame in the morphing sequence.

Go to Last Frame Goes to the last frame of your morphing sequence.

Suggest HInts
Automatically sets Automatically sets hint points on key drawings as a help tool. 
If you're not sure where to set hints, you can use this option. It will set the main 
hints which you can then fine tune.

Hide Hints
Temporarily Temporarily hides the hint points from the key drawings. Use this 
option when you have a series of hint points hiding some lines you would like to 
see.
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Function View Menu
The Functions View menu lets you do many things in the Camera view, including selecting and editing objects in 
different views, changing the display, setting morphing parameters, accessing tools and many more.

How to access the Function menu

 l In the upper-left corner of the Function view, click the menu button.

Command Description

Edit

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select Next Keyframe Selects the next keyframe.

Select Previous 
Keyframe

Selects the previous keyframe.

Select Left Handle Selects the left handle of the selected keyframe.

Select Right Handle Selects the right handle of the selected keyframe.

Select All
Selects all objects in the Function view. This helps you manage multiple objects 
as one.

Deselect All Deselects all selected objects in the Function view.

View

Show Current Frame Displays the current frame 

Toggle Grid Enables the display of the grid.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Function List

Auto Load Selection

Clear

Load Selection

Add Selection

Remove Selection

Show

Show Motion: 

Show Rotation: 

Show Scale: 
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Show Skew: 

Show Other: 
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Library View Menu
The Library View menu lets you access commands specific to the Library view, such as opening a Library or getting 
the rights to modify a library folder.

How to access the Library menu

 l In the upper-left corner of the Library view, click the menu button.

Command Description

View

List Displays the contents of the selected folder as a list.

Thumbnails Displays the contents of the selected folder as a thumbnails.

Details Displays the details of the selected file.

Generate Thumbnails Creates a thumbnail to display in the preview window.

Edit

New Symbol

Creates a new symbol from a drawing or part of a drawing in the 
Drawing or Camera view, a layer in the Timeline view, or a node in the Node view. 

If your selection is in the Timeline  or Node view, the new symbol appears in the  
Symbol folder. The current selection is not replaced by the new symbol. The new 
symbol only appears in the library. You must drag it into your scene to use it.

If your selection is in the Drawing or Camera view, the new symbol appears in the 
Symbol folder and in the Timeline view as a new layer.

Cut Cuts the selected file in the Library view.

Copy Copies the selected file in the Library view.

Paste Pastes the selected file in the Library view.

Delete Deletes the selected file in the Library view.

Delete Thumbnails Deletes any thumbnails that were generated for display in the preview window.

Edit Symbol

Places you inside the symbol where you can edit it. 

To return to the project's timeline, click the Top  button in the Camera view's 
top-left corner, press  Ctrl + Shift + E (Windows/Linux) or ⌘  + Shift + E (Mac OS 
X). 

Remove Unused Files Removes any files not in use in the selected template.

Rename Template Lets you rename a selected template.

Import Files
Imports vector files such as AI, PDF, and SWF. You requires the right to modify 
the library in which you want to import the files.

Folders

New Folder
Creates a new folder in the Library view. Before you can create a new folder, you 
must have the right to modify the folder in which you are creating the new folder.

Refresh Updates the view and its contents.

Open Library Lets you open a library on your computer.
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Close Library Unlinks a library folder from your library list.
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Model View Menu
The Model View menu lets you load models and view them in different ways, as well as access some drawing tools.

How to access the Model menu

 l In the upper-left corner of the Model view, click the menu button.

Command Description

Previous Model Shows the previous model loaded in the Model view.

Next Model Shows the next model loaded in the Model view.

Import Model Imports a TVG drawing as a model in the Model view.

Use Current Drawing as Model Loads the currently selected drawing in the scene as a model in the Model view.

Load Default Models
Loads TVG drawings placed in a custom models folder located in the scene 
folder.

Clear Model Removes the model from the Model view.

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Rotate View CW Rotates the Camera view 30 degrees clockwise, like an animation table.

Rotate View CCW Rotates the Camera view 30 degrees counter-clockwise, like an animation table.

Reset Rotation Resets the view’s rotation to its default position.

Select Activates the Select tool. This tools is also available on the Tools toolbar.

Cutter Selection Allows to cut a section of the model to paste it in your scene.

Dropper Activates the Dropper tool. This tools is also available on the Tools toolbar.

Zoom Activates the Zoom tool. This tools is also available on the Tools toolbar.
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Node View Menu
The Node View menu lets you organize the nodes according to how you like to work and the nodes you use most 
often. You can easily add categories and subcategories, remove categories you don't use, and rename 
categories.

How to access the Node menu

 l In the upper-left corner of the Node view, click the menu button.

Command Description

File

Print
Lets you print the contents of the Node view. You must be connected to a 
printer.

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Layer Properties Shows or hides the Layer Properties view.

Recalculate Selected
Refreshes the node structure and rerenders the display of selected elements 
when the Camera View is in render mode.

Recalculate All
Refreshes the node structure and rerenders the display when the Camera view 
is in render mode.

Tag

You can tag elements in the Timeline or Node views to view only those 
elements. When you tag elements, an asterisk appears beside the item in the 
Timeline view. Once your elements are tagged and you have switched over to 
View Tagged Layers mode, the Timeline view will display only tagged 
elements. The red bar on the left of the layers indicates you are in this view 
mode.

Timeline Tag: Tags selected elements in the Timeline or Node views.

194



Harmony 14 Premium - Reference Guide

Timeline Untag: Untags selected layer in the Timeline view.

Timeline Untag All: Untags all tagged elements.

Timeline Untag All Others: Untags all elements except the selected one.

Auto Render Write
Renders a frame each time the current frame is changed. 

You must have a Write node in your node structure to use this command.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Group Content Select contents within the group node.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Node View Zooms in the view.

Zoom Out Node View Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Centre on Selection
Centre the display of the Node view on the selected node. This is useful when 
you have many nodes in the Node view, you may find it hard to locate which 
one is selected. 

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Show All Nodes Display all nodes.

Editor Display the Layer Properties editor of the selected node.

Publish Attribute Node

To quickly access parameters for nodes that are grouped, you can select your 
most common parameters to modify and make them appear in the group Layer 
Properties editor. This way, you can access them directly without having to 
enter the group every time.

Show Selected 
Thumbnails

Displays the thumbnails of selected nodes.

Hide All Thumbnails Hides all the thumbnails of selected nodes.

Navigator

 

Hide Navigator: Hides the navigator.

Top Right: Places the navigator in the top-right corner of the Node view.

Top Left: Places the navigator in the top-left corner of the Node view.

Bottom Right: Places the navigator in the bottom-right corner of the Node 
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view.

Bottom Left: Places the navigator in the top-left corner of the Node view.

Cable Style
Line: Use straight lines to show the connections between nodes.

Bezier: Use curved (Bezier) lines to show the connections between nodes.

Nodes

Enable Activate the selected node.

Disable Deactivate the selected node.

Enable All Activate all nodes.

Disable All Others
Deactivates all nodes except for those those selected. This operation only 
affects the current level layers. It does not affect the nested nodes within a 
group. Deactivated nodes appear in red.

Clone Selected Nodes: 
Drawings and Timing

Creates a copy of the selected element that is linked to the original. If a 
drawing is modified in the original or cloned layer, both will be updated. 
However, cloned layers can have different timings.

When you clone a node, it does not automatically connect itself to the 
Composite node of your scene.

You can clone the drawings only or both the drawings and timing.

Clone Selected Nodes: 
Drawings Only

Duplicate Selected 
Nodes

Creates an independent copy of the selected element.  This useful when you 
need to modify the element independently, including the timing (exposure). 
Changes to the original element do not propagate to the duplicate.

Group Selection
Creates a simple group from your selection. The resulting group displays the 
same number of connections as elements in the group.

Group Selection with 
Composite

Group a selection.

Ungroup Ungroups the selected group of nodes.

Move to Parent Group Moves selected nodes up to the parent group level.

Exit Group Exits the group.

Clear Published 
Attributes

Removes the most common parameters you selected for quick access in the 
Layer Properties editor of a group.

Insert

Composite Adds a Composite node to the Node view.

Display Adds a Display node to the Node view.

Drawing
Opens the Add Drawing Layer dialog box where you can specify the type of 
layer to add.

Group Adds a Group node to the Node view.

Parent Peg Adds a new peg to the timeline as a parent of the selected layer.

Peg Adds a Peg node to the Node view.

Effects
Lets you add effects from these categories: 3D, Combine, Deformation, 
Favourites, Filter, Generator, Group, Misc, Move, Output, Particle, Sapphire, 
Shading and Plugins.
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Backdrop
Adds a backdrop to the Node view. Backdrops are a way to work with complex 
node systems that let you associate a selected set of nodes by colour. 
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Node Library View Menu
The Node Library View menu lets you organize the nodes according to how you like to work and the nodes you 
use most often. You can easily add categories and subcategories, remove categories you don't use, and rename 
categories.

How to access the Node Library menu

 l In the upper-left corner of the Node Library view, click the menu button.

Command Description

New Category
Adds a new category to the list of categories to which you can organize nodes 
according to how you like to work and the nodes you use most often.

Rename Category Renames an existing category.

Remove Category Remove a category you no longer need.

Remove Node Removes a node from a category.

Refresh Updates the view and its contents.
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Perspective View Menu
The Perspective View menu lets you select and edit elements, manipulate the view during scene setup, set 
parameters for animation and access animation tools.

How to access the Perspective menu

 l In the upper-left corner of the Perspective view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms into the view, towards the view's pivot point, up to 80,000%.

Zoom Out Zooms out of the view, away from the view's pivot point, up to 1%.

Move Forward
Moves infinitely forward into the view, using the direction set by the current 
position and angle of rotation.

Move Backward Moves infinitely backwards out of the view, using the direction set by the 
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current position and angle of rotation.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Face Selected to Draw
Resets any rotations made and brings the selected object to the center of the 
view. Displaying the drawing object at this perspective is intended to facilitate 
drawing  on the object. 

Look at Selected
Resets view to have the selected object at the center, without resetting the 
rotation angles or zoom.

Layer Properties Shows or hides the Layer Properties view.

Light Table

Turns on the light table so you can see Turns on the light table so you can see 
the previous and subsequent active layers in washed-out colours. It is useful 
for seeing the other layers when designing, animating or cleaning up your 
animation. 

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate

Enables the Animate mode which records the position, rotation, scale, skew, 
etc. of objects as keyframes in the Timeline view. Turn off the Animate mode 
to reposition objects for the entire scene. When the Animate mode is disabled, 
keyframes are not created when an object's parameters change.

Insert Keyframe Adds a keyframe to the currently selected frame in the Timeline view.

Insert Control Point

Adds a control point to the motion path at the currently selected frame. This 
control point does not appear in the Timeline, but can be used to reshape the 
motion path—see Coordinates and Control Points View on page 685. In order 
for this command to work,  layers must be set to 3D Path. 

Set Stop-Motion Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic 
interpolation created between the selected point and the next one. The layer 
will maintain its position until the animation reaches the frame of the next point 
and will then jump to the new position. Deselect this option to generate 
interpolation and get the layer to progressively move to the next position.

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on 
your drawing layer following its original axis.Remembers the original X-axis of 
the layer and flips the element following it.
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Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change 
the velocity of selection functions.

Linear Motion Straightens out the motion path on either sides of the selected control point.

Lock in Time
Indicates whether the point is locked to a specific frame (keyframe) or only 
locked to a specific position and the curve can flow through it freely as other 
points are being added, moved, or adjusted (control point).

No Z Dragging
Locks the Z value when you're animating in 3D space. This means you can 
only reposition your object along the x and y axes. 

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the next draw-

ing.
Substitute Drawing Next

Select Previous Keyframe 
/Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the 
active tool. For example, if the Rotate  tool is active, the transformation angle 
will be reset to 0 and if the Transform  tool is active, all the transformation 
values will be reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. 
Your keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often have a 
particular Z ordering for the different views of a character. You might want to 
reset the transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and 
skew as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an 
object up to make it larger or down to make it smaller. Press Shift to scale the 
element while maintaining its proportions.

Maintain Size Keeps elements the same size aspect ratio in the Camera view as you move 
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them towards or away from the camera.

Skew Slants the selected element.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modi-
fying your animation. By default, the trajectory is located at 0,0,0 fields. If your 
elements were drawn in a different location than the centre of the drawing area, 
it will look like the trajectory is not aligned with your drawing. Also, if you have 
several elements attached to one trajectory, you might want your trajectory to 
be at a different location to represent the group's motion better.
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Side View Menu
The Side View menu lets you position elements in 3D space, set parameters for animation and access animation 
tools—see Side View on page 708.

How to access the Side menu

 l In the upper-left corner of the Side view, click the menu button.

Command Description

Edit  

Cut
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view skipping 
effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.
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Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.

Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate

Enables the Animate mode which records the position, rotation, scale, skew, etc. 
of objects as keyframes in the Timeline view. Turn off the Animate mode to 
reposition objects for the entire scene. When the Animate mode is disabled, 
keyframes are not created when an object's parameters change.

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic interpolation 
created between the selected point and the next one. The layer will maintain its 
position until the animation reaches the frame of the next point and will then jump 
to the new position. Deselect this option to generate interpolation and get the 
layer to progressively move to the next position.

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on your 
drawing layer following its original axis.Remembers the original X-axis of the layer 
and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change the 
velocity of selection functions.

Linear Motion Transforms a curved path to a linear path removing tension, bias, and continuity.

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it freely as other 
points are being added, moved, or adjusted (control point).

No Z Dragging
Keeps the Z value constant when you drag a character using the Transform or 
Translate tool.

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.
Substitute Drawing 
Next

Select Previous 
Keyframe /Point

Select the previous keyframe/point.
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Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the active 
tool. For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values will be 
reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often have a 
particular Z ordering for the different views of a character. You might want to reset 
the transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and skew 
as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Reposition Drawing
Lets you reposition, scale, rotate or skew all drawing strokes on every drawing 
included in a layer. 

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If your ele-
ments were drawn in a different location than the centre of the drawing area, it will 
look like the trajectory is not aligned with your drawing. Also, if you have several 
elements attached to one trajectory, you might want your trajectory to be at a dif-
ferent location to represent the group's motion better.
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Timeline View Menu
The Timeline View menu lets you modify layers, keyframe and timing.

How to access the Timeline menu

 l In the upper-left corner of the Timeline view, click the menu button.

Parameter Description

Import

From Scanner Imports drawings from a TWAIN scanner.

Images Imports bitmap images which you can choose to vectorize.

Sounds Lets you import sound files into your project.

Edit

Cut cells from Xsheet
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy cells from Xsheet Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse 
and Reverse-Forward.

Paste Reverse
Reverses the timing of drawings or keyframes in range of selection after 
copying.

Delete Removes selected objects.

Modify Paste Presets
Lets you modify existing presets when pasting keyframes and exposures. 
There are three presets you can modify: the default presets for both key frames 
and exposures, key frames only and exposures only. 

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection

Deselects the currently selected items and selects all other items that were 
not selected. For example, if some lines are selected in a drawing, this 
command will deselect them and select any other lines in the drawing that 
were not selected.

Select Synced Layers
Selects all the layers synced to the selected layer. The selected layer must be 
a synced in order for this option to be enabled.

Select Child Skipping 
Effects

Lets you select the first element parented to the selected peg element in the 
Timeline view skipping effects in the hierarchy.
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Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the 
Timeline view.

Select Parent Skipping 
Effects

Lets you select the parent of the selected element in the Timeline view 
skipping effects in the hierarchy.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

Lock

Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.

Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Tag

Timeline Tag: You can tag elements in the Timeline or Node views to view 
only those elements. When you tag elements, an asterisk appears beside the 
item in the Timeline view. Once your elements are tagged and you have 
switched over to View Tagged Layers mode, the Timeline view will display 
only tagged elements. The red bar on the left of the layers indicates you are in 
this view mode.

Timeline Untag: Untags selected layer in the Timeline view.

Timeline Untag All: Untags all tagged elements.

Timeline Untag All Others: Untags all elements except the selected one.

Scene Markers

Mark Current Frame: Places a scene marker on the current frame on which 
the playhead is parked. The marker appears in the frame counter area of the 
Timeline view. You can customize the colour of the scene marker and add text 
to display as a tooltip when you hover over the marker—see .

Create Scene Marker: Creates a scene marker from a selected frame range 
in the frame counter area of the Timeline view.

Edit Scene Marker: Lets you edit an existing scene marker. 

NOTE: It's important to select the entire length of the scene marker, otherwise 
the Timeline Scene Marker dialog box will not open for editing.

Delete Scene Marker: Removes an existing scene marker.

Share Functions
Lets you share an existing function curve. By default, all function curves can 
only be used and modified using their original parameter. If you want another 
layer or parameter to use the same function curve, you must share it.

View

Cycle to Next View 
Mode

Displays the new view mode.

Normal View Mode Displays the Normal view mode, the default in the Timeline view. It shows 
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everything connected to the chosen display. In this mode, anything not 
connected to the currently set default display will not be shown in the Timeline 
view. This also means that you cannot add certain elements to the Timeline 
view, as by default, when added they are not connected to any display or 
composite node. An example of such an element is a peg.

Selection Only Mode
Displays only elements currently selected in the Camera or Node view. This 
makes it easier to concentrate on one or a few elements at a time.

View Tagged Layers

Lets you see only elements which have been assigned a Tagged status. An 
item that has been tagged will appear in the Timeline view with a small asterisk 
beside its name. 

Once your elements are tagged and you have switched over to View Tagged 
Layers mode, the Timeline view will display only tagged elements. The red bar 
on the left of the layers indicates you are in this view mode. While in this mode, 
the asterisks are not displayed beside the tagged elements.

Show Functions  

Centre on Selection
Centers the Timeline view on the selected layer. This useful when you have 
many layers in the Timeline view, you may find it hard to locate which one is 
selected. 

Change Track Colour Opens the colour picker window to modify the colour of the selected layer.

Default Track Colour Resets the layer colour.

Collapse/Expand
Toggles between expanding and collapsing all parent layers in the Timeline 
view.

Collapse All Collapses all parented layers in the Timeline view.

Expand All Expands all parented layers in the Timeline view.

Set Tempo Marker

Lets you set a marker that synchronizes your animation with a musical score. 
This lets you reproduce the FPB (Frames Per Beat) and use the tempo 
signature as tempo markers. The Xsheet view lets you pace your animation 
according to the tempo or beat of the soundtrack music or to any rhythmic 
sound, such as the ticking of a clock or water leaking from a spout. See .

Layers

Add Synced Drawing Layer
Creates a new drawing layer whose timing is synced immediately with the cur-
rently selected drawing layer.

Sync Layer With
Opens the Convert to Synced Drawing Layer dialog box. In this dialog box, 
every other drawing layer in the project can be selected, parented and have its 
timing synced to the currently selected layer.

Unsync Layer Unsyncs the parent layer of a synced pairing, when the child layer is selected.
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Top View Menu
The Top View menu lets you position elements in 3D space, set parameters for animation and access animation 
tools—see Top View on page 718.

How to access the Top menu

 l In the upper-left corner of the Top view, click the menu button.

Command Description

Edit  

Cut Drawing Object
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy Drawing Object Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Delete Drawing Object Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Invert Selection
Deselects the currently selected items and selects all other items that were not 
selected. For example, if some lines are selected in a drawing, this command will 
deselect them and select any other lines in the drawing that were not selected.

Select Child
Lets you select the first element parented to the selected peg element in the 
Timeline view.

Select Children
Lets you select all elements parented to the selected peg element in the Timeline 
view.

Select Parent Lets you select the parent of the selected element in the Timeline view.

Select Previous Sibling
Lets you select the previous element (above current element) in the Timeline 
view.

Select Next Sibling Lets you select the next element (below current element) in the Timeline view.

View

Zoom In Zooms in the view.

Zoom Out Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Layer Properties Shows or hides the Layer Properties view.

Camera Cone Displays the camera cone.

Control Displays the controls of the selected element.
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Hide All Controls Hides the controls of the selected element.

Enable Playback Plays back your animation in the Perspective view.

Animation

Animate

Enables the Animate mode which records the position, rotation, scale, skew, etc. 
of objects as keyframes in the Timeline view. Turn off the Animate mode to 
reposition objects for the entire scene. When the Animate mode is disabled, 
keyframes are not created when an object's parameters change.

Insert Keyframe Adds a keyframe to the selected cell in the Timeline view.

Insert Control Point

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic interpolation 
created between the selected point and the next one. The layer will maintain its 
position until the animation reaches the frame of the next point and will then jump 
to the new position. Deselect this option to generate interpolation and get the 
layer to progressively move to the next position.

Flip

Flip Horizontal: Flips the current selection horizontally.

Flip Vertical: Flips the current selection vertically.

Flip Scale X: Once your drawing layer is rotated, the original horizontal and 
vertical axes change. The Flip Scale X and Flip Scale Y will perform a flip on your 
drawing layer following its original axis.Remembers the original X-axis of the layer 
and flips the element following it.

Flip Scale Y: Remembers the original Y-axis of the layer and flips the element 
following it.

Set Ease for Multiple 
Parameters

Opens the Set Ease for Multiple Parameters dialog box where you can change the 
velocity of selection functions.

Linear Motion

Lock in Time
Indicates Indicates whether the point is locked to a specific frame (keyframe) or 
only locked to a specific position and the curve can flow through it freely as other 
points are being added, moved, or adjusted (control point).

No Z Dragging

Substitute Drawing 
Previous

Replaces the drawing or cell's symbol on the current frame by the next drawing.
Substitute Drawing 
Next

Select Previous 
Keyframe /Point

Select the previous keyframe/point.

Select Next Keyframe 
/Point

Select Next Keyframe /Point

Lock
Lock: Locks Locks one or a multiple selection of layers. 

Unlock: Unlocks Unlocks one or a multiple selection of locked layers.
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Lock All: Locks Locks all the layers in the Timeline view. 

Unlock All: Unlocks Unlocks all the layers in the Timeline view. 

Lock All Others: Locks Locks every layer except the selected ones.

Reset

Returns Returns the value of the selected element to the initial value of the active 
tool. For example, if the Rotate  tool is active, the transformation angle will be 
reset to 0 and if the Transform  tool is active, all the transformation values will be 
reset.

Reset All
Resets Resets all transformations on the current frame in a selected layer. Your 
keyframe will remain, but all the values will return to the starting value. All 
transformations are reset regardless of the tool you're using.

Reset All Except Z

Resets Resets all transformations on the current frame except the Z position. 
This is useful when doing cut-out animation. Cut-out puppets often have a 
particular Z ordering for the different views of a character. You might want to reset 
the transformation, but not necessarily the Z position. 

Animation Tools

Transform
Lets you create a global selection so you can reposition, scale, rotate and skew 
as one unit, which is useful for cut-out characters.

Translate Lets you move the selected element along the X and Y axes.

Rotate Turns a selected element around its pivot point. 

Scale
Increases or decreases the size of a selected element. You can scale an object 
up to make it larger or down to make it smaller. Press Shift to scale the element 
while maintaining its proportions.

Maintain Size
Keeps elements the same size aspect ratio in the Camera view as you move 
them towards or away from the camera.

Spline Offset

Lets you Lets you reposition the visual trajectory without offsetting or modifying 
your animation. By default, the trajectory is located at 0,0,0 fields. If your ele-
ments were drawn in a different location than the centre of the drawing area, it will 
look like the trajectory is not aligned with your drawing. Also, if you have several 
elements attached to one trajectory, you might want your trajectory to be at a dif-
ferent location to represent the group's motion better.

211



Chapter 3: Menus     View Menus

Xsheet View Menu
The Xsheet View  menu lets you modify columns, keyframe and timing.

How to access the Xsheet menu

 l In the upper-left corner of the Xsheet view, click the menu button.

Parameter Description

File

Import

Images: Imports bitmap images which you can choose to vectorize.

From Scanner: Imports drawings from a TWAIN scanner.

Sounds: Lets you import sound files into your project.

Print
Prints the exposure sheet so you can take it to your animation table,  provide a 
copy to the animator, or create your Xsheet skeleton directly in Harmony.

Edit

Cut cells from Xsheet
Removes selected objects. You can then paste the object or its properties to 
another object.

Copy cells from Xsheet Copies selected objects and properties.

Paste Places an object you cut or copied into the location you select in a view.

Paste Special
Lets you copy and paste selected drawings into a different layer or paste the 
selection in the same layer to duplicate the drawings.

Paste Special Again Pastes new drawings with the previous Paste Special settings.

Paste Cycle
Cycles a portion of an animation. You can increase or decrease the number of 
cycles to paste and select a type of cycle: Normal, Reverse, Forward-Reverse 
and Reverse-Forward.

Paste Reverse
Reverses the timing of drawings or keyframes in range of selection after 
copying.

Delete Removes selected objects.

Select All
Selects all drawing objects in the current drawing window in the Drawing, 
Timeline and Camera views. This helps you manage multiple objects as one 
when moving them.

Deselect All Deselects all selected objects in the Drawing and Camera views.

Insert Mode

Adds a new value or a new value sequence over existing ones, the new values 
are inserted between the old ones. The existing timing sequence is pushed 
down the column. The Insert mode opposite of the Overwrite mode, which is 
the Xsheet default mode.

Gestural Drag Mode

Lets you drag a cell to any other frame in the same column or into another 
column.

This feature does not apply to Annotation columns.

Send to Function View
Sends selected objects to the Function view where you can edit and adjust its 
function curve and parameters.
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View

Zoom In Xsheet Zooms in the view.

Zoom Out Xsheet Zooms out the view.

Reset Zoom Resets the view’s zoom to its default position.

Reset Pan Resets the view’s pan to its default position.

Reset View Resets the view to its default position.

Set Tempo Marker  

Expand/Collapse

Collapse Selection: 

Expand Selection: 

Collapse All: 

Expand All: 

Column Properties

Lets you rename a column, and enable or disable a column. To view additional 
properties, select Edit > Preferences from the top menu. In the Preferences 
dialog box, select the Advanced tab, then select the Advanced Element 
Mode option.

Show Column List  

Column Types Manager

Lets you add advanced column types to create particular animation paths. 
When you create these columns, they are not linked automatically to any 
particular drawing layer. You can create a motion path using these columns 
and then link or unlink several drawing or peg layers to it. 

Show Thumbnails
Displays column thumbnails making it easier to identify a particular column. 
This option displays a small thumbnail picture of the current frame below the 
column header.

Show Selection  

Set Columns Width Lets you change the column width (in pixels) and set it as the default.

All Columns to Default 
Width

Returns all columns to their default width of 100 pixels.

Change Columns 
Colour

Lets you customize the colour of the column by selecting one from the Select 
Colour dialog box. The colour you select is also reflected in the correspondng 
layer in the Timeline view.

Default Column Colour Removes the colour you assigned to a column (if any).

Hide Selected Columns Hides selected columns.

Unhide All Columns Displays all columns.

Show Hidden Columns Displays columns that were previously hidden.

Enable Playback Plays back your animation in the Perspective view.

Columns

Add Columns
Lets you add a column. You can specify the column name, type, and set 
drawing layer options in the Add Column dialog box that opens.

Delete Columns
Removes the selected column. You have the option to delete the associated 
drawing files and element folders.
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Clone Selected 
Columns: Drawings 
Only

Creates a copy of the selected column that is linked to the original. If a drawing 
is modified in the original or cloned column, both will be updated. However, 
cloned columns can have different timings. 

You can clone the drawings only or both the drawings and timing.
Clone Selected 
Columns: Drawings 
and Timing

Duplicate Selected 
Columns

Creates an independent copy of the selected column.  This useful when you 
need to modify the element independently, including the timing (exposure). 
Changes to the original element do not propagate to the duplicate.

Merge Selected 
Columns

There are two methods of merging drawings. 

• You can merge selected drawings in adjacent elements. The columns 
and layers will be left intact, and each new merged drawing will reside in 
the frames of the left-most column or lower layer.

• You can merge elements. All drawings will be merged. Unused columns 
and layers will be deleted, but the original drawing files are still 
accessible.

Frames  

Add Frames At Start
Adds the number of frames you specify to the end of the scene.

Add Frames At End

Add Frames Before 
Selection

Adds the number of frames you specify before or after your selection.
Add Frames After 
Selection

Remove Selected 
Frames

Deletes the selected frames from your scene.

Drawings

Create Empty Drawing
Creates Creates a drawing in the selected cell, replacing any drawing that may 
already be exposed in that cell and the following ones until it meets another 
drawing, key exposure or a blank cell. 

Duplicate Drawings

Lets  you duplicate the drawing and work on a copy of it. This lets you modify 
an existing drawing but retain the original. When duplicating a drawing, the 
selected cell is replaced with the new drawing. The exposure of the original 
drawing that was on the current cell is removed. The original drawing is not 
deleted from the project folder or other cells in which it is exposed.

When duplicating a drawing, the selected cell is replaced with the new 
drawing. The exposure of the original drawing that was on the current cell is 
removed. The original drawing is not deleted from the project folder or other 
cells in which it is exposed.

Rename Drawing Lets you give a selected drawing a new name.

Mark Drawing As

Marks selected drawings as one of the following: Key, Breakdown, In-
between, RetakeKey, RetakeBD or RetakeIB.  

This helps to keep the Xsheet well organized while animating.
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When working with several animators, directors or even other studios, the 
necessity for retakes will often arise. Harmony gives you the possibility to 
mark new drawings as either Retake Key, Retake Breakdown, or Retake In-
betweens.

Substitute Drawing 
Previous Replaces the drawing or cell's symbol on the current frame by the next draw-

ing.Substitute Drawing 
Next

Exposure

Increase

Adds Adds one more exposure to a selected cell; repeating this action adds an 
extra cell each time. This is an efficient way to extend a drawing's exposure 
and is always set in Insert mode. Increasing an exposure pushes the existing 
exposure forward.

Decrease
Decreases exposure of a selected cell by one; repeating this action decreases 
one exposure adds an extra cell each time. This is an efficient way to shorten a 
drawing's exposure. Decreasing an exposure pulls in the existing exposure.

Set Exposure to Lets you set the exposure to 1, 2, 3 or a custom exposure.

Extend Exposure Lets you extend the length of a selected cell.

Add Key Exposure Adds a key exposure to the selected cell. 

Remove Key Exposure
Removes only the key exposure (key frames) not all the exposures. The 
existing key exposure is replaced by the preceding exposure.

Remove Duplicate Key 
Exposure

When working with drawings to adjust the timing of a mouth in a lipsync, for 
example, and forcing the use of specific key exposures, unnecessary key 
exposures will be created. You can delete these duplicates without affecting 
the rest of the drawing. The first drawing of the selection will be used for the 
range.

NOTE: Duplicate key exposures may occur when pasting with the 
Enforce Key Exposure option selected.

Fill Empty Cells

Lets you Lets you fill empty cells to extend the exposure of single frame 
drawings to fill the range of empty cells after each one.When creating drawings 
on  cells that are not side-by-side, the exposure of the first drawing no longer 
fills automatically. You must select the frame range where you want your 
drawings to hold their exposure up to the next drawing and use the Fill Empty 
Cells command.

Insert Blank Cell Adds Adds an empty cell between other cells.

Clear Exposure Removes the exposure from the selected cell.

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Fill Selection

Lets you Lets you fill the same value over an entire selection. The selection 
can be over one cell, a cell range in one column, a cell range over many 
columns, an entire column, or many columns. You can use numbers, words, 
letters, or any alphanumeric value.
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Sequence Fill

Lets you Lets you create a numbered sequence over a selection. The 
sequence can be forward, backward, single, double or higher increment, as a 
cycle, and so on. The selection can be over one cell or a cell range in one 
column or more or an entire column or many entire columns.

Fill Cells Randomly

Lets you Lets you fill in random values over a selection. You can give a 
maximum and a minimum value and create a range for Harmony to choose the 
random values from. The selection can be over one cell or a cell range in one 
column or more or an entire column or many entire columns.

Hold Exposure Lets you expose a drawing for three, four, or five cells and so on. 

Motion

Insert Keyframe

Insert Keyframe and 
Duplicate Drawing

 

Delete Keyframes Deletes the selected keyframes.

Go to Previous 
Keyframe

 

Go to Next Keyframe  

Set Stop-Motion 
Keyframe

Sets a stop-motion keyframe which there is no computer-generated motion 
between two keyframes. The segment is constant or flat. The drawing remains 
still until the playback reaches the next keyframe, then the drawing pops to its 
new location.

Set Motion Keyframe

Sets a motion keyframe. In motion keyframes, there is no automatic 
interpolation created between the selected point and the next one. The layer 
will maintain its position until the animation reaches the frame of the next point 
and will then jump to the new position. Deselect this option to generate 
interpolation and get the layer to progressively move to the next position.

Morphing

Create Morphing
Lets you control a morphing sequence by placing different types of hints to help 
Harmony morph the animation the way you want it.

Delete Morphing
Once a cell is selected in a morphing sequence, deletes the entire sequence 
between the two keyframes.

Insert Morphing Key 
Drawing

Creates a morphing keyframe from a selected morphing frame.

Convert Morphing to 
Drawing

Lets Lets you convert your morphing inbetweens to real drawings you can edit. 
This is useful when manually editing a morphing sequence or if you prefer to 
have animation timing in double frame (on twos) instead of single frame (on 
ones). 

Lip-Sync

Change Mouth Shape 
to

Lets you change the mouth shape to one of the following: A, B, C, D, E, F, G, 
X.

Auto Lip-Sync 
Detection

Generates a sound detection for lip-sync.

Map Lip-Sync Automatically maps Automatically maps drawings in an element to the mouth 
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chart you have generated for a sound. This can save time when you are lip-
synching a voice track.

Sound Display

Sound Name
Shows the name of the sound file, as well as the file format. The line running 
vertically through the column frames between the same file name indicates a 
continuity of the same sound file in these frames.

Mouth Shapes

Shows the letter (or name depending on the way you named your character's 
different mouth positions) in the column's frames. There is only one mouth 
position allotted per frame and this position should correspond to the sound file 
after performing a lip-sync.

Waveform

Shows a vertical display of the sound file's actual waveform. In the column 
header, in the field under the column name, you can type in a percentage to 
zoom in or zoom out on the waveform, or pass the scroll cursor  over the 
Zoom Waveform  icon.

Sound Edit

Insert Blank Cell Places an empty cell between other cells. 

Clear Exposure and 
Pull

Replaces the exposure from the selected cell with exposures that follow it.

Annotation

Import File Lets you import an image file in an Annotation column.

Change Pen Colour
Lets you change the pen colour by selecting one from the Select Colour dialog 
box.

Pen Width Lets you select a pen preset or change the pen width (in pixels).

Eraser Width Lets you modify the width of the Eraser tool.

Erase All
Removes all text and drawn annotations. Annotations that you type in cannot 
be erased using this method.

Erase Selected Images Removes images you select in the Annotation column.

Erase Selected Texts Removes text you select in the Annotation column.

Enable Drawing Lets you draw in the Annotation column using your mouse or pen tablet.

217



Harmony 14 Premium - Reference Guide

218



Harmony 14 Premium - Reference Guide

Chapter 4: Nodes
The Node view uses a visual set of connections (nodes) to show how each element in the scene is connected and 
brought to the final image. It allows you to add extra elements and effects, and to move beyond the possibilities 
offered by the Timeline and Xsheet views. Each node corresponds to a layer in the Timeline view. Very few nodes 
are only visible in the Node view.

The basic rules of the Node view are quite simple. Once you understand them, a lot can be accomplished.

Each node used to build a node system is available in the Node Library view as well as through the Insert menu in 
the Node view. In addition, each time you create a layer from the Timeline or Xsheet views, the corresponding node 
is created in the Node view.

3D Nodes 224

3D Kinematic Output Node 225

Flatten Node 227

Render Maya Batch Node 228

Subnode Animation Node 229

Z Buffer Smoothing Node 232

Combine Nodes 234

Blending Node 235

Composite Node 240

Composite-Generic Node 243

Cutter Node 248

Highlight Node 250

Image Switch Node 253

Tone Node 255
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Transformation Switch Node 258

Deformation Nodes 260

Articulation Node 261

Auto Fold Node 264

Auto Muscle Node 266

Bone Node 269

Curve Node 272

Deformation Composite Node 275

Deformation Root Node 278

Deformation Scale Node 279

Deformation Switch Node 283

Deformation Uniform Scale Node 284

Deformation Wave Node 286

Fold Node 288

Game Bone Node 292

Glue Node 294

Kinematic Output Node 296

Mesh Warp Node 297

Offset Node 300

Stick Node 303

Turbulence Node 305

Filter Nodes 309

Anti-Flicker Node 311

Auto-Patch Node 313

Bloom Node 315

Blur - Box Node 319

Blur-Directional Node 322

Blur - Gaussian Node 325

Blur - Radial  Node 327

Blur - Radial Zoom Node 329

Blur-Variable Node 332

Brightness Contrast Node 334

Channel Selector Node 336
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Channel Swap Node 338

Chroma-Keying Node 340

Colour Banding Node 344

Colour Art Node 347

Colour-Override Node 349

Colour-Scale Node 353

Contrast Node 355

Dither Node 357

Focus Node 359

Focus Multiplier Node 362

Glow Node 364

Grain Node 367

Greyscale Node 370

Hue-Saturation Node 372

Layer Selector Node 375

Luminance Threshold Node 377

Matte-Blur Node 380

Matte-Resize Node 383

Median Node 385

Motion-Blur Node 388

Negate Node 391

Overlay Layer Node 393

Pixelate Node 395

Remove Transparency Node 397

Shadow Node 399

Transparency 401

Underlay Layer Node 404

Generator Nodes 406

Burn-In Node 407

Colour-Card Node 410

Element / Drawing Node 412

Field Chart Node 422

Gradient Node 426
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Grid Node 429

Lens Flare Node 432

Turbulent Noise Node 435

Group Nodes 438

Group Node 439

Multi-Port-In Node 440

Multi-Port-Out Node 441

Miscellaneous Nodes 442

External Node 443

Note Node 446

Render Preview Node 447

Script Node 448

Visibility Node 449

Move Nodes 450

Apply Image Transformation Node 451

Apply Peg Transformation Node 454

Camera Node 458

Ortholock Node 460

Peg Node 461

Transformation Tab 461

Quadmap Node 462

Quake Node 464

Output Nodes 467

Crop Node 468

Display Node 470

Scale Output Node 471

Write Node 472

Particle Nodes 478

3D Region 479

Baker 481

Baker Composite 483

Bounce 483

Explosion 485
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Gravity 487

Image Fracture 488

Kill 492

Move Particles 494

Orbit 495

Planar Region 497

Random 499

Region Composite 500

Repulse 501

Rotation Velocity 502

Sink 504

Size 504

Sprite Emitter 506

System Composite 514

Velocity 514

Visualizer 516

Vortex 517

Wind-Friction 519

Shading Nodes 520

Light Position Node 521

Light Shader Node 523

Normal Map Node 526

Normal Map Converter Node 530

Tone Shader Node 531

Volume Object Node 534

Plugin Nodes 536

Sparkle 537

Selection Preset Note Node 540

Sound Layer Properties 541
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3D Nodes
The nodes found in the 3D category are used to handle and render 3D objects such as animating the sub-nodes or 
rendering using Maya.

3D Kinematic Output Node 225

Flatten Node 227

Render Maya Batch Node 228

Subnode Animation Node 229

Z Buffer Smoothing Node 232
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3D Kinematic Output Node
You  can link 2D drawing layers, pegs, other 3D models and more to follow the movements of a part of a 3D model. 
To do this, you need to add a 3D Kinematic Output node to your 3D model setup in the Node view. More specifically, 
you need to link the 3D Kinematic Output node to both a specific 3D model subnode (part) and to the object that you 
would like to follow that subnode.

Refer to the following example to connect this node.

By default, all parts of an imported 3D model are visible for display, but not setup for animation. You need to setup 
the part of the 3D model to be animated before you can link another object to its movements.

Properties

Use the 3D Graph view to obtain the name of the 3D model's subnode.
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Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name
Use this field to rename the node. It is recommended to use the Subnode 
Name + -Output.

Subnode Name
Use this field to enter in the part of the 3D model whose movements you would 
like to track. Entering the name of the 3D model subnode into this field is what 
lets the 3D Kinematic Output node know which part of the model to read.
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Flatten Node
The Flatten node is used to transform 3D objects into flat planes when ordered in the Composite node. That plane 
can then be moved arouned like any other drawing. Instead of intersecting with 2D layers, the 3D object will either be 
behind or in front.

When all objects are at the same distance (z value) from the camera, the order is based on the Composite ports. 
When elements are placed at different distances from the camera, the z axis value overrides the composite port 
ordering. 

Refer to the following example to connect this node.

Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.
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Render Maya Batch Node
This node uses the script renderMayaBatch();

This script starts a Maya Batch session, renders the 3D elements on that frame, and then closes the session. It 
will open and close the session for every frame to be rendered.

Refer to the following example to connect this node.

Properties

Parameter Description

Name Use this field to rename the node.

Tabs

Attributes
In this field, specify the renderer you would like Maya to use. If it is not the 
default, Maya must have this renderer plug-in installed. Check the Spe-
cifications tab for the list of renderers supported by Harmony.

Specifications View the renderers supported by Harmony.

Softrender Enter or browse for script to be used by the Render Maya Batch node.

Initialization
Enter or browse for script that will run once per session, when the scene is 
loading.

Cleanp
Enter or browse for script that will run once per session, when the scene is 
being closed.
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Subnode Animation Node
A typical 3D model is comprised of many parts (subnodes). Not all of these parts need to be animated; most are just 
used for display. However, if you would like to animate a specific part, you need to add a Subnode Animation node 
under your 3D model.

Refer to the following example to connect this node.

Properties

All animatable 3D model subnodes appear in a list in the Subnode Animation Layer Properties. Expand any of the 
subnodes in the list to view its individual properties.
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Click on any of the Function  buttons  to open the Function Editor for that parameter. 

If movements have already been created in the Camera view, you may not be able to edit some of the fields. They 
just display the value of that parameter at the given position in the Timeline. If you would like to edit these fields, 
change the field type to Local.

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Position

3D Path: Lets you use a 3D path function to animate an element.

Separate: Lets you independently edit the different coordinate fields.

Path: When the 3D Path option is selected, lets you choose the path type. You 
can do this form the field menu, located after the Function button .

Path (x) Axis: Lets you type in a new East/West coordinate corresponding to 
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the desired position.

Path (y) Axis: Lets you type in a new North/South coordinate corresponding to 
the desired position.

Path (z) Axis: Lets you ype in a new Forward/Backward coordinate 
corresponding to the desired position.

Velocity: When the 3D Path option is selected, lets you set the speed at which 
movement occurs across the X, Y and Z axes.

Rotation

Quaternion: Rotations made on the X, Y and Z axes are linked, as is the 
velocity which acts on the three rotation functions simultaneously. 

Euler Angles: Rotations can be made on the X, Y and Z axes  independent of 
each other; each has its own velocity.

3D Rotation: When the Quaternion option is selected, lets you choose the 
path type. You can do this form the field menu, located after the Function 
button .

(x) Axis: Lets you enter the horizontal rotation value in degrees.

(y) Axis: Lets you enter the vertical rotation value in degrees.

(z) Axis: Lets you enter the depth scale value in degrees.

Velocity: When the Quaternion option is selected, lets you set the speed at 
which rotation occurs across the X, Y and Z axes.

Scale

Locked: Resizes the element while keeping its ratio. The X and Y axes scale 
proportionally

Separate: Resizes the element allowing to modify the ratio (squash and 
stretch).

(x) Axis: Lets you enter the horizontal scale value.

(y) Axis: Lets you enter the vertical scale value.

(z) Axis: Lets you enter the depth scale value.

Scale in Fields: Instead of using the standard scaling units, when this option 
is enabled, images are scaled using field units, based on the traditional 
animation field chart. Enter in the x, y, z values respectively in the fields below. 
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Z Buffer Smoothing Node
When batch rendering 3D models originating from Maya, some unwanted artifacts may appear, particularly on 
models with outlines. This is due to problems with the depth information. You can use the Z-Buffer Smoothing 
node to smooth out the edges. 

Connect the node following the example below.

Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

232



Harmony 14 Premium - Reference Guide

Name Use this field to rename the node.

Histogram Range

Lets you define the range of clean pixels in the depth histogram when rendering 
3D models.  Only opaque or semi-transparent values are considered.  

A low value means fewer pixels are used in the depth calculations and may 
flatten your object, while a higher value uses more pixels in the depth 
calculations, but may not eliminate all the image artifacts.

Kernel Size

Lets you determine the size of the matrix used for calculating the depth of a 
single pixel.  For example, for an operation with a kernel size of 3 pixels, 
Harmony uses the pixels within a 1-pixel radius to calculate the effect. A larger 
kernel size means longer calculations.
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Combine Nodes
The nodes found in the Combine category are used to take two or more elements are combine them into a new 
image.

Blending Node 235

Composite Node 240

Composite-Generic Node 243

Cutter Node 248

Highlight Node 250

Image Switch Node 253

Tone Node 255

Transformation Switch Node 258
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Blending Node
Effects nodes, like the Tone node and Highlight node, can control the colour and alpha composite operations for you. 
These nodes were created with preset colour and alpha composite operations to fit the most frequently used, 
composite operations.

You might, however, still want to control the colour and alpha composite operation between two images using the 
Blending node, to create a multiplicity of lighting, shadow, filter or ambient effects. The Blending node combines two 
images into one output image, following the parameters you choose for your movie and images sequence or SWF 
movie exports.

The drawing node connected to the Blending effect will act as the blending image and will be applied to all the 
drawing layers situated under them in the Composite node or Timeline view order.  

NOTE: It is possible to select two different blending modes in the same Blending effect layer, in the event that  
you want to export your project to both a Bitmap and an SWF movie file with different results.

Refer to the following example to connect this node.
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Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Lets you rename the node.

Blend Mode and SWF Blend 
Mode

Choose the blending effect mode you wish to apply to your layer. The Blend 
Mode type will only be visible when the Camera view is set to Render  
mode and will only export to a bitmap movie file or sequence of images.

Both the Blending node and Composite-Generic node have regular blending 
modes and legacy blending modes. The regular blending modes will take the 
source images and unmultiply them before blending the two inputs together. 
The images will be remultiplied when being output from the  node. The legacy 
blending modes use the pre-multipled source images as is in order to apply the 
effect. Unmultiplying the images before processing them will give a final result 
closer to what can be found in software such as Adobe Photoshop.

• Normal: The layer attached to the effect acts as a normal layer and will 
not create any blending mode effect.

• Multiply: This operation multiplies the blending element colour with the 
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output image. This will darken the colour of the overlapping area.
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• Screen: This operation multiplies the inverted colour of the blending 
element with the image. This will lighten the colour of the overlapping 
area.

• Lighten (Lighten Legacy): This operation lightens the area of the 
output image which, is darker than the blending element’s colours. The 
lighter colours will remain unchanged.

• Darken: This operation darkens the area of the output image, which is 
lighter than the blending element’s colours. The darker colours will 
remain unchanged.

• Difference  (Difference Legacy): This operation subtracts the 
blending elements colour from the output image colours or vice-versa, 
depending on which of them has more bright colours. The final result will 
be colours that are more vibrant.

• Add (Add Legacy): This operation lightens the output image using the 
blending element.

• Subtract (Subtract Legacy): This operation darkens the output image 
using the blending element.

• Invert: This operation inverts the output image colours on the area 
overlapping the blending layer colours.

• Overlay (Overlay Legacy): This operation multiplies or screens the 
colours from the blending image, with those of the output image, 
depending on the base colour. Colours from the blending element 
overlay the colours of the drawing elements, while preserving the 
highlights and shadows of the base colour. The base colour is not 
replaced, but mixed with the blend colour to reflect the lightness, or 
darkness, of the original colour.

• Hardlight(Hardlight Legacy): This operation multiplies, or screens, 
the colours of the blending layer with those of the output image, 
depending on the blend colour. If the blend colour is lighter than 50% 
grey, the image is lightened, as if it were screened. This is useful for 
adding highlights to an image. If the blend colour is darker than 50% 
grey, the image is darkened, as if it were multiplied. This is useful for 
adding shadows to an image. Painting with pure black or white results in 
pure black or white. Play with the Opacity value to create a subtler look.

• Alpha: This operation will blend the alpha value of the blending layer 
with the output image. This effect is not available for SWF Blend Mode.

• Erase: This operation produces a cutter effect using the blending 
element. This effect is not available for SWF Blend Mode.

• Divide (Divide Legacy): This operation divides the output image colour 
values by the blending layer colour values. The blending image colour 
values are inverted, creating a negative image. The negative image’s 
colour values are then multiplied by the right image colour values. This 
effect is not available for SWF Blend Mode.

• Replace: This operation replaces the output image by the blending 
layer. This effect is not available for SWF Blend Mode.

• Softlight: This operation darkens or lightens the colours in a soft and 
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diffuse way, depending on the blend colour (image in left port). If the 
blend colour is lighter than 50% grey, the image is lightened. If the blend 
colour is darker than 50% grey, the image is darkened. Painting with 
pure black or white produces a distinctly darker or lighter area, but does 
not result in pure black or white. 

• Linear Light: This operation burns or dodges the colours by decreasing 
or increasing the brightness depending on the colour of the underlying 
colour. If the blend colour is lighter than 50% grey, the colour is 
lightened because the brightness is increased. If the blend colour is 
darker than 50% grey, the colour is darkened because the brightness is 
decreased.

• Pin Light: This operation will replace the colours, depending on the 
underlying colour . If the blend colour is lighter than 50% grey, pixels 
darker than the underlying colour are replaced, and pixels lighter than 
the underlying colour do not change. If the blend colour is darker than 
50% grey, pixels lighter than the underlying colour are replaced, and 
pixels darker than the underlying colour do not change.

• Vivid Light: This operation burns or dodges the colours by decreasing 
or increasing the brightness depending on the colour of the underlying 
colour. If the colour is lighter than 50% grey, the blend colour is 
lightened because the contrast is decreased. If the colour is darker than 
50% grey, the blend colour is darkened because the contrast is 
increased.

• Exclusion: This operation produces a similar result to the Difference 
mode, but with a lower contrast. 

• Dodge: This operation will lighten the colour.

• Burn: This operation will darken the colour.

• Hue: This operation will result in a colour that will take the luminosity 
and saturation of the underlying colour, and the hue of the source colour.

• Saturation: This operation will result in a colour that will have the same 
luminosity and hue of the underlying colour, and the saturation of the 
source colour.

• Colour: This operation will result in a colour that will have the 
luminosity of the underlying colour, and the hue and saturation of the 
source colour.

• Luminosity: This operation will result in a colour which has the hue and 
saturation of the underlying colour, and the luminosity of the source 
colour. This mode is opposite to the Colour mode. 
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Composite Node
The Composite node allows you to use several images and output a single image. You can compare that to doing 
pre-compositions in editing software. You can connect several drawing, image generators and effect nodes in 
your Composite node and one bitmap (or vector in some cases) comes out of it. 

Refer to the following example to connect this node.

By default, the image resulting from the Composite node is a bitmap. The layers are composited together 
depending on their position on the Z-axis (forward-backward) first, then their order in the Composite node. If two 
images are at the same position on the Z-axis, their order in the Composite will determine which one is displayed 
in front and which one is displayed behind.

Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node 
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views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Mode

As Bitmap: Composites all images into a single, flat bitmap image. The Z 
value of the final image is based on the Output Z selection.

As Vector: Composites all the images as a single vector image. The Z value of 
the final image is based on the Output Z selection. Bitmap elements are 
ignored and do not appear in the final frame.

As Seamless Bitmap: Composites all the images into a single, flat bitmap 
image (just like the As Bitmap compositing mode). The main difference 
between the As Bitmap and As Seamless Bitmap modes is that the seamless 
version ensures that there is no visible seam between adjacent vector 
drawings that have matching geometries. This can be useful for cut-out 
animation, where multiple drawings may align perfectly like pieces of a puzzle 
(using masking/cutter). This can also be useful when building a 3D set out of 
flat drawings rotated in 3D. In this case, using the Seamless mode will produce 
the correct result when two drawings are intersecting or nearly intersecting. 
When using this mode, the following effects are not supported: Shadow, Glow, 
Blending  and Focus.

Pass Through: No compositing operations occur. No image is merged or 
flattened. Each individual image  keeps its own properties. The compositing 
operations happen only in the next Composite node connected below. In this 
case, the port ordering is ignored.

If a Composite set to Pass Through it is the last one in the compositing chain, 
it will act the same as the As Bitmap option. At that point, the Input Ordering 
options are considered.

Input Ordering

2D: Elements connected in the node are composited based on their port 
ordering. The Z-axis (forward-backward) values are ignored. The scaling value 
will be correct, but the actual position on the Z-axis is ignored. 

You can use the 2D composite type to create effects such as a camera 
recording overlay on your scene. Since you always want this element to be in 
front regardless of the other elementsè Z-axis position, you can set the option 
to 2D.

3D Flat: The Z-axis value of the elements connected in the Composite node 
are considered, so the visual representation is correct in the Camera view. The 
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output is a flat image.

3D: The Z-axis value of the elements connected in the composite node are 
considered, so the visual representation is correct in the Camera view. The 
image is not flattened. The 3D aspect of the elements are kept. For example, if 
you rotated elements on the three axes, the information is retained and 
elements composited in lower levels are able to intersect with the elements 
coming from a 3D Composite node.
The 3D Composite node should only be used in advanced cases. It is better to 
use a Pass Through composite type than a 3D composite type. This way, all 
the elements are composited in the final Composite node.

Output Options

Output Z: Identifies which element’s front-back value from the current 
composition is applied to the entire composited image in the next operation. If 
you select Portnumber, identify the appropriate port by its position using the 
Port For Output Z menu.

Port for Output Z: When using the Portnumber option in the Output Z menu, 
you can select which port you want to use as the Z value for the Composite 
node. The port used appears in a bright green colour on the Composite node. 
By default, the leftmost port is displayed in front and the rightmost port is 
displayed behind.

Bitmap Options

These options are active when you select the As Bitmap mode.

Apply Focus: Activates the Focus effect for this node in the composite 
operation.

Focus Multiplier: The value entered in this field is used as a multiplier for the 
radius value specified in the Focus or Focus-Multiplier nodes. 

Vector Options

These options are active when you select the As Vector mode.

Palette Name: When you render files using As Vector Composite nodes, use 
this field to set the name of the palette files that Toon Boom Harmony will 
create for them.

Flatten: Flattens vector drawings into one vector drawing file. Any 
transparency will be lost in the process. This creates smaller vector files, but 
might increase the time required to composite the drawings. This can be useful 
when reusing drawings. Because they will be vector files, you can still apply 
vector-based transformations and effects.
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Composite-Generic Node
During the composition of images, colour and alpha values of an input image are combined with the image 
underneath to produce the output image. 

Effects nodes, like Tone and Highlight, can control the colour and alpha composite operations for you. A Composite 
node was created, in which the colour and alpha composite operation are preset to the standard, and more frequently 
used, composite operations.

You may, however, still want to control the colour and alpha composite operation between two images using the 
Composite-Generic Node which combines two images into one output image. The image linked to the left port of the 
node is layered on top of the image in the right port based on the selected colour and alpha composite operation. 

Refer to the following example to connect this node.

Properties

The following abbreviations are used in the descriptions of composite operations:

 l ORGB: RGB values of the Output Image

 l The Output Image is the resulting image from a composite operation. In the formulas for the composite oper-
ations, this image is also processed through a composite operation, representing the bottom layer in the com-
posited image.

 l LRGB: RGB values of the Left Image

 l RRGB: RGB values of the Right Image

 l LA: Alpha of the Left Image
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 l RA: Alpha of the Right Image

 l OA: Alpha of the Output Image

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name
Use this field to rename the node. It is recommended to use the Subnode 
Name + -Output.

Colour Operation

The colour values of the output image are determined based on the alpha and 
colour values of the left and right image.

Both the Blending node and Composite-Generic node have regular blending 
modes and legacy blending modes. The regular blending modes will take the 
source images and unmultiply them before blending the two inputs together. 
The images will be remultiplied when being output from the  node. The legacy 
blending modes use the pre-multipled source images as is in order to apply the 
effect. Unmultiplying the images before processing them will give a final result 
closer to what can be found in software such as Adobe Photoshop.

Right: The colour values in the output image are derived from the image in the 
right port. Colour values in the left port are ignored.

Left: The colour values in the output image are derived from the image in the 
left port. Colour values in the right port are ignored.

Apply With Alpha: ORGB=[RRGB*(1-LA)]+LRGB. This is a standard 
composite operation called "alpha blending." During this operation, colour 
values of the left and right images are combined based on the alpha value of 
the left image. Where the left image is completely opaque (LA=1), the ORGB 
will be replaced completely with LRGB. Where the left image is completely 
transparent (LA=0), the ORGB is unaffected. Where the left image is partially 
transparent, you get a blend of the RRGB and the LRGB, where the values are 
added together and clipped to 255. The LA is the opacity of the left image. This 
operation (1-LA) calculates the amount of opacity to retain in the output image. 
The operation [RRGB*(1-LA)] removes as much of the output image as you 
are about to add from the left image. Remember that LRGB has been pre-
multiplied by the LA, so the equation is really ORGB=[RRGB*(1-LA)]+
(LRGB*LA), which is simply the weighted average of L and R, with LA 
supplying the weight.

Apply Tone Highlight: ORGB=RRGB+(LRGB*RA). This operation restricts 
the output of the tone to the region of the matte (RA), and uses the 
transparency and colour value of the input image to determine the colour 
values of the output. This is used to lighten or darken the output image. 
Darkening occurs when RRGB contains negative values.

Apply Add (Apply Add Legacy): ORGB=RRGB+LRGB. This operation 
uses the transparency and colour value of the left image to determine the 
output values. Effects such as shadows and glows are calculated in this 
manner. Unlike the Apply Tone Highlight operation, the result is not clipped to 
the matte (RA) of the output image.
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Apply Matte For Overlay: ORGB=RRGB*(1-LA).This operation prepares 
the output image using the overlay's matte; the matte's RGB values are 
ignored. This operation prepares the output image to receive the colour portion 
of the overlay. It is typically used when an overlay and its matte are stored in 
separate images.

Apply Overlay Into Matte: ORGB=RRGB+(LRGB*RA). This operation 
maps an overlay into an area prepared by a matte. It is typically used when an 
overlay and its matte are stored in separate images, and Apply Matte For 
Overlay has been used to prepare the output image to receive the RGB portion 
of the overlay.

Apply Transparency: ORGB=RRGB*(1-LA). This operation is used for a 
cutter matte to prepare the output image to receive the colour values of another 
image. It has the effect of increasing the transparency of ORGB (but not OA), 
based on the LA. This function is the equivalent to Apply Matte for Overlay. It 
is almost always used with Apply Transparency Matte, an Alpha Composite 
Operation.

Apply Multiplicative Tone: ORGB=RRGB*(LRGB+1-LA). This operation 
multiplies the left and right images (see the Multiply colours selection), to be 
combined with the right image colour, creating a darker output colour. This 
effect created by this operation is identical to the Multiply Colour Blending 
effect in Photoshop.

Multiply Colours: ORGB=RRGB*LRGB. This operation multiplies the left 
and right image colours. Multiplying colours filters the colour values of the right 
image from the output image. For instance, to make the left image less blue, 
you can add a right image to this node with a blue colour value and select this 
option.

Linear Light: This operation burns or dodges the colours by decreasing or 
increasing the brightness depending on the colour of the underlying colour. If 
the blend colour is lighter than 50% grey, the colour is lightened because the 
brightness is increased. If the blend colour is darker than 50% grey, the colour 
is darkened because the brightness is decreased.

Pin Light: This operation will replace the colours, depending on the underlying 
colour . If the blend colour is lighter than 50% grey, pixels darker than the 
underlying colour are replaced, and pixels lighter than the underlying colour do 
not change. If the blend colour is darker than 50% grey, pixels lighter than the 
underlying colour are replaced, and pixels darker than the underlying colour do 
not change.

Vivid Light: This operation burns or dodges the colours by decreasing or 
increasing the brightness depending on the colour of the underlying colour. If 
the colour is lighter than 50% grey, the blend colour is lightened because the 
contrast is decreased. If the colour is darker than 50% grey, the blend colour is 
darkened because the contrast is increased.

Exclusion: This operation produces a similar result to the Difference mode, but 
with a lower contrast. 

Dodge: This operation will lighten the colour.

Burn: This operation will darken the colour.
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Hue: This operation will result in a colour that will take the luminosity and 
saturation of the underlying colour, and the hue of the source colour.

Saturation: This operation will result in a colour that will have the same 
luminosity and hue of the underlying colour, and the saturation of the source 
colour.

Colour: This operation will result in a colour that will have the luminosity of the 
underlying colour, and the hue and saturation of the source colour.

Luminosity: This operation will result in a colour which has the hue and 
saturation of the underlying colour, and the luminosity of the source colour. 
This mode is opposite to the Colour mode. 

Divide Colours (Divide Colours Legacy): ORGB=RRGB/LRGB. This 
operation divides the right image colour values by the left colour values. The 
left image colour values are inverted, creating a negative image (1/LRGB). The 
negative's colour values are then multiplied by the right image colour values.

Lighten (Lighten Legacy): This operation looks at the colour information 
coming from both the images in the left and right ports and selects the base or 
blend colour - whichever is lighter - as the result colour. Pixels darker than the 
blend colour are replaced, and pixels lighter than the blend colour do not 
change. 

Softlight (Softlight Legacy): This operation darkens or lightens the colours in 
a soft and diffuse way, depending on the blend colour (image in left port). If the 
blend colour is lighter than 50% grey, the image is lightened. If the blend colour 
is darker than 50% grey, the image is darkened. Painting with pure black or 
white produces a distinctly darker or lighter area, but does not result in pure 
black or white. 

Hardlight (Hardlight Legacy): This operation multiplies or screens the 
colours of the image in the left port with those of the image in the right port, 
depending on the blend colour. If the blend colour (left port image) is lighter than 
50% grey, the image is lightened, as if it were screened. This is useful for 
adding highlights to an image. If the blend colour is darker than 50% grey, the 
image is darkened, as if it were multiplied. This is useful for adding shadows to 
an image. Painting with pure black or white results in pure black or white. Play 
with the Opacity value to create a subtler look.

Overlay (Overlay Legacy): This operation multiplies or screens the colours 
from the image connected to the left port, with those on the right, depending on 
the base colour. Colours from the left-port element overlay the colours of the 
drawing elements connected to the right, while preserving the highlights and 
shadows of the base colour. The base colour is not replaced, but mixed with 
the blend colour to reflect the lightness or darkness of the original colour. 

Opacity The level of transparency.

Alpha Operation

Right: The transparency of the output image is derived from the alpha values 
of the image in the right port. The values in the left port are ignored.

Left: The transparency of the output image is derived from the alpha values of 
the image in the left port. The values in the right port are ignored.

Apply: OA=[RA*(1-LA)]+LA. This operation computes the output alpha of the 
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output image based on the alpha values of the left and right images. This is the 
standard method of combining alpha channels. Notice its similarity to the 
Apply With Alpha colour Composite Operation.

Add: OA=RA+LA. This operation adds the alpha values of the two images to 
produce the alpha value of the output image.

Subtract: OA=RA-LA. This operation subtracts the alpha values of the input 
image from the alpha values of the output image. It is useful in situations where 
two tone levels have been drawn with overlap, but a double-darkening in the 
overlap is not wanted. This operation will reduce the opacity of overlapping 
regions.

Apply Transparent Matte: OA=RA*(1-LA). This operation is used to 
increase the transparency of the output alpha in the final composited image.

Black: OA=0. Sets the matte of the entire output image to black, so that it is 
transparent.

White: OA=1. Sets the matte of the entire output image to white, so that it is 
opaque.

Output Z

Leftmost: Indicates that the Z value for the output image will be taken from the 
node in the left port.

Rightmost: Indicates that the Z value for the output image will be taken from 
the node in the right port.

Backmost: Indicates that the Z value for the output image will be taken from 
the image that is the farthest back in the scene.

Frontmost: Indicates that the Z value for the output image will be taken from 
the image that is closest to the front of the scene.

Portnumber: Indicates that the Z value for the output image will be taken from 
the node in the selected port. Enter the appropriate port in the Port for Output 
Z field.
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Cutter Node
T-HFND-010-009

The Cutter effect cuts out a portion of an image. To accomplish this, it needs to be connected to the drawing it is 
intended to cut as well as to a matte  layer. The cutter will take the shape of the drawing in its matte layer and cut 
this shape out of the drawing layer. This is especially useful if you want to make a character disappear between a 
background element, or if you want to cut out a hole in the middle of a character. 

The Cutter effect has an Inverted parameter, which is disabled by default. When enabled, the Cutter will have the 
revert effect: Instead of cutting the matte's shape out of the drawing, it will cut everything outside of the matte's 
shape out of the drawing, leaving only the parts of the drawing that are covered by the matte.

The Cutter effect can be used with 2D-3D integration. Rendered 2D drawings, integrated with 3D models, display 
soft, anti-aliased edges, even where the Cutter effect is applied.

Refer to the following example to connect this node.
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Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Allows you to change the node's name.

Inverted
When this option is enabled, the Cutter node will invert the matte shape to cut the 
drawing. Instead of cutting the image intersecting with the matte, it will cut any 
artwork outside of the matte shape.
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Highlight Node
T-HFND-010-009C

The Highlight effect lets you to turn a drawing's area lighter to simulate a light source. For this effect, you will 
need to create a matte to determine the shape and position of the highlight on another element and so you can blur 
the edges to create a softer effect. By adjusting the Highlight properties, you can control the type and amount of 
blur, as well as the colour of the highlight effect. 

Author

Christina Halstead
2D Animator and Character Designer

shadowbrushcreations.com

Refer to the following example to connect this node.
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Properties 

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When disabled, the effect's values will remain 
unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type

Radial: The edges of the matte are blurred evenly around points that make up the 
edge of the matte.

Directional: The matte is blurred in the direction you select.

Radius Enter a value for the size of the blur. The larger the value, the greater the blur 
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effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you selected the Directional Blur type, you can set the direction of the blur by 
entering a value from 0 to 360 in this field.

0: Blurs the image to the west.

90: Blurs the image to the south.

180: Blurs the image to the east.

270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

0: Makes the blur fade out slowly, distributing the blur evenly from the edge of the 
character to the farthest edge of the blur.

1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of the 
image.

Invert Matte Inverts the matte used to create the tone, shadow, or highlight.

Use Matte/Source Colour

Creates the shadow or tone using the matte shape's colour. Be sure that you are 
in render mode  to see this effect and that your background is NOT white and 
that you do NOT have a white colour card node attached to the composite. As the 
matte only gives colour information, but no alpha, the matte is automatically mul-
tiplied with the background colours. If there is no colour card attached and the 
background appears black, you will see the matte colour at full opacity. If it is mul-
tiplied with a white background, the colours disappear into the full 255.

Multiplicative Multiplies the tone or shadow colours with the background.

Colour

RGBA
Enter a value to add or subtract from the colour channels in the drawings or attach 
these values to function curves.

Colour Swatch Opens the Colour Picker where you can specify the colour.

Intensity
Lets you set a value to determine the strength of the effect or attach a function to 
animate the effect.

252



Harmony 14 Premium - Reference Guide

Image Switch Node
The Image Switch  effect lets you use multiple effects, such as Colour Override, and choose which port will be sent 
to rendering if you want to apply different variations of an effect that cannot be changed over time. You then create 
multiple separate versions of the effect, connect them all to the Image Switch, and then if you want to change to a 
different version of the effect at different points in your scene, you would add a curve and animate the port number. 
Image Switch simply lets you change over time which port is being rendered.

 

Refer to the following example to connect this node.

Properties 

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.
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Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Port Index

Switches from one image to another. There is no gradual animation from one 
colour to another as you are only changing (over time) which port will be rendered. 
Use whole values.

Click the Function  button to open the Function editor to animate a parameter 
over time—see .
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Tone Node
The Tone effect lets you add a dark-coloured region to your drawing and simulate the shaded area away from a light 
source. To produce the tone effect, create a drawing to control where the tone will appear. The Tone effect uses a 
matte to determine the shape and position of the tone on your drawing and can be blurred at the edges to create a 
softer effect. 

Refer to the following example to connect this node.
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Properties 

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo 
a change of depth or scale. When disabled, the effect's values will remain 
unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type

Radial: The edges of the matte are blurred evenly around points that make up 
the edge of the matte.

Directional: The matte is blurred in the direction you select.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you selected the Directional Blur type, you can set the direction of the blur by 
entering a value from 0 to 360 in this field.

0: Blurs the image to the west.

90: Blurs the image to the south.

180: Blurs the image to the east.

270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

0: Makes the blur fade out slowly, distributing the blur evenly from the edge of 
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the character to the farthest edge of the blur.

1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of 
the image.

Invert Matte Inverts the matte used to create the tone, shadow, or highlight.

Use Matte/Source Colour

Creates the shadow or tone using the matte shape's colour. Be sure that you 
are in render mode  to see this effect and that your background is NOT 
white and that you do NOT have a white colour card node attached to the com-
posite. As the matte only gives colour information, but no alpha, the matte is 
automatically multiplied with the background colours. If there is no colour card 
attached and the background appears black, you will see the matte colour at 
full opacity. If it is multiplied with a white background, the colours disappear 
into the full 255.

Multiplicative Multiplies the tone or shadow colours with the background.

Colour

RGBA
Enter a value to add or subtract from the colour channels in the drawings or 
attach these values to function curves.

Colour Swatch Opens the Colour Picker where you can specify the colour.

Intensity
Lets you set a value to determine the strength of the effect or attach a function 
to animate the effect.
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Transformation Switch Node
The Transformation-Switch node acts as a on and off switch for the deformation chains. It is used when building 
multi-pose (multiple deformation chains) rigs. the Transformation-Switch can also be used with other node types 
than Deformation nodes. It can be used with any transformation nodes such as Peg and Quadmap nodes. 

Refer to the following example to connect this node.

The Transformation-Switch replaces the Deformation-Switch node. 

Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Element Columns

Full Name: Select which element to connect to the node from the list of 
elements that already exist in your scene.  

Drawing Path: Displays the full path to the current drawing.

Timing Columns Name: Path to the file you want to link to.  
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Timing Column: Link to the column that contains the desired timing.  

Extension: When linking to a background file, enter its file name extension.  

Field Chart: If you are importing traditional animation, select the size of the 
paper on which the animation was drawn.

Transformation Names
List the drawing names associated to each transformation chain. You can 
enter additional drawings and separate the names with semi-colons (;).
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Deformation Nodes
The deformation rigs are composed of several different types of nodes. Additional ones such as the Kinematic 
Output node can be used to enhance the results.

Articulation Node 261

Auto Fold Node 264

Auto Muscle Node 266

Bone Node 269

Curve Node 272

Deformation Composite Node 275

Deformation Root Node 278

Deformation Scale Node 279

Deformation Switch Node 283

Deformation Uniform Scale Node 284

Deformation Wave Node 286

Fold Node 288

Game Bone Node 292

Glue Node 294

Kinematic Output Node 296

Mesh Warp Node 297

Offset Node 300

Stick Node 303

Turbulence Node 305
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Articulation Node
The Articulation node is no longer used in the current release of Harmony. This node is still available for compatibility 
purposes with previous deformation rigs.

The Articulation node is used between two bones (legacy) to create a joint where the limb or element will rotate. The 
current Bone and Game Bone nodes include the articulation parameters. 

Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and 
Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Resting Parameters

Rest Radius Lets you set the resting radius of the articulation (size of the circle).

Resting Orientation Lets you set the resting rotation angle value of the articulation.

Rest Bias

Lets you set the resting bias value of the articulation, which can also 
be seen as the steepness of the articulation. The smaller the bias 
value, the smoother the articulation angle, and the larger the bias 
value, the more angular the articulation is.

Deformation Parameters

Radius
Lets you set the radius of the articulation (size of the circle). When 
animated, this value will be connected to a function.

Orientation
Lets you set the rotation angle value of the articulation. When anim-
ated, this value will be connected to a function.

261



Chapter 4: Nodes     Deformation Nodes

Bias
Lets you set the bias value, which can also be seen as the steepness 
of the articulation. When animated, this value will be connected to a 
function.

Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls 
the Left and Right transversal radius values. When disabled, it controls the 
size of the left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The Left Transversal radius value is automatically applied to the Right 
Transversal. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Right Transversal radius. By default, this value is set to 
2.

Longitudinal Influence Radius 
Begin

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The End Longitudinal value is automatically applied to the Begin 
Longitudinal value. When the Symmetric Ellipse of Influence option is 
disabled, it controls the size of the Begin Longitudinal radius. By default, this 
value is set to 0.25.

Longitudinal Influence Radius 
End

When the Symmetric Ellipse of Influence option is enabled, this field controls 
both the Begin and End Longitudinal radius values. When this option is 
disabled, it controls the size of the End Longitudinal radius. By default, this 
value is set to 0.25.

Symmetric Ellipse Influence
Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
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Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.
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Auto Fold Node
The AutoFold node lets you automatically fix the folding area of a deformer, so no line overlap occurs. If your 
drawing pieces are separated on different layers, you will not need the AutoFold node. The AutoFold node is 
similar to the Fold node, but since it's automated, it is optimized to fit the most standard folding point with fewer 
controls to set up. You can also avoid this issue by separating your drawing onto two layers or separating your 
drawing in two pieces using the Cutter tool and repasting it in place in the same drawing.

Connect the AutoFold node directly under the Deformation node which is causing the unwanted line effect, for 
example the forearm.

Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Name this field to rename the node.

Enable AutoFold Type 1 to enable it or 0 to disable the effect.
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If you connect this option to a function, then you can enable or disable the 
effect at a specific point in your animation.

Length

Sets the length of the fold axis line.
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Auto Muscle Node
The Auto-Muscle node is used to simulate muscle movement. This will allow your characters to flex their 
muscles when they lift something or to create muscle tone when they move. When the Auto-Muscle node is 
connected to a Bone Deformer that is rotated, the drawing is automatically inflated to simulate muscle movement 
in the limb. 

NOTE: Connect the Auto-Muscle node above the drawing you want to add a muscle to and after the Bone 
chain.

Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Muscle Left

This option is enabled by default. When enabled, the left side of the Bone Deformer will 
inflate as the articulation is rotated toward the direction of the Bone Deformer. Disable 
this option if you do not want the left side of the bone to inflate.

Left Start

The default value of the starting position of the left muscle is set to -2. This means it 
will start at the deformer situated two steps before the position where the Auto-Muscle 
is connected. You can change the starting point by typing the number corresponding to 
the deformer node.
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Left Span
This parameter controls the length (muscle length) over which the effect node will be 
applied to the left side of the deformer. By default the setting is 1, representing the 
length of the deformer to which it is applied.

Left Amplitude

This parameter controls the physical size of the left muscle. Increase the value to 
make the muscle bigger, decrease the value to make it smaller.

Muscle Right

This option is enabled by default. When enabled, the right side of the Bone Deformer 
will inflate as the articulation is rotated toward the direction of the Bone Deformer. 
Disable this option if you don't want the right side of the bone to inflate.

Same as Left
This option is enabled by default, allowing each side of the Bone Deformer to inflate to 
follow the rotation of the articulation. Enable this option to synchronize the right muscle 
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with the left so both muscles inflate when the articulation is rotated to the left.

Right Start

The default value of the starting position of the right muscle is set to -2. This means it 
will start at the deformer situated two steps before where the Auto-Muscle is 
connected, in this case, Bone. You can change the starting point by typing the number 
corresponding to the deformer node.

Right Span
This parameter controls the length (muscle length) over which the effect node will be 
applied to the right side of the deformer. By default the setting is 1, representing the 
length of the deformer to which it is applied.

Right Amplitude
This parameter controls the physical size of the right muscle. Increase the value to 
make the muscle bigger, decrease the value to make it smaller.

268



Harmony 14 Premium - Reference Guide

Bone Node
The Bone node is one of the main nodes used to build a deformation rig. Each Bone node consists of a bone and an 
articulation. You can chain Bone nodes to create a skeleton chain for your character. The Rigging tool can be used to 
create and connect those nodes automatically. 

Properties

Parameter Descriptions

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Resting Parameters Rest Offset

(x) Axis This is the bone x-axis (horizontal) coordinates for the resting position.

(y) Axis This is the bone y-axis (vertical) coordinates for the resting position.

Rest Radius This is the articulation's radius value (articulation size) for the resting position.

Rest Orientation This is the bone's orientation angle for the resting position.

Rest Bias
This is the articulation's bias (roundness and smoothness) for the resting pos-
ition.

Rest Length This is the bone's length for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y-axis parameters are controlled by the 
same 2D path function.

Separate When this option is enabled, the X and Y-axis parameters are individual one 
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from another.

Path When using a 2D Path, this field displays the name of the function.

(x) Axis
This is the bone X-axis (horizontal) coordinates for the animation position. This 
parameter can be linked to a function to be animated over time.

(y) Axis
This is the bone y-axis (vertical) coordinates for the animation position. This 
parameter can be linked to a function to be animated over time.

Radius
This is the articulation's radius value (articulation size) for the animation pos-
ition. This parameter can be linked to a function to be animated over time.

Orientation
This is the bone's orientation angle for the animation position. This parameter 
can be linked to a function to be animated over time.

Bias
This is the articulation's bias (roundness and smoothness) for the animation 
position. This parameter can be linked to a function to be animated over time.

Length
This is the bone's length for the animation position. This parameter can be 
linked to a function to be animated over time.

Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls 
the Left and Right transversal radius values. When disabled, it controls the size 
of the left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The Left Transversal radius value is automatically applied to the Right 
Transversal. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Right Transversal radius. By default, this value is set to 
2.

Longitudinal Influence Radius 
Begin

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The End Longitudinal value is automatically applied to the Begin 
Longitudinal value. When the Symmetric Ellipse of Influence option is disabled, 
it controls the size of the Begin Longitudinal radius. By default, this value is set 
to 0.25.
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Longitudinal Influence Radius 
End

When the Symmetric Ellipse of Influence option is enabled, this field controls 
both the Begin and End Longitudinal radius values. When this option is disabled, 
it controls the size of the End Longitudinal radius. By default, this value is set to 
0.25.

Symmetric Ellipse Influence

Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.
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Curve Node
The Curve node is one of the main nodes for building a deformation rig. You can chaining Curve nodes to create a 
Bezier handles skeleton. The Rigging tool can be used to create and connect the nodes automatically. 

Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Resting Parameters Resting Offset

(x) Axis This is the curve x-axis (horizontal) coordinates for the resting position.

(y) Axis This is the curve y-axis (vertical) coordinates for the resting position.

Resting Orientation 0 This is the orientation for the first Bezier handle for the resting position.

Rest Length 0 This is the length for the first Bezier handle for the resting position.

Resting Orientation 1 This is the orientation for the second Bezier handle for the resting position.

Rest Length 1 This is the length for the second Bezier handle for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y-axis parameters are controlled by 
the same 2D path function.

Separate
When this option is enabled, the X and Y-axis parameters are individual one 
from another.
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(x) Axis This is the curve X-axis (horizontal) coordinates for the animation position.

(y) Axis This is the curve Y-axis (vertical) coordinates for the animation position.

Orientation 0 This is the orientation for the first Bezier handle for the animation position.

Length 0 This is the length for the first Bezier handle for the animation position.

Orientation 1
This is the orientation for the second Bezier handle for the animation pos-
ition.

Length 1 This is the length for the second Bezier handle for the animation position.

Envelope Parameters

Apply Parent Modifier's Trans-
formation

When this option is disabled, the deformation from the parent curves are no 
longer affecting the current curve. Interesting effects can be achieved when 
disabling this effect on the last child curve and rotating the Offset point. The 
curve tail end will remain pinned on the spot while the rest of the curves 
deforms.

Close Contour
When this option is enabled, the extrimity of the curve is snapped to the ini-
tial chain's Offset point. This creates an Envelope deformation. More than 
one curve can be linked to the Offset point.

Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls 
the Left and Right transversal radius values. When disabled, it controls the 
size of the left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field 
becomes inactive. The Left Transversal radius value is automatically applied 
to the Right Transversal. When the Symmetric Ellipse of Influence option is 
disabled, it controls the size of the Right Transversal radius. By default, this 
value is set to 2.

Longitudinal Influence Radius 
Begin

When the Symmetric Ellipse of Influence option is enabled, this field 
becomes inactive. The End Longitudinal value is automatically applied to the 
Begin Longitudinal value. When the Symmetric Ellipse of Influence option is 
disabled, it controls the size of the Begin Longitudinal radius. By default, this 
value is set to 0.25.
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Longitudinal Influence Radius 
End

When the Symmetric Ellipse of Influence option is enabled, this field controls 
both the Begin and End Longitudinal radius values. When this option is 
disabled, it controls the size of the End Longitudinal radius. By default, this 
value is set to 0.25.

Symmetric Ellipse Influence

Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.
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Deformation Composite Node
Just like a standard Composite node, the Deformation-Composite node is used to bring together all the elements 
that are connected to it, allowing you to customize parameters that will influence the result of the output. The 
Deformation-Composite links the deformation chain to the graphic element to which it is related. 

Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and 
Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Output Kinematic Only

This option is disabled by default, allowing the deformation chain to out-
put deformation and position information. This option should be enabled 
in order to output the chain information position only. This will allow you 
to connect a part to the hierarchy without it undergoing the deformation 
applied to the rest of the chain.

Output Selected Port Only 

This option is important if you have several deformation chains for one 
element, as in the case of a character with multiple poses. 

• When this option is enabled, it will only use the selected chain, 
which you will be able to define in the Output Kinematic Chain 
options of the Deformation-Composite. In some situations, this 
option is enabled and setup automatically (For example, when 
you are working with the Create Posed Deformer in Create 
Deformation Above/Under enabled)—see Creating a Full 
Character Turnaround Deformation Rig on page 1.

• When this option is disabled, all the different chains for this 
element will be used at once. 

Output Kinematic Chain
Lets you select a deformation chain option to use. This parameter is 
used when the Output Selected Port Only option is enabled. 
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Rightmost: Only the first chain connected to the right of the composite 
node will be used.

Leftmost: Only the first chain connected to the left of the composite 
node will be used.

Select: If you select this option, you can define which chain to output 
according to the order they are connected from left to right. 

Use First Connected Element’s Exposure as Key: Allows the deform-
ation effect to automatically detect which deformation chain to use (sub-
group) by detecting the exposure of the first element connected to the 
deformation. This option is used in the case of a multiple pose rig—see 
Creating a Full Character Turnaround Deformation Rig.

Use Parent Composite’s Connected Element Exposure: When the 
Output Kinematic Only option enabled, the information from the parent 
element’s exposure is used to attach the child to the correct chain, fol-
lowing which pose is exposed—see 

Output Kinematic Chain Selection

When the Output Selected Port Only option is selected AND the Select 
option is used as the Output Kinematic Chain setting, this field defines 
which deformation chain you want to use on your element. Select the 
number which corresponds to the left to right order that the chains are 
connected to the Deformation-Composite node.

You can attach this value to a function and enable different chains over a 
period of time on specific frames. This value can be modified in the 
Timeline view by using the Deformation-Switch layer. Since the 
Deformation-Composite node is only visible in the Node view, the layer 
has a reference to this parameter enabling you to easily edit the value 
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when working in the Timeline view.
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Deformation Root Node
The Deformation-Root is used when creating manual legacy multi-pose rigs. It can be placed at the start of the 
deformation chains. This node is no longer used for the current multi-pose rig structure.

You can modify the quality level of the Deformation effect in the Deformation-Root Layer Properties window:

Properties

Parameter Description

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Quality

Defines the number of slices the graphic is split into and used when undergoing 
a deformation. The higher the quality level, the more slices are created and the 
smoother the deformation applied to the graphic. There are five levels of 
quality:

• Low

• Medium

• High

• Very High (default value)

• Extreme
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Deformation Scale Node
The deformers can only be scaled along the centre axis to adjust the length of the limb. The Deformation-Scale can 
be used in combination with a Bone or Curve deformer to scale a drawing so it follows the opposite direction of the 
deformer axis (the width). For example, when combined with function curves this can be used to create advanced 
muscle effects. All these settings can be animated over time.

How to set up the Deformation-Scale effect node

 1. In the Node view, navigate to the node to which you want to add a Deformation-Scale effect.

 2. In the Node Library view, select a Deformation-Scale node and drag it to the Node view.

 3. Connect the Deformation-Scale node directly under the lower deformer node of your chain.

 4. In the Node view, select the Deformation-Scale node and select View > Show > Control to display its con-
trols in the Camera view. 

 5. Click on the square yellow button of the Deformation-Scale node to open the Layer Properties window. You 
can animate the different parameters of the Deformation-Scale node by enabling the Animate  mode in the 
Tools toolbar and adding keyframes. In this case, different values will be connected to functions.

NOTE: If the controls are too far away from the deformer, you can change the default display of the 
Deformation-Scale and Deformation-Uniform-Scale controls in the Preferences dialog box to bring them 
closer.
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Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

This series of options controls the left scaling deformation. 

Scale Left

This option is enabled by default. It allows the left side of the deformer to be 
scaled. In the Camera view, the dark blue controls are used for the left side. If 
you disable this option, the controls will be hidden and no scaling deformation will 
occur for this side.

Left Fade In
The value is set to 0 (no fade) by default. Increase the value to add a fade effect 
to smooth the transition between the starting point of the scale and the area 
before it.

Left Fade Out
The value is set to 0 (no fade) by default. Increase the value to add a fade effect 
to smooth the transition between the Left Span point of the scale and the area 
after it.

Left Start

Defines the starting point of the left scale deformation. The default value is 0 and 
represents the Deformation-Root. Each main control point count for +1.

Move the first blue arrow along the deformer’s central axis to set the starting point 
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of the Deformation-Scale and the last arrow to set the length (span) of the 
transformation.

Left Span Defines the length of the left scale effect.

Left Start Scale

Defines the start of the left scale effect.

Drag the square scaling curve control points away and forward from the deformer 
axis to set the scaling value at the starting and ending point.

Left End Scale Defines the end of the left scale effect.

Left Start Handle Position

Defines the starting position of the left handle.

Drag the two middle blue arrows along the deformer’s centre axis to set the 
position of the curve handles.
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Left End Handle Position Defines the ending position of the left handle.

Left Start Handle Scale

Defines the starting position of the left scale handle.

To modify the scaling value of the curve, drag the two control handles away and 
forward from the deformation axis. 

Left End Handle Scale Defines the ending position of the left scale handle.

Scale Right

This option is enabled by default. It allows the right side of the deformer to be 
scaled. In the Camera view, the light blue controls are used for the right side. If 
you disable this option, the controls will be hidden and no scaling deformation will 
occur for this side.

Same as Left

This option is disabled by default. It means that the left and right sides will use 
different scaling parameters. If you enable this option, the right side controls will 
be hidden in the Camera view and the left parameters will be used for both side 
for a symmetrical scaling effect.

The right side parameters are a mirror of the left side parameters
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Deformation Switch Node
The Deformation-Switch (Legacy) node acts as a on and off switch for the deformation chain. It is used when 
building legacy multi-pose rigs. It is also the node which controls the Region of Influence Fade area. The 
Deformation-Switch also displays a Kinematic Chain Selection Reference option, which allows you to modify the 
chain selection directly in the Timeline view.

The Deformation-Switch has been replaced with the Transformation-Switch node.

Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Vector Quality

Defines the quality of the deformation effect when your drawings are stretched 
and deformed. There are five levels of quality:

• Low

• Medium

• High

• Very High (default value)

• Extreme

Influence Fade Exponent
A value of 1 is similar to a linear curve. A higher value will result in an ease-in type 
of curve. A lower value will result in an ease-out type of curve.

Fade Inside Region
This option is disabled by default. The  fade effect will occur outside the zone of 
influence. Enable this option to have the fade effect inside the Zone of Influence.

Enable Deformation
Acts as an on/off switch for the deformation. The value of this field is set to 1 by 
default, which means the deformation is enabled. Enter a value of 0 to disable it.

Kinematic Chain Selection 
Reference

Determines which chain is selected and used at a specific frame. It is a reference 
to the option in the Deformation-Composite node. Having this reference in the 
Deformation-Switch node allows you to use and modify the chain selection value 
directly in the Timeline view since the Deformation-Composite node is only vis-
ible in the Node view.
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Deformation Uniform Scale Node
The Deformation-Uniform-Scale effect node let you create the squash and stretch effect on your animated 
deformation rig. You can scale the rigged element on the opposite axis of the deformer (width). 

How to use the Deformation-Uniform-Scale node

 1. In the Node view, navigate to the deformation node to which you want to add a Deformation-Uniform-Scale 
node.

 2. In the Node Library view, select the Deformation-Uniform-Scale node and drag it to the Node view.

 3. Connect the Deformation-Uniform-Scale node directly below the lowest deformation node in your chain.

 4. Connect the Deform-Uniform-Scale node to all the drawing nodes it should scale.

 5. In the Node view, select the Deformation-Uniform-Scale node.

 6. Display the Uniform Scale controls in the Camera view by pressing Shift + F11.

 7. In the Camera view, drag the handle to resize the width of the limb. You can also use the Scale field to 
enter a specific value. These parameters can be animated over time.

NOTE: If the controls are too far away from the deformer, you can change the default display of the Deform-
ation-Scale and Deformation-Uniform-Scale controls in the Preferences dialog box to bring them closer.
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Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Scale Use this field to type in the value to resize the width of the limb.
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Deformation Wave Node
The Deformation-Wave effect deforms the chain by adjusting the scaling in a waveform style. It can be used to 
animate a wave deformation effect on your deformation chain over a period of time. 

How to use the Deformation-Wave effect

 1. In the Node view, navigate inside the Deformation node to which you want to add a Deformation-Wave 
effect.

 2. In the Node Library view, select an Deformation-Wave node and drag it to the Node view.

 3. Connect the Deformation-Wave node to your deformation chain.

A wave deformation is applied to the limb or art connected to the deformation chain.

 4. In the Node view, open the Layer Properties window of the Deformation-Wave node.

Properties

Parameter Description

286



Harmony 14 Premium - Reference Guide

Enable/Disable
Enables or disables the selected node in the Camera, Timeline, and Node 
views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Wave Left
This option is enabled by default, allowing the Deformation-Wave effect to be 
applied on the left side of the deformer chain. Disable this option to prevent the 
effect from being applied.

Left Start Defines the length of the left wave effect.

Left Span
Defines the starting point of the left wave deformation. The default value is 0 
and represents the root point. Each main control point count for +1.

Left Offset Deformer
This is the parameter you may want to connect to a function. It controls the 
offset of the deformation on the left side and allows you to create a fluid wave 
animation along the deformer axis.

Left Amplitude Controls the height of the left wave effect.

Left Offset Scaling
Used to apply an offset value to the amplitude of the left wave. The wave will 
be lifted and become higher, or dropped and become lower, depending whether 
the value is increased or decreased.

Left Period
Controls the interval of occurrence of the left waves. By default the value is 1, 
meaning that a wave will occur for every deformer. If you decrease the value to 
0.5, it will result in a wave occurring every half deformer.

Wave Right
By default this option is enabled, allowing the Deformation-Wave effect to be 
applied on the right side of the deformer chain. Disable this option to prevent 
the effect from being applied.

Same as Left
This option is disabled by default. It allows the left and right size of the 
Deformation-Wave to be controlled separately. Select this option if you want 
the effect to be symmetrical and controlled by the left side parameters.

Right Start
Defines the starting point of the right wave deformation. The default value is 0 
and represents the Deformation-Root. Each main control point count for +1.

Right Span Defines the length of the right wave effect.

Right Offset Deformer
This is the parameter you might want to connect to a function. It controls the 
offset of the deformation on the right side, allowing you to create a fluid wave 
animation along the deformer axis.

Right Amplitude Controls the height of the right wave effect.

Right Offset Scaling
Used to apply an offset value to the amplitude of the right wave. The wave will 
be lifted and become higher, or dropped and become lower, depending whether 
the value is increased or decreased.

Right Period
Controls the interval of occurrence of the right side waves. By default the value 
is 1, meaning that a wave will occur for every deformer. If you decrease the 
value at 0.5 it will result in a wave occurring every half deformer.
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Fold Node
The Fold effect is used when bending a deformation further than the drawing is able to take it. This may result in 
an unwanted overlap of the line art at the junction of the articulation or deformation. The Fold effect lets you 
control certain parameters that will help eliminate the unwanted line effect. You can also avoid this issue by 
separating your drawing onto two layers or separating your drawing in two pieces using the Cutter tool and 
repasting it in place in the same drawing.

The Fold effect works best with the Curve deformers.

How to set up the Fold node

 1. In  the Node view, navigate to the Deformation node causing the unwanted overlap (in this case, an artic-
ulation).

 2. In the Node Library view, select the Fold node and drag it to the Node view.

 3. Connect the Deformation-Fold node directly under the deformation effect node which is causing the 
unwanted line effect.

 4. In the Node view, select the Deformation-Fold node.

 5. From the top menu, select View > Show > Control or press Shift + F11 (Windows/Linux) or ⌘  + F11 
(Mac OS X) to display its controls in the Camera view.

 6. In the Tools toolbar, select the Transform  tool.

 7. In the Camera view, set up the Deformation-Fold. You can also set these parameters directly in the 
Deformation-Fold properties:
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‣ Click on the fold axis and rotate it to match the angle of the bend articulation.

‣ Use the middle arrow to position the axis along the deformer’s central line. It should be in the corner of the 
bending area.

‣ Use the right and left arrows to control the appearance of the two overlapping lines.
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‣ Use the axis’s square handle to lengthen or shorten the axis.

 8. If your character moves a lot and you need to adjust the fold at different positions to follow the limb anim-
ation, you can set up the Deformation-Fold node in a different position over time. To do this, enable the 
Animation  mode in the Tools toolbar and add keyframes. In this case, the different values will be con-
nected to functions.

 9. You can also enable/disable the Deformation-Fold node over time by connecting a function to the Enable 
Fold parameter in the Layer Properties. A value of 1 enables the effect, a value of 0 disables the effect.
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Game Bone Node
The Bone node is one of the main node used to build a deformation rig. Each Bone node consists of a bone and an 
articulation. Chaining Bone nodes will create a skeleton chain for your character. The Rigging tool can be used to 
create and connect those nodes automatically.

Parameter Descriptions

Resting Parameters Rest Offset

(x) Axis This is the bone X-axis (horizontal) coordinates for the resting position.

(y) Axis This is the bone Y-axis (vertical) coordinates for the resting position.

Rest Radius This is the articulation's radius value (articulation size) for the resting position.

Rest Orientation This is the bone's orientation angle for the resting position.

Rest Length This is the bone's length for the resting position.

Deform Parameters Offset

2D Path
When this option is enabled, the X and Y axis parameters are controlled by the 
same 2D path function.

Separate
When this option is enabled, the X and Y axis parameters are individual from 
each other.

Path When using a 2D Path, this field displays the name of the function curve.

(x) Axis
This is the bone X-axis (horizontal) coordinates for the animation position. This 
parameter can be linked to a function curve to be animated over time.

(y) Axis
This is the bone Y-axis (vertical) coordinates for the animation position. This 
parameter can be linked to a function curve to be animated over time.

Radius
This is the articulation's radius value (articulation size) for the animation pos-
ition. This parameter can be linked to a function curve to be animated over 
time.

Orientation
This is the bone's orientation angle for the animation position. This parameter 
can be linked to a function curve to be animated over time.
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Length
This is the bone's length for the animation position. This parameter can be 
linked to a function curve to be animated over time.
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Glue Node

The Glue effect lets you repair the cracks that appear between joints during animation.

The Glue node has three ports:

• Left Port (Matte): Receives the matte.

• Middle Port (Port A): Receives the element that will not be used to fill the joint.

• Right Port (Port B): Receives the element that will be used to fill the joint.

For most effects with the Glue node, the default options are sufficient. However, you can modify these options 
using the Glue editor.
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Glue Properties

Parameter Description

Bias
Indicates the tendency to favour the static or moving element. Set to 0, it favours 
element A; set to 1 it favours element B; set to 0.5 it is in between A and B.

Tension
Indicates how tight the joint will be. Set to 1, the tension has no effect; set less 
than 1, the tension decreases; set greater than 1, the tension increases. 

Type
From this menu, select the type of joint to create. You can choose from among 
Curve (default), Line and Corner.

Use Z for Composition Order
You can use this option to choose the drawing with the higher front-back value to 
create the joint.

A Over B
Indicates which image is rendered on top in the final image. By default, A is 
rendered on top of B, which indicates that the image in the middle port (A) is 
rendered on top of the image in the right port (B).

Spread A

By default, the image in port B is spread to fill the joint. You can use this option to 
choose the image in the A port to create the joint. If you select this option, the 
drawing node must receive position information from the "B" element. Thus, you 
must connect the Drawing node of the "B" element to the Drawing node of the 
matte.

Invert Matte
Activate this option to invert the matte used to fill the joint. If you want to use the 
"B" element as the matte, you must select this element.
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Kinematic Output Node
The Kinematic Output node lets you hook a separate element that you want to be linked to the deformation chain 
but not be part of the deformation, such as a hand to an arm or an arm to the body. These elements will follow the 
movement of the chain just like a regular cut-out character hierarchy piece without being influenced by the 
deformation of the arm. If you don't use the Kinematic Output, the piece's pivot will not follow the deformation.

Connect a Kinematic Output node below the deformation node you want your drawing to follow.
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Mesh Warp Node

Use the Mesh Warp effect to distort your drawings. With this node you can create effects such as a character in a 
warped mirror and looking through a glass jar. You can also animate the position of the grid to perform the distortion 
over time.

The Mesh Warp node is a position node, same as a Peg node.

How to use the Mesh Warp Effect

 1. In the Node Library, under the Filter tab, select the Mesh Warp node and drag it to the Node view.

 2. In the Node view, connect the Mesh-Warp node to your drawing or group nodes to deform.
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 3. In the Node view, select the Mesh Warp node.

 4. Select View > Show > Control or press Shift + F11 (Windows/Linux) or ⌘  + F11 (Mac OS X) to display 
the deformation grid.

 5. Move the intersection points and move the Bezier handles to deform the grid.

 6. Grab the grid in the void spaces to pan it around. Using keyframes, you can animate its position over time.

Mesh Warp Properties

Use the Mesh Warp editor to adjust the grid size, deformation quality and the region of interest.
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Parameter Description

Rows
Increase or decrease the Rows value to change the amount of rows to use in the 
deformation grid.

Columns
Increase or decrease the Columns value to change the amount of columns to use 
in the deformation grid.

Region of Interest
Select the 2D Path option if you want both your X and Y curves to be controlled by 
the same velocity function. Select the Separate option if you want your X and Y 
curves to be independent and have independent velocity.

(x) Axis
This is the X position of the gird. This value can be animated overtime to move the 
grid horizontally.

(y) Axis
This is the Y position of the gird. This value can be animated overtime to move the 
grid vertically.

Width
This is the width value of the gird. This value can be animated overtime to squash 
or stretch the grid horizontally.

Height
This is the height value of the gird. This value can be animated overtime to 
squash or stretch the grid vertically.

Deformation Quality
This is the quality of the warm deformation. It ranges from Low to Extreme. The 
higher the quality, the better the formation will look, but the longer it will take to 
render.
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Offset Node
The Offset node lets you position the root of your deformation chain. It is automatically added to your deformation 
rig when you create a Curve or Envelope deformation rig using the Rigging  tool. 

Parameter Description

Name Use this field to rename the node.

(x) Axis Sets the resting position on the X (east/west) axis.

(y) Axis Sets the resting position on the Y (north/south) axis. 

Resting Orientation Sets the rotation angle of the resting position. 

Offset Type

Lets you choose the type of coordinates to use: 

 Separate: The two coordinates are set separately. If they are connected to a 
function, each one will have its own function curve. This is the default setting. 

 2DPath: The two coordinates are set together within a single 2D path 
function.

(x) Axis

(y) Axis

This option is only available when the Type is set to Separate. It is used to set 
the active position value of the Deformation-Root on the X (east/west) and Y 
(north/south) axis. 

You can enter the value, use the up and down arrow buttons to choose a value, 
or use the Transform tool, when Setup mode is NOT enabled, to move the 
deformation chain. Remember, that if you want to add a keyframe, you need to 
enable Animation mode from the Tools toolbar.

Path

This option is only available when the Type is set to 2D Path. It is used to set 
the active position value of both the Y and X axis. Use the Transform tool when 
Setup mode is NOT enabled to move the deformation chain along the 2D path. 
Remember, if you want to add a keyframe, you need to enable the Animation 
mode on the Tools toolbar.

Orientation

Sets the rotation angle of the active position of the Deformation-Root. You can 
enter the angle, use the up and down arrow buttons to choose the desired 
value, or use the Transform tool when Setup mode is NOT enabled to rotate 
the deformation chain. Remember, if you want to add a keyframe, you need to 
enable Animation mode on the Tools toolbar.
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Apply Parent Modifier's Trans-
formation

When this option is disabled, the parent's deformations no longer affect the cur-
rent deformer.

Refract 

Use the Refract effect to create effects such as ripples and heat haze. This effect is based on the refraction of light, 
which occurs when a beam of light passes through media of different density, causing the light to refract or change 
angles. This effect makes objects appear distorted or offset from their actual positions. If you imagine an object in a 
pool of water the part beneath the surface of the water appears offset from its true position.

To create a refraction effect, you need a matte with alpha values. This creates the effect of a volume passing over 
an image, refracting the light that bounces off the contents below. For a ripple effect moving across an image, you 
must move the matte with a Peg layer.

If your matte is only black and white, meaning that there is no gradients and only solid colours in your matte drawing, 
you will need to connect a Blur Radial node after your matte Drawing node to soften the edges and get nicer waves.
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Refract Properties

Parameter Description

Name Lets you rename the node.

Intensity
The amount of refraction to apply to the image. 

You can attach the value to a function curve to change its  value over time.

Height

The amount of depth to add to the refraction effect. When coupled with the 
Intensity effect, this value can create the effect of bending the objects below 
the refraction matte.

You can attach the value to a function curve to change its  value over time.
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Stick Node
The Stick node is available for compatibility with previous versions of deformation rigs. This node is the legacy Bone 
node. When the Stick node is imported in the Node view, it is renamed Bone.

Parameter Descriptions

Rest Length This is the bone's length for the resting position.

Length
This is the bone's length for the animation position. This parameter can be 
linked to a function to be animated over time.

Region of Influence

Influence Fade Radius
This defines the size of the fade area around the actual region of influence's 
boundaries.

Transversal Influence Radius 
Left

When the Symmetric Ellipse of Influence option is enabled, this field controls 
the Left and Right transversal radius values. When disabled, it controls the size 
of the left transversal radius. By default, this value is set to 2.

Transversal Influence Radius 
Right

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The Left Transversal radius value is automatically applied to the Right 
Transversal. When the Symmetric Ellipse of Influence option is disabled, it 
controls the size of the Right Transversal radius. By default, this value is set to 
2.

Longitudinal Influence Radius 
Begin

When the Symmetric Ellipse of Influence option is enabled, this field becomes 
inactive. The End Longitudinal value is automatically applied to the Begin 
Longitudinal value. When the Symmetric Ellipse of Influence option is disabled, 
it controls the size of the Begin Longitudinal radius. By default, this value is set 
to 0.25.
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Longitudinal Influence Radius 
End

When the Symmetric Ellipse of Influence option is enabled, this field controls 
both the Begin and End Longitudinal radius values. When this option is disabled, 
it controls the size of the End Longitudinal radius. By default, this value is set to 
0.25.

Symmetric Ellipse Influence

Enabled by default. The shape of the ellipse will be symmetrical on both the 
transversal and longitudinal radii. In this case, use the Transversal Influence 
Radius Left field to set the transversal radius value and use the Longitudinal 
Influence Radius End field to set the longitudinal radius value. The two other 
fields will remain unused unless you disable the Symmetric Ellipse Influence 
option. In that case, you can set up different radius sizes for the four radii 
directions.

304



Harmony 14 Premium - Reference Guide

Turbulence Node
The Turbulence effect is a mathematically generated effect that uses fractal noise to create turbulent distortions in 
an image. You can see the effect when used with an image as the background. You can create flowing water, 
funhouse mirrors, and waving flags.

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.
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Turbulence Properties 

Parameter Description
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Noise Type

Lets you select a type of noise pattern.

Perlin: Creates pseudo random patterns. The greyscale contains a continuity 
between different tones of grey.

Simplex: Creates a more contrasted noise pattern with more variation than Per-
lin. There is a smooth variation of intensity.

Sinusoidal: Creates a repeated wavelike pattern.

Sub Scaling: Applies Perlin noise twice. The second noise is added where 
dark areas appear in the original. The frequency of the second iteration is 
higher so the noise is smaller.

Rocky: Uses the Perlin pattern but converts the very high and low values to 
more moderate values. For example, the whites become light greys and the 
blacks become dark greys.

Small Bumps: Uses the Perlin pattern. The transitional grey areas between 
blacks and whites become inverted so they look like dark lines. The extremes, 
black and white areas, become whitish.

Fractal Type

Transforms the noise pattern, created by the Noise type and controls the way 
layers are composited. These are variations of the basic noise.

Turbulent Twist: Applies a turbulent effect on the pattern so it changes the 
transition between black and white by adding more modulation.

Fractional Brownian: Applies a basic application of noise and composites by 
adding subsequent layer with the Complexity parameter.

Threshold: Changes the dark greys into black values so there is more black in 
the noise for higher contrast.

Invert Threshold: Inverts all the values of the Threshold type so a negative 
image of it is created.

 Terrain: Adds contrast and converts the dark greys into white or light greys.

Pinning Constrains the effect within the image boundaries.

Amount Specifies the amplitude of displacement.

Frequency
The density of displacement appearing in the noise. A higher value produces a 
greater amount of displacement in a given area; a lower value produces a smal-
ler amount.

Offset Moves the entire image.

Seed
This value determines the starting noise pattern on the first evolution of the 
effect.

Locked Applies parameter value while retaining the X and Y ratio.

Separate Allows you to apply different parameter values to X and Y.

xy
When locked, applies parameter values to both X and Y. When separated, 
allows you to apply different value to X and Y.

Evolution Determines the displacement pattern over time.

 
Evolution Frequency: This factor makes the complexity iterations animate or 
transform at a higher speed. In other words, the second, third, etc. passes, con-
trolled by the Complexity parameter, will mutate faster than the main one.
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Complexity

Complexity: The number of noise layers that make up the noise. Each 
successive layer has a higher frequency, resulting in a smaller noise effect. 
You can have up to seven passes. Increasing this number increases the depth 
and amount of detail in the noise. Use Complexity with Sub Scaling when the 
value is 1 or greater. Note: Increasing the Complexity results in longer 
rendering times. 

 

Gain: Controls the amount of opacity present in the iteration of noise. This also 
affects the layer when using Sub Scaling. With a value of 0, you will not see 
the sub noise. A value of 1 will show the sub noise just as strong as the main 
one. For example, with water ripples, a higher amount of Gain will reveal more 
ripple or subripples.

 

Sub Scaling: The factor by which the main noise is modified at each iteration 
of complexity. A value of 1 make the two noises identical. A value of 2 makes 
the sub noise twice as small. The next iteration would be 4 times smaller. Val-
ues must be greater than 1.
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Filter Nodes
Here is the list of the main filter effects available in Harmony.

Anti-Flicker Node 311

Auto-Patch Node 313

Bloom Node 315

Blur - Box Node 319

Blur-Directional Node 322

Blur - Gaussian Node 325

Blur - Radial  Node 327

Blur - Radial Zoom Node 329

Blur-Variable Node 332

Brightness Contrast Node 334

Channel Selector Node 336

Channel Swap Node 338

Chroma-Keying Node 340

Colour Banding Node 344

Colour Art Node 347

Colour-Override Node 349

Colour-Scale Node 353

Contrast Node 355

Dither Node 357

Focus Node 359

Focus Multiplier Node 362

Glow Node 364

Grain Node 367

Greyscale Node 370

Hue-Saturation Node 372

Layer Selector Node 375

Luminance Threshold Node 377

Matte-Blur Node 380

Matte-Resize Node 383

Median Node 385

Motion-Blur Node 388

Negate Node 391
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Overlay Layer Node 393

Pixelate Node 395

Remove Transparency Node 397

Shadow Node 399

Transparency 401

Underlay Layer Node 404
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Anti-Flicker Node
Use the Anti-Flicker to compensate for flickering in your output to TV formats. The Anti-Flicker effect applies a 
vertical blur to the rendered output. You should place the Anti-Flicker before a Write node in the Node view.

Refer to the following example to connect this node.

Use the Anti-Flicker editor to control the amount of blur that is applied to rendered output. In the Radius field, enter a 
value for the number of pixels to be considered in the blur.

Properties

Parameter Description
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Name Use this field to rename the node.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the blur. 
The blur radius is affected by the drawing scale and camera position. Click the 
Edit Curve button to change these values over time by adjusting the function 
curve.
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Auto-Patch Node
T-RIG-005-001

The Auto Patch node is used mainly when creating joint patches for cut-out puppets drawn with pencil lines and 
painted in the Colour Art layer. Instead of removing a portion of the outline to attempt to create a seamless joint, you 
can draw complete pieces, and with the Auto Patch node, automatically create a perfect articulation.

The requirements for this effect to work are:

 l Drawing outlines must be drawn in pencil lines

 l Drawing outlines must be drawn in the Line Art layer

 l Drawing fill colours must be painted in the Colour Art layer

Pencil lines are central vector lines. The vector is located along the centre of the line. This means that when you 
paint a zone delimited by a pencil line, the colour fill will expand to the centre of the pencil line.

When using the regular patch technique, recommended for the brush line, the result with pencil lines is very odd 
looking because the colour fill zone is bigger than the pencil line inner contour.

Instead of using the regular patch method, you can use the Auto Patch node. It will automatically extract the Colour 
Art and clip it to the right size. Then, you can connect it in front of the piece to be covered.

The node connection for the Auto Patch is quite simple. Once your basic character rigging is done, add the Auto 
Patch node to the joints you want to cover. There is no need to set any parameters. 

Refer to the following example to connect this node.
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Properties 

Parameter Description

Name Use this field to rename the node.
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Bloom Node
The Bloom effect is used to make a specular area blurrier on a bitmap image, such as street lamps at night.

Refer to the following example to connect this node.

It's  a combination of the Luminance Threshold, Cutter, Blur - Gaussian and Composite Generic nodes—see 
Luminance Threshold Node on page 377, Cutter Node on page 248 Blur - Gaussian Node on page 325, and 
Composite-Generic Node on page 243.
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Properties

Parameter Description

Name Allows you to change the node's name.

Threshold

 

Controls how much of the dark value to clamp off. A high value will keep only the bright 
areas of your image.
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Soften Colours

Brings back the entire spectrum of luminance in areas defined by the threshold to avoid 
having only bright values.

Gamma Correction

Multiplies the gamma value to make the area brighter or darker.  A value of 1 keeps the 
gamma the same as the original image.  You can use the gamma modification on the whole 
image if you use a threshold of 0 for example.

Output Greyscale 
Matte

Allows you output an image in grey values to use in combination with a Blending or Cutter  
node elsewhere in the node structure.
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Invert Matte Lets you invert the mask shape if you connected a mask image to the node's left port.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a change of 
depth or scale. When this option is deselected, the effect's values remain unchanged 
regardless of any depth or scale changes. This option should be deselected when multiple 
drawings are composited and attached to this effect.

Radius Adjusts the amount of blur applied to the image.

Quality
Controls the quality of the blur. A higher quality yields better results, but will be slower to 
render.

Composite with 
Source Image

Blends the area defined by the threshold with the original image.

Blend Mode
Defines the blending mode between the original image and the area defined by the 
threshold to avoid having to add a Composite Generic node after the Bloom node.
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Blur - Box Node
The Blur - Box effect  is a quick and easy way to create a blurring effect. The Box blur changes the colour value of 
each pixel based on the pixels next to it in the vertical and horizontal directions. The look of the blur is similar to the 
look achieved using Gaussian blur, but renders much faster. This effect is useful when a fast rendering time is 
important, and the quality of the blur is less important. Also, you can use a matte with this effect to isolate areas of 
the image.

Refer to the following example to connect this node.

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.
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Properties 

Parameter Description

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo 
a change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option 
should be deselected when multiple drawings are composited and attached to 
this effect.

Repeat Edge Pixels
Makes the blur algorithm operate as if the pixel values beyond the edge of the 
layer are the same as the values of the edge pixels. This keeps edges sharp, 
preventing them from darkening and becoming more transparent.

Blurriness Amount of blur applied to the layer.

Directional
Blurs according to the length, width, and angle you specify. For example, if a 
character is walking east, the blur may fall to the west.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the 
blur. The blur radius is affected by the drawing scale and camera position. 
Click the Edit Curve button to change these values over time by adjusting the 
function curve.

Length Length of the blur.

Width Thickness of the blur.

Angle
The direction in which the blur is applied: sideways, up, down,  90 degrees, 45 
degrees, and so on.

Bidirectional Applies the blur on both sides of the pixel.

Fall Off

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. A fall-off rate of 0 causes the blur to fade out slowly, dis-
tributing the blur evenly from the edge of the character to the farthest edge of 
the blur. A fall-off rate of 1 causes the blur to fade out quickly, so the blur is 
heaviest closer to the edge of the image.
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Number of Iterations
The number of times the blur is applied to the image. A higher number of iter-
ations creates smoother transitions between colours and increases the blur, 
but also increases render time.

Precision
Precision: Blurs the image the number of times the precision indicates at 
different radius (between 0 and the specified radius).
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Blur-Directional Node
The Blur-Directional effect creates the effect of a motion blur that pulls and smears the image from one contour 
edge to a different direction or angle. This effect is useful in creating the impression of speed, such as the streaks 
of colour that follow a car travelling at high speed. 

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this effect.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the blur. 
The blur radius is affected by the drawing scale and camera position. Click the 
Edit Curve button to change these values over time by adjusting the function 
curve.

Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. A fall-off rate of 0 causes the blur to fade out slowly, distributing 
the blur evenly from the edge of the character to the farthest edge of the blur. A 
fall-off rate of 1 causes the blur to fade out quickly, so the blur is heaviest closer 
to the edge of the image.

Angle

The direction of the blur. Enter a value from 0 to 360.

0: Blurs the image to the west.

90: Blurs the image to the south.

180: Blurs the image to the east.

270: Blurs the image to the north.

Direction of trail
If you do not set an Angle for the direction of the blur, you can select a direction 
(north, south, east, or west) from this menu. The calculations for this feature are 
faster than the calculations for the Angle setting.

Ignore Alpha
Controls the leading edge of the blur. Deselect this option for a solid or hard lead-
ing edge on the blur.

Extra Final Blur
Adds a second blur after the Blur-Directional is created. If you have a Blur-Dir-
ectional that begins at 0 and gradually gets stronger, deselect this option to 
ensure a smooth progression.

Number of Iterations
The number of times the blur is applied to the image. A higher number of iterations 
creates smoother transitions between colours and increases the blur, but also 
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increases render time.
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Blur - Gaussian Node
The Blur - Gaussian effect softens the image, reducing the amount of noise and detail. The look of the Gaussian blur 
is smooth, but does take some rendering time. This effect is useful when rendering time is less important, and 
quality is more important. Also, you can use a matte with this effect to isolate areas of the image.

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.

Refer to the following example to connect this node.

s
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Properties 

Parameter Description

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo 
a change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option 
should be deselected when multiple drawings are composited and attached to 
this effect.

Repeat Edge Pixels
Makes the blur algorithm operate as if the pixel values beyond the edge of the 
layer are the same as the values of the edge pixels. This keeps edges sharp, 
preventing them from darkening and becoming more transparent.

Blurriness

Directional
Blurs according to the length, width, and angle you specify. For example, if a 
character is walking east, the blur may fall to the west.

Blurriness Amount of blur applied to the layer.

Horizontal Blurriness Length of the blur.

Vertical Blurriness Thickness of the blur.

Angle
The direction in which the blur is applied: sideways, up, down,  90 degrees, 45 
degrees, and so on.

Bidirectional Blurs in both horizontal and vertical directions.

Matte
Precision: Blurs the image the number of times the precision indicates at 
different radius (between 0 and the specified radius).
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Blur - Radial  Node
T-HFND-010-007

The Blur-Radial effect creates an effect that softens, fogs or obscures the image evenly in all directions. This effect 
is useful when you want to make cloudy images not realistically seen in detail, such as a drawing object that is 
farther back or in the background of your scene, usually blurry due to the laws of atmospheric perspective. Other 
uses include the general softening of objects such as snow, stars and shadows that do not naturally have a hard 
outline.

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo 
a change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option 
should be deselected when multiple drawings are composited and attached to 
this effect.

Radius

Size of the blur. The larger the value, the greater the strength or reach of the 
blur. The blur radius is affected by the drawing scale and camera position. 
Click the Edit Curve button to change these values over time by adjusting the 
function curve.

Quality
Select High for a slow and accurate operation or Low for a faster operation with 
a more raw look.
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Blur - Radial Zoom Node
The Blur - Radial Zoom effect creates blurs around a centre point, simulating the look of a zooming or rotating 
camera. You can use a matte to isolate the area of the image from which you want the effect to radiate from. For 
example, in the illustration below, a circular matte was created to mask the eyeball and a Negate effect was applied 
so the blur is outside the matte. Then the centre point was positioned on the character's iris, which is the centre of 
the matte.

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.

Refer to the following example to connect this node.
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Properties 

Parameter Description

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo 
a change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option 
should be deselected when multiple drawings are composited and attached to 
this effect.

Focus

2D Path: Lets you move the centre point visually in the Camera view.

Separate: Lets you control the x and y axis by entering values in the fields or 
by moving the centre point visually in the Camera view.

(x) and (y) Axis
When the Separate type of centre is selected, lets you individually set the x 
and y coordinates for the centre.

Blurriness Amount of blur applied to the layer.

Variation

Constant: An equal, constant blur is applied on all pixels.

Linear: A gradual blur is applied on all pixels.

Quadratic: An exponential blur is applied on all pixels.

Direction Lets you select preset blur types or create a custom blur.

Presets
A set of preset radial, zoom, and spiral blurs to get you started. You can then 
adjust the type to customize the blur.

Custom Create your own blur by entering a value for the direction of the blur lines.
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Fall Off

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. A fall-off rate of 0 causes the blur to fade out slowly, dis-
tributing the blur evenly from the edge of the character to the farthest edge of 
the blur. A fall-off rate of 1 causes the blur to fade out quickly, so the blur is 
heaviest closer to the edge of the image.

Bidirectional Applies the blur on both sides of the pixel.

Quality
Affects the quality of the blur by defining how fine the reference radial grid is on 
the image.  This determines the width of all the wedges.   A higher quality yields 
achieve better results, but will be slower to render.

Matte
Precision: Blurs the image the number of times the precision indicates at 
different radius (between 0 and the specified radius).
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Blur-Variable Node
Use the Blur-Variable effect to create a radial blur that varies within a single image based on the white and black 
values in the matte you supply. You can set one blur value for the black regions in the matte, and another blur 
value for the white regions. The blur value for each grey region is interpolated between your black and white blur 
settings.

The following example is a network for a Variable Blur effect. A black and white copy of the character was used to 
create the effect. Use the Blur-Variable editor to control the blur value for the white and black radius. 

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Use this field to rename the node.

Black radius
The amount of blur to apply to the black (transparent) values in the matte. Higher 
values create more blur in the colour image's regions that correspond to the black 
matte region.

White radius
The amount of blur to apply to the white (opaque) values in the matte. Higher val-
ues create more blur in the colour image's regions that correspond to the white 
matte region.

Quality
Select High for a slow and accurate operation or Low for a faster operation with a 
more raw look.

Keep inside source image This option confines the blur to the source image.
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Brightness Contrast Node
The Brightness and Contrast effect lets you modify the brilliance or dullness of an image or to create a greater 
difference between the lights and darks of an image by increasing their respective intensities. This effect can be 
used when an image appears too flat. Increasing the brightness or contrast can give a drawing a more attractive 
and 3D quality. This can be useful if you want to push your background to the rear by making it look dull and flat 
and pulling your foreground elements to the front by giving them a higher contrast.

Refer to the following example to connect this node.

Properties

Parameter Description

Name Use this field to rename the node.

Brightness
A value less than 0 will darken the image; a value greater than 0 will brighten it. 
Attach a Bezier or Ease function to change the brightness over time.

Contrast A value less than 0 will reduce contrast; a value greater than 0 will increase 
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contrast. Attach a Bezier or Ease function to change the contrast over time.

Legacy Brightness/Contrast
If you are using an older version of this effect, the Legacy Brightness and 
Legacy Contrast options are automatically selected. This ensures that the res-
ulting effect looks the same as in older versions.
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Channel Selector Node
The Channel Selector effect lets you isolate one of the four colour channels of an image.

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Allows you to change the node's name.

Red Lets you select the red channel of an image.

Green Lets you select the green channel of an image.

Blue Lets you select the blue channel of an image.

Alpha Lets you select the alpha channel of an image.
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Channel Swap Node
The Channel Swap effect lets you take the image information from one channel and use it in another channel to 
achieve interesting effects. You can extract the following: red, green, blue, alpha values, hue, saturation, 
lightness, and luminance, as well as turn the information on or off. 

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.

Refer to the following example to connect this node.
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Properties 

Parameter Description

Name Use this field to rename the node.

Red, Green, Blue, and Alpha 
Channel From

Lets you select the image information to feed into the red, green, blue, and alpha 
channels. Full On sets all values to 255 and Full Off sets all values to 0.
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Chroma-Keying Node
The Chroma-Keying effect lets you create an alpha channel (transparency zone) for a bitmap image or image 
sequence. For example, if you have a series of bitmap images with a character filmed on a green or blue screen, 
you can use this node to create an alpha channel based on the screen colour and cut it out from your image 
sequence.

The  Chroma-Keying  node MUST be connected to a bitmap image. The Chroma-Keying  node will create an alpha 
channel that can be seen in the Camera view in the Matte Render mode. To cut the background colour from your 
image, you will need to use a Cutter node.

To obtain a better result than just extracting the raw colour, you can adjust some parameters such as the contour 
blurriness and the matte size. You can see all the options available in the  Chroma-Keying  properties.
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Properties

Parameter Description

Name Allows you to change the node's name.

Colour

Red/Green/Blue/Alpha Lets you enter the RGBA values for the colour to extract from your image.

Colour Swatch

Opens the Colour Picker window where you can select a colour from the palette 
or use the Dropper  tool to select a colour directly from your image—see 
Selecting a Colour in a Drawing in Chapter 7: Ink and Paint in the Paperless 
Animation Guide.

Matte

Black Point
Increases the transparent (black) portion of the Chroma Key matte. This will 
reduce the edge of the visible image.
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White Point

Reduces the transparent (black) portion of the Chroma Key matte. This will 
increase the edge of the visible image.

Blur Passes Lets you set the number of times the image will be blurred.
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Adjacent Pixels per Pass

When blurring the matte edge's with the Blur Passes parameter, the Adjacent 
Pixel parameter will blur the matte border with the next few pixels (amount indic-
ated in the field) to create a nicer edge.

Output

Threshold Mate
Applies a threshold (tolerance) to the selected colour to be removed. The 
Threshold amount is set in the Threshold field.

Threshold 

Increases or decreases the tolerance for the selected colour to be removed from 
the image. The higher the value, the more coloured pixels will be considered in the  
Chroma-Keying  matte. The pixel colour value will not have to be as close to the 
RGB value as the one selected in the colour swatch. A lower Threshold value 
means the RGB values must be closer to the selected colour in order to be part of 

the matte.

Cut Colour

Removes the selected colour from the image and leaves a transparent zone so 
you can see the background and other layers behind the image. If the option is dis-
abled, the colour will remain, but an alpha channel is created that you can use 
with any other nodes with a a Matte input.
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Colour Banding Node
Use the Colour Banding effect to add a colour banding visual effect to your elements. The node will associate a 
flat colour to the different regions of your element. These regions are delimited according the alpha values that are 
set up in the effect node and which will be recognized on the original element. You can use this effect to change 
the visual style of a particle node, for example, by giving it a more cartoonish look.

In this example, a Colour Banding node has been connected to a fire created with particle effects. 

Refer to the following example to connect this node.

Properties

In the Colour Banding properties, there are four sections with which to set up the four different region's alpha and 
colour override values.
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This is how the regions range are calculated.

 l Region1: Threshold 1 to Threshold 2

 l Region2: Threshold 2 to Threshold 3

 l Region3: Threshold 3 to Threshold 4

 l Region4: Threshold 4 to 100% alpha

Parameter Description

Name Use this field to rename the node.

Threshold 1

Use this first threshold field to determine the first region outer limit. A value of 0 
represent an alpha of 0 which is completely transparent. A value of 100 rep-
resents an alpha of 255 which is completely opaque. If for example, you enter a 
value of 5 for the first threshold, the region of your element which is within the 
range of alpha going from 5% to the Threshold 2 value, will be coloured with the 
Area 1 colour value.

RGBA Enter the value of red, green, blue, and alpha for the first, second, third, and fourth 
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region colour.

Colour Swatch Opens the Colour Picker where you can specify the colour for the first region.

Blur1–4 Add a blur effect to the edge of the first, second, third, and fourth region.
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Colour Art Node
The Colour-Art effect lets you isolate the colour art in a layer. Placing a Colour Art node after a drawing node in the 
Node view only displays the Colour Art output. You can connect the Colour-Art node after nodes of any type. Any 
bitmap information will pass through the node and be processed.

This effect will only work if there is something on the Colour Art layer of the drawing. 

Refer to the following example to connect this node.

 

Properties

347



Chapter 4: Nodes     Filter Nodes

Parameter Description

Name Allows you to change the node's name.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that 
may have been hidden by colour fills might now be visible. Enable the Flatten 
option to cut the extra artwork. Harmony will use the colour fills to cut 
unnecessary artwork. If your zones are not painted, nothing will be cut. This 
option works with both pencil lines and brush strokes.

Apply to Matte Ports on Input 
Effects

At times, you may have situations where your node is placed below a Cutter 
node using a mask input and a drawing input. By default, the effect only 
processes the colours in the drawing input. The mask drawing remains 
untouched. If you want to also filter the mask drawing, select the Apply to 
Matte Ports on Input Effects option.

Antialiasing Quality

Smoothness setting applied to Colour-Art. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the set-
ting, the greater the amount of antialiasing applied. Higher quality images 
require more time to render and more memory from your system. Use a lower 
quality when rendering a pencil test.

Antialiasing Exponent

Controls the extent of the area around the Colour-Art edges used in the anti-
aliasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Colour-Override Node
The Colour-Override effects processes the colours in a drawing layer. Using this effect, you can change colours 
from the palette without affecting the actual palette, swap clone palettes, or even replace a specific colour zone.  
You can also substitute colour areas with bitmap textures. The drawings in this layer must be .tvg files as the 
Colour-Override uses the colour palettes linked to them.

The Colour-Override effect lets you:

 l Change colour values in drawings during the compositing process.

 l Use colour values from a specific colour palette in the palette list.

 l Establish the priority of override palettes in the palette list. For example, you may have different clones of the 
same palette, such as a daytime and nighttime version.

 l Isolate specific areas of a drawing by selecting certain colours. For example, using specific colours to gen-
erate a matte for a glow effect.

 l Hide certain colours.

To learn how to use the advanced functions of the Colour Override node, see: 

Refer to the following example to connect this node.
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Interface

Palettes

The Palettes section displays the palettes in the palette list of the selected layer. You can move these palettes 
into the Whole Palette Overrides section to reorder them. If you have cloned palettes, the higher one in the list will 
override the others. This is useful for overriding the clone palette ordering set in the scene through the Colour 
view. 

You can load additional palettes in the palette list from either your project, by clicking on The Palette  button, 
or your computer by clicking on the Browse  button.

 l The Palette  button allows you to load a palette contained within the project hierarchy (Environment, 
Job, Scene and Elements).

 l The Browse  button allows you to load a palette located outside the project hierarchy, anywhere on 
your system or server. If you link to a palette outside of your project, you will be prompted with the fol-
lowing warning message:

You can hover your mouse over the palette name in any of the override sections to display the path to the palette.
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Colours

The Colours section displays the colour swatches of the selected palette. Move a swatch into the Colour-Overrides 
section to change its value.

Whole Palette Overrides

The Whole Palette Overrides section forces the use of a particular palette (clone palette) or palette list ordering 
during the compositing process. You must drag palettes from the Palettes section to change their order. Harmony 
uses the palettes in the order they appear in the palette list to find the colour values associated with the colour IDs of 
each colour zone. To apply a different version of a colour palette to, for example, switch from a day to a night palette, 
use the Override section to change the order of the colour palettes (you must be working with cloned palettes).

Individual Colour Overrides

When you drag a swatch from the Colours section to this section, you can override its value. You can also override a 
colour with a texture. The default override mode is set to New RGBA so you can override the RGB value as well as 
the transparency value.

The Current column always displays the colours from the currently active palette.  Selecting a clone palette in the 
Palettes area will not change the colours if you haven't changed the active palette in the Whole Palette Overrides 
section. The update will be done once you close and reopen the Colour Override Layer Properties window.
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Render Selected Colours Only

The Render Selected Colours Only section is used to display some colours and ignore all others. You may, for 
example, want to display only the colour used for the character outline and ignore all the filling colours.

Only the colour swatches listed in the Rendered Selected Colours Only section will be rendered. The option is not 
activated by default. If you want to display only the selected colours, you must select the correct option from the 
Rendering menu:

 l Render All: This is the default option. All colours in the palettes are rendered regardless of the listed selec-
tion. This allows you to quickly switch back and forth between your selection of colours and all the colours 
without having to delete and add your swatches from and to the list.

 l Render Selected Colours: When this option is selected, the Colour Override module displays only the 
colours listed in your selection.

 l Rendered Selected Colours and Bitmaps: This option displays all colours listed as well as any bitmap 
images passing through the Colour Override node. For example, if you have a Composite node grouping a 
series of drawing and bitmap nodes, the vector colours will be filtered through the Colour Override nodes 
but the bitmap images will pass through without being affected. Note that you must be in Render View 
mode to see the colours and bitmaps. 

You might have situations where your Colour Override node is placed below a Cutter node using a mask input and 
a drawing input. By default, the Colour Override only processed the colours in the drawing input. The mask 
drawing remains untouched. If you want the Colour Override to also filter the mask drawing, select the Apply to 
Matte Ports on Input Effects option.
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Colour-Scale Node
The Colour-Scale effect offsets an image's colours. This effect is useful in creating ambient transitions, such as 
from daytime to nighttime.

Refer to the following example to connect this node.

Properties
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Parameter Description

Name Use this field to rename the node.

Red, Green, Blue, Alpha The red, green, blue and alpha used to offset the image.

Hue The colour or hue to offset the image.

Saturation The amount of colour to offset the image.

Value

Enter the value for the colour to offset the image. The actual colour values of 
the image are not changed; instead, the channels are multiplied by a selected 
amount. For example:

 l A value of 1 does not change the colour values.

 l A value greater than 1 brings the colour channel value closer to 255 (or 
white).

 l A value less than 1 brings the colour channel value closer to zero (0 or 
black).
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Contrast Node
Use the Contrast effect to increase or decrease the level of contrast in an image. This is done by changing the 
contrast in the dark and bright pixels and setting the transition point between dark and bright.

You can enter static values in the dialog box fields or you can attach these values to function curves to change over 
time.

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Use this field to rename the node.

Mid Point

The value that separates dark from bright colours. The midpoint is a value 
between 0 and 1 that represents the percentage of the 0 to 255 RGB channel 
range.

Pixels with colour values lower than the midpoint: These are considered 
dark pixels. 

Pixels with colour values higher than the midpoint: These are considered 
bright pixels.

Dark Pixel Adjustment and 
Bright Pixel Adjustment

The amount of contrast to be applied to pixels that fall on either side of the Mid 
Point value.

A value equal to 1: No change

A value less than 1: The node makes the pixel colours brighter

A value greater than 1: The node makes the pixel colours darker
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Dither Node
Dithering is the process of approximating a higher number of colours in a low bit-depth colour system. Use the Dither 
effect to give the appearance of greater colour variability in 8-bit per channel colour images. 

Refer to the following example to connect this node.

The Dither effect is useful in the case of a gradient that varies between 100 and 105 in the blue channel, for example. 
Since the difference in the colour values is not great, banding might appear in the image. In this case, use the Dither 
node to give the impression of greater values of blue, decreasing the unwanted banding effect.

The results of the dither operation may be imperceptible.

Properties

Parameter Description

Name Use this field to rename the node.

Magnitude
A magnitude of 1 performs a normal dithering operation, using all bands of colour. 
A magnitude greater than 1 introduces a bias towards brighter colours. A mag-
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nitude of less than 1 creates a faster transition between bands of colour, lessen-
ing the bias towards brighter colours.

Correlate
When selected, the three colour channels (RGB) are changed simultaneously, for 
better colour accuracy. When this option is not selected, the three channels are 
dithered separately, resulting in smoother transitions.

Random The standard algorithm for the dithering operation.
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Focus Node
Use the Focus effect to set up depth-of-field effects for your scene. The Focus node is used to determine how much 
blur will be applied to images, based on their distance from the focal point. 

The focal point can be the zero value of your scene or you can link the Focus node to another node, such as a 
drawing or peg layer, to retrieve the focal point from the node's Z-axis position. 

Refer to the following example to connect this node.

Use the Focus editor to determine how the focus will change as objects move farther from the focal point.

In the Side view window, you can see how the blur values change based on their distance from the focal point. 
Select the Focus node in the Node view, make sure you are using the Transform tool, then right-click on the Side 
view window and select Control from the pop-up menu.
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If you edited the function curve and adjusted the velocity, you can also adjust the Bezier handles in the Side view.

Properties
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Parameter Description

Name Use this field to rename the node.

Mirror Select this option to also blur images in front of the focal point.

Mirror Front/Back Ratio
When the Mirror option is selected, this ratio is applied to the calculation of the 
blur on images in front of the focal point. The default ratio of 1:2 produces realistic 
results. Experiment with different values to create customized effects.

Radius
Controls the amount of blur applied to an element based on its distance from the 
focal point. Click on the Edit Curve button to change these values by adjusting 
the function curve.

Quality
Controls the quality of the blur. A higher quality will achieve better results but will 
be slower to render.
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Focus Multiplier Node
The Focus Multiplier effect works with the Focus node. This node applies a blur to the selected layer, based on 
the blur radius in the Focus node.

Use the Focus Multiplier node when you want to apply the focus to selected elements or when you need to apply 
the focus before doing more effects in a composite operation. 

Refer to the following example to connect this node.

You must disable the Apply Focus option in the Composite node in order to apply the focus effect to the selected 
node only. If you do not disable that option, the focus effect will be calculated twice on the selected node.

Use the Focus Multiplier editor to multiply the Focus Radius by a selected value. You can enter a static value in 
the Multiplier field or attach it to a function curve. 

Properties

Parameter Description
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Name Use this field to rename the node.

Multiplier This is the value by which the normal focus radius value is multiplied.
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Glow Node
T-HFND-010-009B

The Glow effect turns your image into a glow area with a bright soft-edged light or diffuse light region around an 
image. The Glow effect is useful for creating a shining rim around objects, such as the sun or stars. Clone your 
layer or connect it a second time to the Composite node to display the original image on top of the glow.

Refer to the following example to connect this node.
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NOTE: If this effect is connected below a Composite node set to Pass-Through, the effect will be applied to 
each element connected in the Composite node individually. If some of these elements are overlapping, the 
effect will also overlap.

Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Truck Factor
Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When disabled, the effect's values will remain 
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unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type

Radial: The edges of the matte are blurred evenly around points that make up the 
edge of the matte.

Directional: The matte is blurred in the direction you select.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you selected the Directional Blur type, you can set the direction of the blur by 
entering a value from 0 to 360 in this field.

0: Blurs the image to the west.

90: Blurs the image to the south.

180: Blurs the image to the east.

270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

0: Makes the blur fade out slowly, distributing the blur evenly from the edge of the 
character to the farthest edge of the blur.

1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of the 
image.

Invert Matte Inverts the matte used to create the tone, shadow, or highlight.

Use Matte/Source Colour

Creates the shadow or tone using the matte shape's colour. Be sure that you are 
in render mode  to see this effect and that your background is NOT white and 
that you do NOT have a white colour card node attached to the composite. As the 
matte only gives colour information, but no alpha, the matte is automatically mul-
tiplied with the background colours. If there is no colour card attached and the 
background appears black, you will see the matte colour at full opacity. If it is mul-
tiplied with a white background, the colours disappear into the full 255.

Multiplicative Multiplies the tone or shadow colours with the background.

Colour

RGBA
Enter a value to add or subtract from the colour channels in the drawings or attach 
these values to function curves.

Colour Swatch Opens the Colour Picker where you can specify the colour.

Intensity
Lets you set a value to determine the strength of the effect or attach a function to 
animate the effect.
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Grain Node
Use the Grain effect to add a film grain to an image; the film grain looks like video noise.

Refer to the following example to connect this node.

  

You can also use the Matte port to determine where the grain area will be applied. Connect the original image to the 
Matte port to cover it entirely with grain.
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The Grain node has two input ports. 

• On the left port, attach the element that will act as the matte defining the grain area.

• On the right port, attach the element on which you want to apply the grain effect.

Use the Grain editor to adjust the amount of grain to add to an image; you can also use it to adjust the sharpness 
or softness of the grain.

Grain Properties

Parameter Description

Name Use this field to rename the node.

Noise
The amount of grain to add to the image based on the percentage of pixels to 
alter. The larger the value, the courser the grain. The smaller the value is to 0 
(zero), the finer the grain.

Smooth
The amount of blending to apply to the grain effect, based on the blur radius, to 
make the effect appear less pixelated. The larger the value, the greater the 
smoothing.

Random at Each Frame

Computes the colour shift in the grain using a different value at each com-
posite. This means that your images will look different each time you render 
them. Deselect this option and select a Seed Value to ensure the same result 
every time you composite the grain effect.
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Seed Value
This value corresponds to a unique pattern in the grain. If you want to retain 
this pattern in other frames, you can reuse this value.
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Greyscale Node 
The Greyscale effect lets you convert a colour image to greyscale. This example demonstrates what happens 
when you set the greyscale to 100% using the Greyscale node.

You can also use the Contrast node to adjust the darkness and lightness of the pixels in your element.  

Refer to the following example to connect this node.

Properties

Parameter Description
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Name Lets you rename the node.

Percent
Lets you enter the percentage of black and white to apply to the image. You 
can enter a static value in the Percent field or attach the value to a function 
curve to change over time.

Matte Output
Maintains the colour values. However, alpha values are read from the colours 
you see in the Camera view Matte View mode.
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Hue-Saturation Node
The Hue-Saturation effect lets you adjust the hue, saturation and lightness values individually or by using the 
HLS picker or Hue Range picker. You can achieve effects over the entire image, such as a sepia tone. Changes 
you make to the values are additive to the final image.

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.

Refer to the following example to connect this node.

372

https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects
https://www.toonboom.com/resources/video-tutorials/chapter/adam-phillips-harmony-effects


Harmony 14 Premium - Reference Guide

Properties 

Parameter Description

Name Use this field to rename the node.

Master

Allows you to remap all the colours at the same time using the Hue, Saturation 
and Lightness fields. 

Note: When using the Master parameters, the Colorize parameters are disabled.

Opens the Hue Range Picker which displays the original colour spectrum of the 
image in the top bar and the new colour spectrum in the bottom bar. The 
Saturation and Lightness in the upper bar can range from -100 to 100, allowing you 
to decrease the original values.

 

 

Colourize
Lets you set the hue, saturation, and lightness by entering values or by using the 
HSL Picker. In the Colorize mode, Lightness can range from -100 to 100. 
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Select a colour by moving the colour picker.

Note: When using the Colourize parameters, the Master parameters and other 
colour tabs are disabled.

Hue The colour or hue of the image.

Saturation The amount of colour in the image.

Lightness The brightness of the image.

Colour Swatch Opens the HLS Picker where you can specify the colour.

Tabs Reds, Greens, Blues, Cyans, Magentas, Yellows

Opens the Hue Range Picker. The top bar displays the colour spectrum with 
arrows for defining the colour range more precisely. The triangles indicate the 
falloff of the effect, which you can also adjust. 

Specify the hue as an angle from 0° to 360° that corresponds to a location on the 
color wheel. Specify saturation and lightness (B) as percentages (0 to 100).

Reset Range
Resets only the range of hue values over which the effect is applied, i.e. the 
arrows and triangles. The HSL adjustments are maintained.
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Layer Selector Node 
The Layer Selector effect lets you isolate and display one or more art layers:

 l Overlay

 l Line Art

 l Colour Art

 l Underlay 

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Lets you rename the node.

Read Overlay, Line Art, Colour 
Art, Underlay

Turns the display of the Overlay, Line Art, Colour Art and Underlay layers on or 
off.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that 
may have been hidden by colour fills might now be visible. Enable the Flatten 
option to cut the extra artwork. Harmony will use the colour fills to cut 
unnecessary artwork. If your zones are not painted, nothing will be cut. This 
option works with both pencil lines and brush strokes.

Apply to Matte Ports on Input 
Effects

At times, you may have situations where your node is placed below a Cutter 
node using a mask input and a drawing input. By default, the effect only 
processes the colours in the drawing input. The mask drawing remains 
untouched. If you want to also filter the mask drawing, select the Apply to 
Matte Ports on Input Effects option.

Antialiasing Quality

Smoothness setting applied to the art layer. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the quality 
of the chosen setting, the greater the amount of antialiasing that is applied. 
Higher quality images require more time to render and more memory from your 
system.

Antialiasing Exponent

Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Luminance Threshold Node
The Luminance Threshold effect generates a matte by thresholding the luminance of an image. This works well with 
bitmap images that have many shades of colours. A pure vector image with flat colors could use a color override to 
isolate areas.

Thresholding is a method to segment or isolate certain zones in an image. This effect will isolate areas based on the 
image's luminance. Thresholding is used within the Bloom effect—see Bloom Node on page 315. 

Refer to the following example to connect this node.

Properties

Parameter Description
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Name Allows you to change the node's name.

Threshold

Controls how much of the dark value to clamp off. A high value will keep only the bright areas 
of your image.

Soften Colours

Brings back the entire spectrum of luminance in areas defined by the threshold to avoid 
having only bright values.

Gamma Correction

Multiplies the gamma value to make the area brighter or darker.  A value of 1 keeps the 
gamma the same as the original image.  You can use the gamma modification on the whole 
image if you use a threshold of 0 for example.
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Output Greyscale 
Matte

Allows you output an image in grey values to use in combination with a Blending or Cutter  
node elsewhere in the node structure.
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Matte-Blur Node
Use the Matte-Blureffect to blur a matte or change its colour. Here is an example of a network with the result of a 
Matte-Blur effect.

Refer to the following example to connect this node.

NOTE: If this effect is connected below a Composite node set to Pass-Through, the effect will be applied to 
each element connected in the Composite node individually. If some of these elements are overlapping, the 
effect will also overlap.
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Properties

Parameter Description

Name Use this field to rename the node.

Truck Factor

Activated by default, this option readjusts the blur when the elements undergo a 
change of depth or scale. When this option is deselected, the effect's values 
remain unchanged regardless of any depth or scale changes. This option should 
be deselected when multiple drawings are composited and attached to this effect.

Blur Type

Directional: Blurs the matte in the direction you select. For example, if a 
character is walking east, the blur may fall to the west. 

Radial: Blurs the edges of the matte evenly around points that make up its edge.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you select a Blur Directional type, you can select the direction of the blur by 
entering a value from 0 to 360 in this field.

‣ 0: Blurs the image to the west.

‣ 90: Blurs the image to the south.

‣ 180: Blurs the image to the east.

‣ 270: Blurs the image to the north.

Directional Fall-off Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

 l A fall-off rate of zero causes the blur to fade out slowly, distributing the blur 
evenly from the edge of the character to the farthest edge of the blur.

 l A fall-off rate of 1 causes the blur to fade out quickly so that the blur is 
heaviest closer to the edge of the image.
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Invert Matte
Inverts the matte used to create the glow. The matte will become a black sil-
houette while the glow fills the background space.

Use Source Colour
Uses the colours painted in the matte for the glow effect. If you deselect this 
option, select a colour and alpha values in the Colour section.

Multiplicative Creates a more diffused glow.

Colour Lets you choose the colour and alpha values for the glow effect.

Intensity
Lets you set a value to determine the strength of the effect or attach a function to 
animate the effect.
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Matte-Resize Node 
The Matte-Resize effect lets you evenly expand a matte outward in all directions. The matte increases size from its 
centre. 

Refer to the following example to connect this node.

If you use the Matte-Resize node to create a pulsating glow, you can enlarge the region without softening the edges. 
Using the Blur-Radial effect, the effect may be softer than you intend. This node produces a limited antialiased 
matte, which can have slightly jagged edges. You could use this node in combination with other nodes, such as:

 l Tone

 l Highlight

 l Glow

 l Shadow

 l Matte-Blur
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Properties

Parameter Description

Name Lets you rename the node.

Radius
Lets you enter a static value for the radius (size increase or decrease) of the 
matte. You can also attach the Radius value to a function column to change 
the value over time. 
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Median Node
The Median effect lets you reduce the noise in a drawing while preserving its edges. Harmony sorts the values of 
pixels within a specified radius and uses the median value. You can also use this effect to create a Impressionist 
type of style.

The Median effect is only visible when the Camera view is set to Render  mode. 

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Allows you to change the node's name.

Radius

Lets you specify the size of the area of values to consider determining the median value. A 
median is calculated by sorting all the pixel values from the surrounding area into 
numerical order. Then the middle pixel value is used to replace the pixel being considered. 

The median tends to make an image look a bit blurrier because it reduces the contrast of 
adjacent pixels. However, it does a good job of smoothing the image and removing 
artifacts.

Colour Depth

Determines the number of levels per colour channel. The larger the number, the more 
levels of colour are used in the image and the more time it takes to render. Conversely, the 
lower the colour depth, the fewer colours are used, the faster it is to render. 
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Motion-Blur Node
The Motion-Blur effect is used to create a faded trail behind objects animated on a motion path. You cannot create 
a Motion-Blur on a hand-drawn animation. The layer must be moving along a trajectory (motion path) in order to 
work properly.

Refer to the following example to connect this node.

You can also use a matte to apply the blur only on a certain area of the drawing.
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The Motion- Blur effect automatically creates a matte for the drawing layer attached to it, so it is not necessary to 
connect any matte into the Mask layer.

Properties

Parameter Description

Name Use this field to rename the node.

Number of Frames in Trail Number of frames before the current frame that will be used in the trail.

Number of Samples
Number of copies of each drawing used in the trail. The higher the number, the 
more continuous the trail appears.

Fall-off Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1. 

A fall-off rate of 0 causes the trail to fade out slowly, distributing the colour evenly 
from the edge of the character to the farthest edge of the trail. 

A fall-off rate of 1 causes the trail to fade out quickly so that the trail is more 
opaque closer to the edge of the image and transparent at the end of the trail.

Intensity
Select a value to define the opacity of the trail between 0 and 10. A value of 10 will 
make the trail very dark and almost opaque, where as a value of 0 will make the 
trail quite pale and ghostly transparent.
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Use Mirror on Edges

When enabled this option appear when the image is close to the edge of the cam-
era frame. It forces the software to use a mirror of the image to calculate the blur 
so that it appears on both sides of the drawing object. Without this option once 
your drawing reaches the edge of the Camera frame, it gets cropped so does the 
trail.
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Negate Node
The Negate effect lets you invert the colour and/or alpha values in the Colour Art and Line Art of an image. The 
original value of each channel (RGB or A) is subtracted from the maximum value of that channel (255 for 8-bit 
channels) to produce the negative image.

Refer to the following example to connect this node.

Properties

Parameter Description

Name Use this field to rename the node.

Negate Colour Inverts the values of the colour channels.
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Negate Alpha Inverts the transparency value (alpha channel).

Negate Colour Clamp to Alpha Limits the negated area to the alpha channel.
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Overlay Layer Node
The Overlay Layer effect lets you read an element's Overlay Art layer. By placing an Overlay Layer node after a 
drawing node in the Node view, you can display only the node's Overlay layer output. The Overlay Layer node can 
be connected after nodes of any type. Any bitmap information will pass through and be processed. 

This effect will only work if something has been drawn or painted on a drawing's Overlay Art layer. 

Refer to the following example to connect this node.

Properties
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Parameter Description

Name Lets you rename the node.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that 
may have been hidden by colour fills might now be visible. Enable the Flatten 
option to cut the extra artwork. Harmony will use the colour fills to cut 
unnecessary artwork. If your zones are not painted, nothing will be cut. This 
option works with both pencil lines and brush strokes.

Apply to Matte Ports on Input 
Effects

At times, you may have situations where your node is placed below a Cutter 
node using a mask input and a drawing input. By default, the effect only 
processes the colours in the drawing input. The mask drawing remains 
untouched. If you want to also filter the mask drawing, select the Apply to 
Matte Ports on Input Effects option.

Antialiasing Quality

Smoothness setting applied to the art layer. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the quality 
of the chosen setting, the greater the amount of antialiasing that is applied. 
Higher quality images require more time to render and more memory from your 
system.

Antialiasing Exponent

Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Pixelate Node
The Pixelate effect lets you apply a mosaic effect to an image (and its matte) based on the matte you supply. 
Pixelation makes the image look like it is made up of square tiles.

Refer to the following example to connect this node.

Properties

Parameter Description

Name Lets you rename the node.

Factor Lets you control the amount the image is pixelated. You can attach the Factor 
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value to a function curve to change the value over time.

Antialiasing Exponent

Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Remove Transparency Node
The Remove Transparency effect negates transparent values in an image. You can use the Remove Transparency 
node to remove the result of antialiasing around an image.

Refer to the following example to connect this node.

Properties

Parameter Description

Name Lets you rename the node.
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Threshold
All values above the Threshold represent a transparent value. In this field, you 
must identify the value above which all alpha values are considered transparent. 
Alpha is measured from 0 to 255.

Remove Colour Transparency
Determines which pixels in the Colour-Art (RGB channels) to make fully opaque 
or fully transparent.

Remove Alpha Transparency
When selected, the Threshold value is used to determine which pixels in the 
alpha channel to make fully opaque or fully transparent.
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Shadow Node
With the Shadow effect, you can turn a drawing into a shadow. It doesn't matter if the drawing layer is a fully 
coloured character. The Shadow effect will render it into a grey, semitransparent, slightly blurry silhouette. Clone 
your image or connect it a second time to the final Composite node to see the original image displayed on top of the 
shadow.

Refer to the following example to connect this node.

NOTE: If this effect is connected below a Composite node set to Pass-Through, the effect will be applied to 
each element connected in the Composite node individually. If some of these elements are overlapping, the 
effect will also overlap.

Properties

Parameter Description

Enable/Disable Enables or disables the selected node in the Camera, Timeline, and Node views.

Colour Swatch Changes the node and layer colour.

Name Use this field to rename the node.

Truck Factor Activated by default, this option readjusts the blur when the elements undergo a 
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change of depth or scale. When disabled, the effect's values will remain 
unchanged regardless of depth or scale changes. It is recommended that this 
option be disabled when multiple drawings are composited and attached this 
effect.

Blur Type

Radial: The edges of the matte are blurred evenly around points that make up the 
edge of the matte.

Directional: The matte is blurred in the direction you select.

Radius
Enter a value for the size of the blur. The larger the value, the greater the blur 
effect. The blur radius is affected by the drawing scale and camera position.

Directional Angle

If you selected the Directional Blur type, you can set the direction of the blur by 
entering a value from 0 to 360 in this field.

0: Blurs the image to the west.

90: Blurs the image to the south.

180: Blurs the image to the east.

270: Blurs the image to the north.

Directional Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

0: Makes the blur fade out slowly, distributing the blur evenly from the edge of the 
character to the farthest edge of the blur.

1: Makes the blur fade out quickly. The blur is heaviest closer to the edge of the 
image.

Invert Matte Inverts the matte used to create the tone, shadow, or highlight.

Use Matte/Source Colour

Creates the shadow or tone using the matte shape's colour. Be sure that you are 
in render mode  to see this effect and that your background is NOT white and 
that you do NOT have a white colour card node attached to the composite. As the 
matte only gives colour information, but no alpha, the matte is automatically mul-
tiplied with the background colours. If there is no colour card attached and the 
background appears black, you will see the matte colour at full opacity. If it is mul-
tiplied with a white background, the colours disappear into the full 255.

Multiplicative Multiplies the tone or shadow colours with the background.

Colour

RGBA
Enter a value to add or subtract from the colour channels in the drawings or attach 
these values to function curves.

Colour Swatch Opens the Colour Picker where you can specify the colour.

Intensity
Lets you set a value to determine the strength of the effect or attach a function to 
animate the effect.
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Transparency 
T-HFND-010-008

The Transparency effect is used to make an image partially transparent. The Transparency effect is useful when 
fading images in and out, such as a phantom or to make something partially see-through, such as a window.

Author

Christina Halstead
2D Animator and Character Designer

shadowbrushcreations.com

Refer to the following example to connect this node.
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You can enter a value in the Transparency field or change the transparency value over time by linking it to a 
function curve. Entering a value of 100 in the Transparency field will make the element 100% transparent, in other 
words, invisible. Entering a value of 0 will render the element completely opaque.

It is also possible to adjust a layer/node's transparency directly in the Layer Properties window without using the 
Transparency node. In the layer's properties, go to the Drawing tab and adjust the Opacity parameter. This 
parameter is visible in OpenGL mode.

Properties

Parameter Description

Name Allows you to change the node's name.

Transparency
Lets you set the opacity of an element.  Values range from 0 to 100. A value of 
100 will make the element 100% transparent and a value of 0 will render the ele-
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ment completely opaque.
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Underlay Layer Node
The Underlay Layer effect lets you read an element's Underlay Art layer. By placing an Underlay Layer node after 
a drawing node in the Node view, you can display only the node's Underlay layer output. The Underlay Layer node 
can be connected after nodes of any type. Any bitmap information will pass through and be processed. 

This effect will only work if something has been drawn or painted on a drawing's Underlay layer. 

Refer to the following example to connect this node.
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Properties

Parameter Description

Name Lets you rename the node.

Flatten

When placing the node below a Composite node containing several drawing 
nodes, such as a cut-out character, you can use this option to flatten the 
extracted result. For example, when extracting a series of outlines, parts that may 
have been hidden by colour fills might now be visible. Enable the Flatten option to 
cut the extra artwork. Harmony will use the colour fills to cut unnecessary 
artwork. If your zones are not painted, nothing will be cut. This option works with 
both pencil lines and brush strokes.

Apply to Matte Ports on Input 
Effects

At times, you may have situations where your node is placed below a Cutter node 
using a mask input and a drawing input. By default, the effect only processes the 
colours in the drawing input. The mask drawing remains untouched. If you want to 
also filter the mask drawing, select the Apply to Matte Ports on Input Effects 
option.

Antialiasing Quality

Smoothness setting applied to the art layer. Choose from Low (no antialiasing), 
Medium Low, Medium and High (extensive antialiasing). The higher the quality of 
the chosen setting, the greater the amount of antialiasing that is applied. Higher 
quality images require more time to render and more memory from your system.

Antialiasing Exponent

Controls the amount of area around the art layer edges that is used in the 
antialiasing process. A higher value uses less area, resulting in sharper edges, 
while a lower value uses more area, resulting in softer edges. If the Antialiasing 
Quality value is set to Low (no antialiasing), this value is ignored.
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Generator Nodes
The nodes found in the Generator category are nodes that generate an image on their without using any external 
TVG or bitmap drawings. You can adjust the parameters to control the image outputted by these nodes.

Burn-In Node 407

Colour-Card Node 410

Element / Drawing Node 412

Field Chart Node 422

Gradient Node 426

Grid Node 429

Lens Flare Node 432

Turbulent Noise Node 435
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Burn-In Node

The Burn-In effect lets you add scene information which is visible in the Camera view. The information is displayed 
on top of any content in the scene. You can choose to display the scene name, timecode, frame count, environment 
and job, as well as add a frame offset if you need blank frames to precede the scene content. Also, to make the 
information more visible, you can also add a background and choose its colour, and customize the text font and 
alignment.

When you attach a Burn-In node to a Composite node, the burn-in information is rendered when you export the 
scene.

NOTE: When you're working with 3D objects with a high Z position value, you may find the objects obscuring 
the scene information. To work around this, use a peg to ensure the burned in scene information is always vis-
ible.

How to add burn in scene information

 1. In the Node Library, drag a Burn-In node to the Node view.
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 2. Connect it to the Composite node.

 3. On the Burn-In node, click the square yellow properties button. 

The Burn-In property window displays.

 4. In the Show section, enter the following information:

‣ Frame Number: The frame number to start the burn-in information.

‣ Time code: The time code at which the burn-in information starts.

‣ Scene name: By default the scene name, environment and job information is display. Type the 
following to display specific types of information. 

Scene Name: %s

Environment: %e

Job: %j

‣ Frame Offset: Add lead-in frames before the scene begins or at a specific frame. Use positive values 
for frames that precede the scene content and negative values to start your scene information at a 
certain frame number.

 5. In the Text section, customize the text that is displayed.

 6. In the Background section, add a background box to make the text more visible and then customize the col-
our.

Burn-In Properties

Parameter Description
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Name Allows you to change the node's name.

Show

Frame Number Displays the number of the current frame.

Time Code Displays the time code of the current frame.

Scene Name

Lets you display different types of information, including the scene name, envir-
onment and job. You can display one or all of these pieces of information. To 
do so, type the following in the Scene Name field:

• Scene Name: %s

• Environment: %e

• Job: %j
You can rearrange the order in which the information is displayed. For example, 
you may want to see the job before the environment.

Frame Offset
Lets you add blank lead-in frames before the scene or somewhere in the 
scene. Use positive values for frames that precede the scene content and neg-
ative values to start your scene information at a certain frame number.

Text

Font Lets you select a font for the information displayed.

Alignment Lets you set the alignment of the text: Left, Center, Right.

Size Lets you set the size of the text.

Background

Add Background Box
Adds a box behind the scene information which is useful when the scene con-
tains colours or content that may make it difficult to read the scene information.

Colour

Red/Green/Blue/Alpha Lets you enter R, G, B and A values for the colour of the background box.

Colour Swatch

Opens the Colour Picker window where you can select a colour from the 
palette or use the Dropper  tool to select a colour directly from your image—
see Selecting a Colour in a Drawing in Chapter 7: Ink and Paint in the 
Paperless Animation Guide.
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Colour-Card Node

The Colour Card is a solid background the same size as the camera. The Colour Card lets you fill the scene's 
background with a solid colour when there is no background image. If no background or colour card is added to the 
scene, the resulting export will appear with a black background. 

By default, the Colour Card has a Z ordering value of 12 Backward. This puts the Colour card behind all elements 
that have a value lower than 12 Backward. Most of the time, the Colour card will appear automatically behind all 
the scene elements as they are all set to 0 Backward, unless you have changed the Z ordering of the scene 
components. If so, the Colour Card will be in front of the elements that are pushed back to more than 12 fields 
backward.
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Colour Card Properties

Parameter Description

Depth
The value used to determine composition order when the Z value of two elements 
is the same.

Offset Z
The front-back position of the Colour Card layer in 3D space. This value can be 
verified in the Top view.

Red/Green/Blue/Alpha

The colour and transparency of the Colour Card. You can also attach these 
parameters to function columns to change their values over time. 

Click the colour swatch to open the Colour Picker window and select a colour.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.
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Element / Drawing Node
The drawing layer's properties is composed of the following tabs:

Transformation Tab

The Transformation tab contains parameters for adjusting the position, scale, rotation, skew and pivots of an 
element.

When the Enable 3D option is selected, additional parameters appear in the Rotation and Pivot sections to rotate 
objects on 3 axis in the 3D space.

Parameter Description

Enable 3D Displays additional parameters for working with 3D objects.

Position 3D Path: Lets you use a 3D path function to animate an element.
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Separate: Lets you independently edit the different coordinate fields.

Path (x) Axis: Lets you type in a new East/West coordinate corresponding to 
the desired position.

Path (y) Axis: Lets you type in a new North/South coordinate corresponding to 
the desired position.

Path (z) Axis: Lets you ype in a new Forward/Backward coordinate 
corresponding to the desired position.

Velocity: When the 3D Path option is selected, lets you set the speed at which 

Scale

Locked: Resizes the element while keeping its ratio. The X and Y axes scale 
proportionally

Separate: Resizes the element allowing to modify the ratio (squash and 
stretch).

(x) Axis: Lets you type in the horizontal scale value.

(y) Axis: Lets you type in the vertical scale value.

Scale in Fields: Instead of using the standard scaling units, when this option 
is enabled, images are scaled using field units, based on the traditional 
animation field chart.

Ignore Parent Scaling: When this option is enabled, any scaling value 
applied to a parent layer is ignored in the current layer. This can be handy in 
cut-out rigs when you need to scale an arm without affecting the forearm. 

Rotation
Angle z: Lets you  type in a degree value for the rotation angle. Note that you 
can enter values greater than 360 and -360 degrees. If you enter 720, the object 
will rotate twice.

Skew Skew: Lets you type in a degree value between -90 to 90 for the skew angle.

Pivot

(x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

(y) Axis: Lets you ype in a new North/South coordinate corresponding to the 
desired position.

Drawing Pivot

Use Embedded Pivots: 

Harmony has three types of pivots:

 l Permanent Pivot

This is a permanent pivot, sometime referred to as peg pivot, that is applied to 
the entire drawing or peg layer. If you modify its position, it will be changed for 
the entire layer, modifying the animation, scale and rotation interpolation. The 
permanent pivot is set using the Rotate, Translate or Scale tool. The 
Transform tool will only move that pivot temporarily for positioning purposes, 
but the animation interpolation will be done from the original permanent pivot's 
position. The Transform tool is designed to move the pivot temporarily during 
the animation process. It also permits you to select multiple pegs and apply a 
common temporary pivot.
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To permanently move a peg pivot, use the Rotate  or Scale  tool. You can also 
directly type the values in the Layer Properties window in the Pivot section's 
(x) Axis and (y) Axis fields.

In the Layer Properties window, in the Drawing Pivot section, select the Don't 
Use Embedded Pivot option to use the permanent pivot.

 l Drawing Pivot

The Drawing pivot is contained within each drawing. In one layer, each drawing 
can have its own pivot. If you have many different views of a character within 
one layer, the pivot positions can be different and the animation will adjust to 
the pivot. The Drawing pivot can also be referred to as embedded pivot. If you 
are not mixing different views within the same layers or are using pegs to 
animate your layers, it is recommended to use the permanent pivot.

You can set a different pivot for each one of your drawings. For example, if you 
have a series of drawings from different views, they are not likely to rotate from 
the same location. In that case, you can set a different pivot for these drawings 
by using the Drawing Pivot  tool.

In the Layer Properties window, in the Drawing Pivot section, select the Apply 
Embedded Pivot on Drawing Layer option to use the drawing pivot directly 
on the drawing layer. If you want to apply the drawing pivot to a parent peg to 
force the peg to follow the drawing pivot variations, enable the Apply 
Embedded Pivot on Parent Peg option.

 l Symbol Pivots

The Symbol pivot is similar to the Drawing pivot. Each symbol cell can have its 
own pivot and act the same as the Drawing pivot. The Symbol pivot can also 
be referred to as embedded pivot. Inside a symbol, each drawing can have its 
own pivot. If you are not mixing different views within the same layers or are 
using pegs to animate your layers, it is recommended to use the Peg pivot.

For a simple character rig, it is recommended to set the Peg pivot (even on 
drawing layers) using the Rotate  tool.
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Drawing Tab

The Drawing tab contains parameters for the element and timing columns, designating art layers, and setting bitmap 
options.

Parameter Description

Element Columns

Full Name: Select which element to connect to the node from the list of elements 
that already exist in your scene.  

Drawing Path: Displays the full path to the current drawing.

Timing Columns

Name: Path to the file you want to link to.  

Timing Column: Link to the column that contains the desired timing.  

Extension: When linking to a background file, enter its file name extension.  

Field Chart: If you are importing traditional animation, select the size of the paper 
on which the animation was drawn.

Art Layers

Overlay Art Enabled: Enables the Overlay Art display.

Line Art Enabled: Enables the Line Art display.

Colour Art Enabled: Enables the Colour Art display. 

Underlay Art Enabled: Enables the Underlay Art display.  

Overlay Art Type: Allows you to set the Overlay Art as Vector or Bitmap type.

Line Art Type: Allows you to set the Line Art as Vector or Bitmap type.

Colour Art Type: Allows you to set the Colour Art as Vector or Bitmap type.

Underlay Art Type: Allows you to set the Underlay Art as Vector or Bitmap type.
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Bitmap File Options

When an image is created with an external software and that image has some 
transparency, there are several formats the software can use when writing the 
RBG channels. The purpose of the four import options for the transparency is for 
the user to tell Harmony how to interpret the RGB channels of the imported 
image. The correct option has to match the ouput format of the software that was 
used to create the image in the first place. For instance, if the you used Adobe 
Photoshop and exported an image as Straight, then it should be imported in 
Harmony as Straight in order to get the correct result. 

Note that if the image has no alpha channel or if it does have an alpha channel and 
all the pixels are 100% opaque, it does not make any difference which option is 
selected. 

Colour: Controls the production of colour information from bitmap images. If this 
module reads 3 or 4-channel bitmaps, this selection determines whether the 
colour should be read or ignored. If this module reads 1-channel bitmaps, this 
selection determines whether the channel should be read as colour. When this 
option is selected with 1-channel images, the resulting image will be a greyscale 
image.  

Transparency: Controls the production of alpha information from bitmap images. 
If this module reads a 1 or 3-channel image, this option will create a matte from 
the colour values in the image. If the module reads a 4-channel image and this 
option is not selected, the alpha information in the image will be ignored.

Transparency Type  

Premultiplied with Black: Semi-transparent pixels in the original image are 
blended with black. 

Premultiplied with White: Semi-transparent pixels in the original image are 
blended with white. 

Straight: Semi-transparent pixels in the original image are left as is (unmatted). 

Clamp Colour to Alpha: Semi-transparent pixels in the original image are 
blended with black. On import, each of the RGB channels is clamped so that a 
color value never exceed the alpha value for a given pixel. When the RGB values 
are multiplied with the alpha value, that is to say, if you have a pixel of value 
R=247, G=188, B=29 and the alpha is 50% or the image has a 50% transparency, 
then the actual RGB values output would be half of the amounts listed above.
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Controls Tab

The Controls tab contains animation control options.

Parameter Description

Animation

Animate Using Animation Tools: By default, a drawing layer can be animated 
using the same parameters as a peg, but you can disable this feature. Being able 
to switch your drawing layers so they can no longer be animated without a peg 
has certain advantages. In cut-out animation, it is easier to separate your drawing 
exposure and keyframes to change timing easier and rearrange keyframe position 
in the Timeline view. This feature is also available for backward compatibility 
when bringing in templates created in older versions of the software, so as not to 
lose their offset keyframes or drawing substitution keyframes.

Angle Limit Values

Lets you set a maximum and minimum rotation angle for a drawing. This option is 
used mainly for a cut-out character when you do not want an elbow to bend too far 
in or out. 

 Enable Min/Max Angle: Activates the minimum and maximum angle 
constraints. 

Min Angle: Type the minimum angle you want the drawing to rotate too. 

Max Angle: Type the maximum angle you want the drawing to rotate too.

Spline Offset

In the X, Y and Z axis fields, type the coordinates of where you want to offset the 
visual trajectory. By default, the trajectory is displayed at the centre drawing 
using the layer's pivot position. If you want to move it so it corresponds better 
with your drawing, either type new coordinates or use the Spline Offset  tool 
available in the Advanced Animation toolbar.  

To display the trajectory in the Camera view, select your drawing and select View 
> Show > Control. You can also press Shift + F11 (Windows/Linux) or ⌘  + F11 
(Mac OS X).

Advanced Tab 

The Advanced tab contains options for setting the alignment of drawings, clipping, line thickness, vector render 
options, and more.
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Parameter Description

Alignment

Alignment Rule: The alignment rule selections are intended to deal with 
drawings that were created on paper of a different size or orientation from the 
default alignment rule (set up in the Scene Settings dialog box) or imported 
bitmap images. The drawings are then scaled to match the Harmony alignment 
rectangle. Note that alignment rules are not based on the camera frame, but on 
the scene frame. Refer to the Fundamentals Guide to learn more about scene 
alignment and scene settings.

• Left: The default alignment for drawings; aligns the drawings to the left 
side of the scene’s alignment rectangle. Harmony scales the drawings 
to match their height to the alignment rectangle of the scene.

• Right: Aligns the drawings to the right side of the alignment rectangle. 
Harmony scales the drawings to match their height to the height of the 
alignment rectangle of the scene.

• Top: Aligns the drawings to the top of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.

• Bottom: Aligns the drawings to the bottom of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.
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• Centre Fit: Centers the drawings.

• Centre Fill: Centers the drawings and then scales them so the width or 
height fills the available space.

• Centre LR: Aligns the drawings in the left-right centre of the alignment 
rectangle. Harmony scales the drawings to match their height to the 
height of the alignment rectangle of the scene.

• Centre TB: Aligns the drawings in the top-bottom centre of the 
alignment rectangle. Harmony scales the drawings to match their 
widths to the width of the alignment rectangle of the scene.

• Stretch: Scales the drawings so they fit within the alignment rectangle 
of the scene. This is particularly useful for images that you will 
manipulate with a Quadmap node. If the drawings in the Quadmap node 
do not have the same aspect ratio as the alignment rectangle of the 
scene (from the Scene Settings dialog box), the handles on the 
quadmap will not appear on the corners of the image, making it difficult 
to manipulate the quadmap. In this case, you would set the drawing 
layer of the quadmap images to Stretch to make the handles appear on 
the corner of the image. This can have the effect of distorting the 
images, but it is not an issue with images that will be distorted through 
the Quadmap node anyways.

• As Is: Leaves the drawings aligned as they are. 

• Centre First Page: Aligns the centre of the first part of a standard pan 
cel with the centre of the field chart.

Turn Before Alignment: Rotates  the drawings in the selected element 90 
degrees to the left before scaling and aligning them according to the alignment 
rule, and before performing any offset, rotation or scaling for the element or 
peg. This and the Alignment Rule are intended for drawings that were created 
on paper of a different size or orientation than the other paper in the scene, and 
requires alignment  so they are treated accurately.

Flip Horizontal: Flips the drawing on the X-axis.

Flip Vertical: Flips the drawing on the Y-axis.

Clipping

No Clipping: Select this option if you do not want to clip the images in this 
node before an effect is applied to it.

Clipping Factor (X)/(Y): This is an option for rendering images that are larger 
than the final frame. With this option enabled, images can be moved by an 
Apply Peg Transformation node without black entering into the composite as 
a result of early clipping. In addition, this option is useful for images that have a 
blur that should appear in the frame even though the image itself is not in 
frame.

Line Thickness

As you move the camera in your scene along the Z-axis, notice that, logically, 
the lines of the elements become thicker the closer the camera gets to the 
drawing. If you prefer the lines to remain the same size or become thicker at a 
different speed, you can use the thickness feature to adjust your brush stroke 
and pencil line thickness. You can modify the size of the lines even if the 
camera is not animated.
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 l Adjust Pencil Lines Thickness: Lets you work with pencil lines and 
adjust their thickness. You will not see any changes to lines in the Cam-
era view OpenGL mode. You must switch to the Render mode.

 l Normal Thickness: Disables all overrides on the brush stroke line thick-
ness. This option must be enabled in order for the pencil line thickness 
parameter and pencil lines to appear. If you want to modify the brush 
stroke thickness, deselect this option. To enable brush strokes to work 
with the line thickness feature, you must first create central strokes in 
the Colour Art layer. The central strokes control the line variation of your 
brush strokes in the Line Art layer. Select Drawing > Create Colour 
Art from Line Art.

 l Zoom Independent Thickness: Select this if you want your line thick-
ness to remain constant independently from the camera move. 
Everything else will increase in size, but the line thickness will stay the 
same.

 l Proportional: Enter a multiple by which you want to increase the line 
thickness base on its original thickness. A value of 1 will result in no 
change; a value of 0 (zero) will hide the lines.

 l Constant:  Enter a value in pixels (based on a 720x540 screen res-
olution) to indicate the amount of pixels you want to add around the 
existing line.

 l Minimum: Enter a value in pixels (based on a 720x540 screen res-
olution) for the minimum line thickness allowed.

 l Maximum: Enter a value in pixels (based on a 720x540 screen res-
olution) for the maximum line thickness allowed.

Vector Render Options

• Antialiasing Quality: A smoothness (antialiasing) setting applied to the 
final rendered image. 

• Low: No antialiasing 

• Medium Low: Basic antialiasing

• Medium: Improved antialiasing (blurs the textures)

• High: High quality antialiasing (does not blur the textures)

Higher quality images require more time to render and more system 
memory. Choose a lower quality if you are rendering a pencil test.

• Antialiasing Exponent: Controls the size of the area around the final 
image edges used in the antialiasing process. A higher value uses less 
area, resulting in sharper edges, while a lower value uses more area, 
resulting in softer edges. If the Antialiasing Quality value is set to Low 
(no antialiasing) or Medium Low, this value is ignored. Values: Between 
0 and 1.

• Texture Filter: This option changes the way coloured pixels of TVG 
textures are calculated when rendered for different degrees of accuracy. 

• Bilinear: This option takes the four pixels around each point and 
makes a bilinear interpolation between them. (Medium Quality)

• Nearest: This option chooses the colour of the closest pixel to a 

420



Harmony 14 Premium - Reference Guide

point. (Lower Quality)

• Nearest (Filtered): This option is an improved version of Bilinear 
and improves the quality when zooming on a texture. (Best Quality)

Miscellaneous

• Depth: Overrides the order of cables in the node system to determine 
the forward/backward order in which this element is rendered. The Z 
position value overrides the depth value.

• Morphing Velocity: Creates a velocity function curve for morphing 
sequences in the layer. This function modifies the interpolation 
percentage between the 2 drawings. If set, the morphing between the 
two drawings will not be linear over time between the two drawings but 
will be modulated according to this curve.  This can be used to create a 
periodic morphing over a long period of time.

• Opacity: Lets you quickly change the transparency of the selected 
element. Opacity settings here will be reflected in both OpenGL 
preview, and full render. 
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Field Chart Node

The Field Chart node displays a traditional animation field chart, which allows you to position elements in the 
Camera view. The Field Chart node doesn't export. If you want to export a field chart, use the Grid node—see Grid 
Node on page 429.
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Field Chart Properties

Parameter Description

Name Lets you rename the node.

Drawing

Size
Adjusts the number of units in the grid (field chart). The grid size will always be a 
4:3 ratio, as per traditional animation standards. The gird is available in 12 or 16 
fields.

Opaque
Inserts  a white background behind the grid and covers everything else behind it. 
By default, you can see through the grid.

Antialiasing

• Antialiasing Quality: A smoothness (antialiasing) setting applied to the 
final rendered image. 

• Low: No antialiasing 

• Medium Low: Basic antialiasing

• Medium: Improved antialiasing (blurs the textures)

• High: High quality antialiasing (does not blur the textures)

Higher quality images require more time to render and more system 
memory. Choose a lower quality if you are rendering a pencil test.

• Antialiasing Exponent: Controls the size of the area around the final 
image edges used in the antialiasing process. A higher value uses less 
area, resulting in sharper edges, while a lower value uses more area, 
resulting in softer edges. If the Antialiasing Quality value is set to Low (no 
antialiasing) or Medium Low, this value is ignored. Values: Between 0 and 
1.

Alignment Rule
The alignment rule selections are intended to deal with drawings that were 
created on paper of a different size or orientation from the default alignment rule 
(set up in the Scene Settings dialog box) or imported bitmap images. The 
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drawings are then scaled to match the Harmony alignment rectangle. Note that 
alignment rules are not based on the camera frame, but on the scene frame. Refer 
to the Fundamentals Guide to learn more about scene alignment and scene 
settings.

• Left: The default alignment for drawings; aligns the drawings to the left 
side of the scene’s alignment rectangle. Harmony scales the drawings to 
match their height to the alignment rectangle of the scene.

• Right: Aligns the drawings to the right side of the alignment rectangle. 
Harmony scales the drawings to match their height to the height of the 
alignment rectangle of the scene.

• Top: Aligns the drawings to the top of the alignment rectangle. Harmony 
scales the drawings to match their widths to the width of the alignment 
rectangle of the scene.

• Bottom: Aligns the drawings to the bottom of the alignment rectangle. 
Harmony scales the drawings to match their widths to the width of the 
alignment rectangle of the scene.

• Centre Fit: Centers the drawings.

• Centre Fill: Centers the drawings and then scales them so the width or 
height fills the available space.

• Centre LR: Aligns the drawings in the left-right centre of the alignment 
rectangle. Harmony scales the drawings to match their height to the height 
of the alignment rectangle of the scene.

• Centre TB: Aligns the drawings in the top-bottom centre of the alignment 
rectangle. Harmony scales the drawings to match their widths to the width 
of the alignment rectangle of the scene.

• Stretch: Scales the drawings so they fit within the alignment rectangle of 
the scene. This is particularly useful for images that you will manipulate 
with a Quadmap node. If the drawings in the Quadmap node do not have 
the same aspect ratio as the alignment rectangle of the scene (from the 
Scene Settings dialog box), the handles on the quadmap will not appear on 
the corners of the image, making it difficult to manipulate the quadmap. In 
this case, you would set the drawing layer of the quadmap images to 
Stretch to make the handles appear on the corner of the image. This can 
have the effect of distorting the images, but it is not an issue with images 
that will be distorted through the Quadmap node anyways.

• As Is: Leaves the drawings aligned as they are. 

• Centre First Page: Aligns the centre of the first part of a standard pan cel 
with the centre of the field chart.

Turn Before Alignment

Turn Before Alignment: Rotates  the drawings in the selected element 90 
degrees to the left before scaling and aligning them according to the alignment 
rule, and before performing any offset, rotation or scaling for the element or peg. 
This and the Alignment Rule are intended for drawings that were created on paper 
of a different size or orientation than the other paper in the scene, and requires 
alignment  so they are treated accurately.

Depth Overrides the order of cables in the node system to determine the 
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forward/backward order in which this element is rendered. The Z position value 
overrides the depth value.

Position

Animate Using Animation 
Tools

By default, the grid can be animated using the same parameters as a peg, but you 
can disable this feature so the field chart remains in place. You can connect it to a 
peg to animate it or move it.

When  this option is deselected, you cannot move the layer in the Camera view 
using the Transform and Advanced tools. This prevents you from accidentally 
displacing or modifying a layer.

Position

3D Path: Lets you use a 3D path function to animate an element.

Separate: Lets you independently edit the different coordinate fields.

Path (x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

Path (y) Axis: Lets you type in a new North/South coordinate corresponding to 
the desired position.

Path (z) Axis: Lets you ype in a new Forward/Backward coordinate 
corresponding to the desired position.

Scale

Locked: Resizes the element while keeping its ratio. The X and Y axes scale 
proportionally

Separate: Resizes the element allowing to modify the ratio (squash and stretch).

(x) Axis: Lets you type in the horizontal scale value.

(y) Axis: Lets you type in the vertical scale value.

Scale in Fields: Instead of using the standard scaling units, when this option is 
enabled, images are scaled using field units, based on the traditional animation 
field chart.

Angle Z
Lets you  type in a degree value for the rotation angle. Note that you can enter 
values greater than 360 and -360 degrees. If you enter 720, the object will rotate 
twice.

Pivot

(x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

(y) Axis: Lets you ype in a new North/South coordinate corresponding to the 
desired position.
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Gradient Node

The Gradient effect lets you create a transition of colour or alpha values between two areas of colours. You can 
create a linear or radial gradient. Use two points to indicate where those two coloured areas are. You can then 
move these points to create the transition.

The Gradient node covers the entire camera frame and beyond. You do not need to scale it up or down. It will 
automatically cover an infinite zone. You simply need to connect it behind your scene's elements. You can 
connect it in front of some elements you want to cover. By default, the Gradient has a Z ordering value of 0. When 
you select the Gradient node, the Camera view displays yellow triangles to indicate that it's selected.

Use the Gradient property editor to modify the values of the gradient and the position of its output.

Controlling the Gradient in the Camera View

If you want to control the gradient's orientation and points position in the Camera view, you can use the Control 
command to display the points and move them.

How to control the gradient in the Camera view

 1. In the Tools toolbar, select the Transform  tool.
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 2. In the Node view, select the Gradient node.

 3. From the top menu, select View > Show > Control.

 4. In the Camera view, click the Gradient's points and move them.

Gradient Properties
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Parameter Description

Gradient Type Lets you select a linear or radial gradient.

Point 1, Point 1
These sections control the values of the first point (point 0) and the second 
point (point 1) in the gradient.

Red, Green, Blue, Alpha

The colour and alpha values of the corresponding point. You can also click the 
colour swatch to open the Colour Picker window and select a new colour. 
These colours can be animated over time if the value parameter is attached to 
a function curve. Default values: 0,0,0 and 255, 255, 255.

(x) Axis Sets the X coordinate for the corresponding point.

(z) Axis Sets the Y coordinate for the corresponding point.

Offset Z
Enter the front-back position of the Gradient layer in 3D space. You can verify 
this value in the Top view.

Depth
Determines the composition order when the Z value of two elements is the 
same.
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Grid Node

The Grid node displays a grid, in field chart unit, which allows you to position elements in the Camera view.
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Grid Properties

Parameter Description

Name Lets you rename the node.

Size

Adjusts the amount of units in the grid (field chart). The grid size will always be 
a 4:3 ratio, as per traditional animation standards, but will adjust the camera 
frame width. You can change the grid to adjust to the camera frame by 
deselecting the Fit Vertical option.

Aspect

The grid size default format is 4:3 ratio, as per traditional animation standards, 
but will adjust the camera frame width. You can change the grid ratio by entering 
a new ratio. To find your scene ratio, select Scene > Scene Settings.
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Fit Vertical

Makes the grid size adjust the camera width or height.

Display Text Turns the display of numbers on or off.

Fill
Makes the grid's background opaque. Nothing behind will be shown. You can 
also click on the colour swatch to open the Colour Picker window and select a 
background colour.

RGBA
The colour and alpha values of the corresponding point. You can also click on 
the colour swatch to open the Colour Picker window and select a grid or 
background colour. Default values: 0,0,0 and 255, 255, 255.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.
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Lens Flare Node

The Lens Flare effect simulates the refraction caused by shining a bright light into a camera lens. The shape of 
the lens flare can be circular or hexagonal.

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.

Here is how a typical lens flare can be set up:
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Lens Flare Properties 

Parameter Description

Flares

Flare Type
Custom: Lets you use your own custom art or drawing.

Type 1: Circular lens flare.
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Type 2: Hexagonal lens flare.

Blend Mode: Normal/Screen

Lets you apply a normal or screen blending mode to the image.

Normal: When selected, this operation will not create any blending mode effect.

Screen: When deselected, this operation multiplies the inverted colour of the 
blending element with the image. This lightens the colour of the overlapping area. 
Screen is the default blending mode.

Position X, Y, Z Lets you precisely orient the flare in the x, y, and z axes.

Brightness

Intensity The strength of the lens flare.

Red Red values of the image.

Green Green values of the image.

Blue Blue values of the image.

Alpha Alpha values of the image.

Colour Swatch Opens the Colour Picker where you can specify the colour of the main flare.

Flare 1–10
Lets you create custom lens flares by associating them with specific drawings. 
You can create up to 10 different flares.

 

Drawing: Lets you specify a drawing to use for the flare.

Position: The position of the flare. 

Size: The size of the flare.

Blur Intensity: The strength of the flare.
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Turbulent Noise Node

The Turbulent Noise effect uses Perlin noise to create greyscale noise for organic-looking backgrounds, 
displacement maps, and textures, or to simulate clouds, fire, lava, steam, flowing water, or vapour. The Turbulent 
Noise effect models turbulent systems with smaller noise features moving more quickly than larger noise features.  
The Turbulent Noise effect creates smooth animations and takes less time to render than other noise or grain 
effects. 

For detailed video tutorials and sample scenes by Adam Phillips, see toonboom.com/resources/video-
tutorials/chapter/adam-phillips-harmony-effects.
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Turbulent-Noise Properties

Parameter Description

Noise Type

Perlin: Creates pseudo random patterns. The greyscale contains a continuity 
between different tones of grey.

Simplex: Creates a more contrasted noise pattern with more variation than Per-
lin. There is a smooth variation of intensity.

Sinusoidal: Creates a repeated wavelike pattern.

Sub Scaling: Applies Perlin noise twice. The second noise is added where 
dark areas appear in the original. The frequency of the second iteration is 
higher so the noise is smaller.

Rocky: Uses the Perlin pattern but converts the very high and low values to 
more moderate values. For example, the whites become light greys and the 
blacks become dark greys.

Small Bumps: Uses the Perlin pattern. The transitional grey areas between 
blacks and whites become inverted so they look like dark lines. The extremes, 
black and white areas, become whitish.

Fractal Type

Transforms the noise pattern, created by the Noise type and controls the way 
layers are composited. These are variations of the basic noise.

Turbulent Twist: Applies a turbulent effect on the pattern so it changes the 
transition between black and white by adding more modulation.

Fractional Brownian: Applies a basic application of noise and composites by 
adding subsequent layer with the Complexity parameter.

Threshold: Changes the dark greys into black values so there is more black in 
the noise for higher contrast.

Invert Threshold: Inverts all the values of the Threshold type so a negative 
image of it is created.

Terrain: Adds contrast and converts the dark greys into white or light greys.

Frequency
The density of displacement appearing in the noise. A higher value produces a 
greater amount of displacement in a given area; a lower value produces a smal-
ler amount.

Offset Moves the entire image.

Locked Applies parameter value while retaining the X and Y ratio.

Separate Allows you to apply different parameter values to X and Y.
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xy
When locked, applies parameter values to both X and Y. When separated, 
allows you to apply different value to X and Y.

Evolution Determines the displacement pattern over time.

 
Evolution Frequency: This factor makes the complexity iterations animate or 
transform at a higher speed. In other words, the second, third, etc. passes, con-
trolled by the Complexity parameter, will mutate faster than the main one.

Complexity

Complexity: The number of noise layers that make up the noise. Each suc-
cessive layer has a higher frequency, resulting in a smaller noise effect. You 
can have up to seven passes. Increasing this number increases the depth and 
amount of detail in the noise. Use Complexity with Sub Scaling when the value 
is 1 or greater. Note: Increasing the Complexity results in longer rendering 
times. 

 

Gain: Controls the amount of opacity present in the iteration of noise. This also 
affects the layer when using Sub Scaling. With a value of 0, you will not see 
the sub noise. A value of 1 will show the sub noise just as strong as the main 
one. For example, with water ripples, a higher amount of Gain will reveal more 
ripple or subripples.

 

Sub Scaling: The factor by which the main noise is modified at each iteration 
of complexity. A value of 1 make the two noises identical. A value of 2 makes 
the sub noise twice as small. The next iteration would be 4 times smaller. Val-
ues must be greater than 1.

 
Depth:  This value determines the composition order when the Z value of two 
elements is the same.
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Group Nodes
The nodes found in the group category are used to organize the Node view by grouping nodes and providing input 
and output ports for these groups.

Group Node 439

Multi-Port-In Node 440

Multi-Port-Out Node 441
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Group Node
You can group your elements to keep your work organized.

How to group nodes

 1. In the Node view, drag a selection around the nodes you want to group.

 2. In the Node menu, do one of the following:

 l Select Edit > Group > Group Selected Layers.

 l Press Ctrl + G (Windows/Linux) or ⌘  + G (Mac OS X).

You can also right-click in the Node view and select one of the following:

 l Group > Group Selection With Composite or press Ctrl +Shift + G (Windows/Linux) or ⌘  + 
Shift + G (Mac OS X).

 l Group > Group Selection or press Ctrl + G (Windows/Linux) or ⌘  + G (Mac OS X)

The selected nodes are grouped.

NOTE: 
To ensure that you have a Multi-Port Out node in your group and that your group remains connected, include a 
Composite node in your selection and make sure it is connected to the main Composite node of the scene 
before grouping.
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Multi-Port-In Node
A Multi-Port-In node is added by default in a new Group node. Use it to add one or more input ports to the Group 
node so that you can process an image through the nodes in the Group node. 

When you plug an element to a Multi-Port-In node, an input port appears at the top of the Group node. You can add 
additional ports to the nodes as needed.

Pass your cursor over the Group node input port to see the name of the Port Image In node that it connects to. 
You will notice that the Group node in these examples has no output port. It requires a Multi-Port-Out node to 
output data from its network.

A Multi-Port-In is automatically added when you create a group.

Use the Multi-Port-In editor to rename the node.
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Multi-Port-Out Node
A Multi-Port-Out node is added in a new Group node by default. Use it to add output ports to the Group node so that 
you can output the result of the group operation to the rest of the network. After you plug an element to a Multi-Port-
Out node, an output port appears on the bottom of your Group node. You can add additional output ports as needed.

A Multi-Port-Out is automatically added when you create a group.

Use the Multi-Port-Out editor to rename the node in the network.
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Miscellaneous Nodes
The nodes found in the Miscellaneous category are various nodes used to either add notes to the Node view, use 
external scripts or previous and hide elements in OpenGL and Render view.

External Node 443

Note Node 446

Render Preview Node 447

Script Node 448

Visibility Node 449
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External Node
Use the External node to process images through external programs and input the resulting images back into the 
network. Note that not all programs work with the External node.

Using the External node lets you avoid having to export your animation to another software to do some processing 
over it and then bringing it back to Harmony. This way, you can modify your scene and animation as much as you 
want and still use the effects or render process from a third-party software.

NOTE: Harmony also supports OpenFX plugins.

The External node writes input files to temporary files on the system. It then calls the external program, which will 
process the input images. If two images are input into the node, the program must composite them together to 
produce one output image. Finally, the file produced by the external program is read back into the network.

The command is sent to the external program in the following format:

program_name file_1 file_2 output_file numerical_param extension
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Use the External editor to control the program that is launched by the node, the files that it reads, and the file that 
it outputs into the network.

In this example, the ImageMagick 6.3 software was used without a matte connection.

Use the External editor to write down the parameters matching the chosen external program.

External Properties

Parameter Description

External Program

The name of the program launched by the External node. This field can include 
a full or relative path to the executable file. If no path is entered, the user's path 
is searched to locate the program.

Enter the command directly into this field. 

For example:

mogrify -spread $NUM $IN1

Where:

mogrify: Is the name of the program

spread: Is the option to be applied, 

$NUM and $IN1: Are the numerical parameter and first input file variable 
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declared in the External node.

Program First Input File ($IN1)
The name and location of the temporary file that Harmony will write to the file 
system for the external program to read. It must not include the dot or the exten-
sion; the External node will add these based on the Extension field.

Program Second Input File 
($IN2)

When processing two files through this node (such as an image and a matte), 
this is the name and location of the second temporary file that Harmony writes 
to the file system for the external program to read. It must not include the dot or 
the extension; the External node will add these based on the Extension field.

Program Output File ($OUT)
The name and location of the temporary file that the external program will write 
to the file system so that Harmony can read it back into the network.

Extension ($EXT) The file type that will be processed by the external program.

Numerical Parameter($NUM)
A value passed to the external program as a file processing option. It can be 
attached to a function curve to change over time.

The program files are temporary files that are overwritten at each frame as the node is executed. They are only 
meant to temporarily store the image that is being processed at each frame.

Generate Unique FileNames

If this option is enabled, the temporary output file will have a unique iden-
tification number added to its name to avoid any file override if another scene or 
External script is rendered at the same time. It could be possible to have an 
override when two scenes using the External nodes are rendered in batch pro-
cessing.
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Note Node
The Note node allows you to record any textual information that is relevant to your project. You can add 
comments, suggestions or reminders. You can add Note nodes anywhere in the network, including groups.
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Render Preview Node
To adjust the effect's visual controls in OpenGL mode, from the Node Library view, drag a Render Preview node to 
the Node view. Connect it between the effect and the Composite nodes.
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Script Node
Use the script node to enter your own scripts to execute whatever custom functions you desire.

Properties

Parameter Description

Name Use this field to rename the node.

Tabs

Attributes
By default this tab does not specify any function. You can enter script in the 
Specifications tab to create functions for the Attributes tab.

Specifications Enter code to create functions for the Attributes tab.

Softrender Enter or browse for script to be used during software rendering operations.

Initialization
Enter or browse for script that will run once per session, when the scene is 
loading.

Cleanp
Enter or browse for script that will run once per session, when the scene is 
being closed.
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Visibility Node
The Visibility node lets you control whether an item is visible in OpenGL mode versus the Soft Render mode in the 
Camera view. If the Soft Render option is not enabled, the layer will not be exported.

Visibility Properties

Parameter Description

Display in OpenGL View Displays your render in OpenGL mode.

Soft Render  
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Move Nodes
The nodes found in the Move category are used to animate layers as well as camera motions.

Apply Image Transformation Node 451

Apply Peg Transformation Node 454

Camera Node 458

Ortholock Node 460

Peg Node 461

Transformation Tab 461

Quadmap Node 462

Quake Node 464
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Apply Image Transformation Node
The Apply Image Transformation effect is mainly used when you want to pan an object out of the camera frame and 
that object has an effect such as a Glow or a Blur on it. When you use a peg or the Apply Peg Transformation node to 
translate an object such as the sun out of the camera frame, as soon as the sun starts to go outside of the camera 
frame, the sun's circle is cropped and the blur is applied on the shape left over. This also means that when the sun is 
completely out of the frame, the Blur is not calculated anymore and the Blur pops out.

To prevent this from happening, you must use the Apply Image Transformation node to pan the sun out.

The Apply Image Transformation node applies the panning transformation once the full drawing of the sun is blurred, 
once the image is composited. Here is an example of this network:

Here is how to connect the Blur effect for a sun panning out:

Here is the visual result of the blurred sun:
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Look at the following example to understand better why using the Apply Image Transformation instead of a regular 
peg or the Apply Peg Transformation node.

The normal rendering behaviour is to crop the image before applying the effects. When planning a sunset using 
either a Peg or the Apply Peg Transformation node, as soon as the drawing of the sun is out of the camera frame, 
the drawing is cropped and there is no image left to blur. This means that the glowing edge pops out of the camera 
instead of panning out gradually. Using the Apply Image Transformation node, the image is blurred before being 
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panned out, so this means that even once the drawing is out of the camera frame, its glowing edge will still show 
until the drawing is far enough from the camera border. This way, there is no pop when panning out blurred objects.

Use the Apply Image Transformation editor to change the name of the node.
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Apply Peg Transformation Node
Use the Apply Peg Transformation node to apply a transformation coming from a Peg, Ortholock, or Quadmap 
node on a single node or a group of nodes. When using the drawing layer's No Clipping option, you can use this 
node to apply all Camera and Peg transformations once all of the effects and nodes connected above the drawing 
node are calculated.

You can use this effect node to create a simple highlight on a cut-out puppet or use the No Clipping option 
available in the drawing layer.

The No Clipping option, found under the drawing Layer Properties' Advanced tab is used when you do not want to 
crop your images before all effects are applied to your drawing. No camera motion or peg transformation will be 
applied to your drawing until you connect an Apply Peg Transformation.

The advantage of this node is that you can create a second output of your image or puppet and offset it, scale it or 
apply any kind of transformation on it.

The transformations set in the Peg, Ortholock, or Quadmap node connected to the Apply Peg Transformation 
node are applied BEFORE the image is composited.

Here is an example of how to connect the Apply Peg Transformation node:

The transformation set in the Peg node from the example above is applied before the image is composited, which 
is the equivalent of the following network:
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In the following images you can see the result of the transformation without the Apply Peg Transformation node and 
with it:

Using the Apply Peg Transformation you can apply transformation on drawings that are outside the camera frame 
and make them appear inside the frame.

If you are using the Apply Image Transformation node to create a drop-down shadow for a character, it will work 
correctly so long as the character is not going outside of the camera frame or that the drawing connected in it is a 
VECTOR drawing. The reason is the Apply Image Transformation node applies the transformation once the drawing 
is rendered, moved by its own set of Pegs, motion paths and quadmap and cropped to the camera frame size. This 
crop operation does not occur if the drawing is a vector drawing (*.TVG). Although, as soon as the drawing is passed 
through an effect node or a bitmap type Composite node, the drawing is turned into a bitmap image and gets 
cropped.

So, if you offset a bitmap half inside and half outside the camera frame, the outside part is cropped out and then 
moved by the Apply Image Transformation node. A part of the original drawing is cut. You need to use the Apply Peg 
Transformation node for the transformation to be applied before the image is processed and cropped.
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Advanced Apply Peg Transformation 

You can use the Apply Peg Transformation's middle port to apply the transformation you connected to the node 
after one of the Peg or Quadmap connected above the drawing node.

In the following example, two pegs were added to control the different motions on independent trajectories:

 l Peg-Translation

 l Peg-Scale
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When there is no Apply Peg Transformation node, the Peg-Translation is the first trajectory to affect the drawing 
node. Then, once the translation is applied, the Scale trajectory affects the drawing node.

When using an Apply Peg Transformation node without using the middle port, the Peg-Rotation connected in the 
APT node is applied at the top of everything. The order in which the trajectories are applied to the drawing node is:

 1. Peg-Rotation

 2. Peg-Translation

 3. Peg-Scale 

When the Peg-Translation is connected in the Apply Peg Transformation's middle port, the Peg-Rotation is applied 
after the Peg-Translation and before the Peg-Scale. This means that the translation is done before the rotation 
instead of the rotation before the translation.

The order in which the trajectories are applied to the drawing node is:

 1. Peg-Translation

 2. Peg-Rotation

 3. Peg-Scale

Use the Apply Peg Transformation editor to rename the node.
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Camera Node
You can setup the camera position by entering coordinates and values in the Layer Properties view.

Parameter Description

Enable/Disable Turns the camera layer on or off.

Change Track Colour

The Change Track Colour  button lets you change the colour of the exposed 
frames; this helps you to quickly locate a layer in the Timeline view. Click the 
Change Track Colour  button to open the Select Colour window and choose a 
new colour. You can modify the colour for any type of layer, such as group, 
peg, drawing, and effects.

Name
Displays the current layer name. You can rename the layer by typing in a new 
layer name.

Position

Displays the current position of the camera layer using X-axis (East/West), Y-
axis (North/South) and Z-axis (Forward/Backward) coordinates. To reposition 
your camera frame, type in the new values corresponding to the desired pos-
ition coordinates. You can also use the up and down arrows to set the value of 
each field.

Angle
Displays the current rotation value. To set a new rotation position, type in a 
new angle value. You can also use the up and down arrows to set the new 
angle value.

Pivot

Displays the current position of the rotation pivot of the camera layer. The cam-
era will perform a rotation taking the position of the pivot as its angle centre. By 
default, the pivot is set at the centre of the camera frame. To reposition the 
pivot point, enter new X and Y coordinates values in the appropriate field. To 
see the pivot's position, the Rotate tool must be selected.

Clipping Planes You can change the near and far clipping planes of the camera. The near plane 
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is the point on the camera cone where the camera is located. The far clipping 
plane is the far end of the camera cone. Nothing outside that range is visible. 
This is useful when dealing with 3D elements and 3D sets.  For example, the 
camera can be looking inside a 3D box or room and you might want the 
foreground wall to not obstruct the view of the interior. By default, the near 
clipping plane is set to 1 field and the far clipping plane is set to 1000 fields.

Override Scene FOV Enable the FOV field in which you can type in a new field-of-view value. 

FOV

Displays the current field-of-view default value. When enabled, you can type in 
a new zoom value for your camera frame. You can also use the up and down 
arrows to set the new zoom value.

Click on the Create Function button to animate the camera zoom value.

Set Default FOV Resets the custom zoom value to its default value. 
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Ortholock Node
When you create a 3D camera move in your scene, notice that layers are treated as flat objects. That is, 
animation layers that are supposed to face the camera at all times will look like a flat sheet of rotating paper.

Use the Ortholock layer when mixing flat animation layers with a set built in 3D. Ortholock forces your drawing 
layer to always follow the Camera angle. It does not follow its position or zooming level, only the rotation. This 
prevents drawings from being distorted by the camera motion.
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Peg Node
Find below a description of all the Peg node parameters.

Transformation Tab
Parameter Description

Enable 3D Displays additional parameters for working with 3D objects.

Position

3D Path: Lets you use a 3D path function to animate an element.

Separate: Lets you independently edit the different coordinate fields.

Path (x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

Path (y) Axis: Lets you type in a new North/South coordinate corresponding to 
the desired position.

Path (z) Axis: Lets you ype in a new Forward/Backward coordinate 
corresponding to the desired position.

Velocity: When the 3D Path option is selected, lets you set the speed at which 

Scale

Locked: Resizes the element while keeping its ratio. The X and Y axes scale 
proportionally

Separate: Resizes the element allowing to modify the ratio (squash and stretch).

(x) Axis: Lets you type in the horizontal scale value.

(y) Axis: Lets you type in the vertical scale value.

Scale in Fields: Instead of using the standard scaling units, when this option is 
enabled, images are scaled using field units, based on the traditional animation 
field chart.

Ignore Parent Scaling: When this option is enabled, any scaling value applied to 
a parent layer is ignored in the current layer. This can be handy in cut-out rigs 
when you need to scale an arm without affecting the forearm. 

Rotation
Angle z: Lets you  type in a degree value for the rotation angle. Note that you can 
enter values greater than 360 and -360 degrees. If you enter 720, the object will 
rotate twice.

Skew Skew: Lets you type in a degree value between -90 to 90 for the skew angle.

Pivot

(x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

(y) Axis: Lets you ype in a new North/South coordinate corresponding to the 
desired position.
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Quadmap Node
The Quadmap transformation layer lets you deform the shape of an element. For example, you can use it to 
create a drop-shadow effect on an element.

You can edit the Quadmap visually in the Camera view.

How to edit the Quadmap in the Camera view

 1. In the Timeline view, click the Add Layer  button and select Quadmap.

 2. Connect the drawing you want to deformto the Quadmap.

‣ In the Node view, add a Quadmap node and connect to the drawing element node that you want the 
effect to act on.

 3. In the Tools toolbar, disable the Animate mode to change the value for the Quadmap over the entire dur-
ation of the element.

 4. In the Timeline view, click on the Quadmap layer to select it.

 5. From the top menu, select View > Show > Control or pressShift + F11.

The quadmap handles appear around the element in the window. There is also a pivot point at the centre of 
the quadmap frame that you can reposition.

462



Harmony 14 Premium - Reference Guide

 6. In the Camera view window, use the Transform tool to move the points on the quadmap. Shift + click to 
select multiple points.

The value of each point on the quadmap can be changed gradually. To do this, use the Quadmap node Layer 
Properties to attach the points to function curves.

Only the X and Y values of each point in the quadmap can be changed.

Properties

Parameter Description

Name Lets you rename the node.

2D Path
Changes the X and Y values simultaneously and control the velocity of the 
change.

Separate
Changes the X and Y values separately. Each one can be attached to separate 
function curves.
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Quake Node
The Quake node lets you create a very common camera move, the camera shake. Using the Quake node, you 
can generate an automated quake instead of manually entering random keyframes. This way, you can simulate 
the shock of something heavy falling on the ground, like an earthquake or a strong vibration.

How to use the Quake node to create a camera shake

 1. From the Node Library view, drag a Quake node to the Node view.

 2. If you do not have a Camera node already, drag one from the Node Library view to the Node view.

 3. Connect the Quake node to the Camera node.

 4. Click on the Quake node's yellow square properties button to open the Quake properties.

 5. In the Quake properties window, adjust the properties.
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Quake Properties

Parameter Description

Name Lets you rename the node.

Hold Time
Lets you enter the number of frames you want one of the quake vibrations (pos-
ition) to hold for. Most camera shakes are done in a single frame (1) or double 
frame (2).

Interpolate
An interpolation is generated between the random values. Instead of jumping to 
the next position, it will slowly progress forwards to the next position. It is the 
same principle as stop-motion keyframes and motion keyframes.

Move Amplitude

This is the strength of the quake. The higher the value, the stronger the quake. If 
the value is set to 0, there will be no  motion. To have the motion start and stop at 
a specific frame during the scene, you can create a function curve and animate 
the amplitude over time. Simply click the Function  button to generate the func-
tion, then click on it again to open the Function editor.

Apply on X, Y, Z Applies the quake to the X, Y and Z-axis.

Rotation Amplitude
When the value is higher than 0, a rotating quake is applied. The higher the value, 
the stronger the quake.
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Random Seed

Generates a different randomization pattern. If you cascade two Quake nodes or 
more to apply a different amplitude on a different axis, you can change the Ran-
dom Seed value to generate a different randomization pattern. If the X quake has 
a strong amplitude and the Y quake a weak amplitude and you do not want them 
to follow the same random pattern, then set the Random Seed value of the Quake 
nodes to different numbers.
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Output Nodes
The nodes found in the Output category are used to control the image outputted in the various views as well as 
during the rendering process.

Crop Node 468

Display Node 470

Scale Output Node 471

Write Node 472
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Crop Node
To output two files with different aspect ratios, such as 16:9 and 4:3, you can use the Crop node. This node is 
used to crop the final image in order to discard excess information without distorting the render.

If you start with a higher resolution and want to crop down to a lower resolution, such as HDTV to NTSC, you will 
need to combine the Crop node with a Scale Output node.

Find below the Crop node properties.

Cropping Tab

Parameter Description

X Resolution This is the X (width) value in pixel of the resolution to crop the final image to.

Y Resolution This is the Y (height) value in pixel of the resolution to crop the final image to.

X Offset This is the X (horizontal) offset value in pixel to move the crop box to in the final 
image.

Y Offset This is the Y (vertical) offset value in pixel to move the crop box to in the final 
image.

Draw Frame Enable the Draw Frame option if, instead of cropping the images, you prefer to 
have Harmony draw the frame over the rendered scene.

Red, Green, Blue, Alpha These are the RGBA values used for the frame colour if you enabled the Draw 
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Frame value. You can also modify the colour using the Colour Picker window 
by clicking on the colour swatch below.

Colour Swatch Click in the colour swatch to adjust the frame colour using the Colour Picker 
window if you have enabled the Draw Frame option.

Enabling Tab

Parameter Description

Always Enabled Enable this option for the Crop node to always be enabled.

Enabled when Resolution 
Name is

Enable this option for the Crop node to only crop the final images when the scene 
resolution is set to a specific resolution preset.

Filter Name Select one of the existing resolution preset from the list for the Crop node to only 
crop images when that resolution is set at the scene settings level.

Enabled when Resolution is Enable this option for the Crop node to only crop the final images when the scene 
resolution is set to the X and Y resolution specified in the X resolution and Y res-
olution fields.

X Resolution X (horizontal) value in pixel of the scene resolution the Crop node will become act-
ive.

Y Resolution Y (vertical) value in pixel of the scene resolution the Crop node will become act-
ive.
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Display Node
The Display node is an important node; it is used by the export and views to display your scene, primarily the 
Camera and Timeline views. By default, a scene's node system always has a Display node which can be used to 
show your entire scene, a single node or a group of nodes through a Composite or Group node. You might use it to 
see one single character as you animate it, debug your node system as you create complex effects or export your 
complete scene or a portion of it. 
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Scale Output Node
Once your Write nodes are connected, you need some Scale-Output nodes to change the resolution output of the 
Write node without changing the scene settings. For example, if you export in a high resolution and a low resolution, 
you need one Scale-Output node.

Set the project’s resolution to the highest resolution needed for this export and use the Scale-Output nodes to scale 
down the other outputs. 

DO NOT scale up the output size, that will not provide a good result. It is also better to use the Scale-Output node to 
scale down in a same aspect ratio so that it does not distort the image.

Find below the Scale-Output node properties.

Parameter Description

Resolution Name Select one of the existing resolution preset from the list to indicate the resolution 
you want the finale images to be scaled at. Always make sure the selected res-
olution is smaller than the scene setting one.

Custom Resolution Enable this option to set a resolution that is not available in the Resolution preset 
list.

Width X (horizontal) value in pixel of the resolution to scale the images down to.

Height Y (vertical) value in pixel of the resolution to scale the images down to.
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Write Node
The Node view allows you to make advanced connections and isolate certain portions of your project. It also 
allows you to perform multiple exports from the entire node structure or from specific sections.

For this kind of process, use the Write node. The Write node lets you render and output the connected image 
information. Using the Write node, you can export a project as a QuickTime movie or as image sequences. You 
can export one format at a time or both simultaneously.

To export an image sequence, you need to adjust a few settings in the Write node’s properties.

Here is a list of all the  image formats supported for rendering with Write nodes.

Format Specification Description

TVG                                              Toon Boom Vector Graphic (*.tvg)

Toon Boom's proprietary format for storing vector drawings. 

NOTE: To export TVG files, your Write node must be con-
nected to a vector drawing layer or to a vector composite node. 
The exported TVG files will contain the vector and bitmap draw-
ing information, but will ignore  effects and deformations. 

TGA                                              Full colour Truevision TGA/TARGA (*.tga)

A standard image format with lossless compression and support for 
transparency.

TGA1                                              Greyscale

TGA3                                              Full colour

TGA4                                              Full colour with trans-
parency

SGI                                              Full colour / 8 bits per 
channel

Silicon Graphics Image (*.sgi)

A highly capable format with lossless compression as well as 
support for double precision and transparency.SGI1                                              Greyscale / 8 bits per 

channel

SGI3                                              Full colour / 8 bits per 
channel

SGI4                                              Full colour with trans-
parency / 8 bits per chan-
nel

SGIDP                                              Full colour / 16 bits per 
channel

SGIDP3                                              Full colour / 16 bits per 
channel

SGIDP4                                              Full colour with trans-
parency / 16 bits per chan-
nel

PSD                                              Full colour / 8 bits per Photoshop Document (*.psd)
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channel An Adobe Photoshop proprietary format used for image editing. 

PSD files exported by Harmony contain a single background layer 
with the rasterized image. 

PSD1                                              Greyscale / 8 bits per 
channel

PSD3                                              Full colour / 8 bits per 
channel

PSD4                                              Full colour with trans-
parency / 8 bits per chan-
nel

PSDDP                                              Full colour / 16 bits per 
channel

PSDDP1                                              Greyscale / 16 bits per 
channel

PSDDP3                                              Full colour / 16 bits per 
channel

PSDDP4                                              Full colour with trans-
parency / 16 bits per chan-
nel

YUV                                              Y'UV frame (*.yuv)

A legacy format optimized for NTSC television. The image 
information is encoded in the Y'UV color space, which means Luma 
(Y') and Chrominance (UV). 

NOTE: YUV images must be exported in NTSC resolution (720 
x 540), or they will not be legible.

PAL                                              PAL frame (*.pal)

A legacy format optimized for PAL television.

NOTE: PAL images must be exported in PAL resolution (768 x 
576), or they will not be legible. 

SCAN                                              Toon Boom Scan Files (*.scan)

A Toon Boom proprietary format used by Scan to store scanned 
image information along with its registration (peg) information. 
SCAN files are in gresycale. 

PNG                                              Full colour / 8 bits per 
channel

Portable Network Graphics (*.png)

A highly portable image format with lossless compression as well 
as support for transparency and double-precision. PNG is typically 
used for Web applications, graphical user interfaces and image 
sharing.

PNG4                                              Full colour with trans-
parency / 8 bits per chan-
nel
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PNGDP                                              Full colour / 16 bits per 
channel

PNGDP3                                              Full colour / 16 bits per 
channel

PNGDP4                                              Full colour with trans-
parency / 16 bits per chan-
nel

JPG                                              Jpeg (*.jpg)

A very compact image format with lossy compression. It is typically 
used for Web pages and photo sharing. Because it does not 
preserve image quality, it is recommended to never use it except 
when disk space or rendering time is critical and image quality is 
expendable. 

BMP                                              Full colour Bitmap (*.bmp)

A standard uncompressed image format commonly used on 
Microsoft operating systems. 

BMP4                                              Full colour with trans-
parency

IFF                                              8 bits per channel Interchange File Format (*.iff)

A container file format which can store text, image and sound data, 
and which is commonly used for exchanging data between different 
platforms. 

IFF files exported by Harmony contain the rendered image as well 
as Z-depth information for each pixel. If your scene has multiplane 
or 3D elements, this format can be used for compositing your 
animation with other graphical elements in 3D animation software. 

NOTE: Contrary to EXR and DTEX images, this format does 
not support antialiasing. It is recommended to use EXR or 
DTEX if possible. 

IFF_16                                              16 bits per channel

OPT                                              Full colour Toon Boom OPT image (*.opt)

A legacy Toon Boom proprietary format that stores raw image data 
with lossless compression.

OPT1                                              Greyscale

OPT3                                              Full colour

OPT4                                              Full colour with trans-
parency

VAR                                              Toon Boom VAR image (*.var)

A legacy Toon Boom proprietary format that stores raw image data 
with lossless compression in greyscale.

TIFF                                              Tagged Image File Format (*.tiff)

An image format with many compression and encoding settings. It 
is often used for image exchange in visual arts and publishing.
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TIFF images exported by Harmony are uncompressed, encoded on 
a per-pixel (interleaved) basis in PC byte order. 

DPX                                               8 bits per channel / Full 
color / RGB channel order

Digital Picture Exchange (*.dpx)

A professional photo format that supports various different 
approaches to storing colour information, which can be used for 
storing, exchanging and editing raw information recorded by 
cameras. It is commonly used in film production. 

DPX3_8                                              8 bits per channel / Full 
color / RGB channel order

DPX3_10                                              10 bits per channel / Full 
color / RGB channel order

DPX3_12                                              12 bits per channel / Full 
color / RGB channel order

DPX3_16                                              16 bits per channel / Full 
color / RGB channel order

DPX3_10_
INVERTED_
CHANNELS                                              

10 bits per channel / Full 
color / BGR channel order

DPX3_12_
INVERTED_
CHANNELS                                              

12 bits per channel / Full 
color / BGR channel order

DPX3_16_
INVERTED_
CHANNELS                                              

16 bits per channel / Full 
color / BGR channel order

EXR                                              OpenEXR (*.exr)

A highly capable deep image format. Each pixel in an EXR file is 
exported with its Z-depth information, as well as color and depth 
information of pixels further back for semi-transparent pixels. If your 
scene has multiplane or 3D elements, this format can be used for 
compositing your animation with other graphical elements in 3D 
animation software.

PDF                                              Portable Document File (*.pdf)

Typically, PDF files are used to store, archive, share and print 
documents. However, Harmony uses the PDF format for its 
capability to store bitmap images and vector graphics.

If the write node is connected to a vector drawing layer or to a vector 
composite, the exported PDF files will contain the image as a vector 
graphic. It will ignore bitmap layers, effects and deformations. 
Otherwise, the PDF files will contain the rendered image as a 
bitmap.

DTEX                                              Deep Texture (*.dtex)

A commonly used deep image format. Each pixel in an DTEX file is 
exported with its Z-depth information, as well as color and depth 
information of pixels further back for  semi-transparent pixels. If your 
scene has multiplane or 3D elements, this format can be used for 
compositing your animation with other graphical elements in 3D 
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animation software.

NOTE: Exporting in Deep Texture requires RenderMan to be 
installed on the machine and the path to RenderMan properly 
configured in Harmony. For more information, see the Setting 
3D Renderer Paths topic of the User Guide.

 

Output Tab

Parameter Description

Drawing Folder Click Choose and browse to the directory where you want to save the output. 
You can also use the default directory to save in the default frames folder 
included in the scene directory. 

Drawing Filename Type the image sequence’s name prefix. It is recommended to leave the 
hyphen (-) at the end of the name to separate the image name from the image 
number.

Drawing Select this option to create an image sequence.

Start Select the starting number for the image sequence.

Leading Zeros Select the number of digits you want to see after the sequence prefix.

Drawing Type Select the file format in which your project will output. When the file format 
includes a "4" at the end of its name, it means that an alpha channel will be cre-
ated.

Movie Select this option to create a QuickTime move. When enabled the Movie 
Filename and Movie Folder fields appear. Type in the movie output name and 
select the output folder.
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Movie Options Click the Customize button to open the QuickTime movie settings dialog box 
to customize the movie output.

Enabling Tab

Parameter Description

Always Enabled Enable this option for the Crop node to always be enabled.

Enabled when Resolution 
Name is

Enable this option for the Crop node to only crop the final images when the scene 
resolution is set to a specific resolution preset.

Filter Name Select one of the existing resolution preset from the list for the Crop node to only 
crop images when that resolution is set at the scene settings level.

Enabled when Resolution is Enable this option for the Crop node to only crop the final images when the scene 
resolution is set to the X and Y resolution specified in the X resolution and Y res-
olution fields.

X Resolution X (horizontal) value in pixel of the scene resolution the Crop node will become act-
ive.

Y Resolution Y (vertical) value in pixel of the scene resolution the Crop node will become act-
ive.
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Particle Nodes
You can access the Particle effects through the Node Library view. The Particle category contains all the nodes 
needed to build various Particle effect systems.

This section explains each node's purpose, its layer properties and how to adjust these properties. 

3D Region 479

Baker 481

Baker Composite 483

Bounce 483

Explosion 485

Gravity 487

Image Fracture 488

Kill 492

Move Particles 494

Orbit 495

Planar Region 497

Random 499

Region Composite 500

Repulse 501

Rotation Velocity 502

Sink 504

Size 504

Sprite Emitter 506

System Composite 514

Velocity 514

Visualizer 516
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Vortex 517

Wind-Friction 519

3D Region 479

Baker 481

Baker Composite 483

Bounce 483

Explosion 485

Gravity 487

Image Fracture 488

Kill 492

Move Particles 494

Orbit 495

Planar Region 497

Random 499

Region Composite 500

Repulse 501

Rotation Velocity 502

Sink 504

Size 504

Sprite Emitter 506

System Composite 514

Velocity 514

Visualizer 516

Vortex 517

Wind-Friction 519

3D Region
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The 3D Region effect lets you define the 3D region, which can take many forms, such as a sphere, cone, cylinder 
or box. The 3D Region node acts in contrast to the Planer Region node, which generates and emits particles from 
a 2D plane.

You can connect a 3D Region to a Sprite-Emitter to define the region from which particles are generated. It could 
also be connected to a Bounce node to define a region against which particles bounce. If connected to a Sink 
node, it will define a region where the particles will disappear.

How to preview the 3D Region

1. From the top menu, select View > Show > Control or press Shift + F11 (Windows/Linux) or ⌘  + F11 
(Mac OS X).

3D Region Properties

Parameter Description

Name Lets you rename the node.

Shape

Choose a shape for the 3D Region by clicking on the Type drop-down menu 
and selecting either Box, Cylinder, Cones, Sphere or Image.

If you select Image, you must connect the node of a vector drawing or a 
vectorized bitmap image to the left port (blue node) of the 3D Region node. The 
particles will then be emitted from that image' shape. Don't forget that you can 
rotate your vector drawing in 3D space by enabling the 3D option in its Layer 
Properties.
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Size

Enter different values into the Width, Height and Depth fields to change the 
dimensions of the 3D Region's selected shape. Depending on the shape 
selected, some fields may be greyed-out if they are not applicable. You can 
also modify the shape with the Transform Tool by grabbing the control handles 
(turquoise squares) in the Camera or Perspective views. You can also change 
the dimensions of the region over time by click on the function button at the end 
of each field.

Radius

Enter different values in the Max or Min fields to change the inner or outer 
radius of applicable shapes, such as a cylinder, cone or sphere. You can also 
change the radii by grabbing the control handles (turquoise squares) in the 
Camera or Perspective views. The radii of the region can be changed over time 
by clicking the function button at the end of each field.

Baker

The Baker effect, also known as Particle-Baker, lets you make decisions about the particle system's position, 
angle, number, etc. in the same way that a baker would make decisions about the ingredients that go into baking a 
cake. The Baker performs the particle simulation, combining all the ingredients specified to get the final result. The 
Baker must always be connected to the Particle-Visualizer.
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Particle Baker Properties

Parameter Description

Name Lets you rename the node.

Seed

Allows you to apply a random effect to the particle system. There may be 
times when you want to copy the particle system to two different locations on 
your screen. You can take the out-port of the Particle System Composite node, 
and plug this into two separate Bakers and Visualizers. Then you could move 
one system over by attaching a peg into the left side of one Visualizer. This 
makes the two systems look exactly the same. Add a random Seed to make 
them look different.

Simulation Quality

Defines how many simulation steps per frame are performed. The lowest 
quality creates one step per frame. Raising the quality will divide the simulation 
time and create two or more steps of simulation for each frame. This increases 
the computation time, but also increases the quality of the result.

Number of Pre-roll Frames
Allows you to select a start position in the particle effect sequence, other than 
the start (generation) of the sequence. This allows you to start the particle 
effect part-way through its cycle, even if it starts on frame 1 of your project. An 
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example of when this parameter might come in handy is when you want it to be 
already raining at the start of your scene. If you don't change the number of 
Pre-roll Frames, it will always start to rain at the beginning of the scene.

Maximum Number of Particles
Lets you put a limit on the number of particles that will be created; particles will 
stop being generated once this number is reached. 

Age Particles

Tracks how long a particle has existed in its cycle from the time of its 
inception. Knowing a particles "age"  means you can tack other parameters 
onto its life span, such as having the particle start to disappear or change 
colour at a certain time.age.

Move Position

Allows the particles to move position, otherwise the particles cannot flow in a 
specified direction. This option also exists in the Move Particles node. You do 
not always need a Move Particles node; this is why this option exists in the 
Baker. This option is also useful when your Move Particles node is cut off by a 
sink—see Sink on page 504. 

Move Angle

Allow particles to flow from different angles. This option also exists in the 
Move Particles node. You do not always need a Move Particles node; this is 
why this option exists in the Baker. This option is also useful for when your 
Move Particles node is cut off by a sink—see Sink on page 504. 

Baker Composite

The Baker Composite effect is used to composite more than one Particle-Baker, as well as any other elements that 
need to be combined before they pass through the Particle Visualizer.

Bounce
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The Bounce effect lets you to make particles bounce off a surface with realistic physical modelling. This node 
should have a region connected to it, and that region will act as a bounce plane so when any particle hits it, it will 
bounce off at the correct angle.

Bounce Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Friction

Enter a value in this field to increase the amount of friction each particle exper-
iences as it makes contact with the planar surface. A positive value creates 
more friction and slows the particle down. A negative value lessens the friction 
and makes the surface appear more slippery.

Resilience

Increases or decreases the bounciness of the particle. A value of zero causes 
the particle to hit the planar surface once and slide off any downward facing 
angle. A positive value, even by decimal increments, causes the particle to 
become bouncy. A negative value deadens the effect, the same way a lack of 
Region would.

Cutoff Speed
Increasing this value widens the bounce arc. If the connected Planar Region is 
completely flat, a value of zero will cause the particle to bounce up and down in 
place. A tilted plane in the direction of the bounce will also widen the arc.
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Explosion

The Explosion effect lets you create an explosion. As it is an Action node, it should be connected to the Particle 
System Composite after the Sprite Emitter. As the explosion occurs, the particles will burst rapidly away from the 
centre of the explosion (the centre of the defined Region), then gradually slow down.
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Explosion Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Coordinates
Use the X, Y and Z fields to enter different position values to move the particle 
system around in 3D space. You can also connect a Peg node to the Explosion 
to manipulate its position with the Transform or Move tool.

Radius

Defines the surface of an invisible sphere. As the explosion occurs, the 
exploded particles inside the boundaries of this sphere will be effected by the 
force of the explosion, while the particles that eventually pass through will 
remain unaffected.

Sigma
The higher the Sigma value, the longer it takes for the particles to completely 
disappear, even if the initial explosion seems to occur just as rapidly.

Magnitude
Defines the magnitude of the explosion. The greater the magnitude, the faster 
the particles break up.

Epsilon

This value works in opposition to the Sigma value. The higher the value, the 
slower the initial explosion occurs. If the value is high (an integer value) then lar-
ger particles remain suspended for a longer period of time from the initial explo-
sion and takes a while to gradually break down. A smaller (decimal) value 
breaks the particles down to smaller forms more rapidly from the time of the ini-
tial explosion. 

: 
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Gravity

The Gravity effect lets you define the gravity of the particle system.

 

Gravity Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.
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Apply Gravity

Forces the particle system to adhere to the force of gravity. Values must be 
entered into the Direction fields, along with enabling this option, in order for it to 
work. If this option is not selected, the particle system will explode outwards from 
its origin point.

X Direction
Directs the particle stream to the left or right (along the X-axis). A value of 1 
forces the particle stream to the right, while a value of -1 forces the particle 
stream to the left.

Y Direction
Directs the particle stream up or down (along the Y-axis). A value of 1 forces the 
particle stream to flow upwards, while a value of -1 forces the particle stream to 
flow downwards.

Z Direction
Directs the particle stream forwards or backwards (along the Z-axis). A value of 1 
forces the particle stream to flow forwards, while a value of -1 forces the particle 
stream to flow backwards.

Apply Gravity between 
Particles (Relative Gravity)

Applies gravity between each particle, taking their masses into account. The 
mass of the particle can be specified at emission time via the Sprite or Image 
Emitter. 

Relative Gravity Magnitude Adjust the amount of gravity applied between particles. 

Relative Gravity Epsilon
The acceleration falls off the further the particles get from each other. When the 
particles are very close to each other, the acceleration becomes very high, so you 
should define a small region around the particles so they never actually touch.

Relative Gravity Maximum 
Distance

Adjusts the radius beyond which particles do not affect each other.

Image Fracture

The Image Fracture effect breaks an image into pieces. This effect requires two image objects: the image to be 
cut and the shape of the cut pieces (matte). The image to be cut can be anything from a vector drawing to a 
bitmap image to an entire scene's composite—effects and all. The image to be cut should be hooked to the Image 
Fracture's right port.

The matte should be flattened if you want it to work like a cookie cutter (hollow shape with a frame) and can be 
composed of brush or pencil lines. It can also be a solid shape, many solid filled shapes, and even many solid 
filled overlapping shapes. When the matte is made of overlapping pieces, the cut image will be multiplied at those 
zones to break apart in multiple layers. The matte drawing should be hooked to the Image Fracture's left port.

The two image objects overlap perfectly when combined in the Image Fracture. This means that you must take 
the 12 by 12 field into account when judging the scale and proportion of these objects. If the matte does not 
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overlap a part of the image, that part of the image will not be cut. The matte does not have to be a continuous shape. 
It could be three separate circles, which would then be cut and pulled away from the image.

NOTE: You can display the grid and use the Light Table feature in the Drawing view while drawing or scaling the 
image and matte to ensure that they're the correct size relative to one another.

Here's an example of a node structure with the Image Fracture effect:
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Image Fracture Properties

Generation Tab

Parameter Description

Emission

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Type You may want to design a variety of different drawings that will vary the appear-
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ance of the particle system. In this case, you should put each drawing on its 
own cell in the drawing layer. Each drawing will then be a new type of particle.

Type Generation Strategy
Lets you sequentially or randomly assign a type (moving from one drawing to 
the next).

Particle Type 0
This is the frame number of the first drawing. If you have a 5-frame cycle that 
starts on frame 1, you would put a 1 here.

Particle Type 1
This is the frame number of the last drawing. If you have a 5-frame cycle that 
starts on frame 1, you would put 5 here.

Age

Age at Birth
A different start frame number can be entered in this field. This means that a 
particle can start with a different drawing than the drawing on frame 1.

Age at Birth Standard Devi-
ation

Allows a random deviation for the birth of the particles. If you have a five-frame 
cycle that starts on frame 1, but you want the particles to be a random type, 
then you may want to set the Age and Birth to 3 with a standard deviation of 2. 
That means the particles will randomly be born at any frame from 1 to 5.

Advanced

Particles Mass
Defines a mass for the particles which will affect how the particles interact 
with gravity.

Align Initial Velocity
Aligns the initial velocity with the region from which the particles are being emit-
ted. If you are emitting from a sphere, the particles will all start out moving 
away from the centre of the sphere.

Rendering Tab

Parameter Description

Transformation

Size over Age
Lets you determine the size of the particle as it ages. Attach a function to this 
attribute if you would like to, for example, have the particles get smaller as time 
goes on.

Directional Scale Scales the particle in the direction of its movement.

Directional Scale Exponent 
Factor

Sets an exponent here for how much you would like that particle to scale.

Align with Direction Aligns the particle in the direction of its movement.

Axis to Align
Select the axis that you want to align. This axis refers to the axis of the Drawing 
grid from the Drawing node plugged into the emitter.

Flip X Axis to Match Direction
You may want to have the particle align to the X direction of movement. You can 
see this property being used in the Lemmings example.

Flip Y Axis to Match Direction
Similar to flipping the X axis, you may want to flip the Y axis of a drawing to match 
the direction of the particle movement.

Use Rotation of Particle Enables rotation on the particle.

Keep Volume
When you choose to do a Directional Scale, this will automatically maintain the 
volume of the particle by squashing it proportionally to how much it stretches as a 
result of the directional scale.
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Colouring

Colouring Strategy Lets you choose how to define the colour of the particle.

Use Drawing Colour The particle remains the same colour as it was drawn with.

Map RGB Based on Age
Attach a function to this to vary the Red, Green, and Blue values of the particle as 
it ages.

Map RGBA Based on Age
Attach a function to this to vary the Red, Green, Blue, and Alpha values of the 
particle as it ages.

Apply Opacity Based on Age
Keeps the original RGB values from the drawing, but vary the Alpha (Opacity) 
according to a function that you define here.

Map RGB Based on Frame
Changes the Red, Green, and Blue values of the particles based on the frame. 
Changing based on the frame means that ALL particles will change colour on that 
frame, regardless of their age.

Map RGBA Based on Frame
Changes the Red, Green, Blue, and Alpha values of all particles on a given frame 
by attaching a function.

Apply Opacity Based on 
Frame

Uses the original RGB values from your drawing, but varies the Alpha (Opacity) of 
the particles on a certain frame by attaching a function to this.

Red, Blue, Green, Alpha
This is where you can attach functions to the Red, Blue, Green and Alpha values. 
You can also click on the colour swatch to adjust the colour.

Compositing

Blur
Lets you attach a function to define how you want the particles to blur based on 
the age, frame or camera distance of each particle. There are low and high quality 
blurs. Also, you can attach a function to define how all particles should be blurred. 

Blur Intensity
Lets you set a value or attach a function to animate the blur according to the type 
of blur that was defined from the drop-down list.

Falloff Rate

The distance where the blur fades from the edge of the image. Select a value 
between 0 and 1.

A falloff rate of 0 causes the blur to fade out slowly, distributing the blur evenly 
from the edge of the drawing to the farthest edge of the blur.

A falloff rate of 1 causes the blur to fade out quickly so that the blur is heaviest at 
the edge of the drawing. 

Blend Mode Defines a blend mode for the particles to get cool effects.

Blend Intensity
This is a percentage of how opaque you want the particles to be blended. 50 = 
50% transparent. 100 = opaque.

Kill
The Kill effect lets you determine when particles disappear.
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Kill Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Use Maximum Lifespan Makes particles disappear when they reach their maximum lifespan.

Kill Younger

To use this parameter, you must attach a function to this property because if you 
select this option at time 0, you will never see any particles. If you set Kill 
Younger to 10, at time 0, there will be no particles older than 10, so you will never 
see any particles. 

It may be useful to have the particles animating over time, and at some point in 
time, you may want to kill all the younger particles. An example would be an 
animation where the particles change from blue to yellow. At every frame, new 
particles are generated, and the particles that already exist age. Then you would 
add an explosion that kills all particles younger than 10 frames. It would kill all the 
blue particles, leaving only the yellow particles.

Kill Younger Than This is where you can animate the effect for Kill Younger.

Kill Older Makes particles disappear when they reach a certain level of maturity.

Kill Older Than Lets you set the age at which particles disappear.
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Move Particles

The Move Particles effect lets you determine whether the particles are stationary (like grass) or moving (like rain), 
and you can animate this function on and off. 

Move Particles Properties

Parameter Description

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Age Particles

Ages the particles. Note that if you select the Move Position and Move Angle, 
then the particles will age implicitly. If you do not want the particles to move, 
but still want them to age, deselect Move Position and Move Angle, and select 
Age Particles. 

The Age Particles parameter also exists in the Baker, however whatever 
happens in the Baker happens after everything else in the particle system. So, 
if for example you have a Kill node, it will kill the particles before they age. You 
probably want to age the particles before you determine whether to kill them. 
Therefore, if you have a Kill node, make sure to age the particles in your Move 
node before you kill them. If you age the particles both in the Move and Baker 
node, then the particles will age twice on that frame instead of once.

Move Position

Lets you enable movement on the particles. There is also a Move Particles
option in the Baker. If it's deselected in the Baker and in the Move node, the 
particles will not move; they will simply generate in place and stay there. If the 
option is selected on the Baker, the particles will move. But if you need the 
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particles to interact with another Action, say a Sink, then you want the 
particles to move before they reach the sink. This is why you have a separate 
Move node, so you can place this Move before (to the right of) the Sink in your 
particle system composite.

Move Angle
Like the Move Position, this enables the rotation of particles in the particle 
system.

Move Particles Follow Each 
Other

Allows one particle to follow another particle, through an attraction between the 
particles. This is particularly useful when you want to create a snake-like 
effect, where the particles are animating across the screen and following each 
other.

Follow Intensity
Lets you adjust the strength of the attraction between particles following each 
other.

Orbit

The Orbit effect lets you define an axis the particles will be attracted to and orbit around. You can place a Peg layer 
into the orbit to move the position of the orbit without adjusting the parameters in the Layer Properties.

Fine-tuning the Orbit effect can take a bit of finesse because the orbit takes into account the velocity of the particles, 
and uses this to determine whether:

• The particle will orbit around the axis

• The particle will be influenced but eventually escape

• The particle will hardly be influenced at all. 

This is just like how gravity between astral bodies works in space. Here are some examples of how having the orbit 
in the wrong place can give some cool (but perhaps not useful) effects:
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You will also want to make sure that your initial velocity is varied, so use an interpolated speed and set two 
different values. That way, there will be a spread between them. If not, then you will get the effects as shown 
above.

Also, you should use the Peg layer to move the position of the Orbit node around until you find the right spot to get 
the look you're trying to achieve. It also helps to set some pre-roll frames on your Baker to get things ramped-up 
before you start to manipulate the position of the Orbit node.

Here's an example of what a typical node structure with an Orbit node looks like:

Orbit Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Orbit Type
Lets you select the type of Orbit you want to use. For most scenarios, like 
asteroids orbiting a planet, a point will suffice. If you want to rotate around an 
axis instead, choose between the X, Y, Z axes or set up your own custom 
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axis.

Magnitude

Adjust the amount that the acceleration of each particle will be adjusted. The 
higher the value, the more the particle will accelerate towards the orbit. A 
magnitude of 0.001 is a good number to use for this. When the magnitude is set 
too high, the particles will simply fly out into space.

  

Point X
Defines the X position of the centre of the Orbit. You may also leave this at 0 
and use a peg to move the position of the Orbit node.

Point Y and Z Defines the Y and Z position of the centre of the Orbit.

Direction X

Defines the X component of the axis of rotation for the orbit. This is only taken 
into account if you choose to set up a custom axis. If this is set to 1, and Y and 
Z are set to 0, then the axis will be going in the same direction as the X axis. If 
the X component is set to 1, and the Y component is also set to 1, then the axis 
will be at a 45 degree angle between the two.

Direction Y and Z Defines the Y and Z components of the axis of rotation for the orbit.

Planar Region

Like the 3D region, this determines a region that you can use as a source or as a bounce plane, but instead of a 3D 
region, it's a 2D plane. Connect a peg to the right in-port to adjust the position of the plane.
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Planar Region Properties

Parameter Description

Name Lets you rename the node.

Shape Type

Lets you define the shape of the plane. The parameters that you can adjust 
below will be greyed out depending on the shape type you choose. Each shape 
can be adjusted from the Camera view using the Transform tool by selecting 
the Planar Region and then selecting View > Show > Control.

Rectangle: The width and height on a rectangle.

Disc: The point (the centre) of the disk. You can also adjust values for the 
minimum and maximum radius. A minimum radius of 0 will simply be a circle.

Triangle: The three points of the triangle independently.
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Line: The two points on a line.

Point: The position of one single point.

Image: If you choose to use the Image option, then you should use the left in-
port of the Planar-Region to connect a drawing layer that can be used as a 
mask.

Mirror Negative Frames
Mirrors the input peg transformation to generate positions for frames before the 
scene begins.  

Size
Width: The width of a rectangular region.

Height: Adjust the height of a rectangular region.

Radius
Minimum: The minimum radius on a disc region.

Maximum: Adjust the maximum radius on a disc region.

P1

X: The X position of Point 1. Point 1 could refer to the point on a triangle, line, or 
point.

Y: The Y position of Point 1.

P2
X: The X position of Point 2. Point 2 could refer to the point on a triangle or line.

Y: The Y position of Point 2.

P3
X: The X position of Point 3. Point 3 refers to a point on a triangle.

Y: The Y position of Point 3.

Random
The Random effects lets you put a random seed on some qualities like acceleration, speed, rotation speed, and 
position. There's also a Seed value in the Baker, but you may only want to make one particular aspect of the system 
random. This effect gives you control over the randomness of a particular property.
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Random Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Parameter
Lets you choose a parameter to make random: None, Acceleration, Speed, 
Rotation Speed, and Position.

 

Region Composite

The Region Composite effect lets you composite multiple regions, 3D regions or planar regions. You may want to 
emit particles from multiple regions in the same particle system.
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Repulse
The Repulse effect repulses a particle around a region, but is different than the Bounce node as it is repelled before it 
physically hits the region.

Repulse Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Magnitude This value should be between 0 and 2. The higher the value, the more drastically 
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the particles will be repulsed.

Look Ahead
Determines how far ahead of the particle's current position to see whether there's 
an obstacle coming. This value should be between 0 and 100.

Epsilon
Affects how quickly the effect of the repulse wears off. The smaller the number, 
the longer the effect lasts. This value should be between 0.1 and 0.0001.

Rotation Velocity

The Rotation Velocity effect lets you define the initial rotational velocity of the particles. The values that you set 
up for this node refer to each individual particle's drawing axes. This means that if you choose to rotate around the 
X-axis, it will rotate around each particle's local X-axis as defined by its drawing plane.

The rotational velocity should be set before you emit the particles, such as to the right, so the velocity is taken 
into account when the particles are created.
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Rotation Velocity Properties

Parameter Description

Name Lets you rename the node.

General

Trigger: An on/off switch using binary code. 1 = on, 0 = off.

Axis Type: Lets you select the type of axis to use.

• Use Input Shape: Uses a region to define the rotational axis of the 
particles. The axis of each particle's rotation will be perpendicular to the 
plane that particle is created on.

• Constant Axis: If you choose to rotate the particles around a constant 
axis, then each particle will rotate around the same axis. This axis will 
then be defined as Axis0.

• Interpolated Axis: If you choose to rotate the particles around an 
interpolated axis, that means each particle will have its own rotational 
velocity which lies somewhere between Axis0 and Axis1.

Axis

Axis0 X: Defines the X component of Axis0. If you set the X to 1, and the Y and Z 
to 0, then the particle will rotate around its X-axis as defined by its drawing plane. 
If you set X to 1 and also Y to 1, then it will rotate around an axis that is 45 
degrees between X and Y.

Axis0 Y: Defines the Y component of Axis0.

Axis0 Z: Defines the Z component of Axis0.

Axis1 X: Defines the X component of Axis1. This applies only when you have 
selected an Interpolated axis.

Axis1 Y: Defines the Y component of Axis1.

Axis1 Z: Defines the Z component of Axis1.

503



Chapter 4: Nodes     Particle Nodes

Speed (Degrees/Frame)

Minimum: The minimum initial rotation that a particle can have, in degrees per 
frame.

Maximum: The maximum initial rotation that a particle can have, in degrees per 
frame.

Sink
The Sink effect causes particles to disappear when outside the region that is plugged into the sink. It can also be 
inverted, so the particles disappear when they enter the region instead.

Sink Properties

Parameter Description

Name Lets you rename the node.

Invert
The default behaviour of the sink is for particles to disappear when they depart 
the region. When inverted, the particles disappear when they enter the region 
instead.

Size
The Size effect lets you animate the size of the particles.
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Size Properties

Parameter Description

Name Lets you rename the node.

Trigger An on/off switch using binary code. 1 = on, 0 = off.

Size Type

Lets you select a type for the size. If you choose Constant Size, then all 
particles will be animated to have the same size. If you choose Input Shape 
instead, then you must input a Region into the in-port of the Size node. It will 
use this region to determine the size of the particles.

Size Lets you adjust the size of the particles.

: 

: 

Sprite Emitter

The Sprite Emitter effect is an all-purpose emitter. You can plug it into a drawing layer to generate particles that 
look like your drawing layer. You could also just output dot particles if you have no image layer connected. There 
are many parameters to control how particles are emitted. 
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Sprite Emitter Properties

Generation Tab

Parameter Description

Emission

Trigger: An on/off switch using binary code. 1 = on, 0 = off.

Number of Particles: This is where you can define how many particles will be emitted on 
each frame.

Probability of Generating Any Particles: This is a probability percentage between 0 
and 100. If the probability is set to 100%, it will generate the Number of Particles 
specified. If you set the percentage to 50%, then there's only a 50% chance that it will 
generate the number of particles set in the Number of Particles. You can play with this 
value to add random spacing to the generation of particles.

Generator

Streak Seed: The number of streaks to generate.

Source Sampling Time Offset: Sets the streak start at a different time to offset its 
position.

Source Sampling Duration: This parameter is the key to generating streaks. If set to 0, 
the behaviour is the same as before. If set to -10 for example, it will sample the input 
region (in this example the Planar-Region) 10 frames in the past. If in this mode, the 
Number of Particles parameter is the number of streaks to generate. If you want to 
generate five streaks for example, you need to set the Streak Size to a value different 
than 0, otherwise all the streaks will be at the same spot.

Source Samples Per Frame: The number of subdivisions for each frame. A value of 1 
generates a particle for each frame. A value of 16 generates a particle on each 1/16th of a 
frame.

Streak Size: The radius of the sphere used for sampling the offset of the streak.
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Region Size for Baked Particle Input: The Baked Particle Input property refers to when 
you use a Baker as an input to a Sprite Emitter. You can do this when you want to 
generate particles from other particles. When you do this, you have the option of setting a 
sphere around the source particle from which the new particle system will generate 
particles. That is the region which is referred to in this value. If you look at the following 
example, you'll see that the purple smiley faces are generating smaller green, blue, and 
yellow smiley faces. This is done by plugging the Baker from the purple smiley faces into 
the Sprite Emitter of the other smiley faces. See the following images:

Type

You may want to design a variety of different drawings that will vary the appearance of 
your particle system. To do this, you should put each drawing on its own cell in the 
drawing layer. Each drawing will then be a new Type of particle.

Type Generation Strategy: 

Lets you sequentially or randomly assign a type (moving from one drawing to the next).

Particle Type 0: 

This is the frame number of the first drawing. If you have a 5-frame cycle that starts on 
frame 1, you would put a 1 here.

Particle Type 1:

This is the frame number of the last drawing. If you have a 5-frame cycle that starts on 
frame 1, you would put 5 here.
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Initial Parameters Tab

Parameter Description

Age

Age at Birth: A different start frame number can be entered in this field. This means that 
a particle can start with a different drawing than the drawing that you have on frame 1.

Age at Birth Standard Deviation: Allows a random deviation for the birth of the 
particles. If you have a 5-frame cycle that starts on frame 1, but you want the particles to 
be of a random type, then you may want to set the Age and Birth to 3 with a standard 
deviation of 2. That means that particles will randomly be born at any frame from 1 to 5.

Set Maximum Lifespan: Makes particles die automatically.

Maximum Lifespan: This is how long the particle will exist before dying.

Maximum Lifespan Sigma: The lifespan variation of particles. If set to 0, all particles 
will have the same lifespan. A larger value means that particle lifespans will be 
distributed over a larger range.

Advanced

Particles Mass: Define a mass for the particles. This mass will affect how the particles 
interact with gravity.

Copy Particle Velocity for Baked Particle Input: If you select this option, the velocity 
of the parent system will be applied to the child system when a Baker is used as the 
region for a Sprite Emitter.

Add Particle Age for Baked Particle Input: If you select this option, the age of the 
parent system will be inherited by the child system when a Baker is used as the region for 
a Sprite Emitter.

Align Initial Velocity: This aligns the initial velocity with the region from which the 
particles are being emitted. If you are emitting from a sphere, then the particles will all 
start out moving away from the centre of the sphere.

Minimum Initial Rotation: Define a minimum rotation in degrees that the particle can 
have when it is generated. There is also a separate Rotation-Velocity node in which you 
can define this parameter.
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Maximum Initial Rotation: Define a maximum rotation in degrees that the particle can 
have when it is generated.

Rendering Tab

Parameter Description

Sprite Selection

Rendering Strategy: Select a method to determine the particle type defined 
for each particle that is created.

• Render as Dot: Renders each particle as a dot. This is useful 
mainly for previewing the effects of your particle system without 
using the drawing layer (sprite).

• Use Frame Number: As the frame number increases, the type of 
particle will change to match the frame number. This means that 
ALL particles in the system will change together as the frame 
number changes. If you only have a few drawings, then you may 
want to enable Cycling to cycle those drawings.

• Use Frame Number as Index in Selector: When you select this 
option, you can use the Selector to animate the Frame Number it 
uses over time. So, instead of taking the current frame as the Frame 
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Number, you can write your own function instead. For example, if 
you animate the selector so that at frame 1, it starts out at 2, then 8 
frames later you add another keyframe to set the value to 4. 
Between frame 1 and frame 8, the particles will all change type 
together from what they look like on frame 2 to what they look like on 
frame 4.

• Use Particle Type: Each particle that is generated will look like the 
Particle Type that was assigned on the Generation tab. For 
example, if you use a value of 1 for Particle Type 0, and 6 for 
Particle Type 1, then each particle will be assigned a type from 1 to 
6. This type corresponds to the drawing that appears on the sprite on 
that frame number. So if you have a drawing layer called Sprite that 
is plugged into the left in-port of the Emitter, it will look for the 
drawings in cells 1 to 6 of Sprite to assign those drawings to each 
particle.

• Use Particle Type as Index in Selector: This option allows you to 
use the Selector to manually create a function that assigns how 
many of which particle will be created. 

For example, you can set the Particle Type to go from 1 to 100 in the 
Generation tab. Then use the Selector to remap the particle types to 
a certain drawing. So for example you could create five drawings, 
labelled 1 to 5, and use the selector to create mainly 1s, no 2s, a few 
3s, 4s, and a very few 5s. What it's doing is looking at the X-axis to 
find what the particle "type" is, then looking at the Y-axis to find out 
which drawing to assign to that "type." When you use 1 to 100 as a 
type, then when you're setting the values, they act as a percentage.

• Use Age: As the particle ages, it will change appearance from what 
appears on the Sprite's first drawing to the subsequent drawings. 
This means that each particle can have its appearance animated as 
it gets older.
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• Use Age as Index in Selector: You can animate the Selector to 
change how a particle ages over time. For example, if you have a 
Sprite with six drawings on it, you might want to animate it so it 
changes from drawing 1, on frame 1, to drawing 2, on frame 10, then 
drawing 3 on frame 14, drawing 4 on frame 16, drawing 5 on frame 
17, etc. so the particle rapidly ages. This allows you to change the 
timing of the aging dynamically through the selector, instead of 
having to modify the exposure of the cells on the Sprite.

Selector: Animates the Selector in conjunction with the Rendering Strategy to 
adjust the parameters that control the particle’s appearance at birth and over 
time.

Cycling: If you're using rendering strategies like Frame Number or Age, you 
may want to cycle the drawings. For example, if you are using Frame Number, 
but you've only got 5 frames worth of drawings in your Sprite, then if you use 
"No Cycle," your Particles will disappear after frame 5. You can choose to 
cycle Normally (1-2-3-4-5-1-2-3-4-5) or Back and Forth (1-2-3-4-5-4-3-2-1).

Number of Drawings in Cycle: Lets you indicate how many frames from your 
Sprite you'd like to cycle.

Transformation

Size over Age: Lets you determine the size of the particle as it ages. Attach a 
function to this attribute if you want to, for example, have the particles get 
smaller as time goes on.

Directional Scale: Scales the particle in the direction of its movement.

Directional Scale Exponent Factor: Sets an exponent here for how much 
you want that particle to scale.

Align with Direction: Aligns the particle in the direction of its movement.

Axis to Align: Select the axis that you want to align. This axis refers to the axis 
of the Drawing grid from the Drawing node plugged into the emitter.

Flip X Axis to Match Direction: You may want to have the particle align to the 
X direction of movement. You can see this property being used in the 
Lemmings example.

Flip Y Axis to Match Direction: Similar to flipping the X axis, you may want to 
flip the Y axis of a drawing to match the direction of the particle movement..

Use Rotation of Particle: Enables rotation on the particle.

Keep Volume: When you choose to do a Directional Scale, this will 
automatically maintain the volume of the particle by squashing it proportionally 
to how much it stretches as a result of the directional scale.

Colouring

Colouring Strategy: Lets you choose how to define the colour of the particle.

• Use Drawing Colour: The particle remains the same colour as it 
was drawn with.

• Map RGB Based on Age: Attach a function to this to vary the Red, 
Green, and Blue values of the particle as it ages.

• Map RGBA Based on Age: Attach a function to this to vary the 
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Red, Green, Blue, and Alpha values of the particle as it ages.

• Apply Opacity Based on Age: Keeps the original RGB values from 
the drawing, but vary the Alpha (Opacity) according to a function 
that you define here.

• Map RGB Based on Frame: Changes the Red, Green, and Blue 
values of the particles based on the frame. Changing based on the 
frame means that ALL particles will change colour on that frame, 
regardless of their age.

• Map RGBA Based on Frame: Changes the Red, Green, Blue, and 
Alpha values of all particles on a given frame by attaching a 
function.

• Apply Opacity Based on Frame: Uses the original RGB values 
from your drawing, but varies the Alpha (Opacity) of the particles on 
a certain frame by attaching a function to this.

Red, Blue, Green, Alpha: This is where you can attach functions to the Red, 
Blue, Green and Alpha values. You can also click on the colour swatch to 
adjust the colour.

Compositing

Blur: Lets you determine the Blur to apply to the particles.

• No Blur: No blur will be applied to the particles.

• Directional Blur Based on Age: Attaches a function to define how 
you want the particles to blur based on the age of each particle. The 
particle will blur in the direction of movement.

• Directional Blur Based on Frame: Attaches a function to define 
how all particles should be blurred at a particular frame. The particle 
will blur in the direction of movement.

• Low Quality Radial Blur Based on Age: Attaches a function to 
define how you want the particles to blur based on the age of each 
particle. This will be a low quality blur.

• Low Quality Radial Blur Based on Frame: Attaches a function to 
define how all particles should be blurred at a particular frame. This 
will be a low quality blur.

• Low Quality Radial Blur Based on Camera Distance: Defines 
how you want the particles to blur based on their distance from the 
camera. This is a low quality blur. 

• High Quality Radial Blur Based on Age: Attaches a function to 
define how you want the particles to blur based on the age of each 
particle. This is a high quality blur.

• High Quality Radial Blur Based on Frame: Attaches a function to 
define how all particles should be blurred at a particular frame. This 
is a high quality blur.

• High Quality Radial Blur Based on Camera Distance: Defines 
how you want the particles to blur based on their distance from the 
camera. This is a high quality blur. 

Blur Intensity: Lets you set a value or attach a function to animate the blur 
according to the type of blur that was defined from the drop-down list.

513



Chapter 4: Nodes     Particle Nodes

Falloff Rate: The distance where the blur fades from the edge of the image. 
Select a value between 0 and 1. A falloff rate of 0 causes the blur to fade out 
slowly, distributing the blur evenly from the edge of the drawing to the farthest 
edge of the blur. A falloff rate of 1 causes the blur to fade out quickly so that the 
blur is heaviest at the edge of the drawing.

Blend Mode: Defines a blend mode for the particles to get cool effects.

Blend Intensity: This is a percentage of how opaque you want the particles to 
be blended. 50 = 50% transparent. 100 = opaque.

 

System Composite
The System Composite node is where you connect all the "Actions" of your particle system. An action includes 
any of the light-purple nodes, like Gravity, Emitters, and velocity parameters. All of the "Actions" help to define 
the behaviour of the particle system.

Velocity
The Velocity effect defines the initial velocity of the particles that are emitted in the particle system. You can 
select this node and select View > Show > Control to display the manipulation handles to help you set the 
parameters of this node. Use your Transform tool to modify the manipulation handles in the Camera or 
Perspective view.
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Velocity Properties

Parameter Description

General

Trigger: Is an on/off switch using binary code, where 1 = on, while 0 = off.

Velocity Type

• Use Input Shape: If you plug a Region into the in-port of the Velocity 
node, it will take the shape of this region to determine the initial velocity 
of the particles. They will take a velocity that is perpendicular to the 
surface of the shape.

• Constant Speed: Sets a constant speed for the initial velocity of the 
particles.

• Interpolated Speed: Each particle is assigned an initial speed that is 
somewhere between the two values set for Interpolated Speed.

• Random in All Directions 2D: All particles will be assigned a random 
velocity in any direction on a 2D plane.

• Random in All Directions 3D: All particles will be assigned a random 
velocity in any direction.

• Random in Cone: Particles will be assigned an initial velocity 
anywhere in the shape of a cone.

• Random in 2D-Pie: Particles will be assigned an initial velocity 
anywhere in the shape of a pie slice on a 2D plane.

Bilateral: Generates positive and negative velocities in a given direction. For 
example, you can generate particles with cone-shaped velocity, (e.g. a bazooka 
firing) going only in the forward direction, but you can also generate velocities in 
the opposite direction.

Direction of Normal (for Ran-
dom in all Directions 2D)

Lets you input values for the perpendicular direction for the Random property in All 
Directions 2D.
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X: Sets a value between 0 and 1 to determine how much influence the X-axis has 
over the direction of the normal. For example, if the X value is set to 1, and Y and 
Z are set to 0, then the perpendicular (normal) will be going in the X direction. If X 
is set to 1, and Y is also set to 1, then the axis will be 45 degrees, halfway 
between X and Y. Feel free to use the Manipulation Handles for the velocity node 
by selecting the Velocity node and then selecting View > Show > Control. This 
will allow you to use the Transform tool in the Camera View or the Perspective 
View to set the appropriate values.

Y: Set a value between 0 and 1 to determine how much influence the Y-axis has 
over the direction of the normal.

Z: Set a value between 0 and 1 to determine how much influence the Z-axis has 
over the direction of the normal.

Speed

Minimum: There are some speeds that are constant, and some that are a range of 
values between a minimum and maximum. Set the minimum speed here.

Maximum: Set the maximum speed for interpolated speeds.

Deviation from Direction

Minimum Angle: This is used for Cone and Pie shapes. Put a non-zero value 
here if you want there to be a hole in the middle of your cone or pie.

Maximum Angle: Set the maximum angle for your cone or pie here.

Visualizer
The Particle-Visualizer effect renders and flattens the particle system down to a single plane. You can plug a peg 
module into the left port to animate the position of the whole particle system. Plugging a peg into the right port will 
move the depth where the flat plane is generated, so you can move it behind or in front of various other drawing 
layers in your scene. You can even have two Visualizers with pegs in the right in-ports that are at different depths 
to display some particles in front of and some particles behind a character or drawing in the scene.

Visualizer Properties

Parameter Description
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Force Render as Dots

Temporarily renders your system as Dots when previewing a simulation. All 
drawings are ignored and the system is forced to render as dots.  
Note: You can also use the option View > Particle > Show Particles as Dots 
in OpenGL. When enabled, the particles will always be displayed as dots in the 
OpenGL preview mode to make playback speed faster for heavy scenes.

Rendering Order

Lets you set the order in which you want the particles to appear in the render.  

Back to Front: Added particles will appear behind existing particles.  

Front to Back: Added particles will appear in front of existing particles.  

Oldest to Youngest: Older particles will appear behind younger particles.  

Youngest to Oldest: Older particles will appear in front of younger particles. 

 Ascending Types: Lower types will appear behind higher types.  

Descending Types: Lower types will appear in front of higher types.

Fix Output Alpha

This is an important option when using some filters like Screen or Multiply in 
the Blend Mode that can be specified in the Rendering tab of the Emitter. When 
working with premultiplied images, if the alpha is not fixed in the visualizer, you 
may see some unusual artifacts. 

Scale Particle System Using 
Parent Peg

Respects the scaling of a particle system so you can position and resize it as 
you like. Old scenes with particle system will still work as this option is dis-
abled.

Global Scaling Factor Lets you set the scaling factor for particle system.

Vortex

The Vortext effect allows you to define an axis as a vortex, so the particles will spin around this axis.
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Vortex Properties

Parameter Description

Trigger An on/off switch using binary code, where 1 = on and 0 = off.

X Direction Defines the X portion of the axis of rotation for the Vortex.

Y Direction Defines the Y portion of the axis of rotation for the Vortex.

Z Direction Defines the Z portion of the axis of rotation of the Vortex.

Radius Defines the radius at the top of the vortex.

Exponent (1=cone)
Defines a curve that gives the Vortex a certain silhouette. 1 forms a cone, 
greater than 1 curves inward.

Up Acceleration Defines the vertical acceleration of the particles that are inside the Vortex.

In Acceleration Defines the inward acceleration of particles that are outside the Vortex.
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Around Acceleration
Defines the acceleration around the vortex of particles that are inside the Vor-
tex.

Wind-Friction
The Wind-Friction effect lets you define the amount of wind in the scene, and animate the wind over time.

Wind-Friction Properties

Parameter Description

Trigger An on/off switch using binary code, where 1 = on and 0 = off.

Friction/Wind X, Y, Z
Defines the amount that the wind will dampen or increase the speed of the 
particles in the X, Y or Z direction.

Min Speed
The minimum speed of particles that will be affected by the wind. Particles mov-
ing slower than this will not be affected

Max Speed
The maximum speed of particles that will be affected by the wind. Particles mov-
ing faster than this will not be affected.
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Shading Nodes
Harmony provides you with a wide series of parameters to customize your light shading effects.

Light Position Node 521

Light Shader Node 523

Normal Map Node 526

Normal Map Converter Node 530

Tone Shader Node 531

Volume Object Node 534
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Light Position Node
The Light Position node is the actual light source interacting with all the defined volume objects. You can set its 
position in relation to the objects and animate it over time. All volumes will react according to the light's motion.

This is not where you set the light type or colour. You'll be adjusting these in the Light Shader and Tone Shader 
nodes.

Light Position Properties

Parameter Description

Source Lets you control the value of the light source.

Target The point or direction at which the light is pointing

 

3D Path: Lets you use a 3D path when animating the light.

Separate: Lets you enter separate values for the X, Y and Z axes.

(x) Axis: Lets you type in a new East/West coordinate corresponding to the 
desired position.

(y) Axis: Lets you type in a new North/South coordinate corresponding to the 
desired position.
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(z) Axis: Lets you type in a new Forward/Backward coordinate corresponding to 
the desired position.
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Light Shader Node
The Light Shader node lets you adjust the highlight parameters, such as the colour, to create the desired ambiance. 
You can animate most parameters over time to create a mood change, sunset or any other type of light transition. 
The beveling height and smoothing is set in the Normal Map node.

Light Shader Properties

Parameter Description

Name Lets you rename the node.
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Light

Light Type

Directional: A light that is parallel in the scene. Each “beam” of light follows the 
direction defined by the light source and target, and point in the same direction. 
This type of light is used when the light source is far away or very big, like the 
sun.

Point: A light that illuminates everything around it. Its “beam” of light will go in all 
directions like a fire.

Spot: A light that forms a conical shape like a flashlight.

Cone Angle
The value that defines the light’s cone angle. This option is only accessible with 
the Light Type set to Spot.

Diffusion
Lets you play with the diffusion of the light on the surface of the drawing. In other 
words, it is the edge softness. This option is only accessible with the Light Type 
set to Spot.

Light Source Elevation
Defines the height of the spotlight. This option is only accessible when the Light 
Type set to Spot or Point.

Shading Type
Smooth: The light and tone fx will have smooth edges.

Sharp: The light and tone fx will have sharp edges.

Bias

Define the polarization of the light. 

When the Shade type is set to Smooth, it defines the width of the light’s smooth 
zone. 

When the Shade type is set to Sharp, the Bias defines the antialiasing on the 
edge of the hightlight or tone zone. But,if the Shade type is set to Sharp, the Bias 
option need a small value such as 0.1 or 0.2. The exponent will be able to 
compensate the limitation of this small value.

Abruptness
This is a multiplier value of the Bias option. It will define how quick the 
polarization of the light will change from a value to another.

Adjust Light Intensity Lets you adjust the light intensity.

Intensity Lets you set the strength of the light.

Multiplier Multiplies the value of the Intensity option.

Surface Reflectivity
This option is useful for exaggerating the light on the edge of the 3D geometry. 
The closer an edge is to the light source, the more intense the light will be.

Colour

Red/Green/Blue/Alpha

The colour and transparency of the Colour Card. You can also attach these 
parameters to function columns to change their values over time. 

Click the colour swatch to open the Colour Picker window and select a colour.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.

Use Image Colour
Lets you use the colour of the drawing in a lighter or darker colour for the highlight 
and tone fx.

Image Colour Intensity Lets you blend the colour of the light with the image colour.

Flatten Fx
This is useful when there are several highlight and tone fx, one over the other, but 
are supposed to be merged together. Sometimes, shadows and lights look better 
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when they do not overlap.
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Normal Map Node
The Normal Map node lets you centralize all Volume Object nodes and chisel out the shading 3D geometry (bevel 
height, smoothing, carving, etc.). It could be described as carving a bas relief. You only need one Normal Map 
node per light shading effect and, in general, only one per scene.

A normal map can be used to create other effects. If you're are working with an OpenFX plugin or other plugin 
requiring a normal map, you can use the Normal Map Converter node to translate the Harmony normal map to a 
format supported by your plugin. The Normal Map Converter node has been optimized to work with GenArts® 
plugins, but you also have the ability to use it on custom plugins..
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Normal Map Properties

Parameter Description

Volume Creation
Lists all the different volume object IDs are listed. This is where you can define 
the basic volumetric shape of each Volume Object node connect to the Normal 
Map.

Object

Let you add or remove Volume Object nodes that are connected to the Normal 
Map node.

Add All Defined Objects: Adds all Volume Object nodes connected to the 
Normal Map node.

Remove Selected Objects: Removes all Volume Object nodes from the Volume 
Creation list.

Name

The name that was previously set ineach Volume Object node. This information 
can be really helpful when there are many  volume objects listed. With a good 
name, it is easy to discover what the ID number is related to.    When you hover 
over this column, a tooltip appears listing all volume objects with the same ID.

In the following image, the tooltip indicates that three copies were made from 
FootR-Object. By keeping the same name, you can easily see that each time you 
see a Volume Object named “FootR-Object”, the ID will be the same.
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In the second example, a specific name was created for each volume object, 
even if they have the same ID. That way, it is easy to find a specific nodenode 
when searching for an element with the Search tool in the NetworkNode view.

ID

The identity number that was previously set in the volume object nodenode 
appears here. The tooltip in the ID column lists all drawing elements that are 
connected to the volume object with this identity number.

Bevel Size
Defines the size of the bevel on the contour of all the drawings related to a 
specific ID number

Elevation
Defines the elevation of a specific volume object. The higher the value, the more 
the volumetry of this Volume Object resembles a conical or pyramidal shape.

Elevation Smoothness
Complementary to the Elevation column. Instead of keeping a conical or 
pyramidal shape, the shape will be smoothed to create a sphere or a bump shape. 
The edge will be round instead of sharp.

Bevel Multiplier A multiplier of the Bevel Size value in the board. This affects every object listed.
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Elevation Multiplier A multiplier of the Elevation value in the board. This affects every object listed.

Elevation Smoothness Mul-
tiplier

A multiplier of the Elevation Smoothness value in the list. This affects every 
object listed.

Consider Truck Factor

Keeps the same ratio for the Light Shading system when the camera zooms in or 
out. This parameter cannot work properly if the size of the drawing, with a volume 
object nodenode, is changed on the drawing itself. In other words, if the animation 
is directly created on the drawing layer.

Override Modelling by Colour

Add Colour
Lets you add or remove any colour that will affect the Adding/ Carving options in 
the list beneath.  When you select this button, each colour palette in the scene is 
listed and all their swatches are displayed.

Swatches
The first column of the Override Modelling by Colour board is the Swatches. This 
column does not have a name. When you select a colour swatch from the Add 
Colour list, the colour swatch appears at the beginning of the list. 

Generate Normals Activates or deactivates the generation of the Normal Map.

Normal Map Quality Lets you change the Quality of the Normal Map from low to high. 

Output Elevation in Blue Chan-
nel

When selected, the Elevation is calculated and appears in the soft render mode. 

When deselected, the object ID appears in the soft render mode. 

Because it is connected to the blue channel of a drawing, the result will only affect 
the blue channel.
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Normal Map Converter Node
The normal map will carve and emboss a flat plane using vectors. The X, Y and Z coordinates of the normal map 
vectors are stored in RGB values to convert the 3D aspect into a visual result and use it to create various effects, 
such as light reflections (light shading). The X value is stored in the Red channel. The Y value is stored in the 
Green channel. The Z value is stored in the Blue channel.

NOTE: Note that not all normal map formats are supported.

The Normal Map Converter uses the following formula per channel:

 l value * (+/- length) + offset

 l * +/- depending if inverse is set to true ("-" if true)

Parameter Description

Conversion Type
By default, the conversion type is set to Genarts. If you work with a different 
manufacturer and want to adjust the parameters, set the conversion type to 
Custom.

Offset
Offsets the original position of the vector. You need to read the plugin doc-
umentation to know the offset you need to use. You must use the same offset 
value as the manufacturer is using. By default the offset is set to 0.

Length
The Normal Map Converter normalizes Harmony vectors to 1. By default the 
length value is set to 1. If your plugin requires shorter or longer vectors, enter a 
value smaller or greater than 1. It will multiply the vector length.

Invert Red
Inverts the red value (x). If your value is 125, the invert setting will transform it 
to -125.

Invert Green
Inverts the green value (y). If your value is 125, the invert setting will transform 
it to -125.

Invert Blue
Inverts the blue value (z). If your value is 125, the invert setting will transform it 
to -125.

530



Harmony 14 Premium - Reference Guide

Tone Shader Node
The Tone Shader node lets you adjust the tone parameters, such as the colour, to create the desired ambiance. You 
can animate most parameters over time to create shade transitions. The beveling height and smoothing is set in the 
Normal Map node.

Tone Shader Properties
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Parameter Description

Name Lets you rename the node.

Light

Light Type

Directional: A light that is parallel in the scene. Each “beam” of light follows 
the direction defined by the light source and target, and point in the same 
direction. This type of light is used when the light source is far away or very 
big, like the sun.

Point: A light that illuminates everything around it. Its “beam” of light will go in 
all directions like a fire.

Spot: A light that forms a conical shape like a flashlight.

Cone Angle
The value that defines the light’s cone angle. This option is only accessible 
with the Light Type set to Spot.

Diffusion
Lets you play with the diffusion of the light on the surface of the drawing. In 
other words, it is the edge softness. This option is only accessible with the 
Light Type set to Spot.

Light Source Elevation
Defines the height of the spotlight. This option is only accessible when the 
Light Type set to Spot or Point.

Shading Type
Smooth: The light and tone fx will have smooth edges.

Sharp: The light and tone fx will have sharp edges.

Bias

Define the polarization of the light. 

When the Shade type is set to Smooth, it defines the width of the light’s 
smooth zone. 

When the Shade type is set to Sharp, the Bias defines the antialiasing on the 
edge of the hightlight or tone zone. But,if the Shade type is set to Sharp, the 
Bias option need a small value such as 0.1 or 0.2. The exponent will be able to 
compensate the limitation of this small value.

Abruptness
This is a multiplier value of the Bias option. It will define how quick the 
polarization of the light will change from a value to another.

Adjust Light Intensity Lets you adjust the light intensity.

Intensity Lets you set the strength of the light.

Multiplier Multiplies the value of the Intensity option.

Surface Reflectivity
This option is useful for exaggerating the light on the edge of the 3D geometry. 
The closer an edge is to the light source, the more intense the light will be.

Colour

Red/Green/Blue/Alpha

The colour and transparency of the Colour Card. You can also attach these 
parameters to function columns to change their values over time. 

Click the colour swatch to open the Colour Picker window and select a colour.

Colour Swatch Opens the Colour Picker window in which you can specify the colour.

Use Image Colour
Lets you use the colour of the drawing in a lighter or darker colour for the 
highlight and tone fx.
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Image Colour Intensity Lets you blend the colour of the light with the image colour.

Flatten Fx
This is useful when there are several highlight and tone fx, one over the other, 
but are supposed to be merged together. Sometimes, shadows and lights look 
better when they do not overlap.
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Volume Object Node
The Volume Object node lets you define a volume zone the light will interact with.

If there is a single drawing on which you want to apply shading, you only need one Volume Object node. For cut-
out characters, you will require more as you will define which should be different volumes. For example, you could 
decide that the arm, forearm, and hand will form one shape for the light to hit and create a highlight. You could 
then define the body as a separate volume. If you use different Volume Object nodes on the arm pieces, you will 
get odd carvings and bumps where the joints overlap. Before adding light shading to your rig, you should analyze 
how the parts will interact with one another.

All the Volume Object nodes in your structure will be gathered in the Normal Map node where you can define the 
parameter for each volume.

Volume Object Properties

Parameter Description

Name

With the light shading feature, the naming of the nodes becomes important. 
Since there isn’t any limitation on the number of Volume Object nodes that can 
be added to a node structure, it's quite important to give a good name to each 
Volume Object node. These names will later appear in the Normal Map node, in 
the Volume Creation section.

ID

This is the identity number you assign to a drawing or a group of drawings that 
will be represented in the same volume once it is generated by the Normal Map 
node. This ID is also in the Normal Map node, where a list of all Volume 
Objects is applied.

Cut Volume Cues with Geo-
metry

When this option is not selected, Harmony cuts the 3D geometry (shading bas 
relief) of the drawing after it has been generated by the Normal Map node. 
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Some nodes, such as filters, can affect the shape or colour of the drawing. 
Those nodes will be processed and recognized by the Normal Map node. 
Therefore, it is possible to limit the 3D geometry only on a part of the drawing, 
but not all of it. The 3D geometry follows the edge of the entire drawing and will 
not be affect by the filters.

Use Drawing to Create 
Volume

During the generation created by the Normal Map node, the shape of the 
drawing or group of drawings identified with the same ID will be recognized to 
create the volume. When this option is selected, the Light Shader and Tone 
Shader effect appear inside the contour of those drawings.

Elevation Baseline

The baseline defines how much you can add or carve the Volume Object. The 
drawing or group of drawings connected to this Volume Object node share the 
same baseline value. Because this setting is closely tied to the adding/curving 
option called Intensity (0-100) (accessible in the Volumetric Colour Information 
of the Normal Map node), both places need to have some parameters set. 
Playing only with the Geometry Intensity won’t change anything if there aren’t 
any parameters set in the Normal Map node.

535



Chapter 4: Nodes     Plugin Nodes

Plugin Nodes
There are 2 plug-in node effects available in Harmony:

 l Brightness-Contrast—see Brightness Contrast Node

 l Sparkle
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Sparkle 

The Sparkle effect transforms a vector drawing into sparkles. You have a high degree of control over the appearance 
of the sparkles.

The sparkle effect can only be used with vector drawings. If the sparkle effect node is attached to a composite, 
verify that the Composite editor is set to Vector Flatten Output.

Use the Sparkle editor to modify how the Sparkle node creates the sparkle effect. You can also use Bezier and Ease 
function curves to change the values of factors over time.
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Sparkle Properties

Parameter Description

Start Angle
Enter a value between -360 and 360 to indicate the angle of rotation of each 
sparkle.

Scale
Sparkles are determined by the size of the bounding box of the coloured areas 
in the drawing. Enter the multiple to use to scale the sparkle size.

Factor
Enter a value between 0.1 and 1 to determine how pointy the sparkle is. A 
value closer to 0 will result in a more pointed sparkle. A value closer to 1 will 
result in a more rounded sparkle.

Density Adjusts the density level.

Number of Points Enter the number of points you want each sparkle to have.

Probability of Appearing
Enter the percentage of possibility that sparkles will be displayed. Enter 100 to 
always show sparkles. Enter 0 to always hide sparkles.

Point Noise
Enter a value between 0.1 and 1 to indicate the amount by which points in a 
sparkle will distort.

Centre Noise
Enter a value between 0.1 and 1 to indicate the amount by which the angles 
between each point in a sparkle will distort.

Angle Noise
Enter a value between 0.1 and 1 to indicate the amount by which the Start 
Angle in a sparkle will distort.

Random Seed Enter a positive integer value that will be used to determine the sparkle pattern.

Use Drawing Colours
Select this option to use the colour attributes of the drawing for the sparkle col-
our. When this selection is disabled (default setting), the colour values will be 
used as they are entered in the editor.
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Flatten Sparkles of Same Col-
our

Flatten all drawings of the same colour into a single layer.

Red/Green/Blue/Alpha In the RGBA fields, enter the values to use for the sparkle colour. 
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Selection Preset Note Node
The Selection Preset Note node appears in the Node view after an initial Selection Preset is created.

Selection Preset Note Properties

Parameter Description

Enable/Disable
Checking this option enables the node. Unchecking this option disables the 
node.

Track Colour

Click on this swatch to open the Select Colour window. Select a colour and 
click OK to mark the node with the selected colour.

Name Lets you rename the node.

Text
Displays the code text for the Selection Presets list that can be found in the 
Selection Presets window.

Close Closers the Properties window.
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Sound Layer Properties
When you select a sound layer in the Timeline view, the options related to that layer appear in the Layer Properties 
view.
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Chapter 5: Tools Properties
Harmony has a wide variety of drawing and manipulation tools and each one of them has a series of options and 
modes available in the Tool Properties view. This section covers these options.  

 

Brush Tool Properties (Vector) 545

Size and Smoothness Tab 546

Paper Texture Tab 547

Brush Tool Properties (Bitmap) 549

Tip Tab 551

Transparency Tab 556

Dual Tip Tab 559

Paper Texture Tab 563

Close Gap Tool Properties 566

Contour Editor Tool Properties 567

Cutter Tool Properties 569

Drawing Pivot Tool Properties 571

Dropper Tool Properties 573

Ellipse Tool Properties 574

Size and Smoothness Tab 577

Texture Tab 578

Envelope Tool Properties 579

Eraser Tool Properties 581

Size and Smoothness Tab 582

Soft Eraser Tab 583

Ink Tool Properties 584

Inverse Kinematics Tool Properties 586

Mode 586
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IK Options 587

Selection 587

Line Tool Properties 589

Size and Smoothness Tab 592

Texture Tab 593

Morphing Tool Properties 595

Paint Tool Properties 598

Pencil Tool Properties 602

Size and Smoothness Tab 605

Texture Tab 606

Pencil Editor Tool Properties 608

Perspective Tool Properties 612

Polyline Tool Properties 614

Size and Smoothness Tab 615

Texture Tab 616

Rectangle Tool Properties 618

Size and Smoothness Tab 620

Texture Tab 621

Reposition All Drawings Tool Properties 623

Rigging Tool Properties 625

Mode 625

Options 625

Operations 626

Select Tool Properties 627

Smooth Editor Tool Properties 634

Stroke Tool Properties 636

Text Tool Properties 637

Transform Tool Properties 640

Zoom Tool Properties 642
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Brush Tool Properties (Vector)
When you're drawing on a vector layer and select the Brush  tool, its properties and options appear in the Tool 
Properties view.

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to display 
advanced customization parameters.

 Maximum Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Smoothing
Defines the number of control points added to the centre line. The fewer 
the control points the smoother (but less faithful) the line.

 Brush Presets
Presets are created by saving the properties of the current tool to a new 
preset, which you can reuse for repeated tasks. You can create as many 
presets as you need.

New Brush Allows to create a new preset.

New Dynamic Brush Allows you to create a new dynamic brush to clone custom patterns. 

Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes
Allows you to import a set of XML Harmony presets previously exported 
via the Export Brushes command. 
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 Export Brushes
Allows you to export Harmony presets to backup or import on a different 
computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Draw Behind

When drawing on vector layers, the Draw Behind mode lets you paint 
behind existing art. By default, strokes appear over your work until you 
release the tool.

Repaint Brush

The Repaint Brush  is used to repaint zones that have already been 
painted, it will not affect empty zones or pencil lines. You can use this 
mode to paint tones or highlights onto your character.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.

Auto-Flatten Mode

When enabled, the Auto-Flatten  mode automatically flattens the new lines 
created with the existing artwork as you draw in the Drawing or Camera 
view. Brush strokes will flatten with brush strokes and pencil lines will 
flatten with pencil lines.

Respect Protected Col-
our

The Respect Protected Colour  option prevent the colours you marked as 
protected, in the Colour view, to be repainted using the Repaint Brush 
mode or any of the painting tools.

Use Stored Colour 
Gradient

The Use Stored Colour Gradient  option makes your tool use the previously 
stored gradient position. This way, every new brush line or colour fill will 
use the stored gradient position.

Size and Smoothness Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 
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Tool Name Description

Maximum Size
Defines the maximum size of your drawing tool. This parameter defines the  width of 
the stroke.

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If 
you do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Contour Smoothing
Defines the number of points on the contour share of your stroke. This will smooth 
out the bumps and waves on tour contour shape of your brush strokes.

Tip Shape

Lets you select a tip shape—from round and square ones to star shaped. This option 
is disabled when using a textured brush.

Paper Texture Tab 
You can create texture brushes to draw on vector layers. Enable the Paper Texture option to access the options. 

Parameter Description

Hardness

The hardness value corresponds to the softness of the line edge. The lower the 
value, the softer the line edge will be. The higher the value, the sharper the line 

edge will be.  
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Maximum Opacity
This value corresponds to the transparency of the stroke when the pressure is 
heavy.  

Minimum Opacity

This value corresponds to the transparency of the stroke when the pressure is 
light and is a percentage of the Maximum Opacity value. 
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Brush Tool Properties (Bitmap)
When you're drawing on a bitmap layer and select the Brush  tool, its properties and options appear in the Tool 
Properties view.

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to display 
advanced customization parameters.

 Maximum Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Flow

The Flow parameter lets Lets you set the range for the rate at which paint 
flows from the brush. The analogy works better with a pen. The greater the 
flow, the more ink comes out, which gives you a more consistent line 
colour and texture. If the flow is light,  then the colour and texture of the line 
may look spotty. The flow works with the pressure sensitivity of a pen 
tablet.

 Opacity
The Opacity parameter are where you set the transparency for a brush 
stroke. This works with the pressure sensitivity of a pen tablet.

 Brush Presets
Presets are created by saving the properties of the current tool to a new 
preset, which you can reuse for repeated tasks. You can create as many 
presets as you need.
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New Brush Allows to create a new preset.

Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes
Allows you to import a set of XML Harmony presets previously exported 
via the Export Brushes command. 

 Export Brushes
Allows you to export Harmony presets to backup or import on a different 
computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Draw Behind

When drawing on vector layers, the Draw Behind mode lets you paint 
behind existing art. By default, strokes appear over your work until you 
release the tool.

Repaint Brush

The Repaint Brush  is used to repaint zones that have already been 
painted, it will not affect empty zones or pencil lines. You can use this 
mode to paint tones or highlights onto your character.
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Tip Tab

Tool Name Description
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Brush Tip 
Library

This is where you select the shape of the brush tip. By default it is round. Note that some tips are 
designed to have semitransparent areas, even when the maximum brush opacity is set to 100%.

To create a custom brush tip, you must prepare the file ahead of time, either in Harmony or in a third-
party software, such as Adobe Photoshop. Colour is not supported and transparency is not 
supported in the traditional sense. Black appears as 100% opaque, white appears as 100% 
transparent and all the shades of grey in between appear as varying degrees of semitransparency. A 
range of file formats are supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha channels are 
disregarded on import. It is recommended that your file be between 100 x 100 pixels and 400 x 400 
pixels. 

You can also import brush tips that you exported from Harmony, so you can share them with 
colleagues.

Minimum 
and 
Maximum 
Size

The minimum and maximum sizes of your drawing tool produce the thick and thin effect on your 
stroke. This works with the pressure sensitivity of a pen tablet.

 l Maximum Size: Defines the maximum  width of the stroke.

 l Minimum Size: Defines the minimum width of the stroke in relation to and as a percentage of 
the maximum size.

NOTE: Setting the Minimum Size value to 100% eliminates the possibility of creating width vari-
ation on your stroke. In other words, you would be forcing a uniform line width using the Max-
imum Size value.

Roundness 
and Angle

The Roundness and Angle parameters allow you to change the shape and orientation of the brush 
tip.

 l Roundness: Squashes the height of the brush tip from its centre point. 100% roundness = 
the native height of the brush tip. A smaller percentage will make the brush tip look flatter and 
more narrow. The squashing is NOT relative to the angle value—if the brush tip is rotated, the 
squashing function still uses the brush tip's original orientation.

 l Angle: Rotates the brush tip counter-clockwise. 0° = the brush tip's native orientation.
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Hardness

The Hardness and Spacing parameters allow you to change the softness and spacing of the marks 
made by the brush tip. You can preview the hardness and spacing at the top of the Bitmap Brush 
Properties window, stroke preview area.

The hardness value corresponds to the softness of the brush tip's edges. The lower the value, the 
softer the tip edge. The higher the value, the sharper the tip edge. Be aware that some brush tips are 
not 100% opaque, so they will always appear somewhat soft, even at 100% hardness.

Spacing

Defines the amount of space between each stamp of the brush. A value of 100% sets the stamp 
marks edge to edge, if there is no white space around the shape. The larger the value, the greater 
the space between marks. A really large value can make the brush stroke appear as a string of 
individual marks. Conversely, a small spacing value will give the appearance of a fluid brush stroke. 

Spacing is only evident when making a continuous stroke. 

Ran-
domness

The Randomness parameters let you create a varied bitmap brush stroke. Refining these options 
can give your stroke a lovely, non-mechanical look.

Random 
Size

You can create variation between the thick and thin of your brush stroke just by setting the 
Maximum and Minimum Size values. If you add randomness to the mix, pressure sensitivity from 
your drawing tablet will still be applied. Light pressure will create random values around the 
minimum, while heavy pressure will create random values closer to the maximum. The larger the 
percentage, the larger the range of random variation.  
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NOTE: Setting the Minimum Size to 100% eliminates the possibility of creating width variation 
on your stroke, whether you are applying randomness or not. Therefore, you would be forcing a 
uniform line width using the Maximum Size value.

Random 
Angle

Sets the range for random rotation around the set Angle value. For example, if the Angle is set to 45° 
and the Random Angle set to 10°, the software will choose values between 40°–50° (plus or minus 5 
degrees, equaling a total of 10 degrees).

Random 
Spacing

Sets the range for random spacing around the set Spacing value. For example, if the Spacing is set 
to 50% and the Random Spacing is set to 10%, then Harmony will choose values between 45%–
55% (plus or minus 5 percent, equaling a total of 10 percent).
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Transparency Tab

Tool Name Description

Maximum and Minimum Flow

The Maximum and Minimum Flow parameters let you set the range for the rate 
at which paint flows from your brush. The analogy works better with a pen. 
The greater the flow, the more ink comes out, hence the more consistent the 
colour and texture of the line. If the flow is light,  then the colour and texture of 
the line may look spotty. This feature works with the pressure sensitivity of a 
pen tablet.

 l Maximum Flow: Sets the maximum rate at which colour and texture 
are applied as you create a fluid stroke. 

 l Minimum Flow: Sets the minimum rate at which colour and texture are 
applied as you create a fluid stroke. It is defined as a percentage of the 
Maximum Flow value. If the Minimum Flow value is set to 100%, then 
tablet pressure sensitivity will no longer be applicable. The flow will be 
set to the constant rate of the Maximum Flow value.
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Maximum Opacity and Min-
imum Opacity

The Maximum and Minimum Opacity parameters are where you set the 
opacity range for a brush mark. This works with the pressure sensitivity of a 
pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the brush mark 
when the pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the brush mark when 
the pressure is very light. It is defined as a percentage of the Maximum 
Opacity value. If the Minimum Opacity value is set to 100%, then tab-
let pressure sensitivity will no longer be applicable. The opacity will be 
set to the constant rate of the Maximum Opacity value.

Randomness
Th Randomness parameter lets you set the range for the randomness of the 
flow and opacity. This works with the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your brush stroke just by setting the 
Maximum and Minimum Flow values. If you add randomness to the mix, 
pressure sensitivity from your drawing tablet will still be applied. Light 
pressure will create random values around the minimum, while heavy 
pressure will create random values closer to the maximum. The larger the 
percentage, the larger the range of random variation. 

557



Chapter 5: Tools Properties     Brush Tool Properties (Bitmap)

NOTE: Setting the Minimum Flow value to 100% eliminates the pos-
sibility of creating flow variation on your stroke, whether you are applying 
randomness or not. That is, you would be forcing a uniform flow using the 
Maximum Flow value.

Random Opacity

You can create variation in the opacity of your brush stroke just by setting the 
Maximum and Minimum Opacity values. If you add randomness to the mix, 
pressure sensitivity from your drawing tablet will still be applied. Light 
pressure will create random values around the minimum, while heavy 
pressure will create random values closer to the maximum. The larger the 
percentage, the larger the range of random variation.

NOTE: Setting the Minimum Opacity value to 100% eliminates the pos-
sibility of creating opacity variation on your stroke, whether you are apply-
ing randomness or not. That is, you would be forcing a uniform opacity 
using the Maximum Opacity value.558
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Dual Tip Tab
The Dual Tip tab lets you set the parameters for creating a dual tip brush. The primary bitmap brush tip and the dual 
tip always work together. You can set the parameters for the primary tip in the Tip tab and those for the dual tip in the 
Dual Tip tab. The Blend mode you select determines how the tips are combined. 

You must select the Dual Tip option to access the tab's parameters. 

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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Tool Name Description

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply

This is the default blend mode. When the two brush tips are combined in this 
mode, they essentially cut each other out in overlapping areas, where one or both 
tips have an area of 100% transparency. The less opaque the brush tips are, the 
lighter their combination. 
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Colour Dodge
In this mode, the primary tip cuts out the shape of the dual tip. Where the tip 
shapes overlap, within the boundaries of the primary shape, the colour and opacity 
appear darker.
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Combine
This mode treats the two tips as two different and separate brushes that have the 
same colour and follow the same path.
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Paper Texture Tab
The Paper Texture tab lets you view and select a paper-like texture for your brush. You can also import paper 
textures that were previously exported.

You must select this option to access the tab's parameters.
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Tool 
Name

Description

Texture 
Scale

Increase or decreases the size of the paper texture.

Additive
This option layers the texture on top of itself as you scribble overlapping lines in one continuous 
stroke.  If this option is turned off, areas of overlapping lines from a single, continuous stroke will 
appear the same, in terms of darkness and texture, as non-overlapping areas.
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Aligned

This option defines the way separate, overlapping strokes behave. If this option is enabled, the 
paper texture's position does not change with each sweep of the brush. If this option is disabled, 
each sweep of the brush produces a different texture position. The texture orientation always stays 
the same.
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Close Gap Tool Properties
When you select the Close Gap tool, its properties and options appears in the Tool Properties view. 

Icon Tool Name Description

Auto-Flatten Mode When enabled, the Auto-Flatten  mode automatically 
flattens the new lines created with the existing 
artwork as you draw in the Drawing or Camera view. 
Brush strokes will flatten with brush strokes and 
pencil lines will flatten with pencil lines.
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Contour Editor Tool Properties
When you select the Contour Editor tool, its properties and options appear in the Tool Properties view.

Icon Tool Name Description

Lasso Sets the selection mode to Lasso. Click and hold Alt to 
temporarily switch between the Marquee and Lasso 
modes.

Marquee Sets the selection mode to Marquee. Click and hold Alt 
to temporarily switch between the Marquee and Lasso 
modes.

Snap to Contour Snaps your selection or point to any line you position it 
on. As soon as you move it close enough to another 
line, your point or selection will snap to it. 

 

Snap and Align Snaps the selected anchor point to any existing line 
while displaying temporary rulers as a guide that you 
can also snap your anchor point to. 

Show Contour Editor Con-
trols

Use the Show Contour Editor Controls  option to show 
the contour editor controls. You can use these controls 
to scale, reposition and rotate the selected anchor 
points.

Apply to Line and Colour Art The Apply to Line and Colour Art  option uses the 
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concept of Line Art and Colour Art layers. Use this 
option to apply an action such as selecting, resizing or 
erasing a drawing on both Line Art and Colour Art 
layers, as well as the Overlay and Underlay layers.

Smooth Selection The Smooth operation lets you smooth out selected 
drawing strokes and remove extra points.

 l From the top menu, select Drawing> Optimize 
> Smooth or press Alt + Shift + S.

Split Pencil Line and Join 
Pencil Lines

When drawing with the Polyline tool, your drawing has 
an even line thickness. You can use the Pencil Editor to 
adjust the thickness point by point, but if you want to 
adjust it quicker, you can use the Split Pencil Line and 
Point Pencil Lines options to create segments and 
apply a pencil stencil to your drawing. Note that if you 
did not join the pencil lines on your polyline stroke, the 
segments between the points will act as separated 
segments.
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Cutter Tool Properties
When you select the Cutter  tool, its properties and options appear in the Tool Properties view.

Ico-
n

Tool 
Name

Description

Lasso Sets the selection mode to Lasso. Click and hold Alt to temporarily switch between the Marquee 
and Lasso modes.

Marquee Sets the selection mode to Marquee. Click and hold Alt to temporarily switch between the Mar-
quee and Lasso modes.

Apply to 
Line and 
Colour Art

The Apply to Line and Colour Art  option uses the concept of Line Art and Colour Art layers. Use 
this option to apply an action such as selecting, resizing or erasing a drawing on both Line Art and 
Colour Art layers, as well as the Overlay and Underlay layers.

Apply to 
Synced 
Drawing 
Layers

Applies to the Camera view only. Works in conjunction with the Works on Single Drawing. Only 
selects lines from the current drawing and drawing layers synced to the current drawing.

Layers are synced when drawings need to be separated on different layers, but need to have the 
same timing. When you enable the Apply to Synced Drawing Layers option, only drawings on 
layers synced with other layers will be available for cutting. When you click on a synced layer in 
the Timeline view, the other layers that it is synced with will display the link icon.

In the example above, the torso layer is synced with the torso_pattern_1 and torso_
pattern_2 layers.

Use 
Mouse 
Gesture 

When using the Lasso  selection type, the Use Mouse Gesture  option lets you automatically 
delete any extra sections of line in your artwork by simply dragging your mouse over it. 

NOTE: For this operation to work, you lines CANNOT be flattened.
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Use 
Mouse 
Gesture 
Breaker 
Mode

When using the Lasso  selection type, the Use Mouse Gesture Breaker Mode  option lets you 
draw an invisible stroke on a pencil line to cut it in two individual objects. Once a pencil line is cut 
with this option, you will be able to select the two portions independently with either the Cutter 
tool, Pencil Editor tool or Select tool.

NOTE: This option only works with pencil lines.

 Tip Style If you erase the end of a pencil line or erase a pencil line through the centre, new line tips or line 
ends are created. Use the Tip Style option to customize the  shape of the new line tips that are 
created.

 Antiali-
asing

When drawing on a bitmap layer, lines are no longer clean vector shapes. For the edges to be 
smooth, a slight amount of antialiasing is used. When using the Cutter tool, you can cut a portion 
of your drawing with or without antialiasing. By default, the option is enabled. If you want to cut 
your drawing using a hard edge, you can select the Antialiasing Off option. 

Flip Hori-
zontal

Flips the current selection horizontally.

Flip Ver-
tical

Flips the current selection vertically.

Rotate 90 
Degrees 
CW

Rotates the current selection 90 degrees clockwise.

Rotate 90 
Degrees 
CCW

Rotates the current selection 90 degrees counter-clockwise.
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Drawing Pivot Tool Properties
The Drawing Pivot  tool lets you set the pivots on your character. You can set the drawing pivots on drawings and 
symbols.

Icon Tool Name Description

Setting the Drawing Pivot 
for Symbols on All Frames

The Set the Pivot for Symbol on All Frames  option is 
enabled by default. When you set a drawing pivot on a 
symbol, all of its cells use the same drawing pivot. This 
means you do not have to set a drawing pivot on all 
frames. Once you set it, it is done.

If you prefer to set a different drawing pivot for a series 
of cells, you can deselect the option and set your pivots 
on each cell or cell range.

NOTE: If you have already set several different 
pivots on your symbol's cells and selected the Set 
the Pivot for Symbol on All Frames option, once 
you set a new pivot on the same symbol, all of its 
pivots will be reset and will use your new pivot.

Snap to Contour Snaps your selection or point to any line you position it 
on. As soon as you move it close enough to another 
line, your point or selection will snap to it.

Snap and Align Snaps the selected anchor point to any existing line 
while displaying temporary rulers as a guide that you 
can also snap your anchor point to.

Snap to Grid Snaps your selection following the currently enabled 
grid. 

Reset Pivot When you click the Reset Pivot  option, the drawing 
pivot of the selected drawing or symbol is reset to the 
centre of the Camera view.

571



Chapter 5: Tools Properties     Drawing Pivot Tool Properties

Copying Pivot on Parent 
Symbol

When you import new extra drawings, such as hands 
and mouths, you can use the drawing pivot that was set 
on your drawings and report them to the symbol's cells. 
Use the Copy Pivot to Parent Symbol   command for 
this.

NOTE: When you copy drawing pivots to the par-
ent symbol, there is no link between the drawings' 
pivots and the symbol's pivots. If you modify the 
drawing pivot later, it will not link to the symbol. 
You would need to perform the operation again. If 
you need to modify the symbol's pivots, you can do 
it directly on the symbol's cells.
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Dropper Tool Properties
When you select the Dropper tool, its properties and options appears in the Tool Properties view. 

Icon Tool Name Description

Sample All Layers On bitmap layers, if strokes with transparency located 
on separated art layers overlap, the Dropper will pick 
the combination of the two colours. When disabled, the 
Dropper will pick the colour on the current art layer.

Do not Pick Transparency On bitmap layers, when enabled, the dropper will pick 
the colour at 100% of opacity even if the selection has 
some transparency.
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Ellipse Tool Properties
When you select the Ellipse tool, its properties and options appear in the Tool Properties view. There are a few 
less options available when working on a bitmap layer. 

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to 
display advanced customization parameters.

 Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Shape You can adjust the start, end, and joint  style of a pencil line.
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 l Start: Lets you select the style of the start  tip, which is the first 
tip you drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip 
you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line 
curves abruptly. You could also define the Join style as the 
corner style. You can choose between Round, Mitre and Bevel 
style.

 Presets

Harmony provides a variety of presets and also lets you create and 
save your own. It is a good idea to create and save pencils with precise 
sizes and parameters when you draw and design for efficiency and 
consistency. 

All tools using pencil lines share the same preset list. Therefore, the 
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same 
preset list.

New Brush Allows to create a new preset.

Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes
Allows you to import a set of XML Harmony presets previously 
exported via the Export Brushes command. 

 Export Brushes
Allows you to export Harmony presets to backup or import on a 
different computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Draw Behind

When drawing on vector layers, the Draw Behind mode lets you paint 
behind existing art. By default, strokes appear over your work until you 
release the tool.

Automatic Filling

Use the Automatic Filling  option to automatically fill your shape with the 
selected colour as you draw. By default, the Shape tool creates the 
outline of an empty shape that you can later fill using the Paint tool. 
This option is unavailable for the line tool. 

575



Chapter 5: Tools Properties     Ellipse Tool Properties

Snap to Contour
Snaps your selection or point to any line you position it on. As soon as 
you move it close enough to another line, your point or selection will 
snap to it.

Snap and Align
Snaps the selected anchor point to any existing line while displaying 
temporary rulers as a guide that you can also snap your anchor point to.

Snap to Grid

Snaps your selection following the currently enabled grid. 

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

Auto-Flatten Mode

When enabled, the Auto-Flatten  mode automatically flattens the new 
lines created with the existing artwork as you draw in the Drawing or 
Camera view. Brush strokes will flatten with brush strokes and pencil 
lines will flatten with pencil lines.

NOTE: 
Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the Auto-
Flatten mode are essentially cut into segments by the overlap and 
can be treated as individual lines.
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Use Stored Colour Gradi-
ent

The Use Stored Colour Gradient  option makes your tool use the 
previously stored gradient position. This way, every new brush line or 
colour fill will use the stored gradient position.

 Draw Circle
Enable this option to draw perfect circle (ratio 1:1) without holding any 
keyboard shortcuts. As an alternative, you can hold down the Shift key.

Size and Smoothness Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 

Tool Name Description

Maximum Size
Defines the maximum size of your drawing tool. This parameter defines the  width of 
the stroke.

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If 
you do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Contour Smoothing
Defines the number of points on the contour share of your stroke. This will smooth 
out the bumps and waves on tour contour shape of your brush strokes.

Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.
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Texture Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 

  

Icon Tool Name Description

Copy to Preferences You can add a pencil texture to your preset preferences. 

 New Texture Adds a new custom pencil texture to the list.

 Delete Texture Deletes a texture preset from the list.

 Rename Texture Renames the selected texture to keep the list organized.

 Presets
Harmony provides a variety of pencil texture presets and also lets you 
create and save your own.

 Pencil Texture Palette
Displays the colour palette assigned to hold the pencil textures. Use 
the Colour View menu to assign a new palette.

578



Harmony 14 Premium - Reference Guide

Envelope Tool Properties
Selecting the Envelope tool displays its properties and options in the Tool Properties view. 

Icon Tool Name Description

 Width and Height Increase the width and height values to add more 
columns and rows to the deformation grids.

Lasso Sets the selection mode to Lasso. Click and hold Alt to 
temporarily switch between the Marquee and Lasso 
modes.

Marquee Sets the selection mode to Marquee. Click and hold Alt 
to temporarily switch between the Marquee and Lasso 
modes.

Snap to Contour Snaps your selection or point to any line you position it 
on. As soon as you move it close enough to another 
line, your point or selection will snap to it.

Snap and Align Snaps the selected anchor point to any existing line 
while displaying temporary rulers as a guide that you 
can also snap your anchor point to.

Snap to Grid Snaps your selection following the currently enabled 
grid. 
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Show Advanced Controls To display more controls,you can click on the Show 
Advanced Controls  button.

Apply to Line and Colour Art The Apply to Line and Colour Art  option uses the 
concept of Line Art and Colour Art layers. Use this 
option to apply an action such as selecting, resizing or 
erasing a drawing on both Line Art and Colour Art 
layers, as well as the Overlay and Underlay layers.

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-clock-
wise.

Smooth You can modify the central line smoothness  of your line 
using this option. This parameter smooths the deformed 
lines. Increasing the value will result in a smoother line 
with fewer control points. The more you increase the 
value, the less details and curves you will get. Use the 
left and right arrows to increment the value by one full 
unit. Use the Up - Down slider to quickly increment the 
value.
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Eraser Tool Properties
When you're drawing on vector layer and you select the Eraser  tool, its properties and options appear in the Tool 
Properties view.

The bitmap eraser options are identical to those of the bitmap brush with one obvious exception. Instead of 
customizing the parameters of a mark or stroke, you will be customizing the parameters for the absence of a mark or 
stroke. 

It is a good idea to create an eraser preset with the identical properties of a brush preset and to use them as a pair. 
That way, when part of a stroke is erased, its soft textured look is not interrupted with a hard edged eraser mark.

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to display 
advanced customization parameters.

 Maximum Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Smoothing
Defines the number of control points added to the centre line. The fewer 
the control points the smoother (but less faithful) the line.

 Eraser Presets
Presets are created by saving the properties of the current tool to a new 
preset, which you can reuse for repeated tasks. You can create as many 
presets as you need.

New Brush Allows to create a new preset.
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Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes
Allows you to import a set of XML Harmony presets previously exported 
via the Export Brushes command. 

 Export Brushes
Allows you to export Harmony presets to backup or import on a different 
computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Apply to Line and Colour 
Art

The Apply to Line and Colour Art  option uses the concept of Line Art and 
Colour Art layers. Use this option to apply an action such as selecting, 
resizing or erasing a drawing on both Line Art and Colour Art layers, as 
well as the Overlay and Underlay layers.

 Tip Style

If you erase the end of a pencil line or erase a pencil line through the 
centre, new line tips or line ends are created. Use the Tip Style option to 
customize the  shape of the new line tips that are created.

Apply to Synced Drawing 
Layers

Applies to the Camera view only. Works in conjunction with the Works on 
Single Drawing. Only selects lines from the current drawing and drawing 
layers synced to the current drawing.

Size and Smoothness Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 

Tool Name Description
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Maximum Size
Defines the maximum size of your drawing tool. This parameter defines the  width 
of the stroke.

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If 
you do not have pressure sensitivity from a pen table, the minimum size value will 
be ignored. 

Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Contour Smoothing
Defines the number of points on the contour share of your stroke. This will smooth 
out the bumps and waves on tour contour shape of your brush strokes.

Tip Shape

Lets you select a tip shape—from round and square ones to star shaped. This 
option is disabled when using a textured brush.

Soft Eraser Tab 
You can create texture brushes to draw on vector layers. Enable the Soft Eraser option to access the options.  

Hardness
Defines the softness of the stroke edge. The lower the value, the softer the stroke 
edge will be. The higher the value, the sharper the stroke edge will be.

Saturation
Lets you adjust the softness of edge feathering. Works in conjunction with the 
Hardness, e.g. 100% Hardness will yield no results in saturation change. 0% 
Hardness will allow a fine tuning of the feathering of the soft stroke edge.

Maximum Opacity

The transparency of the brush when the pressure is heavy.  A smaller value will 
leave semi-transparent colour and texture. A larger value will ensure that 
everything is properly erased. This option in unavailable if the Keep Vectors 
option is disabled.

Minimum Opacity

Sets the minimum transparency of the brush, in relation to the Maximum Opacity, 
when the pressure is very light. A smaller value will leave semi-transparent colour 
and texture. A larger value will ensure that everything is properly erased.  This 
option in unavailable if the Keep Vectors option is disabled.

Keep Vectors

Keeps the vector frames around your strokes intact, only the texture fill dis-
appears. Disabling this option will cut the stroke's vector frame into different 
pieces when the Eraser tool passes over it. If you disable this option, the max-
imum and minimum opacity sliders are disabled as well.
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Ink Tool Properties
When you select the Ink tool, its properties and options appear in the Tool Properties view.

Icon Tool Name Tool

Lasso
Sets the selection mode to Lasso. Click and hold 
Alt to temporarily switch between the Marquee 
and Lasso modes. 

Marquee
Sets the selection mode to Marquee. Click and 
hold Alt to temporarily switch between the 
Marquee and Lasso modes. 

Show Inkable Lines

Highlights all pencil lines (no brush strokes) on the 
selected layer. Pencil line segments that are 
already inked with the selected swatch colour 
from the colour palette are also not highlighted.

Be Smart on Connecting Lines

As you hover and move the cursor across 
intersecting pencil lines, the path that you create 
will be highlighted. When you click on your mouse 
or stylus the highlighted segments are inked.  With 
this option disabled, all the intersecting segments 
that your cursor comes near will be highlighted 
and become part of the selection, even if they 
were not situated in the direction of the chosen 
path.

NOTE: This option only works if the Ink tool 
is in Hover mode.

Select Mode

Use this mode instead of the Hover Mode. In the 
Hover Mode, any potentially inkable pencil line 
will have its central vector line highlighted as the 
Ink tool’s cursor hovers over it. Use Ctrl (Win-
dows/Linux) or ⌘  (Mac OS X) to toggle between 
the two modes.

Select Newly Painted, Repainted, 
and Unpainted Contours/Lines

In the Paint   tool properties, this option  keeps a 
selection highlighted around the latest painted 
zone after using the Paint, Repaint, Unpaint, or 
Paint Unpainted tool.
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Raise

As you ink the pencil line, the segment will be 
moved on top of the other intersecting strokes. 
Disable this option for the line to be sent behind. 
Hold down the Alt key to perform the opposite 
operation as you ink.

Mitre

As you hover over two perpendicular or nearly per-
pendicular segments, a highlighted path with a 
corner is created. Clicking on these highlighted 
segments inks both segments and makes them 
appear as a single stroke with a corner or bend. 
Options include: As Is, Round, Miter, and Bevel.

Tip Style
Lets you customize the edge of the Ink tool. 
Options include: Round, Flat, and Bevel.
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Inverse Kinematics Tool Properties
The IK tool has a series of different modes and options available in the Tool Properties view.

Mode
Mode Button Description

Bone Selection

Enabled by default, this mode lets you click on any bone in a 
character and move it without having to select the actual layer.

When you disable this mode, you cannot move any bone except the 
selected one. This allows you to grab and rotate the selected part 
from many angles and locations. You can click completely outside 
the character and move the pieces.

Chain

•  Simple Chain Mode: This is the default mode and will 
only allow for the movement of parts attached to a single chain 
up to the point of intersection. A single chain is a straight line 
with no secondary chain attached.

•  Direct Chain Mode: This mode allows you to move parts 
up a simple secondary chain to a principle chain, as long as 
translation movement is possible (the principle chain is 
attached to its own peg), but will ignore all secondary chains. 
A direct chain is a single chain which goes directly to the core.

•  All Chain Mode: This mode allows you to move all parts 
attached to all chains in the IK skeleton. All chains are 
attached and move simultaneously when one part is moved.

IK Manipulation

The main working mode for the IK tool. Enable this mode when you 
want to animate and position a puppet.

Ctrl + click (Windows/Linux) or ⌘  + click (Mac OS X) on a body part 
to select it. You do not need to select a part to be able to move it.

Apply IK Constraints
Lets you correct a part's position on a series of frames. For example, 
if the character's foot is sinking into the floor, you can correct its pos-
ition and angle over a series of frames.

Edit Min/Max Angle
Lets you set a rotation restriction on some of your parts, such as 
elbows, knees and ankles.
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Bone Editing
Lets you fix the bone orientation on extremities, such as hands and 
feet.

IK Options
Parameter Description

IK Keyframe
Used in combination with the IK Constraints mode, this option determines the 
starting frame of the constraint you will apply.

Ease Shape While animating with the IK tool and before doing a movement,  set an easing 
preset so the motion is not so mechanical.

Before moving the part, select a preset from the Ease Shape menu:

If you select a new preset in the list and move the part again on the same 
keyframe, the easing will automatically update.

Selection
Parameter Description

Enable Translation If Top of 
Hierarchy

Used only on master pegs. This option is useful when you have this particluar situ-
ation: You want the character to do a perfect split (sitting down with the legs at 
right angles to the body or at the sides with the torso facing forwards), then the hip 
will need to translate and not just rotate on the spot. And since IK is all about rota-
tion, you would select the hip layer and enable the translation option.

Enable Rotation
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This option is enabled by default. The pivot disappears but you can still see the 
bone.  When this option is disabled, the selected part cannot be rotated and will 
remain in the same position. You can use this option to simulate an arm in a 
plaster cast.

Exclude from IK
This option lets you exclude certain parts of the puppet from the IK influence, 
such as the eyes and mouth.

IK Nails
These options let you temporarily fix a part of a character to a spot either in trans-
lation or rotation, or enable maximum and minimum angle usage.

Stiffness

When a certain part is selected, you can apply a stiffness value to it. A different 
stiffness value can be set to each body part individually. The greater the stiffness, 
the more difficult it is to make that part rotate, thereby rendering it stiff while the 
other parts continue to move freely on their joints.
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Line Tool Properties
When you select the Line tool, its properties and options appear in the Tool Properties view. There are a few less 
options available when working on a bitmap layer. 

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to display 
advanced customization parameters.

 Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Shape You can adjust the start, end, and joint  style of a pencil line.
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 l Start: Lets you select the style of the start  tip, which is the first tip 
you drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip 
you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line 
curves abruptly. You could also define the Join style as the corner 
style. You can choose between Round, Mitre and Bevel style.

 Presets

Harmony provides a variety of presets and also lets you create and save 
your own. It is a good idea to create and save pencils with precise sizes 
and parameters when you draw and design for efficiency and consistency.
 

All tools using pencil lines share the same preset list. Therefore, the 
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset 
list.

New Brush Allows to create a new preset.

Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes
Allows you to import a set of XML Harmony presets previously exported 
via the Export Brushes command. 

 Export Brushes
Allows you to export Harmony presets to backup or import on a different 
computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Draw Behind

When drawing on vector layers, the Draw Behind mode lets you paint 
behind existing art. By default, strokes appear over your work until you 
release the tool.

Snap to Contour
Snaps your selection or point to any line you position it on. As soon as you 
move it close enough to another line, your point or selection will snap to it.

Snap and Align
Snaps the selected anchor point to any existing line while displaying tem-
porary rulers as a guide that you can also snap your anchor point to.

Snap to Grid Snaps your selection following the currently enabled grid. 
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Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art layer.

Auto-Flatten Mode

When enabled, the Auto-Flatten  mode automatically flattens the new lines 
created with the existing artwork as you draw in the Drawing or Camera 
view. Brush strokes will flatten with brush strokes and pencil lines will 
flatten with pencil lines.

NOTE: 
Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the Auto-
Flatten mode are essentially cut into segments by the overlap and 
can be treated as individual lines.

Auto-Close Gap

When using the pencil tool, you can automatically close strokes with an 
invisible stroke. 

It is recommended to keep this option enabled when drawing with the 
Pencil tool.

Line Building Mode The Line Building mode is very useful when drawing long lines and curves 
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in small increments with pencil lines or the Line tool. As the pencil lines 
are central vector lines, it may be difficult to align the line tips perfectly to 
create a uniform stroke and close all gaps.

In this mode, you can draw lines in small increments and the tips are 
merge into one single stroke.

NOTE: This mode only works with pencil lines or the line  tool.

Use Stored Colour Gradi-
ent

The Use Stored Colour Gradient  option makes your tool use the previously 
stored gradient position. This way, every new brush line or colour fill will 
use the stored gradient position.

 Draw Circle
Enable this option to draw perfect circle (ratio 1:1) without holding any key-
board shortcuts. As an alternative, you can hold down the Shift key.

Size and Smoothness Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 

Tool Name Description

Maximum Size
Defines the maximum size of your drawing tool. This parameter defines the  width 
of the stroke.

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If 
you do not have pressure sensitivity from a pen table, the minimum size value will 
be ignored. 

Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Contour Smoothing Defines the number of points on the contour share of your stroke. This will smooth 
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out the bumps and waves on tour contour shape of your brush strokes.

Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you 
drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 

  

Icon Tool Name Description

Copy to Preferences You can add a pencil texture to your preset preferences. 

 New Texture Adds a new custom pencil texture to the list.

 Delete Texture Deletes a texture preset from the list.

 Rename Texture Renames the selected texture to keep the list organized.

 Presets
Harmony provides a variety of pencil texture presets and also lets you 
create and save your own.

 Pencil Texture Palette Displays the colour palette assigned to hold the pencil textures. Use the 
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Colour View menu to assign a new palette.
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Morphing Tool Properties
As you create and adjust your morphing sequences, you will often use the Tool Properties view. Using this view 
allows you to do things such as toggle between your key drawings, adjust the easing or select a hint type.  

Icon Tool Name Description

Hint Type The Hint Type drop-down menu allows you to select the 
correct hint to remedy any problem areas in your 
drawing.

You can have more than one hint type in your drawings. 
You can mix all of the hint types in your morphing 
sequence.

Do not Pick Transparency The Hide Hints  button temporarily Temporarily hides the 
hint points from the key drawings. Use this option when 
you have a series of hint points hiding some lines you 
would like to see.
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Show Morphing in Place The Show Morphing In Place  option is used with 
morphing layers. Enabling this option prevents the 
currently selected morphing layer from being shown on 
top of the others and maintains the correct layer 
ordering.

Suggest Hints The Suggest Hints  option is used to automatically set 
Automatically sets hint points on key drawings as a 
help tool. If you're not sure where to set hints, you can 
use this option. It will set the main hints which you can 
then fine tune.

Switch Between Drawings The Switch Between Drawings  button is used to toggle 
Toggles between the two key drawings in your 
morphing sequence. This option is useful while setting 
hints. You can use the default keyboard shortcut F4 to 
toggle between your drawings.

Flatten The Flatten  option is used when you have to morph a 
sequence with a semi-transparent or transparent colour 
in it.

 Quality The Quality setting is used to make the lines of the 
morphed drawings smoother. Adjust this parameter 
when you are doing an extreme close up of your 
animation.

 Morphing Layers The Morphing Layers option is used when working with 
morphing layers. You can add, remove and manage 
your different morphing layers in this space.

To create new drawings, double-click on the blank area 
under the From section to create the source drawing 
and the To section for the destination drawing and type 
a different value than the ones used for the main layer.

Add Layer Adds a new Morphing layer.

Delete Layer Deletes the selected Morphing layer.

Move Up Moves the new layer up in the stack.

Move Down Moves the new lower up in the stack.

 Start Indicates the start frame of the selected Morphing layer.
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 Stop Indicates the end frame of the selected Morphing layer. 

 Ease in and Ease out The Easing option is used to adjust the starting and 
ending velocity of your morphing sequence so that the 
motion is smooth and not mechanical.

You can adjust the Ease In and Ease Out value by 
dragging your cursor up and down or typing a new value. 
The values go from -1.0 to 1.0.

Convert Hints The Convert Hints  option is used to switch the type of 
the selected hint points. This option is useful when you 
position hints and then realize they are not the right 
type. You can select them and convert them to the 
correct type instead of deleting them and setting new 
ones.

Use the Morphing tool to select the hints and then 
convert them by going to the Tool Properties view and 
selecting the new hint type from the Convert Hints drop-
down menu.

 Time The Time field is used to set the timing on Appearing 
Point and Vanishing Point hints. These hints are used to 
set the trajectory of appearing and vanishing objects, 
With the Time field, select your Appearing Point or 
Vanishing Point hint and type the frame number on 
which the object will start its appearing or vanishing 
animation.
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Paint Tool Properties 
When you select the Paint tool, its properties and options appears in the Tools Properties view.

Icon Tool Name Description

Lasso Sets the selection mode to Lasso. Click and hold Alt to 
temporarily switch between the Marquee and Lasso modes. 

Marquee Sets the selection mode to Marquee. Click and hold Alt to 
temporarily switch between the Marquee and Lasso modes. 

Paint Modes The Paint tool has four different modes available: 

 l The Paint  mode paints everything it touches, including 
empty and filled zones. 

 l The Paint Unpainted  mode paints only empty zones. 
Any line or filled zone will remain unchanged.

 l The Repaint  mode paints everything it touches except 
empty zones. Any zone that is not painted will remain 
intact. 

 l The Unpaint  mode unpaints everything it touches, 
including empty and filled zones.

Paint and Remove Tex-
tures

The Paint and Remove Texture  option is used when you 
vectorized images as greyscale texture style. An image 
vectorized as texture is a mix of bitmap filling encapsulated in 
a vector-based frame. Painting a textured zones with the 
Paint tool will change the tint of the textured lines. Painting 
the textured zones using the Paint and Remove Texture 
option transforms the bitmap filling into a 100% vector based 
zone and fills it with a solid colour.
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Apply to Multiple Draw-
ings

The Apply to Multiple Drawings  option is used for fast painting 
in hand-drawn animation. When you want to paint several 
drawings in a same layer at once, such as a walk cycle, you 
can enable this option and make a selection in the Camera or 
Drawing view. All the closed zones located within your Paint 
tool selection are painted with the selected colour swatch.

You do not need to enable the Onion Skin preview to use this 
option. The option will stay enabled only for the next action. If 
you want to use it again, you must click on the Apply to 
Multiple Drawings button again, or press Alt + A.

Apply to All Visible Draw-
ings

The Apply to All Visible Drawings  option is used to paint 
several drawings on separated layers on the current frames. If 
you have a character broken in several layers, you can enable 
this option to paint all your layers at once. The operation is 
only applied on the current frame. This option will stay 
enabled only for the next action. If you want to use it again, 
you must click on the Apply to All Visible Drawings button 
again.

NOTE: This option is only available in the Camera view 
and does not affect symbols.

Respect Protected Col-
our

The Respect Protected Colour option is enabled by default. In 
your Colour view, you can protect some colour swatches to 
avoid repainting or unpainting the zones linked to that swatch. 

If you disable this option the Paint tool will not follow the 
protect colour rule and will repaint or unpaint the protected 
colours on your drawings until you enable the option again.

Use Stored Colour Gradi-
ent

When you paint a zone with a gradient or textured colour 
swatch, the gradient or texture’s position is set relative to the 
size of the zone you are painting. If you want the Paint tool to 
use a particular size and position, you must first store your 
desired position and size using the Select  tool and then 
enable the Use Stored Colour Gradient   option in the Paint tool 
properties.
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Select Newly Painted, 
Repainted, and 
Unpainted Con-
tours/Lines

In the Paint   tool properties, this option  keeps a selection 
highlighted around the latest painted zone after using the 
Paint, Repaint, Unpaint, or Paint Unpainted tool.

Close Gap The Close Gap option has four modes available. When the 
option is enabled, Harmony will consume more resources 
while painting.

 l No Close Gap: The moment a zone has a gap in it, the 
Paint tool will not fill the area. 

 l Close Small Gap: If a zone has a small gap in it, the 
Paint tool will fill the area. You can zoom out to make 
the gap appear smaller and the Paint tool will paint. 

 l Close Medium Gap: If a zone has a medium gap in it, 
the Paint tool will fill the area. You can zoom out to 
make the gap appear smaller and the Paint tool will 
paint.  

 l Close Large Gap: If a zone has a large gap in it, the 
Paint tool will fill the area. You can zoom out to make 
the gap appear smaller and the Paint tool will paint. 
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 Pencil Tool Properties
When you select the Pencil  tool, its properties and options appears in the Tool Properties view. 

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to display 
advanced customization parameters.

 Maximum Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Smoothing
Defines the number of control points added to the centre line. The fewer 
the control points the smoother (but less faithful) the line.

 Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first 
tip you drew. You can choose between Round or Flat style.
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 l End: Lets you select the style of the end tip, which is the last tip 
you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line 
curves abruptly. You could also define the Join style as the 
corner style. You can choose between Round, Mitre and Bevel 
style.

 Presets

Harmony provides a variety of pencil presets and thickness stencils and 
also lets you create and save your own. It is a good idea to create and 
save pencils with precise sizes and parameters when you draw and 
design for efficiency and consistency.

A thickness stencil saves the thickness information across the length of 
the line.  When drawing with a thickness stencil, the pressure sensitivity 
of the tablet is discarded. A thickness stencil can be used while 
drawing, or applied afterwards.

You also have the possibility to apply different textures to your lines by 
either using the default presets or importing your own.

You can  export the pencil presets that you have created and import 
those that others have created. This is a good way for you and project 
collaborators to keep a consistent look for the project.

New Brush Allows to create a new preset.

Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes
Allows you to import a set of XML Harmony presets previously exported 
via the Export Brushes command. 

 Export Brushes
Allows you to export Harmony presets to backup or import on a different 
computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Draw Behind

When drawing on vector layers, the Draw Behind mode lets you paint 
behind existing art. By default, strokes appear over your work until you 
release the tool.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.
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Auto-Flatten Mode

When enabled, the Auto-Flatten  mode automatically flattens the new 
lines created with the existing artwork as you draw in the Drawing or 
Camera view. Brush strokes will flatten with brush strokes and pencil 
lines will flatten with pencil lines.

NOTE: 
Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the Auto-
Flatten mode are essentially cut into segments by the overlap and 
can be treated as individual lines.

Auto-Close Gap

When using the pencil tool, you can automatically close strokes with an 
invisible stroke. 

It is recommended to keep this option enabled when drawing with the 
Pencil tool.

Line Building Mode

The Line Building mode is very useful when drawing long lines and 
curves in small increments with pencil lines or the Line tool. As the 
pencil lines are central vector lines, it may be difficult to align the line 
tips perfectly to create a uniform stroke and close all gaps.

In this mode, you can draw lines in small increments and the tips are 
merge into one single stroke.

NOTE: This mode only works with pencil lines or the line  tool.
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Auto Adjust Thickness

The Auto Adjust Thickness  tool is useful when you want to render a 
portion of a line thicker. When tracing a drawing on paper, you will often 
go back to a section of a curve to make it thicker to add dynamism to the 
line. Using the Auto Adjust Thickness tool, you can draw highlight 
strokes over the section to make thicker. Once you release the pen or 
mouse, the line becomes thicker following the shape and curve of the 
original stroke. This way is much faster and smoother than using the 
Pencil Editor tool. You do not have to add extra points and adjust the 
position and Bezier handles.

The default overlay colour is light yellow. If this colour is difficult to see 
because of the background or drawing colour, you can adjust the colour.

Line Pushing Mode

The Line Pushing Mode  option lets you draw highlight strokes over 
existing pencil lines. You can reshape the curves. Depending how you 
draw the pushing stroke over your line, the highlighted section will be 
reshaped in one direction or the other.

The default overlay colour is light yellow. If this colour is difficult to see 
because of the background or drawing colour, you can adjust the colour.

 

 Colour

You can change the colour for the Line Pushing Mode anf the Auto 
Adjust Thickness option by clicking on the Colour swatch and selecting 
a new colour in the Colour Picking window. 

Size and Smoothness Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 
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Tool Name Description

Maximum Size
Defines the maximum size of your drawing tool. This parameter defines the  width 
of the stroke.

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If 
you do not have pressure sensitivity from a pen table, the minimum size value will 
be ignored. 

Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Contour Smoothing
Defines the number of points on the contour share of your stroke. This will smooth 
out the bumps and waves on tour contour shape of your brush strokes.

Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you 
drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 
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Icon Tool Name Description

Copy to Preferences You can add a pencil texture to your preset preferences. 

 New Texture Adds a new custom pencil texture to the list.

 Delete Texture Deletes a texture preset from the list.

 Rename Texture Renames the selected texture to keep the list organized.

 Presets
Harmony provides a variety of pencil texture presets and also lets you 
create and save your own.

 Pencil Texture Palette
Displays the colour palette assigned to hold the pencil textures. Use the 
Colour View menu to assign a new palette.
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Pencil Editor Tool Properties
When you select the Pencil Editor  tool, its properties and options appear in the Tool Properties view. 

Ico-
n

Tool 
Name

Description

Lasso
Sets the selection mode to Lasso. Click and hold Alt to temporarily switch between the Mar-
quee and Lasso modes.
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Marquee
Sets the selection mode to Marquee. Click and hold Alt to temporarily switch between the 
Marquee and Lasso modes.

 
Maximum 
Size

Defines the maximum size of your drawing tool. This parameter defines the  width of the 
stroke.

 
Minimum 
Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you do not 
have pressure sensitivity from a pen table, the minimum size value will be ignored. 

 Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. You can 
choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You can 
choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves abruptly. You 
could also define the Join style as the corner style. You can choose between Round, 
Mitre and Bevel style.

 Presets

Harmony provides a variety of pencil presets and thickness stencils and also lets you create 
and save your own. It is a good idea to create and save pencils with precise sizes and 
parameters when you draw and design for efficiency and consistency.

A thickness stencil saves the thickness information across the length of the line.  When 
drawing with a thickness stencil, the pressure sensitivity of the tablet is discarded. A 
thickness stencil can be used while drawing, or applied afterwards.

You also have the possibility to apply different textures to your lines by either using the default 
presets or importing your own.

You can  export the pencil presets that you have created and import those that others have 
created. This is a good way for you and project collaborators to keep a consistent look for the 
project.

New 
Brush

Allows to create a new preset from the selected pencil line.

Delete 
Brush

Allows you to delete your custom presets. 

 
Rename 
Brush

Allows you to rename a custom preset.

 

Small 
Thumb-
nail, Large 
Thumb-
nail, and 
Stroke 
View

Allows you to display the presets as small square thumbnails, large square thumbnails or a 
list of stroke preview. 
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Copy to 
Prefer-
ences

You can add a pencil texture to your preset preferences. 

 
New Tex-
ture

Adds a new custom pencil texture to the list.

 
Delete 
Texture

Deletes a texture preset from the list.

 
Rename 
Texture

Renames the selected texture to keep the list organized.

 Presets
Harmony provides a variety of pencil texture presets and also lets you create and save your 
own.

 
Pencil Tex-
ture 
Palette

Displays the colour palette assigned to hold the pencil textures. Use the Colour View menu to 
assign a new palette.

Smooth 
Selection

The Smooth operation lets you smooth out selected drawing strokes and remove extra points.

 l From the top menu, select Drawing> Optimize > Smooth or press Alt + Shift + S.

Pump Pen-
cil Pres-
sure

The Pump Pencil Pressure  option is used to increase the line thickness of a selected area on 
a pencil line.

Deflate 
Pencil 
Pressure

The Deflate Pencil Pressure option is used to decrease the line thickness of a selected area 
on a pencil line.
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Merge 
Pencil 
Lines

Pencil lines are central vector lines and it might be difficult to match pencil line’s tips properly 
to align them and make it look like it is one single line. With the Select tool, you can select 
several pencil lines and merge them as one single object using the Merge Pencil Lines  option. 
The ends of your lines are adjusted to form one single line.

 

Reverse 
Pencil 
Thickness

The Reverse Pencil Thickness  option inverts the thick and thin section on a selected pencil 
line. This option will take the thickest size on the line and apply it to the thinnest, and it will 
apply the thinnest to the thickest.
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Perspective Tool Properties
Selecting the Perspective tool displays its properties and options in the Tool Properties view. 

Icon Tool Name Description

Selection Tool Options

Lasso Sets the selection mode to Lasso. Click and hold Alt 
to temporarily switch between the Marquee and 
Lasso modes.

Marquee Sets the selection mode to Marquee. Click and hold 
Alt to temporarily switch between the Marquee and 
Lasso modes.

Snap to Contour Snaps your selection or point to any line you position 
it on. As soon as you move it close enough to 
another line, your point or selection will snap to it.

Snap and Align Snaps the selected anchor point to any existing line 
while displaying temporary rulers as a guide that you 
can also snap your anchor point to.

Snap to Grid Snaps your selection following the currently enabled 
grid. 

Apply to Line and Colour Art The Apply to Line and Colour Art  option uses the 
concept of Line Art and Colour Art layers. Use this 
option to apply an action such as selecting, resizing 
or erasing a drawing on both Line Art and Colour Art 
layers, as well as the Overlay and Underlay layers.

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-
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clockwise.
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Polyline Tool Properties
When you select the Polyline  tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to 
display advanced customization parameters.

 Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Presets

Harmony provides a variety of presets and also lets you create and 
save your own. It is a good idea to create and save pencils with precise 
sizes and parameters when you draw and design for efficiency and 
consistency. 

All tools using pencil lines share the same preset list. Therefore, the 
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same 
preset list.

New Brush Allows to create a new preset.

Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes Allows you to import a set of XML Harmony presets previously 
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exported via the Export Brushes command. 

 Export Brushes
Allows you to export Harmony presets to backup or import on a 
different computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Snap to Contour
Snaps your selection or point to any line you position it on. As soon as 
you move it close enough to another line, your point or selection will 
snap to it.

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

Auto-Flatten Mode

When enabled, the Auto-Flatten  mode automatically flattens the new 
lines created with the existing artwork as you draw in the Drawing or 
Camera view. Brush strokes will flatten with brush strokes and pencil 
lines will flatten with pencil lines.

NOTE: 
Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the Auto-
Flatten mode are essentially cut into segments by the overlap and 
can be treated as individual lines.

Size and Smoothness Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 
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Tool Name Description

Maximum Size
Defines the maximum size of your drawing tool. This parameter defines the  width 
of the stroke.

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If 
you do not have pressure sensitivity from a pen table, the minimum size value will 
be ignored. 

Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Contour Smoothing
Defines the number of points on the contour share of your stroke. This will smooth 
out the bumps and waves on tour contour shape of your brush strokes.

Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you 
drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 
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Icon Tool Name Description

Copy to Preferences You can add a pencil texture to your preset preferences. 

 New Texture Adds a new custom pencil texture to the list.

 Delete Texture Deletes a texture preset from the list.

 Rename Texture Renames the selected texture to keep the list organized.

 Presets
Harmony provides a variety of pencil texture presets and also lets you 
create and save your own.

 Pencil Texture Palette
Displays the colour palette assigned to hold the pencil textures. Use the 
Colour View menu to assign a new palette.
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Rectangle Tool Properties
When you select the Rectangle tool, its properties and options appear in the Tool Properties view. There are a few 
less options available when working on a bitmap layer. 

Icon Tool Name Description

 Previewing the Stroke

The Preview area lets you see a preview of the selected or customized 
stroke. You can click on the Show Extended Properties arrow to 
display advanced customization parameters.

 Size
Defines the maximum size of your drawing tool. This parameter defines 
the  width of the stroke.

 Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first 
tip you drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip 
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you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line 
curves abruptly. You could also define the Join style as the 
corner style. You can choose between Round, Mitre and Bevel 
style.

 Presets

Harmony provides a variety of presets and also lets you create and 
save your own. It is a good idea to create and save pencils with precise 
sizes and parameters when you draw and design for efficiency and 
consistency. 

All tools using pencil lines share the same preset list. Therefore, the 
Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same 
preset list.

New Brush Allows to create a new preset.

Delete Brush Allows you to delete your custom presets. 

 Rename Brush Allows you to rename a custom preset.

 Import Brushes
Allows you to import a set of XML Harmony presets previously 
exported via the Export Brushes command. 

 Export Brushes
Allows you to export Harmony presets to backup or import on a 
different computer. 

 
Small Thumbnail, Large 
Thumbnail, and Stroke 
View

Allows you to display the presets as small square thumbnails, large 
square thumbnails or a list of stroke preview. 

Draw Behind

When drawing on vector layers, the Draw Behind mode lets you paint 
behind existing art. By default, strokes appear over your work until you 
release the tool.

Automatic Filling

Use the Automatic Filling  option to automatically fill your shape with the 
selected colour as you draw. By default, the Shape tool creates the 
outline of an empty shape that you can later fill using the Paint tool. 
This option is unavailable for the line tool. 

Snap to Contour
Snaps your selection or point to any line you position it on. As soon as 
you move it close enough to another line, your point or selection will 
snap to it.

Snap and Align
Snaps the selected anchor point to any existing line while displaying 
temporary rulers as a guide that you can also snap your anchor point to.
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Snap to Grid

Snaps your selection following the currently enabled grid. 

Automatically Create 
Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  
option instantly creates the corresponding strokes in the Colour Art 
layer.

Auto-Flatten Mode

When enabled, the Auto-Flatten  mode automatically flattens the new 
lines created with the existing artwork as you draw in the Drawing or 
Camera view. Brush strokes will flatten with brush strokes and pencil 
lines will flatten with pencil lines.

NOTE: 
Using the Select tool, you can use select and remove a segment of 
flattened pencil lines. Overlapping pencil lines drawn with the Auto-
Flatten mode are essentially cut into segments by the overlap and 
can be treated as individual lines.

Use Stored Colour Gradi-
ent

The Use Stored Colour Gradient  option makes your tool use the 
previously stored gradient position. This way, every new brush line or 
colour fill will use the stored gradient position.

 Draw Square
Enable this option to draw perfect square (ratio 1:1) without holding any 
keyboard shortcuts. As an alternative, you can hold down the Shift key.

Size and Smoothness Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 
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Tool Name Description

Maximum Size
Defines the maximum size of your drawing tool. This parameter defines the  width of 
the stroke.

Minimum Size
Defines the minimum size of your stroke as a percentage of the maximum size. If 
you do not have pressure sensitivity from a pen table, the minimum size value will be 
ignored. 

Smoothing
Defines the number of control points added to the centre line. The fewer the control 
points the smoother (but less faithful) the line.

Contour Smoothing
Defines the number of points on the contour share of your stroke. This will smooth 
out the bumps and waves on tour contour shape of your brush strokes.

Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 
You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 
abruptly. You could also define the Join style as the corner style. You can 
choose between Round, Mitre and Bevel style.

Texture Tab 
You can access advanced properties by clicking on the Previewing the Stoke button in the Tool Properties view. 
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Icon Tool Name Description

Copy to Preferences You can add a pencil texture to your preset preferences. 

 New Texture Adds a new custom pencil texture to the list.

 Delete Texture Deletes a texture preset from the list.

 Rename Texture Renames the selected texture to keep the list organized.

 Presets
Harmony provides a variety of pencil texture presets and also lets you 
create and save your own.

 Pencil Texture Palette
Displays the colour palette assigned to hold the pencil textures. Use 
the Colour View menu to assign a new palette.
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Reposition All Drawings Tool Properties
When you use the Reposition All Drawings tool, its properties and options appear in the Tool Properties view. 

Icon Option Description

Apply to Synced Drawing Layers

Applies to the Camera view only. Works in con-
junction with the Works on Single Drawing. Only 
selects lines from the current drawing and draw-
ing layers synced to the current drawing.

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees CW
Rotates the current selection 90 degrees clock-
wise.

Rotate 90 Degrees CCW
Rotates the current selection 90 degrees 
counter-clockwise.

 Offset X and Y

Use the Offset X and Offset Y operation fields to 
enter specific values and precisely reposition the 
selected shape.

 1. X: Type a value in this field to reposition 
your selection along the X-axis.

 2. Y: Type a value in this field to reposition 
your selection along the Y-axis.

 3. Up/Down arrows: Use the up and down 
arrows to modify the value in the X or Y 
value field.

 Width and Height
Use the Width and Height operation fields to 
enter specific values to resize the selected 
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shape with precision.

 1. Width: Type a value in this field to resize 
the width of your selection.

 2. Height: Type a value in this field to resize 
the height of your selection.

 3. Up/Down arrows: Use the up and down 
arrows to modify the value in the Width or 
Height fields.

 4. Lock icon: Click the lock icon to lock or 
unlock the ratio between the Width and 
Height values.

 Angle

The Angle operation lets you to enter specific 
values and accurately rotate the selected shape.

 1. Angle: Type a degree value in this field to 
rotate your selection.

 2. Up/Down arrows: Use the up and down 
arrows to modify the value in the Angle 
value field.

624



Harmony 14 Premium - Reference Guide

Rigging Tool Properties
In the Tool Properties view, you can customize not only the behaviour of the tool but also the settings of the 
deformers that you will create.

Mode
Name Button Description

Automatic Mode
Sets the Rigging tool to automatically create a Bone or Curve 
deformer, corresponding to the movement of the cursor in the 
Camera view.

Bone Mode Sets the Rigging tool to create Bone deformers.

Curve Mode Sets the Rigging tool to create Curve deformers.

Envelope Mode Sets the Rigging tool to create Envelope deformers.

Game Bone Mode Sets the Rigging tool to create Game Bone deformers.

Options
Parameter Button Description

Show All Manipulators 
(Show All Controls)

Lets you immediately see the resting position in red (Setup) and 
the animated position in green.

Show All Regions of Influ-
ence

Lets you visualize the area within which the art will be influenced 
by the deformation effect—see Rigging Tool Properties on page 
625.

Automatically Create 
Group when Creating a 
New Deformation Rig

This option automatically creates a deformation group connected 
to the input port of the selected element. This group includes all 
the necessary deformation nodes  you created.

Bone and Curve Zone of 
Influence

 
The Zone of Influence setting used as the default when creating 
an articulation, bone deformer or curve deformer using the Rig-
ging tool. 

 Zero Influence: The Zone of Influence does not exist. No 
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deformation will happen.

 

Infinite Influence: This is the default option and is the most com-
monly used. The Zone of Influence has no boundary and covers 
the whole element to which the deformer is linked and its chil-
dren, excluding areas that are already part of another elliptic or 
shaped Zone of Influence. The Infinite Influence zone will extend 
from the centre of your skeleton to infinity, working per-
pendicularly to the skeleton.

 

Elliptic Influence: The Zone of Influence boundary is defined by 
an elliptical shape; its size can be customized using the Bone,or 
Articulation or Curve node properties or by using the Transform  
tool. The Elliptic Influence will most likely be used on a bitmap 
picture you want to deform.

 

Shaped Influence: The Zone of Influence boundary is defined 
by a shape which you can customize using the Transform tool. 
The Shaped Influence will most likely be used on a bitmap pic-
ture you want to deform.

 
Influence Radius: This value is the size of the influence zone. 
The default value is 2.

Operations
Name Button Description

Convert Elliptic Zone of Influ-
ence to Shape

After you have created a deformation chain using Elliptic as 
the Zone of Influence type, you can select your deformer 
and click on this button to convert it to a Shaped type. 
Control points will appear around the shape making it easy 
to customize.You can also convert the Elliptic zone of 
influence to a shape. Select Animation > Deformation > 
Convert Elliptic Deformation ROI to Shape. This will 
create a much smaller  initial zone of influence than if you 
were to convert it directly to a shape.

Reset Deform (Reset Cur-
rent Keyframe)

Copies the resting position of the deformation skeleton to 
the current frame.
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Select Tool Properties
When you use the Select  tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Selection Tool Options

Lasso Sets the selection mode to Lasso. Click and hold Alt to 
temporarily switch between the Marquee and Lasso modes. 

Marquee Sets the selection mode to Marquee. Click and hold Alt to 
temporarily switch between the Marquee and Lasso modes. 

Snap to Contour Snaps your selection or point to any line you position it on. As 
soon as you move it close enough to another line, your point or 
selection will snap to it.

Snap and Align Snaps the selected anchor point to any existing line while dis-
playing temporary rulers as a guide that you can also snap your 
anchor point to.

Snap to Grid Snaps your selection following the currently enabled grid. 

Select by Colour Lets you select all the zones and lines in your drawing painted 
with the same colour swatch. 
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In the Camera or Drawing view, click on any zone or line in your 
drawing. All zones and lines of the same colour are selected. 
Click the Select tool again to return to the regular Select mode.

NOTE: Only the zones painted with the SAME colour 
swatch will be selected. If another zone is coloured with the 
exact same RGB value (same colour), but not painted with 
the same colour swatch, it will not be selected.

Permanent Selection Lets you maintain a selection over multiple drawings. Once this 
option is enabled, the selection zone made using the Select tool 
will remain as you navigate through drawings of the same layer 
and drawings from other drawing layers. This option can be used 
to simultaneously delete artwork inside or outside of the selection 
on several drawings when combined with the Apply to Multiple 
Drawings option.

Apply to Multiple Draw-
ings

The Apply to Multiple Drawings  option is used to perform an 
action on all the drawings contained in a layer. With the Select 
tool, this option can be used to select and remove vector shapes 
on all the drawings contained in a layer. To use it, activate 
Permanent Selection option and make a selection that can be 
applied to all your drawings. Then, activate the Apply to Multiple 
Drawings option and press delete. This will delete all the shapes 
that would have been selected by the permanent selection on 
every drawing in the layer. This can be used for example to 
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remove dirt and registration on the same areas of all the drawings 
simultaneously on a layer.

The Apply to Multiple Drawings option disables itself after each 
action.

Apply to Line and Col-
our Art

The Apply to Line and Colour Art  option uses the concept of Line 
Art and Colour Art layers. Use this option to apply an action such 
as selecting, resizing or erasing a drawing on both Line Art and 
Colour Art layers, as well as the Overlay and Underlay layers.

Apply to Synced Draw-
ing Layers

Applies to the Camera view only. Works in conjunction with the 
Works on Single Drawing. Only selects lines from the current 
drawing and drawing layers synced to the current drawing. 

Works on Single Draw-
ing

By default, when you draw a selection box in the Camera view, 
the Select tool will select only the drawing strokes of the current 
drawing. If you prefer the Select tool to select all the strokes on 
all layers, you can disable the Works on Single Drawing option in 
the Tool Properties view or disable the Select tool Works on 
Single Drawing preference. To do this, go to the top menu, select 
Edit > Preferences > Camera (Windows/Linux) or Harmony 
Premium > Preferences > Camera (Mac OS X) and uncheck 
the Select tool Works on Single Drawing option.

 

Ico-
n

Tool 
Name

Description
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Selection Tool Operations

Flip Hori-
zontal

Flips the current selection horizontally.

Flip Ver-
tical

Flips the current selection vertically.

Rotate 
90 
Degrees 
CW

Rotates the current selection 90 degrees clockwise.

Rotate 
90 
Degrees 
CCW

Rotates the current selection 90 degrees counter-clockwise.

Smooth Smooth out selected drawing strokes and remove extra points.

Flatten Merges drawing objects and brush strokes into a single layer. If you draw new lines to fix a 
drawing or line with many brush strokes, it can be useful to flatten them all into a single shape. By 
default, lines are drawn one on top of each other. If you intend to repaint the lines or modify their 
shape, it will be easier if they are flattened. 

Create 
Colour 
Art from 
Line Art

Lets you use the outline you traced on one of the four embedded layers (line art, colour art, 
overlay, underlay) and create invisible strokes to paint your drawings on separate layers. This 
provides more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on any of the four embedded 
layers.

Dis-
tribute to 
Layers

The Distribute to Layers  option is used to separate the selected art strokes and send them to new 
drawing layers. In the Camera view, once you have drawn your artwork, you can select the 
strokes you want to distribute using the Select  tool and click on the Distribute to Layers  button; 
you can also select Drawing > Distribute to Layers. It will automatically take every stroke from 
the drawing selection made in the Camera view and separate them into a different layer for each. 
If an artwork is composed of several strokes, you must group them using Edit > Group > Group 
before using the Distribute to Layers option. This option cannot be done from the Drawing view.

630



Harmony 14 Premium - Reference Guide

Store Col-
our Gradi-
ent 

Use the Store Colour Gradient  operation to record the selected gradient’s position. This reuses 
the stored position of the gradient when drawing new brush lines or painting colour zones. Enable 
the Use Stored Colour Gradient  option in the Paint or Brush Tool Properties view to do this.

Pencil to 
Brush

Converts the selected centre line pencil strokes into contour strokes brush lines.

Merge 
Pencil 
Lines

Pencil lines are central vector lines and it might be difficult to match pencil line’s tips properly to 
align them and make it look like it is one single line. With the Select tool, you can select several 
pencil lines and merge them as one single object using the Merge Pencil Lines  option. The ends 
of your lines are adjusted to form one single line.

 

NOTE: Points must be close enough to be merged. If there is a large gap between the lines, 
they will not be merged.

Reverse 
Pencil 
Thick-
ness

The Reverse Pencil Thickness  option inverts the thick and thin section on a selected pencil line. 
This option will take the thickest size on the line and apply it to the thinnest, and it will apply the 
thinnest to the thickest.

 Offset X 
and Y

Use the Offset X and Offset Y operation fields to enter specific values and precisely reposition 
the selected shape.
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 1. X: Type a value in this field to reposition your selection along the X-axis.

 2. Y: Type a value in this field to reposition your selection along the Y-axis.

 3. Up/Down arrows: Use the up and down arrows to modify the value in the X or Y value 
field.

 Width 
and 
Height

Use the Width and Height operation fields to enter specific values to resize the selected shape 
with precision.

 1. Width: Type a value in this field to resize the width of your selection.

 2. Height: Type a value in this field to resize the height of your selection.

 3. Up/Down arrows: Use the up and down arrows to modify the value in the Width or Height 
fields.

 4. Lock icon: Click the lock icon to lock or unlock the ratio between the Width and Height val-
ues.

 Angle The Angle operation lets you to enter specific values and accurately rotate the selected shape.

 1. Angle: Type a degree value in this field to rotate your selection.

 2. Up/Down arrows: Use the up and down arrows to modify the value in the Angle value 
field.

 Adjusting 
the Pen-
cil Line 
Thick-
ness

When you select a pencil line with the Select tool, additional options appear in the Tool Properties 
view. 

Use the Adjusting the Pencil Line Thickness operation field to resize the selected centreline 
strokes. This operation is not permitted on contour line shapes, such as brush strokes or shape 
fills.

 1. Minimum Size: Type a value in this field to set the minimum thickness of the selected 
centreline stroke.

 2. Maximum Size: Type a value in this field to set the maximum thickness of the selected 
centreline stroke.

 3. Up/Down arrows: Use the up and down arrows to modify the value contained in the 
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Thickness value field.

 Pencil 
Line 
Shape

You can adjust the start, end, and joint  style of a pencil line.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. You can 
choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You can 
choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves abruptly. You 
could also define the Join style as the corner style. You can choose between Round, Mitre 
and Bevel style.

 Pencil 
Stencils

Gives you the flexibility to change the style and thickness of your pencil lines even after they are 
drawn. You can apply preset pencil stencils or create your own.

 Adding 
Texture 
to a Pen-
cil Line

Pencil lines support texture. Once a pencil line is drawn, you can apply a preset texture or load 
your own. Textures are independent from pencil stencils.

 Adjusting 
the Text 
Selection

When you select text with the Select tool, the  tool properties will display the Text tool options on 
the bottom of the view. You can also press Alt + 9 to display only the Text properties in the Tool 
Properties view—see Text Tool Properties on page 637.
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Smooth Editor Tool Properties
When you select the Smooth Editor tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Smoothing 
Style 

The Smoothing Style options allow you to smooth a portion of your drawing by tracing a 
smoothing stroke over the zone to optimize or by selecting an area of the drawing with 
the Marquee or Lasso.

Note that by default, the Smooth Editor tool colour is yellow, it was changed to orange 
for screen grab clarity.

 

Show Control 
Points 

The Show Control Points  option allows you to show or hide the Bezier points around 
lines. When the Bezier points are displayed, you can see the result of your smoothing 
and the number of points left on the curve. When it is turned off, only the original artwork 
is displayed.

 Minimum 
Size and Max-
imum Size 

This is where you set the minimum and maximum sizes of your drawing tool which will 
produce the thick and thin effect on your stroke. This works with the pressure sensitivity 
of a pen tablet.

This options is available while using the Brush Smoothing  style.

 l Maximum and Minimum Size: Defines the maximum and minimum width of the 
stroke.

 l Up/Down arrows: Use the up and down arrows to set the minimum and max-
imum size value.

Smoothness The Smoothness impacts the strength of the smoothing result. The higher the value, the 
more points are removed and the smoother the curve. The Smoothness range is from 0 
to 100; the default value is 20.
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 Colour You can modify the colour of the control points displayed on the artwork while working 
with the Smooth Editor tool by double-clicking on the colour swatch.
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Stroke Tool Properties
When you select the Stroke tool, its properties and options appears in the Tool Properties view. 

Icon Tool Name Description

Draw Stroke as Straight 
Lines 

Enable the Draw Stroke as Straight Lines  option if 
you want the new strokes you draw to be a perfect 
straight line. Disable the option if you want the stroke 
to follow the mouse gesture.

Connect Line Ends Enable the Connect Line Ends  option if you want the 
start or end point of your new stroke to connect to 
your existing strokes to make sure no gaps are left in 
your drawing.

Auto-Flatten Mode When enabled, the Auto-Flatten  mode automatically 
flattens the new lines created with the existing 
artwork as you draw in the Drawing or Camera view. 
Brush strokes will flatten with brush strokes and 
pencil lines will flatten with pencil lines.

Apply to Line and Colour 
Art

The Apply to Line and Colour Art  option uses the 
concept of Line Art and Colour Art layers. Use this 
option to apply an action such as selecting, resizing 
or erasing a drawing on both Line Art and Colour Art 
layers, as well as the Overlay and Underlay layers.

 Smoothness You can modify the central line smoothness  of your 
line using this option. This parameter smooths the 
initial movement of your line. Increasing the value 
will result in a smoother line with fewer control 
points. Use the left and right arrows to increment the 
value by one full unit. Use the Up - Down slider to 
quickly increment the value.
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Text Tool Properties
Use the Text tool's properties to select the font type and other formatting options you want to apply to the text.

If you already wrote your text, you must first use the Text tool and select the text portion you want to format. You 
can modify the parameters of an entire text box using the Select tool. 

Icon Tool Name Description

 Font Type Use the Font drop-down menu to select a font. OTF 
fonts are supported.

Bold Use this option to bold your text selection. 

Italic Use this option to italicize your text selection. 

 

Left Alignment Use this option to left align the paragraph. 

Centered Alignment Use this option to center align the paragraph. 
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Right Alignment Use this option to right align the paragraph. 

Justified Alignment Use this option to justify align the paragraph. 

 Font Size Enter a size for the text. 

 Kerning Use the kerning field to modify the spacing between 
letters and characters. You can select the Auto Kern 
option to set the kerning automatically based on the 
font’s predefined standard. A negative value decreases 
spacing between each character, creating a letter 
overlap and a positive value increases it.

 Indent Enter a value in the Indent field to increase or decrease 
the indentation on the first line of your text. A positive 
value sets the first line of your paragraph farther to the 
right and a negative value sets it farther to the left.
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 Line Spacing Enter a value in the Line Spacing field to decrease or 
increase the space between each line of text.
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Transform Tool Properties 
When selecting the Transform tool, several options are available in the Tool Properties view.

Icon Tool Name Description

Lasso
Sets the selection mode to Lasso. Click and hold Alt to temporarily 
switch between the Marquee and Lasso modes. 

Marquee
Sets the selection mode to Marquee. Click and hold Alt to temporarily 
switch between the Marquee and Lasso modes. 

Peg Selection Mode

In the Camera view, the Peg Selection Mode limits the selection to peg 
layers instead of drawing layers. This mode is useful when you have 
created a character rig using peg layers for each drawing.  That way, you 
do not accidentally select the drawing layer when you want to animate 
on the peg.

When disabled, the Transform  tool selects the drawing layers.

Snap and Align
Snaps the selected anchor point to any existing line while displaying tem-
porary rulers as a guide that you can also snap your anchor point to.

Snap to Grid

Snaps your selection following the currently enabled grid. 

Hide Manipulator Con-
trols

The Hide Manipulator Controls  button lets you hide the bounding box and 
manipulator controls from the Camera view when an element is 
selected.

Flip Horizontal

Flips the current selection horizontally. 

You can also select Animation > Flip > Flip Horizontal from the top 
menu or press 4 or 5.

Flip Vertical

Flips the current selection vertically.  

You can also select Animation > Flip > Flip Vertical from the top menu 
or press 4 or 5.
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Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-clockwise.

 Offset X and Y

Use the Offset X and Offset Y operation fields to enter specific values 
and precisely reposition the selected shape.

 1. X: Type a value in this field to reposition your selection along the 
X-axis.

 2. Y: Type a value in this field to reposition your selection along the 
Y-axis.

 3. Up/Down arrows: Use the up and down arrows to modify the 
value in the X or Y value field.

 Width and Height

Use the Width and Height operation fields to enter specific values to 
resize the selected shape with precision.

 1. Width: Type a value in this field to resize the width of your selec-
tion.

 2. Height: Type a value in this field to resize the height of your selec-
tion.

 3. Up/Down arrows: Use the up and down arrows to modify the 
value in the Width or Height fields.

 4. Lock icon: Click the lock icon to lock or unlock the ratio between 
the Width and Height values.

 Angle

The Angle operation lets you to enter specific values and accurately 
rotate the selected shape.

 1. Angle: Type a degree value in this field to rotate your selection.

 2. Up/Down arrows: Use the up and down arrows to modify the 
value in the Angle value field.
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Zoom Tool Properties
When you select the Zoom tool, its properties are displayed in the Tool Properties view.

Parameter Button Description

Zoom Tool Options
Zoom In Zooms in

Zoom Out Zooms out

Operations

Perform Zoom In
Zoom in the Camera or Drawing view. 

The keyboard shortcut is 2.

Perform Zoom Out
Zoom out the Camera or Drawing view. 

The keyboard shortcut is 1.

Reset Zoom Restores the current zoom level to 100%.

Reset View
Restores the original display by resetting any 
pan, rotation or zoom actions.
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Chapter 6: Toolbars
Harmony contains toolbars which, by default, are located at the top of the interface. Some views also have a toolbar 
which you can reposition to suit your work style. You can show or hide toolbars, as well as customize it with the 
tools you use most often and hide the ones you don't.

Top Toolbars 644

Advanced Animation Toolbar 645

Art Layer Toolbar 646

Control Point Toolbar 647

Coordinate Toolbar 649

Deformation Toolbar 650

Display Toolbar 653

Easy Flipping Toolbar 654

Edit Toolbar 655

File Toolbar 656

Flip Toolbar 657

Game Toolbar 658

Mark Drawing Toolbar 659

Onion Skin Toolbar 660

Playback Toolbar 661

Scripting Toolbar 662

Tool Presets Toolbar 663

Tools Toolbar 664

Workspace Toolbar 667

View Toolbars 668

3D Graph View Toolbar 669

Node View Toolbar 670

Timeline View Toolbar 671

Xsheet View Toolbar 672
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Top Toolbars
Harmony has a series of toolbars that are added by default at the top of the interface. These toolbars can be 
moved on the sides of the interface as well as within specific views. 

All top toolbars can be added through the top menu Windows > Toolbars > desired toolbar.

Advanced Animation Toolbar 645

Art Layer Toolbar 646

Control Point Toolbar 647

Coordinate Toolbar 649

Deformation Toolbar 650

Display Toolbar 653

Easy Flipping Toolbar 654

Edit Toolbar 655

File Toolbar 656

Flip Toolbar 657

Game Toolbar 658

Mark Drawing Toolbar 659

Onion Skin Toolbar 660

Playback Toolbar 661

Scripting Toolbar 662

Tool Presets Toolbar 663

Tools Toolbar 664

Workspace Toolbar 667
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Advanced Animation Toolbar
The Advanced Animation toolbar contains tools to position and animate layers. The Scale, Translate and Rotate 
tools can be used to reposition the permanent pivot position of a layer. Unlike the Transform tool, each tool in the 
Advanced Animation toolbar performs a single operation, either rotate, scale, translate or scale in relation to the 
camera distance.

How to access the Advance Animation toolbar

 1. Select Windows > Toolbars > Advanced Animation.

Icon Tool Name Description

Translate Lets you move the selected element along the X and Y 
axes.

Rotate Turns a selected element around its pivot point. 

Scale Increases or decreases the size of a selected element. 
You can scale an object up to make it larger or down to 
make it smaller. Press Shift to scale the element while 
maintaining its proportions.

Skew Slants the selected element.

Maintain Size Keeps elements the same size aspect ratio in the Cam-
era view as you move them towards or away from the 
camera.

Spline Offset Lets you reposition the visual trajectory without off-
setting or modifying your animation. By default, the tra-
jectory is located at 0,0,0 fields. If your elements were 
drawn in a different location than the centre of the draw-
ing area, it will look like the trajectory is not aligned with 
your drawing. Also, if you have several elements 
attached to one trajectory, you might want your tra-
jectory to be at a different location to represent the 
group's motion better.

Reposition Drawing Lets you reposition, scale, rotate or skew all drawing 
strokes on every drawing included in a layer. 
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Art Layer Toolbar
The Art Layer toolbar lets you access the art layers. By default, only the Line Art and Colour Art are displayed. A 
drawing is composed of two layers, a line layer and a colour layer. The colour layer is always placed under the line 
layer. These layers are accessible in the Drawing or Camera view (using drawing tools). When you view the final 
drawing, you will see the final composition of the lines and colours, not two separate layers.

You can draw and paint in all layers. If you prefer to work in a single layer, everything can be done in the Line Art 
layer.

You can change your preferences to enable the advanced use of layers and have access to four layers instead of 
two:

 l Overlay

 l Line Art

 l Colour Art

 l Underlay

How to access the Art Layer toolbar

 1. Select Windows > Toolbars > Art Layer.

How to enable the Support Overlay and Underlay Arts option

 1. Select Edit > Preferences ( Windows/Linux ) or Harmony Premium > Preferences ( Mac OS X ).

 2. In the Preferences dialog box, select the Advanced tab.

 3. In the Advanced Options section, select the Support Overlay and Underlay Arts option.

 4. Click OK.

 

Icon Tool Name Description

Preview Line Art and 
Colour Art

Displays all Art layers.

Overlay Art Makes the Overlay Art layer current.

Line Art Makes the Line Art layer current.

Colour Art Makes the Colour Art layer current.

Underlay Art Makes the Underlay Art layer current.
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Control Point Toolbar 
The Control Point toolbar displays parameters when you select a keyframe or control point in the Camera, Timeline 
or Xsheet view. You can edit keyframes and control point parameters, such as the continuity, bias, tension and lock-
in-time. 

How to access the Control Point toolbar

 1. Select Windows > Toolbars > Control Point.

Icon Tool Name Description

 Frame Indicates the current frame.

 Locked in Time Locks a control point in time, making it a keyframe.

 Constant Keyframe Removes any interpolation and keeps the keyframe value constant up to 
the next keyframe.

T Tension Controls how sharply the path bends as it passes through a control point 
or keyframe.

C Continuity Controls the smoothness of a transition between the segments joined by a 
point.

B Bias Controls the slope of the path so it flows towards one side of the motion 
point or the other.
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Coordinate Toolbar
T-ANIMCO2-001-001

 

The Coordinate toolbar displays parameters of keyframes or control points in the Camera, Timeline or Xsheet view. 
You can edit keyframes and control point parameters, such as the position, scale and rotation coordinates.

For tasks related to this toolbar, see Coordinates and Control Points View on page 685.

How to access the Coordinate toolbar

 1. Select Windows > Toolbars > Coordinate.

Parameter Description

Translation The translation fields display the X, Y and Z translation values of the selected 
layer. You can enter precise values to set the first frame and last frame position of 
a layer. By default the Z value field is disabled. It will automatically become active 
when the 3D option is enabled.

Scale The scale fields display the X, Y and Z scaling values of the selected layer. You 
can enter precise values to set the first frame and last frame size of a layer. By 
default the Z value field is disabled. It will automatically become active when the 
3D option is enabled.

Rotation The rotation fields display the X, Y and Z rotation values of the selected layer. 
You can enter precise values to set the first frame and last frame rotation of a 
layer. By default the Z value field is disabled. It will automatically become active 
when the 3D option is enabled.

Skew The skew field displays skew value of the selected object. You can enter a 
precise value to set the skew of the object. 
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Deformation Toolbar
T-RIG-007-009

The Deformation toolbar contains the various tools and options used to create a deformation rig. This toolbar is 
displayed in the default interface.

By default, the Deformation toolbar only contains the essential options. If you right-click on the toolbar and select 
Customize, you can add additional buttons.

 

Icon Tool Name Description

Rigging Tool

The Rigging tool is used to create either a Bone or Curve 
deformation chain. You also use it to set up the resting 
position.

To learn more about the Rigging tool's properties, see 
Rigging Tool Properties on page 625.

Show Selected Manip-
ulators and Hide All Oth-
ers

The Show Selected Manipulators and Hide All Others  
button hides all manipulators displayed in the Camera view. 
Only the manipulators of the selected deformation node are 
displayed

Reset Current Key-
frame

The Reset Current Keyframe copies the resting position, 
the original setup of your skeleton before undergoing any 
deformation, to your current frame. Once you have created 
a deformation chain, you can use the Rigging tool to adjust 
the position and appearance of the rig to fit the element. 
When the skeleton is in place, you can use the Reset 
Current Keyframe button to reset the current frame position 
to the resting position.

Create New Deform- The Create New Deformation Chain option allows you to 
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ation Chain

create a new deformation chain on a same character. For 
example, if you have drawings for the different views of your 
puppet (front, profile, back, etc.), you can use this feature to 
setup a new set of chains for each angle without having to 
create completely different puppets.

Rename Trans-
formation

The Rename Transformation option allows you to give spe-
cific names to your different transformation chains. By 
default, chains are named Transformation plus the number 
of the chain, such as Transformation 2. You can rename 
these to identify them easier, such as front, side, back, and 
so on.

Transformation 
Selector

The Transformation Selector drop-down menu allows you to 
assign an existing chain to a set of drawings. For example 
you might want to reuse the front deformation chains for 
another series of drawing.

When creating a new drawing, the Default Transformation is 
assigned. While on the new drawing frames, from the drop-
down menu, select a different chain to automatically assign 
it.

Enable Deformations

The Enable Deformations button allows you to display your 
drawings in their original state or with deformations while 
creating additional drawings. Depending on the artwork you 
need to create, you might need to refer to the other images 
either deformed or in their original position.

NOTE: Disabling deformations is only a display mode. 
Although drawings will not appear deformed in the 
Camera view, even in Render View mode, they will still 
be deformed in the rendered images.

Associate Parent Trans-
formation Switch with 
Selected Element

Matches the drawing name and drawing location path in the 
Transformation Switch node's Properties with the drawing 
name and drawing location path found in the Drawing 
Layer's Properties. For this button to work, a drawing node 
connect to a deformation group, with a Transformation 
Switch inside, must be selected—see Reusing Deformation 
Groups for Multi-pose Rigs.

Convert Elliptic Zone of 
Influence to Shape

After you have created a deformation chain using Elliptic as 
the Zone of Influence type, you can select your deformer 
and click on this button to convert it to a Shaped type. 
Control points will appear around the shape making it easy 
to customize.You can also convert the Elliptic zone of 
influence to a shape. Select Animation > Deformation > 
Convert Elliptic Deformation ROI to Shape. This will 
create a much smaller  initial zone of influence than if you 
were to convert it directly to a shape.

651



Chapter 6: Toolbars     Top Toolbars

NOTE: You can also convert the Elliptic zone of influ-
ence to a shape. Select Animation > Deformation > 
Convert Elliptic Deformation ROI to Shape. This will 
create a much smaller  initial zone of influence than if 
you were to convert it directly to a shape.

Convert to New 
Drawing and Add 
Deformation Chain

Takes the pose/drawing and the deformer of the selected 
frame and converts it to a new pose/drawing with the cor-
responding deformer. 

Remove All Keyframes
The Remove All Keyframes option removes all keyframes 
on the selected deformation chain.

Show All Controls

The Show All Controls button lets you visualize the resting 
position in red (Setup mode) and the active position 
(Animation) in green at the same time

Show All Regions of 
Influence 

The Show All Regions of Influence button displays all 
regions of influence in the deformers in your project. Note 
that the deformer’s controls must be visible in order for its 
zones of Influence to show. The regions will not be 
displayed when a deformer’s zone of Influence is set to 
Infinite or Zero.

NOTE: Region of influences are not available for Game 
Bone deformers.
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Display Toolbar 
The Display toolbar lets you select the different Display nodes available in the node system. 

When your scene does not have a Display node, it is automatically set to Display All which uses the Timeline view 
ordering and shows floating nodes from the Node view. You can also set your scene to use Display All using the 
Display toolbar.

NOTE: If you try to add a peg or other transformation layer in the Timeline view without having a layer selected, 
an error message will display. Make sure to change to Display All. The peg layer will be floating in the Node 
view and will not be visible in the Timeline view.  The Timeline view shows only layers that are connected to the 
Composite node.

If you switch to Display All, you run the risk of not realizing when you have floating nodes that are not connected 
to your composite.  For this reason, it is not recommended to work in Display All mode.

How to access the Display toolbar

 1. Select Windows > Toolbars > Display.
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Easy Flipping Toolbar
The Easy Flipping toolbar lets you rapidly flip through drawings in the Drawing view as is done with paper 
drawings. In order for the features in this toolbar to work, you must be in the Drawing view.

How to access the Easy Flipping toolbar

 1. Select Windows > Toolbars > Easy Flipping.

Icon Tool Name Description

Previous Drawing Displays the previous drawing of your animation.

Next Drawing Displays the next drawing of your animation.

 Slider Lets you flip forwards or backwards through your 
drawings by moving the slider.

 Loop Displays drawings in the first frame after you reach 
the last frame of your animation.

Easy Flip Automatically flips through the drawings based on 
the FPS.

 Preroll Sets  the number of drawings to be flipped through 
before the starting drawing. The starting drawing is 
determined by the position of the red playhead in the 
Timeline view.

 FPS Sets the speed of playback in the units of frames per 
second.
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Edit Toolbar
The Edit toolbar contains common operations such as Copy, Paste, Cut, Undo and Redo. These options can also 
be found in the Edit menu.

How to access the Edit toolbar

 1. Select Windows > Toolbars > Edit.

 

Icon Tool Name Description

Undo Removes the last change made to your project. 
Harmony supports multiple undo, so you can undo 
changes you made in the order you made them.

Redo Redoes an operation you have undone. This command 
is active only after you use the Undo command.

Cut Removes selected objects. You can then paste the 
object or its properties to another object.

Copy Copies selected objects and properties.

Paste Places an object you cut or copied into the location you 
select in a view.

Create Symbol Creates a symbol from selected drawing elements in 
the Drawing or Camera view, nodes in the Node view, 
or a layer or cells in the Timeline view.
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File Toolbar
The File toolbar contains the common file operations such as New, Save and Open. These options can also be 
found in the File menu.

How to access the File toolbar

 1. Select Windows > Toolbars > File.

 

Icon Tool Name Description

New (Harmony Stand 
Alone)

Creates a new scene while closing any scene 
already open. The New Scene dialog box opens, 
asking for directory, name, and resolution 
information.

Open Displays the Open Scene dialog box where you can 
browse for a scene file.  You can open a new scene 
from the current one and the previous scene will 
close.

Save Saves all changes made to the opened scene, 
drawings, palettes, and palette lists.

Save As Saves the current file with a different name and at a 
different location.

Saves the current state of a scene as another scene. 
The Save As window prompts you for a new name 
and a different location for this scene before saving 
it. This will create a complete scene directory for the 
new scene.

NOTE: The scene name cannot exceed 23 char-
acters.

Import Images Imports bitmap images which you can choose to 
vectorize.
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Flip Toolbar
The Flip toolbar lets you determine the type of drawing to include in your flipping selection. You can flip through the 
key, breakdown or in-between drawings individually, or view a combination.

How to access the Easy Flipping toolbar

 1. Select Windows > Toolbars > Easy Flipping.

Icon Tool Name Description

Show Key Drawings Displays key drawings when flipping through drawings.

Show Breakdown 
Drawings

Displays breakdown drawings when flipping through 
drawings.

Show In-between 
Drawings

Displays in-between drawings when flipping through 
drawings.

Show Retake Key 
Drawings

Displays retake key drawings when flipping through 
drawings.

Show Retake Breakdown 
Drawings

Displays breakdown retake drawings when flipping 
through drawings.

Show Retake In-between 
Drawings

Displays retake in-between drawings when flipping 
through drawings.
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Game Toolbar
The Game toolbar contains tools for setting anchors and props, as well as exporting to sprite sheets and Easel 
JS.

How to access the Game toolbar

 1. Select Windows > Toolbars > Game.

Icon Tool Name Description

Toggle Anchor Adds the Anchor parameter to the selected layer.

Toggle Prop Adds the Prop parameter to the selected layer.

Export to Sprite Sheets Opens the Export to Sprite Sheets window where 
you can export your animation as sprite sheets .

Export to Easel JS Opens the Export to Easel JS window where you can 
export your animation as Easel JS.
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Mark Drawing Toolbar
The Mark Drawing toolbar lets you identify drawings such as key, breakdown and in-between. The drawing 
Identification feature can help the animator stay well organized and save time when identifying key, breakdown or in-
between drawings in the Xsheet and Timeline views. 

How to access the Mark Drawing toolbar

 1. Select Windows > Toolbars > Mark Drawings.

Icon Tool Name Description

Mark as Key Drawing Identifies the selected drawing as a key drawing.

Mark as Breakdown 
Drawing 

Identifies the selected drawing as a breakdown 
drawing.

Mark as In-between 
Drawing 

Identifies the selected drawing as an in-between 
drawing.

Mark as Retake Key 
Drawing 

Identifies the selected drawing as a key retake drawing.

Mark as Retake 
Breakdown Drawing 

Identifies the selected drawing as a breakdown retake 
drawing.

Mark as Retake In-
between Drawing 

Identifies the selected drawing as a in-between retake 
drawing.
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Onion Skin Toolbar
The Onion Skin toolbar displays previous and subsequent drawings. When designing or animating, it is useful to 
see previous drawings. By default, previous drawings appear in a shade of red and next drawings are displayed in 
green. In the Onion Skin toolbar, you can select the type of drawing to display.

NOTE: You can change the default onion skin display colours in the Preferences dialog box. 

For tasks related to this toolbar, see .

How to access the Onion Skin toolbar

 1. Select Windows > Toolbars > Onion Skin.

Icon Tool Name Description

Enable Onion Skin in Other 
Elements

Displays previous and next drawings in other layers 
than the current one. In the Drawing view, use the 
Enable Onion Skin in Other Elements feature to see 
the previous and next drawings of the layers visible 
in Light Table mode.

Show Key Drawings Displays all drawings marked as key drawings.

Show Breakdown 
Drawings

Displays all drawings marked as breakdown 
drawings.

Show In-between 
Drawings

Displays all drawings marked as in-between 
drawings.

Show Retake Key 
Drawings

Displays all key drawings marked to be retaken.

Show Retake Breakdown 
Drawings

Displays all breakdown drawings marked to be 
retaken.

Show Retake In-between 
Drawings

Displays all in-between drawings marked to be 
retaken.
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Playback Toolbar
The Playback toolbar lets you play back animation and sound. Use it to scrub the sound to create your lip-sync, loop 
the playback, navigate through frames, and change the playback range and speed.

Name Button Description

Play

Plays and stops the animation.

You can also select Play > Play Scene 
Forward or Stop.

Render and Play
Creates a render of your scene to play back the 
final result including the effects.

Loop

Repeatedly plays back your animation 
indefinitely.

You can also select Play > Loop.

Sound
Enables sound in the playback. 

You can also select Play > Enable Sound.

Sound Scrubbing

Enables sound scrubbing in the playback.

You can also select Play > Enable Sound 
Scrubbing.

Jog Frames Lets you scroll through the playback’s frames.

Frame ---
Lets you move the playhead by entering a frame 
number.

Start ---

Lets you change the start frame by entering a 
new value in the Start field.

You can also click on Start button to set the start 
frame at the current frame.

Stop ---

Lets you change the end frame by entering a new 
value in the Stop field.

You can also click on Stop button to set the end 
frame at the current frame.

FPS ---
Lets you enter a new value to change the speed 
of the playback.
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Scripting Toolbar
The Scripting toolbar lets you import and access scripts for automating actions and operations.

How to access the Scripting toolbar

 1. Select Windows > Toolbars > Scripting.

Icon Tool Name Description

Manage Scripts Opens the Scripts Manager dialog box where you 
can add scripts and functions to your Scripting 
toolbar.

Stop Script Stops the execution of a script launched from the 
Scripting toolbar.
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Tool Presets Toolbar
The Tool Presets toolbar lets you create new tool presets and manage them.

How to access the Tool Presets toolbar

 1. Select Windows > Toolbars > Tool Presets.

 

Icon Tool Name Description

New Tool Preset Creates a new tool preset from the current tool settings.

Manage Presets Opens the Manage Tool Preset dialog box where you 
can update, organize, and delete existing presets.
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Tools Toolbar
The Tools toolbar contains all the main tools you need to work in Harmony. In the default workspace, this toolbar 
located on the left-most side of the interface. A small triangle at the lower-right corner of a tool indicates additional 
tools under the main tool. To access these tools, hold down the left mouse button until the additional tools appear, 
then select one. 

You can display the Tools toolbar horizontally if you find it more efficient for your workflow. Be sure to restart 
Harmony in order to see the new position of the Tools toolbar.

How to display the Tools toolbar as a flat (horizontal) toolbar

 1. Do one of the following:

 l Select Edit > Preferences (Windows/Linux) or Harmony Premium > Preferences (Mac 
OS X). 

 l Press Ctrl + U (Windows/Linux) or ⌘  + U (Mac OS X).

 2. Select the General tab.

 3. In the Options section, select the Flat Tool Toolbar option.
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 4. Click OK and restart Harmony.

 

Tool Name Icon Description

Select Lets you select elements from the Camera and Drawing views.

Cutter Lets you cut a drawing area to move, copy, cut or delete it.

Reposition All 
Drawings

Lets you reposition, scale, rotate or skew all drawing strokes on 
every drawing included in a layer.

Contour Editor
Lets you add, remove or modify points on a vector line and 
control them.

Pencil Editor Lets you modify the thick and thin contours of a pencil line.

Smooth Editor
Lets you optimize contours and reduce the number of points on 
a line.

Perspective Lets you deform a drawing selection and alter its perspective.

Envelope
Lets you deform and warp part of a drawing using a grid 
envelope and Bezier handles.

Edit 
Gradient/Texture

Lets you modify the position of a gradient or texture colour 
within a specific zone.

Brush
A pressure-sensitive tool for creating a contour shape with a 
thick and thin line effect, as if created with a paint brush.

Pencil
A pressure-sensitive tool for  drawing the final images, such as 
character nodes, cut-out puppet and clean animation. Creates a 
central vector shape.

Text
Lets you type text in your project using various fonts and text 
attributes.

Eraser
A pressure-sensitive tool for precisely erasing parts of a 
drawing.

Paint Lets you paint both empty and filled zones.

Ink
Lets you paint only the segment you clicked on between two 
intersections to be painted.

Paint Unpainted
Lets you paint only empty zones. Lines and filled zones remain 
unchanged.

Repaint Lets  you paint zones except empty zones. Any zone that is not 
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painted remains intact.

Unpaint Lets you unpaint empty and filled zones.

Stroke Lets you draw stokes, connect line ends and flatten lines.

Close Gap
Lets you close small gaps in a drawing by creating small, 
invisible strokes between the two closest points.

Line Lets you draw straight lines which you can then edit.

Rectangle Lets you draw rectangles which you can then edit.

Ellipse Lets you draw ellipses which you can then edit.

Polyline Lets you draw polylines lines which you can then edit.

Dropper Lets you pick a colour directly from a drawing.

Drawing Pivot Lets you set pivots on a characters, drawings and symbols.

Morphing
Lets you control a morphing sequence by placing different types 
of hints to help Harmony morph the animation the way you want 
it.

Hand Lets you pan the Drawing or Camera view.

Zoom Lets you zoom in and out of the Drawing or Camera view.

Rotate View
Lets you rotate the Drawing or Camera view just like with a real 
animation disc. Can also be used in Perspective view.

Animate Mode
Automatically creates a keyframe on the drawing layer. Used to 
animate layers over time.

Transform
Lets you create a global selection so you can reposition, scale, 
rotate and skew as one unit, which is useful for cut-out char-
acters.

Inverse Kinematics
Lets you pull on a character's extremities, such as the hands 
and feet, and have the rest of the body follow. Can be used on 
any piece connected in a hierarchy. 

Onion Skin
Displays the previous and next frames of an animation. Useful 
when animating cut-out characters.
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Workspace Toolbar
The Workspace toolbar lets you load other workspaces. The first time you start Harmony, the default workspace is 
loaded. Other workspaces are available such as the Hand-Drawn Animation and Compositing workspaces; these 
display different views and toolbars. You can access these workspaces and any you create, from the Windows 
menu and the Workspace toolbar.

How to access the Workspace toolbar

 1. Select Windows > Toolbars > Workspace.

 

Icon Tool Name Description

 Workspace List Allows you to select an existing workspace.

Workspace Manager Opens the Workspace Manager where you can 
organize, display, and remove workspace from your list.

Save Workspace When the Automatically Save Workspace preference is 
disabled, the Save Workspace button becomes avail-
able. This allows you to manually save your new work-
space configuration.
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View Toolbars
Harmony has a series of view specific toolbars that are only available in a given view. These toolbars can be 
moved only within their view. 

All view toolbars can be added, as long as the view is visible, through the top menu Windows > Toolbars > 
desired toolbar.

3D Graph View Toolbar 669

Node View Toolbar 670

Timeline View Toolbar 671

Xsheet View Toolbar 672
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3D Graph View Toolbar
The 3D Graph toolbar works in conjunction with the elements in the 3D Graph view.

Button Name Description

Enable Subnode Enables the visibility of a subnode or selection of subnodes.

Disable Subnode Disables the visibility of a subnode or selection of subnodes.

Make Properties Available
Creates transformation attributes for the selected subnode (makes it 
animatable) and automatically creates a corresponding subnode layer 
in the Timeline view.

Add 3D Kinematic Output

Adds a 3D Kinematic Output node under the 3D model (and Subnode 
Animation node) and sets it to use the selected subnode's trans-
formation values. You can use the 3D Kinematic Output node to move 
the another layer in sync with the moves done on the 3D subnode.

How to access the 3D Graph toolbar

You can add the 3D Graph toolbar to the 3D Graph view by:

 l Going to the top menu and selecting Windows > Toolbars > 3D Graph.

 l Right-clicking on the space at the top of the 3D Graph view and selecting 3D Graph.
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Node View Toolbar
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Timeline View Toolbar
The 3D Graph toolbar works in conjunction with the elements in the 3D Graph view.

Button Name Description

 Set Ease Type  

Create Empty Drawing  

Duplicate Drawing  

Insert Keyframe  

Delete Keyframes  

Set Motion Keyframe  

Set Stop-Motion Keyframe  

Go to Previous Keyframe  

Go to Next Keyframe  

Add Key Exposure  

Delete Key Exposure  

Centre On Selection  

Set Ease for Multiple Parameters  

Create Keyframes On
Opens the Create Keyframes On dialog box, where you can set the 
options to create a new keyframe every x number of frames.

Fill Empty Cells  

Paste Mode: All Drawing Attrib-
utes

 

Paste Mode: Keyframes Only  

Paste Mode: Exposures Only  

Add Prefix or Suffix  

How to access the Timeline view toolbar

You can add the Timeline view toolbar to the Timeline view by:

 l Going to the top menu and selecting Windows > Toolbars > Timeline view.

 l Right-clicking on the space at the top of the Timeline view and selecting Timeline view.
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Xsheet View Toolbar
The Xsheet toolbar contains the common timing operations such as Add Column, Delete Column, Clone Column, 
and so on. These options can also be found in the top menu.
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Chapter 7: Views
The Harmony interface is composed of different views, each one designed for a specific purpose. You can modify 
the location of the views by adding a new view as a tab or as a window. You can also swap the location of a view.  

When a view is active, a red rectangle appears around the view. Keyboard shortcuts and top menu options are 
associated with the active view. If a menu option is greyed out, it means it does not apply to the layer, drawing or 
other type of selection or the option does not apply to the active view.

3D Graph View 674

Camera View 675

Colour View 681

Coordinates and Control Points View 685

Drawing View 688

Function View 690

Integrated Help View 692

Layer Properties View 693

Library View 695

Message Log View 697

Model View 698

Node View 699

Node Library View 701

Perspective View 704

Script Editor View 706

Side View 708

Timeline View 710

Tool Properties View 717

Top View 718

Xsheet View 720
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3D Graph View
When a 3D model is selected, the 3D Graph view allows you to view a list of the subnodes composing the 3D 
model, arranged in their hierarchy. You can select a subnode from the list. When a subnode is selected, you can 
manipulate it with the Transform tool, disable or enable it. 

If your 3D model is connected to a Subnode Animation node, you can also animate the selected subnode, add its 
properties to the Subnode Animation's properties in the Timeline, or connect it a 3D Kinematic Output node to it 
so that its animation can be applied to another element. 

How to access the 3D Graph view

Do one of the following:

 l From the top menu, select Windows > 3D Graph.

 l From any of the other views, click the Add View  button and select 3D Graph.

Section Description

3D Graph menu Access commands through this menu—see 3D Graph View Menu.

3D Graph toolbar See 3D Graph View Toolbar.

3D model subnode display area
Displays the parts (subnodes) of the selected 3D model. Selecting the 
Subnode Animation node of a 3D model will also display the 3D model's 
subnodes.

Selected subnode hierarchy path Displays the subnode's parent hierarchy chain within the 3D model.

Search bar Use this field to search for a specific subnode within the 3D model.
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Camera View
The Camera view is the centre of operations in Harmony. In this view, you will draw, paint, animate, create 
animation paths and see your results. You can also move through your symbol’s hierarchy.

The Camera view has a top and bottom toolbar that you can use to navigate in the view, change the display mode, or 
go back up your symbols hierarchy. 

How to access the Camera view

Do one of the following:

 l From the top menu, select Windows > Camera.

 l From any of the other views, click the Add View  button and select Camera.

 

Ico-
n

Section Description

View 
Menu

The View menu contains all the tools and options that you can use in the Camera view to draw, 
animate or set up the scene.

Editing 
Stack

The Editing Stack menu displays the names of the symbols and their hierarchy when you are 
editing a symbol. You can click on the different names to go back up to the different parent 
symbols or the top/current project.

 Camera 
View 
Toolbar

The Camera View toolbar contains all the tools and options you can use in the Camera view to 
draw, animate or set up the scene. The toolbar can be displayed or hidden by right-clicking on it 
and selecting or deselecting the Camera View toolbar—see Camera View Toolbar.
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Light 
Table

When you have a drawing layer or drawing selected, the Light Table button  button allows you to 
fade the colours of the other layers so you can see the current artwork better as you edit with a 
drawing tool. Note that the light table does not work when using a layer editing tool, such as the 
Transform  tool.

Current 
Drawing 
on Top

When this button is enabled, the drawing that you are currently editing with a drawing tool is tem-
porarily displayed in front of all the other elements. The actual scene is not modified.

Camera 
Mask

The Camera Mask  button shows or hides Displays a black mask around the scene’s frame to 
avoid seeing the unnecessary artwork. This option is handy when you're animating and setting up 
the scene. It allows you to see your scene’s composition better.

You can also access this from the top menu by selecting View > Show > Camera Mask.

Safe 
Area 

The Safe Area  button shows or hides Displays the TV safety zone and the centre of the camera 
frame. The safe area adapts to the scene resolution, as well as the safety zone and frame’s 
centre.

You can also access this feature from the top menu by selecting View > Show > Safe Area.
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BBox 
Selectio
n Style

When you select an object in the Camera view with the Transform tool, a bounding box always 
appears around the object and the artwork is tinted in fuchsia, red or yellow. Enabling this option 
will only keep the bounding box and remove the colour tint.

Outline 
Locked 
Drawing
s

Drawings that are locked in the Timeline view (cannot be selected in the Camera view) are 
displayed as wireframes.

Reset 
View 

The Reset View  button resets any panning, zooming or rotation done in the Camera view and 
returns the display to the initial settings. You can also press Shift + M.

 Zoom 
Menu

The Zoom menu lets you enlarge or reduce the Camera or Drawing view display. 

To make the camera frame size always match the size of your view, select the Fit to View option. 
Click the drop-down arrow and select a zoom level or press 1 and 2.
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OpenGL 
View 
Mode 

The OpenGL View Mode  button switches the Camera view to fast display, letting you see your 
animation play in real time. The OpenGL display requires less memory. The final look of your 
effects is not shown in the OpenGL View Mode. You must switch to the Render View Mode to 
see your effects.

Render 
View 
Mode

The Render View Mode  button swithes the Camera view to a fully rendered display showing the 
final image of the current frame. If a modification is done to your current frame or if you move to a 
different frame, click the Update Preview button to update the display if your preview does not 
update automatically.The Render View Mode display lets you see the final look of your frames 
including effects and antialiasing. You cannot play back your scene in Render View Mode. To see 
your scene fully rendered and to play it back, you must press the Render and Play  button in the 
Playback toolbar.
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Matte 
View 
Mode

The Matte View Mode  button switches the Camera view to a matte display showing the alpha 
channel of the elements in your scene. The transparency level ranges from 0 to 100 percent. Zero 
percent is completely transparent and represented by black and 100 percent is completely opaque 
and represented by white. Everything in between these extremes has a transparency level 
somewhere between 1 and 99 percent and is represented in various shades of grey. 

 l To access the Matte View mode, click on the Render View  button and select Matte View  
from the drop-down menu.

Depth 
View 
Mode

The Depth View mode displays images in a relative white to black gradient scale. The object(s) 
closest to the camera are displayed in white and the object(s) furthest from the camera are 
displayed in black. If the position of the last object changes along the z-axis, that object will still 
remain black, so long as it retains its position as the object the farthest back. It does not matter 
where that object is in 3D space, it just matters what its position is relative to the other object in 
the same space. The objects closest and farthest from the camera set the range of the white to 
black scale. All the other objects fall somewhere in between.
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 l To access the Depth View mode, click on the Render View  button and select Depth View  
from the drop-down menu.

 Drawing 
Name 

The Drawing Name field displays the name of the selected drawing, as well as the layer 
containing it. If the cell does not contain any drawing, an Empty Cell text is shown in the field.

 Tool 
Name 

The Tool Name field displays the name of the selected tool. If you temporarily override a drawing 
tool using a keyboard shortcut, the tool’s name will be highlighted in red. You can temporarily 
override a tool by holding its keyboard shortcut without the Alt key. For example, the Select tool 
shortcut is Alt + S. If you hold down the S key, you will switch to the Select tool. When you 
release the key, you will return to the tool you were using.

 Frame 
Number 

The Frame Number field displays the number of the current frame.

 Selected 
Colour

The colour swatch displays the currently selected colour in the Colour view.
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Colour View
The Colour view is where you create colours and palettes and import existing palettes into your project. The Colour 
view is also necessary for drawing, painting and creating colour styling.

How to access the Colour view

Do one of the following:

 l From the top menu, select Windows > Colour.

 l From any of the other views, click the Add View  button and select Colour.

Icon Section Description

View Menu The View menu contains all the commands and options that you can use in 
the Colour view to manage colours and palettes.

 Show/Hide 
Palette List View

The Show/Hide Palette List View   button lets you display the Palette List view 
in the Colour view. This option is for the advanced user who wants to create 
colour palettes for their props and characters.
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Add Palette The Add Palette  button lets you add a new palette to the bottom of your 
palette list.

Remove Palette The Remove Palette  button lets you delete the currently selected palette. If 
the colour swatch is used in your project, zones painted with colour swatches 
which have been deleted will turn red, easily identifying them so you can 
repaint them with another colour swatch.

Link Palette The Link Palette button lets you access other palettes created in the project 
and link them to your scene.

Order Palette List The Up and Down arrows let you reorder the selected palette. When using 
clone palettes (colour styles), the highest palette is the list will override its 
clone located lower in the list.

Edit Palette Mode In Harmony Server, the Edit Palette Mode  button lets you get the rights to 
modify the palette. The palette files can be locked to avoid accidentally 
modifying the palette.

Add Colour The Add Colour  button lets you add a new colour swatch to the bottom of your 
colour list.

Remove Colour The Remove Colour  button lets you delete the currently selected colour 
swatches. If the colour swatch is used in your project, the Delete Colour 
dialog box will appear asking you to confirm the operation. Click OK to 
confirm the operation or Cancel to cancel it.
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Zones painted with colour swatches which have been deleted will turn red, 
easily identifying them so you can repaint them with another colour swatch.

Add Texture The Add Texture  button lets you add a bitmap colour swatch to your palette. 
You can load photos and textures and paint your drawings with it. The bitmap 
image must be a .tga or .psd file format.

Set Current Brush 
Colour 

The Set Current Brush Colour  button let you set the currently selected colour 
swatch as the colour used by the Brush  tool. If you select a new colour in the 
Colour view while using the Brush tool, the Set Current Brush Colour swatch 
will be updated.

Set Current Pencil 
Colour 

The Set Current Pencil Colour  button lets you set the currently selected colour 
swatch as the colour used by the Pencil , Polyline , Ellipse , Rectangle  and 
Line  tools. If you select a new colour in the Colour view while using any of 
these tools, the Set Current Pencil Colour swatch will be updated.

Set Current Paint 
Colour 

The Set Current Paint Colour  button lets you set the currently selected colour 
swatch as the colour used by the Paint tool. If you select a new colour in the 
Colour view while using the Paint tool, the Set Current Paint Colour swatch 
will be updated.

Link/Unlink Three The Link/Unlink Three Colours  button lets you link the Set Current Brush 
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Colours Colour, Set Current Pencil Colour and Set Current Paint Colour swatches to 
the currently selected colour swatches in the Colour view.

 Colour Swatch 
Name 

Each colour swatch available in the Colour view can have its own name, 
making it easy to identify which colour is used to paint what part of your 
character or background. 

Two colours can have the same name.

 Colour Swatch A colour swatch is a specific colour used to paint a certain zone of a character 
or background. Colour palettes are composed of colour swatches. They can 
also be called colour pots. When you paint a zone with a colour swatch, the 
zone is linked to the swatch. So if you update the swatch’s tint, the zone will 
be updated along with it. This allows you to modify your animation colours 
even after it is completely painted.
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Coordinates and Control Points View
The Coordinates and Control Points view displays the parameters of keyframes or control points selected in the 
Camera, Timeline or Xsheet view.  You can also see the same information in the Coordinate and Control Point 
toolbars.

In this view, you can edit keyframes and control point parameters, such as the position, continuity, bias, tension and 
lock-in-time. 

How to access the Coordinates and Control Points view

Do one of the following:

 l From the top menu, select Windows > Coordinates and Control Points.

 l From any of the other views, click the Add View  button and select Coordinates and Control Points.

Parameter Description

Name The name of the function curve to which the select point is linked.

Position

Separate
Modifies modify the X, Y and Z coordinates independently. When this option is 
deselected, all three parameters are linked. If one is deleted, all others will also be 
deleted.

Cumulative Z

When a layer is parented to other layers that are moved forward or backward on 
the Z-axis, the currently selected layer's Z position value may not be accurate 
since its parent will also have an offset on the Z-axis. The Cumulative Z value is a 
compilation of all the Z-axis offsets to give the real Z-axis offset value related to 
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the (0,0) centre.

Scale

Separate Scale

Modifies the width and height values independently. When this option is selected, 
the width and height are locked to the same value, forcing the scale to be on a 1:1 
ratio. If the option is deselected, you have the ability to squash and stretch your 
layer at will.

Rotation

Angle The rotation angle value from the permanent pivot of the element.

Skew

Skew This is the skewing value.

Control Point and Keyframe

Frame The frame at which the select point is set.

Locked in Time
Indicates whether the point is locked to a specific frame (keyframe) or only locked 
to a specific position and the curve can flow through it freely as other points are 
being added, moved, or adjusted (control point).

Stop-Motion Keyframe

When this option is selected, the keyframe is set as a stop-motion point. This 
means that there is no automatic interpolation created between the selected point 
and the next one. The layer will maintain its position until the animation reaches 
the frame of the next point and will then jump to the new position. Deselect this 
option to generate interpolation and get the layer to progressively move to the next 
position.

Tension

Controls how sharply the path bends as it passes through a control point or 
keyframe.

Continuity

Controls the smoothness of a transition between the segments joined by a point.

Bias Controls the slope of the path so it flows towards one side of the motion point or 
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the other.
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Drawing View
In Harmony, you can draw in the Drawing or Camera view. Although the two views are similar, when it comes to 
drawing, there are some differences.

Only the selected drawing is displayed by default in the Drawing view. You can use features, such as the light 
table to display the current drawing of all the enabled layers of your scene in washed-out colours, or the Onion 
Skin to display the previous and next drawings of the currently selected drawing layer.

How to access the Drawing view

Do one of the following:

 l From the top menu, select Windows > Drawing .

 l From any of the other views, click the Add View  button and select Drawing.

 

Icon Section Description

688



Harmony 14 Premium - Reference Guide

View Menu The View menu contains all the tools and options 
that you can use in the Drawing view to draw, 
animate and paint.

 Drawing Area This is the main space in the Drawing view. It is 
where you draw and where the drawings are 
displayed.

 Zoom Menu The Zoom menu lets you enlarge or reduce the 
Camera or Drawing view display. 

To make the camera frame size always match the 
size of your view, select the Fit to View option. Click 
the drop-down arrow and select a zoom level or press 
1 and 2.

 Drawing Name The Drawing Name field displays the name of the 
selected drawing, as well as the layer containing it. If 
the cell does not contain any drawing, an Empty 
Cell text is shown in the field.

 Tool Name The Tool Name field displays the name of the 
selected tool. If you temporarily override a drawing 
tool using a keyboard shortcut, the tool’s name will 
be highlighted in red. You can temporarily override a 
tool by holding its keyboard shortcut without the Alt 
key. For example, the Select tool shortcut is Alt + S. 
If you hold down the S key, you will switch to the 
Select tool. When you release the key, you will return 
to the tool you were using.

 Frame Number This field displays the current frame of the animation 
you are working on.

 Cursor Coordinates This indicates the position of the your pointer in the 
drawing area.

 Colour Picker The Colour Picker allows you to select a colour for 
drawing.
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Function View
The Function view lets you edit function curves and parameters. It contains a visual graph for adding, removing, 
and editing keyframes, as well as adjusting the velocity. The Function view allows you to display multiple 
functions in the background as a reference.

How to access the Function view

Do one of the following:

 l From the top menu, select Windows > Function.

 l From any of the other views, click the Add View  button and select Function.

How to display functions in the Function view

 1. Open the Function view.

The Function view is blank until you select the layer containing the functions you want to display.

 2. To display a function in the Function view, click on the layer containing the functions to adjust in the 
Timeline view.
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 3. To select the functions you want to edit, select them in the Function list.

Parameter Description

Function List

When selecting a layer in the Timeline view, all the corresponding functions are 
displayed (if any).  Select the functions you want to see and edit, and hide the 
ones you don't.

Display Toolbar

Allows you to modify how the editing area is displayed. You can hide the grid, dis-
able the synchronization with the current frame, reset the zoom level and nor-
malize the function display by stacking them one over the other to compare them 
regardless of their value range.

Current Frame Displays the current scene frame.

Selected Keyframe Value Displays the value of the selected keyframe.

Display Advanced Parameter 
Values

Displays the Projection, Bias, Tension and Continuity parameters to adjust the 
curve around the selected keyframe.

Keyframe, Velocity and Inter-
polation Options

This toolbar lets you add and delete keyframes, adjust the velocity curve, adjust 
the segments to motion or stop-motion keyframes and set the velocity to create 
steps instead of a constant progression.

Function Types
This toolbar lets you click on the different function types to enable or disable all 
the listed functions of that type.

Value Scale
Displays the value range for the displayed editing area. It can be referenced to 
know the value of a keyframe.

Selected Keyframe
The selected keyframe is displayed in red. When selected, the keyframe values 
are displayed in the corresponding fields.

Bezier Handles
The Bezier handles let you adjust the ease in and ease out of each keyframe. The 
more the handle is pulled out horizontally, the slower the animation will be. The 
more the handle is pulled out vertically, the faster the animation will be.

Function Curve
The thin line going from keyframe to keyframe is the actual curve. The section of 
a curve located between two keyframes is called a segment.

Frame Scale
The Frame Scale displays the frame range for the displayed editing area. It can be 
referenced to know the current frame of a keyframe.
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Integrated Help View
Use the Integrated Help when you are unsure about what a certain menu item is or the function of a specific 
preference in the Preferences panel, 

If you keep the Integrated Help window open for the entire duration of your work session, then you can use the 
forward and backward arrows to scroll through  a history of the help information that you called up during your 
session.

How to access the Integrated Help view

 1. Do one of the following:

 l From the top menu, select Windows > Integrated Help.

 l From any of the other views, click the Add View  button and select Integrated Help.
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Layer Properties View
The Layer Properties editor or view lets you adjust the properties of a layer in the Timeline view or a node in the Node 
view. The Layer Properties can be viewed as a floating window or as a view (docked).

Each layer has its own set of properties that can be modified, including effect and peg layers. Display the Layer 
Properties editor or view if you want to modify some of the layer’s properties, such as the name or the antialiasing 
quality. 

NOTE: To know more about the parameters displayed in the Layer Properties view, see Nodes.

How to access the Layer Properties view

Do one of the following:

 l From the top menu, select Windows > Layer Properties.

 l From any of the other views, click the Add View  button and select Layer Properties.
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How to access the Layer Properties editor

 l Double-click on a layer in the Timeline view or a node in the Node view.

 l Right-click on a layer in the Timeline view or a node in the Node view and select Layer Properties.

 l Select a layer in the Timeline view or a node in the Node view and press Shift + E.

694



Harmony 14 Premium - Reference Guide

Library View
The Library view is used to store elements such as animation, drawings, backgrounds and puppets to reuse in 
different projects. You can also use the Library view to create and store symbols.

To reuse an element from another project, you must create a template from your drawings. A template is a mini 
scene that you import in other projects. A template has no link to the original scene. When you create a template, the 
full content of your selection is copied in the template.

Additionally, the Library view's Drawing Substitution panel allows you to quickly change the current frame's 
exposure to one of the existing drawings in a layer. This is especially useful for animating a cut-out character's 
mouths, hands, eyelids and other such body parts which typically contain several drawings to choose from. 

How to access the Library view

Do one of the following:

 l From the top menu, select Windows > Library.

 l From any of the other views, click the Add View  button and select Library.

Icon Section Description

View Menu The Library menu lets you access commands related to 
the Library view, importing .swf movies and Illustrator 
files, add a new folder, and refresh the library’s content.

 Preview Window The Preview window lets you see the content of the 
currently selected template or symbol in the 
Template/Symbol list.
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 Preview Playback The Preview Playback button lets you play back the 
content of the selected template or symbol if it contains 
more than one frame. Press the Play  button to play back 
the preview.

 Library Folder List The Library Folder List displays all the folders linked to 
the Library view. 

There are two default folders:

 l Symbols: This folder is the only folder containing 
symbols. You can organize it by adding subfolders 
inside.

 l Harmony Premium Library: This is a default 
folder found on the hard drive in your user doc-
uments. This folder can contain templates, but no 
symbols.

You can link new library folders to the Library view and 
organize them with subfolders.

 Library Search tool When working on a movie or series, you will probably end 
up with many templates and symbols in your library. 
Using the Search tool, you can quickly find the templates 
and symbols in your folders.

 Template/Symbol List The Template/Symbol list displays the templates or 
symbols contained in the selected library folder. You can 
display the templates by right-clicking the symbols’ 
thumbnails and selecting View > Thumbnails.
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Message Log View
The Message log view displays information gathered during a render task, such as which frames and at what time 
they were each rendered. The view also contains a list of the colour recovery operations.

How to access the Message Log view

Do one of the following:

 l From the top menu, select Windows > Message Log.

 l From any of the other views, click the Add View  button and select Message Log.

697



Chapter 7: Views     Model View

Model View
T-ANIMPA-004-004

Once you have a fully painted drawing, you can use it as a colour model and load it in the Model view. This 
drawing can be used and loaded in any of your Harmony scenes. 

Once a drawing is loaded in the Model view, you can use the Dropper  tool to select a colour from the model 
and use it to paint in the Camera or Drawing view without having to pick the colour from the colour palette.

How to access the Model view

Do one of the following:

 l From the top menu, select Windows > Model.

 l From any of the other views, click the Add View  button and select Model.

Icon Section Description

View Menu The View menu contains all the tools and options 
that you can use to manage models.

 Model View Toolbar The Model View toolbar contains all the tools and 
options you can use in the Model view to navigate 
through and manage models.
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Node View
T-HFND-010-002

In the Node view, you can connect effects and compositing nodes to form a network, also known as a node system. 
This view is very useful for rigging puppets, creating advanced effects and having a clear view of complex scenes. 
The organization and order of the nodes determines the flow of data during the compositing process and how your 
animation elements will be composited.

How to access the Node view

Do one of the following:

 l From the top menu, select Windows > Node View.

 l From any of the other views, click the Add View  button and select Node.

Icon Section Description

View Menu The View menu contains all the tools and options that you can use to 
manage the node system.

Editing Stack The Editing Stack menu displays the names of the symbols and their 
hierarchy when you are editing a symbol. You can click on the different 
names to go back up to the different parent symbols or the top/current 
project.
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 Node System The main area of the Node view is where you can add and organize 
different nodes to represent a scene.

 Navigator The Navigator view lets you pan the visible area to move quickly 
through extensive node sets.

 Search Toolbar The Search toolbar lets you find and match a node in the project. The 
search is not case-sensitive. Once you have entered characters in the 
search field, press Enter/Return to validate and find the pattern in the 
node names. If successful, the node is selected and centred in the 
view. If many instances are found, use the Previous and Next buttons 
to cycle through each node.

 Group Navigation When entering a group, the Group Navigation allows you to navigate 
back to the top and see the hierarchy of the group in which you are.
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Node Library View
T-HFND-010-003

To add effects or other types of nodes to the Node view, you must first find them in the Node Library view. 

When you create a new project in Harmony, the default node system that appears in the Node view looks similar to 
the one below.

Notice how layers are connected to your scene's composite. For an effect to work, it must be connected as an 
intermediary between a layer and its composite, as if it was made to filter the layer's drawing information before it 
reaches the composite. 
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How to access the Node Library view

Do one of the following:

 l From the top menu, select Windows > Node Library View.

 l From any of the other views, click the Add View  button and select Node Library View.

Ico-
n

Section Description

View Menu The View menu contains all the tools and options that you can use to manage the Node 
Library.

 Node 
Library 
View 
Toolbar

In the Node Library View toolbar, you can change how the nodes are displayed. You can 
display nodes as icons, as a textual list or as icons with their names and a description.

 Node Cat-
egories

The Node Library view is conveniently divided into several categories retaining the related 
nodes.

 Category Description

 3D Nodes related to working with 3D models within Harmony.

 Combine                     Nodes for combining images.

 Deform-
ation

Nodes needed for building a deformation chain, as well as advanced effects such as Fold 
and Auto Muscle. The Deformation category is divided into the Bone and Distort categories.

 Favorites Nodes most commonly used. To add nodes to the Favorites category, select any node from 
any other section and drag it onto the Favorites category.

 Filter Effect nodes, such as blurs. This category is subdivided into the following categories: 
Adjust, Blur, Colour Correct, Isolate and Stylize.

 Generator Nodes that create an image, such as a gradient or colour.
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 Group Nodes for grouping, like Group nodes and Multi-Port-In nodes.

 Misc Various nodes including External, Note, Script and Visibility.

 Move Nodes for changing elements over time, like Peg nodes, as well as certain transformations.

 Output Output (Export) nodes such as Crop, Display, Scale-Output and Write nodes.

 Particle Nodes needed to construct complex particle systems. This category includes a series of 
examples of particle effects and is subdivided into the following categories: Basic, 
Examples and Modifier.

 Plugins Plugin nodes.

 Shading Nodes for light shading.
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Perspective View
T-HFND-008-016

The Perspective view is used during scene setup. It allows you to see a multiplane scene’s orientation. The 
Perspective view is similar to a 3D display, as it lets you rotate the scene through all possible angles to 
understand the spacing between the elements. You can also position and rotate your layers and the camera 
inside the 3D display to achieve some 3D setup and camera moves.

How to access the Perspective view

Do one of the following:

 l From the top menu, select Windows > Perspective.

 l From any of the other views, click the Add View  button and select Perspective.

Icon Section Description

View Menu The View menu contains all the tools and options 
that you can use to work in the Perspective view.

Editing Stack The Editing Stack menu displays the names of the 
symbols and their hierarchy when you are editing a 
symbol. You can click on the different names to go 
back up to the different parent symbols or the 
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top/current project.

 X Control The red circle rotates the view on its X axis.

 Y Control The green circle rotates the view on its Y axis.

 Z Control The blue circle rotates the view on its Z axis.

 Grid This is a perspective (3D) grid reference.

 Axis Reference Arrows  The axis reference arrows let you maintain your ori-
entation when navigating in the Perspective view.

Show/Hide Camera Shows or hides camera frame in the Perspective 
view. 

Reset View Resets the pan, rotation, and zoom of the Per-
spective view.

Reset Rotation Resets the rotation of the Perspective view.

 Zoom Menu This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use 
a zoom level that lets you see all your scene layers 
and information in the Perspective view at once.

 Layer Name  This field displays the currently selected layer and 
drawing name.

 Tool Name This field displays the currently selected tool.

 Frame Number This field displays the currently selected frame of 
your animation.

 Colour Swatch  This field displays the currently selected colour in the 
palette.
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Script Editor View
Qt Script provides access to many of the functions supported in the  interface. With Qt Script, you can automate a 
number of Harmony functions to speed the completion of various repetitive tasks. The Script Editor view allows 
you to edit existing scripts and create new ones. Refer to the Scripting guide to learn more about scripting with 
Harmony.

How to access the Script Editor view

Do one of the following:

 l From the top menu, select Windows > Script Editor.

 l From any of the other views, click the Add View  button and select Script Editor.

Parameter Description

Script list On the left side of the Script Editor view, all existing script files are listed and 
can be modified in this view. The script format is JavaScript. Click on a  file to 
display its content in the Script Content window of the view.

Script content On the right side of the Script Editor view, the contents of the selected script 
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are displayed and can be edited.

Search toolbar The Search toolbar allows you to search a string within the selected script 
content. You can use the Previous and Next buttons to navigate through the 
results.

Verify This function verifies the syntax of the currently displayed script and lists any 
errors found.

Save Once you are satisfied with the modifications made to the script, click Save 
Changes to save the modifications.
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Side View
T-HFND-008-015

The Side view is used mainly for multiplane scenes and to position elements in 3D space. It allows you to see a 
scene’s stage  from  the side. This lets the camera cone and spacing between the elements to be seen.

How to access the Side view

Do one of the following:

 l From the top menu, select Windows > Side.

 l From any of the other views, click the Add View  button and select Side.

Icon Section Description

View Menu The View menu contains all the tools and options 
that you can use to work in the Side view.

 Thumbnails A thumbnail of each drawing layer in the scene. The 
order of the thumbnail images is based on each 
element’s FB position in the scene space. You can 
see a representation of the FB position of each layer 
in the camera cone.

 Camera Cone The camera cone represents the camera’s position 
and field-of-view (FOV). 

 Axis Reference Arrows  The axis reference arrows let you maintain your ori-
entation when navigating in the view.
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Show/Hide Camera Shows or hides camera frame in the Perspective 
view. 

Reset View Resets the pan, rotation, and zoom of the Per-
spective view.

 Zoom Menu This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use 
a zoom level that lets you see all your scene layers 
and information in the Perspective view at once.

 Layer Name  This field displays the currently selected layer and 
drawing name.

 Tool Name This field displays the currently selected tool.

 Frame Number This field displays the currently selected frame of 
your animation.

 Colour Swatch  This field displays the currently selected colour in the 
palette.
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Timeline View
T-HFND-006-002

To set your animation timing, you will mostly work with the Timeline and Xsheet views. It's extremely useful to 
become familiar with the Timeline view, how it works, and its interface.

The Timeline view is the main view used when adjusting the timing of drawings, adding keyframes and ordering 
layers. The Timeline view displays layers, effects,  sounds, keyframe values, scene length, layer names, 
drawings, keyframes, timing, and frames.

The Timeline view allows you to read your timing from left to right. It represents the scene’s elements in their 
simplest form. You can also see the layers and their names, as well as the drawing’s exposure. The drawing 
name is displayed when you place your pointer over the drawing’s exposure.

How to access the Timeline view

Do one of the following:
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 l From the top menu, select Windows > Timeline.

 l From any of the other views, click the Add View  button and select Timeline.

Ico-
n

Section Description

View Menu The View menu contains all the tools and options that you can use to manage models.

 Model View 
Toolbar

The Model View toolbar contains all the tools and options you can use in the Model view to 
navigate through and manage models.

Enable/Disabl
e All 

The Enable/Disable All  button lets you show or hide layers.

When you deselect a layer in the Timeline view, the corresponding column is hidden in the 
Xsheet view. When a column is hidden in the Xsheet view, the corresponding layer is 
disabled in the Timeline view.

To disable a layer, click the layer's Enable/Disable All  button or press D.

To enable a layer, click the layer's Enable/Disable All  button or press A.

Solo The Solo  button lets you view drawing or sound layers in the Camera view. You can enable 
this mode on multiple layers. When the Sole mode button is deselected, everything is visible 
in the Camera view. When one or more layers are soloed, only those layers appear in the 
Camera view. 

Onion Skin The Onion Skin  button enables the Onion Skin option on a particular layer. If you want to see 
the previous and next frames of a specific layer, go to the Timeline view and click the Onion 
Skin button for that particular layer. Blue arrows appear on both sides of the play head. Drag 
the blue arrows to add more frames to the onion skin display.

To activate the general Onion Skin preview, in the Tools toolbar, click the Onion Skin  button.
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Lock/Unlock 
Layer 

The Lock/Unlock Layer button lets you prevent the selection or editing of a layer in the Cam-
era view. To select some of the layers without selecting others, in the Timeline view, lock the 
layers you do not want to select. When a layer is locked, its name is displayed in red.

In the top menu, there is a series of locking options. Select Animation > Lock > select one of 
the following:

 l Lock: Locks the currently selected element.

 l Unlock: Unlocks the currently selected element.

 l Lock All: Locks all the elements in the Camera view. 

 l Unlock All: Unlocks all the elements in the Camera view.

 l Lock All Others: Locks all the elements in the Camera view except the currently 
selected one.

You can display the locked drawings as outlines in the Camera view to quickly find out which 
drawings are locked. 

Change Track 
Colour 

The Change Track Colour  button lets you change the colour of the exposed frames; this 
helps you to quickly locate a layer in the Timeline view. Click the Change Track Colour  but-
ton to open the Select Colour window and choose a new colour. You can modify the colour for 
any type of layer, such as group, peg, drawing, and effects.
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Add Layers The Add Layers  button lets you add new layers to the Timeline view. When you click the Add 
Layers button, a menu appears displaying the layer types available. You can add several 
different types of layers: 

 l  Camera

 l  Deformation

 l  Drawing

 l  Generator

 l  Group

 l  Transformation

 l   Effects

 l  Sound

Delete Layers The Delete Layers  button lets you delete the currently selected layers in the Timeline view.

Add Drawing 
Layer

The Add Drawing Layer  button lets you automatically add a new drawing layer to the Timeline 
view. By default, the layer is named Drawing.

Add Peg The Add Peg  button lets you add a peg layer to the timeline. If several layers are selected, a 
peg is added and parented to each layer.

 Expand/Colla
pse

The Expand/Collapse  button is used to display the children layers of a parent layer. Once a 
layer is parented to another layer, it is indented to the right and the Collapse/Expand Children 
button appears on the parent layer allowing you to show or hide the child layer.
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Show/Hide 
Functions

The Show/Hide Functions  button lets you display the functions embedded in each layer. The 
functions are the different coordinates and values used to record a layer’s parameters at each 
frame. This information is stored on the function curves using keyframes.

Parameters The Parameters section lets you add, remove or modify a keyframe at the current frame. You 
can show or hide the Parameters section by clicking the Show/Hide Parameters button.

Add Keyframe Adds a keyframe at the current frame.

Delete Key-
frame

Removes an existing keyframe at the current frame.

Hand Cursor Lets you change the current keyframe or drawing exposure. When you hover the cursor over 
the value, the hand cursor appears. Drag left or right to change the value. Or double-click on 
the keyframe value and enter a new value.

Previous Key-
frame

Lets you navigate through the previous keyframes.

Next Key-
frame

Lets you navigate through the next keyframes.

Show Func-
tion Menu

Displays the Function menu where you can link a layer to an existing function or create a new 
function.
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 Keyframe A black or red square is displayed in the Timeline view when a keyframe exists. You can 
select these keyframes and drag them wherever you want on the timeline. You can also 
copy, cut, and delete them.

NOTE: To delete a keyframe without deleting the drawing exposure, go to the Timeline 
view and select the keyframe to be deleted and then select Animation > Delete Key-
frame from the top menu or press F7.

When a parent layer is collapsed and a child layer contains a keyframe, a white square will be 
displayed.

Split The Split  button lets you split the Timeline view in two sections, allowing you to see two 
different portions of the Timeline view. This way, if your scene length is very long, you can 
see the beginning and the end at the same time.

 Drawing 
Exposure 

In the Timeline view, when a drawing is exposed, it is represented as a grey block. If the 
drawing is exposed for several frames, the block is extended. When a second drawing is 
exposed, a new grey block is displayed.

The exposure’s colour can be changed. To pick a new colour, click the Change Track Colour  
button in the corresponding layer.

View Modes The View Modes  button lets you streamline the process of working with elements in the 
Timeline view. There are three different view modes you can choose to work in. With each 
mode you select, certain elements may or may not be visible in the Timeline view. Depending 
on your workflow, this can be useful for quickly hiding elements when you want to focus on 
specific ones. To select a view mode, use the drop-down menu in the bottom-left corner of 
the Timeline view.

Show/Hide 
Additional 
Links

The Show/Hide Additional Links  button lets you display links associated with a layer. For 
example, if you connect a mask to more than one effect such as a Tone and a Highlight, you 
can see these connections in the Additional Links section, as well as links to composite 
nodes.
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 Zoom The Zoom tool increases or reduces the width of the frames in the Timeline view. Move the 
slider right to increase the width or left to reduce it. You can also press 1 and 2. Reset the 
zoom by click the Reset Zoom button.

716



Harmony 14 Premium - Reference Guide

Tool Properties View
T-HFND-004-002

The Tool Properties view contains the most common options and operations related to the currently selected tool. 
When you select a tool from the Tools toolbar, the Tool Properties view updates.

For example, if you choose the Select  tool, the Tool Properties view will display the options and operations related to 
it, such as Snap to Contour, Apply to All Drawings, Flip Horizontal, and Flatten.

NOTE: To learn more about the options appearing in the Tool Properties view, see Tools Properties on page 
543.

How to access the Tool Properties view

Do one of the following:

 l From the top menu, select Windows > Tool Properties.

 l From any of the other views, click the Add View  button and select Tool Properties.
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Top View
T-HFND-008-014

The Top view is used mainly for multiplane scenes and to position elements in 3D space. It allows you to see the 
scene’s stage  from above. This lets the camera cone and the spacing between the elements be seen.

How to access the Top view

Do one of the following:

 l From the top menu, select Windows > Top.

 l From any of the other views, click the Add View  button and select Top.

Icon Section Description

View Menu The View menu contains all the tools and options 
that you can use to work in the Side view.

 Thumbnails A thumbnail of each drawing layer in the scene. The 
order of the thumbnail images is based on each 
element’s FB position in the scene space. You can 
see a representation of the FB position of each layer 
in the camera cone.

 Camera Cone The camera cone represents the camera’s position 
and field-of-view (FOV). 

 Axis Reference Arrows  The axis reference arrows let you maintain your ori-
entation when navigating in the view.
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Show/Hide Camera Shows or hides camera frame in the Perspective 
view. 

Reset View Resets the pan, rotation, and zoom of the Per-
spective view.

 Zoom Menu This field displays the current zoom level in the 
Perspective view. You can use the Zoom level drop-
down menu to select a specific zoom level from the 
list. Zoom levels from 2.5% to 6400% are available; 
you can also select Fit To View to automatically use 
a zoom level that lets you see all your scene layers 
and information in the Perspective view at once.

 Layer Name  This field displays the currently selected layer and 
drawing name.

 Tool Name This field displays the currently selected tool.

 Frame Number This field displays the currently selected frame of 
your animation.

 Colour Swatch  This field displays the currently selected colour in the 
palette.
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Xsheet View
T-HFND-006-003

The Xsheet view lets you read the timing vertically, displays the drawing layers as columns, and shows the 
drawing’s name. You can also see the functions and keyframes of the motion paths in the Xsheet’s function 
columns. The value of each keyframe is shown in the Xsheet view; these are displayed as black squares in the 
Timeline view. The Xsheet view contains more detail than the Timeline view, and is faster and easier to read.

How to access the Xsheet view

Do one of the following:

 l From the top menu, select Windows > Xsheet.

 l From any of the other views, click the Add View  button and select Xsheet.

Icon Section Description

View Menu The View menu contains all the tools and options that you 
can use to manage columns and timing.

 View Toolbar The view toolbar contains all the tools and options you can 
use in the Xsheet view to manage columns and timing.

 Xsheet Main Section The Xsheet view has three sections. By default, only the 
main section is visible. It displays the drawing layers, also 
known as drawing columns.
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When using advanced compositing and animation 
techniques, unconnected functions (motion paths) also 
appear in the main section. Unconnected functions mean 
that some motion paths are not attached to any particular 
layer.

When you reconnect functions to a layer, they are still 
visible in the main section.

 Functions Section The Functions section is used for more advanced 
techniques. This section displays the functions (paths) 
related to the selected layer in the Timeline view. By 
default, the Functions section is hidden.

In the Xsheet view, click the Expand button located on the 
right side of the main section. Click on the same button to 
collapse it. You can also use the Show Column List  button 
in the Xsheet View toolbar. If you select a drawing column 
in the main section of the Xsheet view, the function 
columns will not be displayed. You must select the layer 
from the Timeline view.
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 Column List Section The Column List section allows you to show and hide 
columns in the Xsheet view. When you hide a layer in the 
Xsheet view, it is also disabled in the Timeline view.

You can use the Column List to hide individual columns or 
hide an entire column type (drawing or function) from the 
Xsheet view. By default, the Functions section is hidden.

In the Xsheet view, click the Expand button on the right side 
of the main section to show the Functions section. Click on 
the same button to collapse it. You can also use the Show 
Column List  button in the Xsheet toolbar.

Go to the Xsheet view menu and select View > Show 
Column List. Click the Expand button on the right side of 
the Functions section to display the Column List section.

 Column Header Each column available in the Xsheet view has a header 
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displaying the column’s name. The column’s name is the 
same as the corresponding timeline layer. If you rename 
one or the other, they will both be renamed.

A quick access menu is available when you right-click. This 
menu contains the command affecting an entire column 
such as renaming, changing the default colour, or deleting a 
column.

The tooltip that appears when you hover at the top of each 
Xsheet column shows the folder path to the source 
drawings for that column.

In Harmony, the column header shows the layer’s name and 
the name of the drawing folder to which it is linked. If the 
name of the layer is the same as the drawing folder, the 
drawing folder’s name will not be displayed. For example; 
when you link a Timing column to a certain element (and 
thereby the Element’s folder). To modify the name of the 
element folder independently from the column and layer 
name, you must select the Advanced Element Mode option 
preference in the Advanced tab of the Preferences dialog 
box.

 Current Drawing A drawing selected in dark red indicates that the drawing is 
currently displayed in the Drawing and Camera views. The 
current drawing selection is not linked to the drawing 
displayed in the Camera view since drawings from each 
visible layer are displayed at once.

 Current Frame The darker frame appearing in the Xsheet view represents 
the current frame.
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 Drawing Exposure In the drawing columns, you can see the drawing names 
and their exposure. You can use any alphanumeric symbol 
to name your drawing. When a drawing is exposed over 
more than one cell, a vertical black line is displayed to 
indicate the continuity of the exposure. When there is no 
drawing in a cell, the cell will be blank.

 Frame Numbers On the left side of the Xsheet view, the frame numbers are 
shown indicating where you are. These read vertically 
instead of being displayed horizontally as they are in the 
Timeline view.

 l To go to a particular frame, click the frame number.

 l To select an entire range of frames, click and drag a 
selection downwards.

 Current Frame Display At the bottom-right of the Xsheet view, you can see the 
current frame number, as well as the column containing the 
drawing currently displayed in the Drawing view.

 Functions Column The functions columns are displayed in the Functions 
section of the Xsheet view. They represent the motion and 
rotation you applied to a drawing layer. Only the function 
columns related to the selected layer are displayed.

724



Harmony 14 Premium - Reference Guide

A function column can also be related to an effect. Selecting 
the effect layer shows you the corresponding function 
column in the Xsheet view.

The function columns display the position value or effect 
value on each cell. If there is a keyframe on a cell, a black 
square is displayed. Holding the same value for several 
frames displays a vertical black line.

 Increase/Decrease 
Exposure

You can quickly increase or decrease the exposure of the 
selected cell by clicking on the up and down arrows in the 
Increase/Decrease Exposure field.

 Overwrite/Insert Modes The Overwrite/Insert button allows you to decide the way 
the values are inserted into the Xsheet.
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